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GENESYS

AN ALCATEL-LUCENT COMPANY

Preface

Welcome to the Qutbound Contact 8.0 Deployment Guide. This document
provides step-by-step instructions for the configuration and installation of the
applications and components that are required in order to run Outbound
Contact 8.0.

This document is valid for all 8.0 release(s) of this product.

Note: For versions of this document created for other releases of this

product, visit the Genesys Technical Support website, or request the
Documentation Library DVD, which you can order by e-mail from
Genesys Order Management at ordermanegenesys lab.com.

This preface contains the following sections:

About Outbound Contact, page 15

Intended Audience, page 16

Making Comments on This Document, page 16
Contacting Genesys Technical Support, page 16
Document Change History, page 17

For information about related resources and about the conventions that are
used in this document, see the supplementary material starting on page 435.

About Outbound Contact

Outbound Contact 8.0 is an automated system for creating, modifying,
running, and reporting on outbound campaigns for proactive customer contact.
Outbound Contact Server (OCS) provides automated dialing and call-progress
detection, so that an agent is required only when a customer is connected. OCS
also intelligently uses customer data to ensure that campaigns are contacting
the right customers, not just a large number of customers.

Deployment Guide
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Preface

Intended Audience

Intended Audience

This document is primarily intended for system engineers and other members
of an implementation team who set and maintain Outbound Contact 8.0. It has
been written with the assumption that you have a basic understanding of:

* Computer-telephony integration (CTI) concepts, processes, terminology,
and applications.

* Network design and operation.
*  Your own network configurations.

You should also be familiar with the Genesys Framework architecture and
functions that support Outbound Contact 8.0.

Making Comments on This Document

If you especially like or dislike anything about this document, feel free to
e-mail your comments to Techpubs.webadminegenesyslab.com.

You can comment on what you regard as specific errors or omissions, and on
the accuracy, organization, subject matter, or completeness of this document.
Please limit your comments to the scope of this document only and to the way
in which the information is presented. Contact your Genesys Account
Representative or Genesys Technical Support if you have suggestions about
the product itself.

When you send us comments, you grant Genesys a nonexclusive right to use or
distribute your comments in any way it believes appropriate, without incurring
any obligation to you.

Contacting Genesys Technical Support

If you have purchased support directly from Genesys, contact Genesys
Technical Support at the following regional numbers:

Region

Telephone E-Mail

North America and
Latin America

+888-369-5555 (toll-free) supportegenesyslab.com
+506-674-6767

Europe, Middle East, and +44-(0)-1276-45-7002 supportegenesyslab.co.uk

Africa

Before contacting technical support, refer to the Genesys Technical Support Guide for complete contact
information and procedures.

16
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Document Change History

Region Telephone E-Mail

Asia Pacific +61-7-3368-6868 supportegenesyslab.com.au

Malaysia 1-800-814-472 (toll-free) supportegenesyslab.com.au
+61-7-3368-6868

India 000-800-100-7136 (toll-free) supportegenesyslab.com.au
+91-(022)-3918-0537

Japan +81-3-6361-8950 supportegenesyslab.co.jp

Before contacting technical support, refer to the Genesys Technical Support Guide for complete contact
information and procedures.

Document Change History

Release 8.0.001

Deployment Guide

This section lists topics that are new or that have changed significantly since
the first release of this document.

Chapter 1, “Overview””:

+ The section, “New Features in Release 8.0.001” on page 20 has been
added to describe new features for this release.

Chapter 8, “Manually Defining Outbound Configuration Objects”:

+ Table 14 on page 191 was updated to include a description of the new
Apply to Record Value, “Execute SQL Statement”.

Chapter 9, “Outbound Contact Configuration Options”:

+ The sections, “Multi-Level Options for OCS” on page 219 and
“Campaign Group-Level Options for OCS” on page 226, have been
updated to include new options that were introduced in this release.

Chapter 11, “Pre-Dial Validation”:

+ This is a new chapter, added to provide information about Pre-Dial
Validation over a secure and non-secure connection.

Chapter 12, “Call Handling/Treatments™:

+ The section, “Execute SQL Statement Action Type” on page 346, has
been added to describe this new Action type.

Chapter 13, “SCXML-Based Treatments”:

+ The section, “Document Retrieval from Web or Application Server” on
page 359, has been added to describe how OCS retrieves SCXML
documents from a Web or Application Server.

+ Table 39 on page 368 has been updated to include a description of the
new Custom Actions that were introduced in this release.
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+ The section, “Setting Options for Individual Records or Chain of
Records” on page 379, has been added to provide information about
setting options for individual records or chain of records and includes a
the section, “Custom Actions” on page 379, to describe Custom
Actions for SCXML treatments
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Chapter

Overview

This chapter provides an overview of Outbound Contact 8.0. It introduces the
new features and functions for this release, and defines the basic terms and
concepts that are relevant to the Outbound Contact solution.

This chapter contains the following sections:

+ Introduction to Outbound Contact 8.0, page 19

- New in This Release, page 20

Introduction to Outbound Contact 8.0

Deployment Guide

Outbound Contact 8.0 is an automated system that is used to create, modify,
and run outbound dialing campaigns/dialing sessions in which agents interact
with customers. Running a dialing session, involves launching a dialing
session that is associated with the campaign, monitoring it, and making any
necessary adjustments. To perform these tasks, Outbound Contact users can:

* Create calling lists from customer contact information.
*  Group calling lists into campaigns for outbound dialing.
* Share campaigns among multiple agent groups.

* Create campaign sequences with the Campaign Sequence object, which
provides predefined thresholds and automatic agent assignments.

* Chain records for a customer (multiple call records).
* Choose different dialing modes.

e Define treatments and scheduled calls for unsuccessful calls on each
calling list.

*  Monitor campaigns using Reporting tools.
* Apply Do Not Call restrictions by phone number or customer ID.

Outbound Contact has a client/server architecture consisting of the following
components: Outbound Contact Server (OCS), Call Progress Detection Server
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(CPD Server), and CPD Proxy Server. In release 8.0, Genesys Administrator
replaces Outbound Contact Manager (OCM). Genesys Administrator is a
web-based user interface (UI) that provides provisioning, monitoring,
deployment, and operations of Genesys solutions.

Note: OCM 7.6 can be used with Outbound Contact 8.0.

For more information about these components, see Chapter 2 on page 25.

New in This Release

This section describes the new configuration and/or installation procedures in
Outbound Contact.

New Features in Release 8.0.001

This 8.0.001 release of Outbound Contact includes the following features:

20

Real-time pre-dial validation by an external application—Pre-dial
validation is an optional first step in the processing of a dialing record.
With pre-dial validation configured, OCS connects to the Web or
Application Server using the HTTP or HTTPS and delivers a specifically
formed HTTP POST request immediately before dialing. OCS then dials or
rejects the record based on the received response.

Dynamic port allocation—Outbound Contact allows the optimization of
dialing ports usage in configurations where multiple Campaign Groups
share the same dialing and call progress detection (CPD) resources. OCS
allocates ports, based on an estimated average number of ports required for
each Campaign Group and, based on the current dialing conditions and the
optimization parameters. This feature is available for Progressive,
Predictive, Progressive with Seizing, and Predictive with Seizing
dialing modes.

Separate tracking for engaging channels—Outbound Contact provides the
ability to specify the number of engaging channels and track them
separately from the regular channels in the Predictive Algorithm
calculations for port availability for Campaign Groups that use CPD Server
or SIP Server in Progressive with Seizing or Predictive with Seizing
dialing modes with separate ports for engaging calls.

Transfer/Connect treatment application—Outbound Contact supports the
ability to transfer a call when working in a VoIP environment in Power GVP
or Progressive GVP dialing modes using a Transfer/Connect treatment
application. After an outbound call is processed by a VoiceXML
application, if the VoiceXML application delivers the RecordProcessed
notification to OCS via HTTP with the 6SW_TREATMENT flag set, OCS uses a
single step transfer to deliver the call to the destination specified in the
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treatment. For example, this ability can be used to transfer an outbound call
to an ACD queue for delivery to a live agent after it is self-serviced on a
GVP port.

New Execute SQL treatment—Outbound Contact supports the new
Execute SQL Statement treatment for a record that allows the execution of
a user-defined SQL statement. In addition, the SQL statement can include
macro expressions.

Improved call treatment flexibility using SCXML treatments. In addition

to those scenarios supported for the 8.0.000 release, the following

scenarios are now supported in 8.0.001:

+ Specifying Caller ID and other options on an individual record or on a
chain of records basis.

+  Ability to switch from applying SCXML treatments to traditional
treatments.

+ Enhancements to SCXML document retrieval using HTTP.

+ Ability to retrieve SCXML documents using HTTPS.

New Features in Release 8.0.0

This 8.0.0 release of Outbound Contact includes the following features:

Deployment Guide

Outbound-VoIP environment—Enables automated outbound dialing in an
IP architecture. This feature leverages the capabilities of SIP Server,
Genesys Voice Platform (GVP) Media Server, and Resource Manager, in
addition to Outbound Contact Server. For more information, see Chapter 3
on page 87.

SCXML-based Treatments for customer-focused dialing—Allows you to
create customer-focused treatments that are written in SCXML (State
Chart Extensible Markup Language), which provides greater flexibility on
how to contact customers and handle call results. For more information,
see Chapter 13 on page 357.

Genesys Administrator—A new customer interface provides the capability
to provision, monitor, and deploy Outbound Contact 8.0 and other Genesys
solutions. Genesys Administrator also includes the ability to manage all
related campaigns activities through Operations tab.
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Genesys Administrator replaces Configuration Manager and OCM in
Outbound Contact 8.0. You can use OCM 7.6 with Outbound Contact 8.0.
For more information, see Framework 8.0 Genesys Administrator Help.

Notes: As a result of this replacement, the following comprehensive
changes were made to this deployment guide and the Outbhound
Contact 8.0 Reference Manual:

* All references to and procedures that involve Configuration
Manager are replaced by Genesys Administrator. However,
Configuration Manager can still be used to install and
configure applications and objects.

* In Genesys Administrator and these documents, the phrase,
Dialing Session, is used when loading/starting/stopping/
unloading/force unloading a Campaign Group. However, the
object name remains Campaign Group.

Agent Assignment in Multiple Campaigns in the ASM Modes—Enables
agents to be assigned to multiple campaigns in ASM modes, which
increases efficiency by leveraging agents with their associated skills. If the
agent-assignment option (see page 226) is set to true, OCS adds the
Campaign Group DBID and Campaign Group Name in its request to
engage an agent. For more information, see “Agent Assignment in
Multiple Campaigns” on page 44.

Note: This capability was previously available in the Transfer modes.

Preventing Record Cancellation on an Agent Desktop—A new option,
cancel-on-desktop (see page 235), stops OCS from canceling records that
are already on an agent’s desktop. This allows the agent to complete calls
and their associated records that are still in progress, instead of locking the
records and preventing their completion.

Time-Optimized Predictive Algorithm—A new time-optimized predictive
algorithm provides contact centers with the flexibility to increase or
decrease the dialing pace for a specified period, but still meet any overall
overdial-rate restriction (see “Time Optimized Predictive Algorithm” on
page 56).

Answering Machine and Beep Tone Detection—A new option,
am-beep-detection, specifies whether GVP is forced to detect an
answering machine beep tone before starting the VXML application to
play a recording. For more information on this option, see page 228.
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*  Other features/options:

*

Migration

Dialing mode/third-party client support for Campaign Groups—OCS
now supports third-party clients (for example, Interaction Server) over
a dedicated ESP port for Campaign Groups in all dialing modes. For
more information, see “Dialing Modes and Third-Party Clients” on
page 51.

HTTP Support—OCS supports communication between OCS and
OCS clients, such as GVP by using HTTP requests/responses. For
more information, see the “Outbound Contact and HTTP Server” on
page 77 and the Proactive Contact 8.0 Solution Guide. For a
description of HTTP requests and the URI that OCS supports, see
Outbound Contact 8.0 Reference Manual.

Outbound-specific user data for GVP—Outbound now leverages SIP
Server functionality to deliver user data in the SIP messages header of
TMakePredictiveCall to process a call. For more information, see the
Outbound Contact 8.0 Reference Manual.

Instant Messaging support—OCS can now process records with an
Instant Messaging (IM) phone type.

ASM dialing modes functionality:

+ asm_drop_am_announcement_data option (see page 229)— Enables
the playing of a message if an answering machine is detected before
it releases the established customer call in ASM modes

+ merge-method option (see page 240)—Defines the OCS merge
method for outbound and engaging calls in the ASM mode when
dialing using SIP Server

+ on-bridging-unable option (see page 241)—Defines the behavior of
OCS when there is no established engaging call on the same Media
Server and it is not possible to use the bridging method

VoIP dialing mode functionality:

+ beep-on-merge (see page 230) option—Enables the playing of a
beep tone to the agent on the engaging call immediately before the
agent is bridged to the customer call when running in Outbound
VoIP dialing mode

+ cpd-on-connect option (see page 236)—Specifies when
call-progress analysis is started in Outbound VoIP dialing modes

Refer to the Genesys 8 Migration Guide for detailed information about
migrating Outbound Contact 7.5 to Outbound Contact 8.0.

License Control

Outbound Contact 8.0 requires an 8.0 license. If you want run Outbound
Contact in a mixed environment (in which some Outbound Contact

Deployment Guide
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New in This Release

components are release 8.0, and some others are release 7.5 or 7.6), both 7.x
and 8.0 licenses must be present on License Server. With the exception of Push
Preview and Power GVP, all dialing modes require licenses.

Note: If you are using Dialogic HMP Dialogic software, additional licenses
are necessary. See “HMP Software” on page 406 and contact your
Dialogic representative for more information.

Refer to the Genesys Licensing Guide for detailed information about how to
license Outbound Contact 8.0.
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Chapter

Architecture

This chapter explains the required architecture for outbound campaigns. It
contains the following sections:

Outbound Architecture Overview, page 25
Outbound Contact Terms and Concepts, page 34
Dialing Overview, page 48

Multiple Sites, Users, and Tenants, page 71
Outbound Contact and HTTP Server, page 77
Other Supporting Solutions, page 78

Note: For architectural and related information about using Outbound

Contact in an Outbound-VoIP environment, see Chapter 3 on page 87.

Outbound Architecture Overview

Outbound Contact 8.0 provides an integrated environment for creating,
running, and reporting on outbound campaigns. Figure 1 illustrates how the
Outbound Contact components integrate with other Genesys components in a
standard T-Server environment. For an architectural diagram of Outbound
Contact operating in a VoIP environment, see Chapter 3 on page 87.

Deployment Guide
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Outbound Architecture Overview
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Figure 1: Outbound Contact Architecture - T-Server Configuration

The following subsections describes (respectively) the Outbound Contact
components, Genesys Administrator, and how they fit into the architecture that
is illustrated in Figure 1.

Outbound Contact Server

26

Outbound Contact Server (OCS), as the dialing engine, is the core of Outbound
Contact. It retrieves information from Calling List(s) with the help of the

DB Server and requests that T-Server, or a Dialogic board (through CPD
Server), or another dialer (when using GVP 7.6 Outbound Notification (OBN)
or Interaction Server) dials outbound calls or initiates outbound interactions.
OCS monitors the call flow and reacts to call results and delivers responses to
requests from agent desktops.
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Desktop protocol for Outbound Contact enables OCS to communicate through
T-Server with agent desktops. Third-party protocol for Outbound Contact
enables OCS to communicate through a Communication DN with third-party
applications. Outbound Contact is also capable of communicating with another
OCS, Stat Server, and ICON.

Note: Starting with release 7.5, Outbound Contact Server can also use the
following:

* Genesys Voice Platform (GVP) to dial outbound calls. For more
information, see “Genesys Voice Platform” on page 82.

* Interaction Server to deliver interactions to agent’s desktops. See
“Genesys eServices (formerly, Multimedia)” on page 80 for more
information.

« Stat Server to provide Agent/Place status information solely. In any
dialing mode, when monitoring an Agent/Place group is required,
Stat Server should be properly configured; otherwise, Outbound
Contact will not operate.

OCS also performs the following functions:

* Reads configuration data—including the options for configuration objects
such as Agent Groups, Place Groups, and Campaign Groups— from the
Configuration Database.

* Receives commands from Outbound Contact Manager, Genesys
Administrator, or third-party applications for starting and stopping dialing
sessions for Campaign Groups.

* Provides pacing algorithms for the dialing of outbound calls.
* Updates call results.

* Applies treatments to records based on call results.

* Processes Do Not Call (DNC) requests

*  Checks the Do Not Call list for telephone numbers and customer IDs that
should not be contacted.

Genesys Administrator

Deployment Guide

In release 8.0, Genesys Administrator replaces Outbound Contact Manager
(OCM) as the UI for Outbound Contact. Genesys Administrator is a web-based
UI that provides provisioning, monitoring, and deployment abilities for
Genesys solutions. It supports the same functionality that was previously
provided by OCM 7.6.

The Outbound-specific features of Genesys Administrator enable contact
center managers to perform tasks such as the following:

* Manage calling lists:
+ Add, modify, and delete records in a list.
+  Create chained records in a list.
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+ Move records among calling lists that have the same table format and
that exist in the same type of DBMS.

+ Import/export calling lists.

Browse Calling Lists, Campaign Groups, and their components:
+ Use dialing and viewing filters to select records by particular criteria.

Outbound Contact Manager or Genesys Administrator can
automatically save a viewing filter when the user leaves the current
calling list. When the user reopens the list, Genesys Administrator
retrieves and displays the filter.

View the relationships among campaigns, agent groups, and calling lists.
Start and stop dialing sessions.

If you start a dialing session with Genesys Administrator, and then
Genesys Administrator stops, the dialing session continues to run. When
Genesys Administrator restarts, OCS updates Genesys Administrator with
the current status of the dialing session.

Manage campaign sequences.
Monitor the current status of dialing sessions for outbound campaigns.

Specify or modify the optimization parameters for any campaigns and
campaign sequences that are running.

Update Do Not Call lists with data from external sources.

Prioritize records for dialing by record type.

Note: OCM 7.6 still can be used with Outbound Contact 8.0. If you are

using OCM, Dialing Sessions are called Campaign Groups for starting
and stopping operations.

Call Progress Detection Server

28

Call Progress Detection Server is an optional component for switches that do
not have Call Progress Detection (CPD) capability. This server uses a Dialogic
board to perform CPD for outbound calls and, if configured, to record voice
files. As the dialer, CPD Server interfaces with OCS and the Dialogic board.

Dialing Methods

The way in which outbound dialing is performed depends on the dialing
method and equipment that you use. There are several ways to perform
outbound dialing:

No Call Progress Detection (CPD) Server required if
+ A switch already has call progress detection capability, or
+ SIP Server is used with GVP applications.
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* Transfer modes—The dialing mode in which calls successfully placed and
identified with a positive CPD are transferred from the dialing resource to
the VDN (Vector DN) for distribution to agents.

e ASM modes—

+ For the Dialogic boards, the board connects to the switch through an
ISDN carrier. In this mode, outbound calls are a combination of the
following:

+ Aninternal call from the board to the agent desktop (an engaging
call).

+ An outbound call from the board to the public switched telephone
network (PSTN).

CPD Server connects these two calls on the Dialogic board when it is
time to establish a call between an agent and a dialed number.
Therefore, this method requires twice as many Dialogic ports as
Transfer mode requires.

Note: ASM mode is the only supported dialing mode when using T-Server
for Cisco CallManager/Unified Communications Manager.

For more information on these dialing modes, see “Dialing Modes” on
page 50.

Engaging Calls

An engaging call usually is an internal call dialed from the call-processing port
(dialing modes that used in conjunction when using CPD server) or from the
Trunk Group DN (dialing modes that used in conjunction when using VoIP
environment) to the Voice Transfer Destination DN and is delivered to an agent
from this DN. An agent answers this call, which makes the agent engaged—that
is ready to be connected (bridged) to an outbound call with a customer.

The ASM mode provides the following functionality to enhance performance:

* Eliminates unacceptable delays between the time when a customer picks
up the phone and when the call is connected to an agent.

*  Avoids lack of support for call transfers.

* Eliminates force-tone problems in which a customer can hear a signal
intended only for an agent — for example, when a signal alerts the agent
that a call is transferred.

In the Predictive with seizing dialing mode, a call is dialed automatically,
based on a prediction of agent availability; the agent is then seized (engaged)
before the called party answers. There is no delay after the customer is
connected. OCS includes a campaign-pacing engine with a Predictive dialing
algorithm that initiates the record dialing.
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In the Progressive with seizing dialing mode, a call is dialed automatically
when an agent is already on the line and ready to take the call. Progressive with
seizing means Progressive dialing in ASM mode.

In both modes, the agent should be on the line (engaged) before the customer
answers. The differences between these two dialing modes are as follows:

* InProgressive with seizing mode, the agent is already reserved for the
call when it is dialed.

* InPredictive with seizing mode, the agent is predicted to be available
when the dialer places the call.

Note: Inrelease 7.6.101 and higher, the predictive algorithm accounts for the
average engaging call dialing duration (defined as the time between an
agent going ready and becoming ASM Engaged when the engaging
call is delivered to the agent) for a given campaign and uses this value
when calculating dialing pacing.

Centralized CPD Server

Outbound Contact supports a centralized CPD Server. A contact center that has
a multi-site environment can use a single CPD Server at its central location.
With a centralized CPD Server, a routing strategy at the central site can send
calls and events to Routing Points that are distributed across the network.

For example, in a multi-site environment where a group of agents are logged
into a switch, you can use a single CPD Server that is connected to any
T-Server at that same site. The agents do not have to be logged in to the same
switch to which the CPD Server is connected. With a centralized CPD Server,
a routing strategy at the central site can send calls and events to Routing Points
that are distributed across the network. For more information, see also
“Multi-Sites” on page 71.

Sample Call Flow with Centralized CPD Server

The following is a sample call flow using a centralized CPD Server. In this
example, Steps 1 through 7 occur at the central location in a wide-area network
(WAN).

1. The OCS sends a dial request to the CPD Server. (Both the OCS and CPD
Server are at the central location.)

2. CPD Server sends a dial request to its Dialogic board.

3. The Dialogic board dials the customer’s number. A switch conveys the call
to the customer, while the Dialogic board performs call-progress detection.

4. After receiving an Answer call result, the CPD Server transfers the call to a
Routing Point.

5. A T-Server, that is monitoring the switch to which it is linked (by a CTI
link), informs the Router about the call at the Routing Point.
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6. The routing strategy at the central location determines how to route the
call. In this example, the routing strategy determines that the call should be
routed to an agent at an outlying site.

7. The Router sends the call to Inter Server Call Control (ISCC), an external
routing feature of T-Server.

8. ISCC sends the call to a second switch that is being monitored by a second
T-Server. The second switch relays the call to an ACD Queue for a group
of agents.

In this step, the second switch, the T-Server that monitors it, and the group
of agents associated with the ACD Queue, are all at an outlying location in
the network.

Voice File Recordings

CPD Server is able to record files in a plain VOX format (PCM/8000Hz/8bps).
It creates two voice files for each outbound call:

* File I contains the line recording for the call-progress detection stage.

* File 2 records the conversation between an agent and the called party if the
call result is answer (ASM mode only).

Recording on Dialogic Ports

CPD Server records these voice files on the Dialogic ports used for outbound
dialing. Specific ports are not dedicated for recording, but the number of ports
to use for recording is configurable.

The option max-number-ports-to-record specifies the maximum number of
agent ports on which CPD Server records at the same time. You configure this
option in the CPD Server Application object in Genesys Administrator.

Note: You can also configure this option on this application through
Configuration Manager.

The cpd-recording option enables or disables the recording of File 1 only (call
progress detection stage).

CPD Server counts the ports being recorded, and stops recording when the
specified number of ports is engaged for this purpose. CPD Server will not
record on another port until one is disengaged.

The number of times that the same call transfers from Agent DN to Agent DN
does not increase the number of ports being used for the recording of that call.
The call remains on the same port when it passes from agent to agent. This
extended port usage for recording might necessitate the allocation of more
Dialogic resources—that is, an increased number of ports to be used for
outbound dialing in general.
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<RecRef>

<Date>

<Time>
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For information about the max-number-ports-to-record and cpd-recording
options, See “CPD Server Options” on page 270.

Voice File Names and Content

Voice file names have the format
{Prefix»>_<RecRef>_<PhoneNumber)_<Date>_<Time>_<AgentCustPortNames)

where each of the variables in angle brackets is replaced by an alpha/numeric
string. Table 1 lists and describes each of these variables.

Table 1: Information in File Names

Variable in File Name Description

Structure

{Prefix> Prefix for file type

{RecRef> Recording reference number
<{PhoneNumber > Phone number

{Date> Date of the recording

{Time) Starting time of the recording
{Agent/CustPortNames) Agent Dialogic port name

The prefix in the file name is set by the following CPD Server configuration
options:

* cpd-file-name-prefix for call result (the default is cpd_).
* conversation-file-name-prefix for conversation (the default is conv_).

For more information about these options, See “CPD Server Options” on page
270.

CPD Server assigns a recording reference number to each voice file as part of
its name.

The date is presented in the following format:
<Month (two digits)> <day (two digits)> <year (two digits)>
For example, 060703 represents June 7, 2003.
Time is presented in this format:
<Hour (two digits)> <Minutes (two digits)> <seconds (two digits)>
For example, 111545 represents 11 hours, 15 minutes, 45 seconds.
The hour is presented in 24-hour format as shown in these examples:
* 6:00 AM is 060000.
* 6:00 PMis 180000.
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The following are sample file names:
Sample file name for a call result voice file:
Call_Result_5551212_060703_060000_dtiB1T1.vox
* Sample file name for a conversation voice file:
Conv_5551212_060703_060005_dtiB1T1_dtiB1T2.vox

Note: The call result file is created for call-progress detection only, and the
file name contains only one CPD port. A conversation file, which
records an actual conversation between an agent and a customer, is

recorded in ASM mode only and the file name contains two CPD ports.

CPD Proxy Server

Clients

CPD Cluster
Configuration Server
CPD Server 1
> CPD Proxy ——————P CPD Server 2
CPD Server N

CPD Proxy Server distributes calls among various CPD Servers for optimal
load-balancing and utilization of system resources. CPD Proxy Server
distributes calls for load-balancing when the volume of calls is particularly
heavy. It also notifies clients about changes in hardware resources due to
configuration and license modifications, or “out of service” events caused by

hardware problems. In general, CPD Proxy Server can be used in any situation

to improve overall system stability and load distribution. Figure 2 illustrates
how CPD Proxy Server relates to other components.

Figure 2: Configuration with CPD Proxy Server

Deployment Guide
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Outbound Contact Terms and Concepts

Formats

Fields

Records
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This section introduces the terminology and concepts that pertain to Outbound
Contact.

The layout of each calling list is determined by a format. The term format has
two meanings in Outbound Contact:

1. The field layout in a table in a relational database.

2. A configuration object in Genesys Administrator.

Note: You can also configure this in Configuration Manager.

A format consists of a number of Field objects.

You can create multiple calling lists of the same format, but each calling list
can have only one corresponding format. The configuration database provides
default formats; these consist of all of the mandatory fields that are required by
Outbound Contact 7.x and 6.5. You can create new formats that consist of
user-defined fields and the mandatory fields.

Each format within a tenant has a unique name, which you specify if you
create a new format.

The term field has two definitions for Outbound Contact:
¢ The name of a column in a table in a relational database.

* A configuration object in Genesys Administrator.

Note: You can also configure this in Configuration Manager.

Each Calling List field object contains both database-related information (such
as data type) and business-related information (such as field type).

A record is a row in a Calling List table. Among its mandatory fields, each
record contains:

* A phone number.

*  The fields that determine how the records should be processed (Record
Type and Record Status).
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* The fields that store time boundaries and time zone information; these
enable runtime determination of whether the record can be dialed.

A record can contain as many custom fields as needed as defined in a Calling
List Format object.

Chained Records

Chained records are multiple records for the same customer in a calling list.
These records typically contain alternative phone numbers such as home,
business, and cellular phone. In addition, each record in the same chain can
have different time boundaries and time zone information, and it can also have
different values stored in its business data fields.

Flexible Prioritization of Record Types

Flexible prioritization means that a user can assign his or her own order of
priority to specific record types for dialing purposes.

A user can assign his or her own order of priority to specific record types for
dialing purposes. A record type with a higher priority is dialed before a record
with a lower priority. Genesys Administrator (Outbound) automatically passes
the priority for the record type and its parameters to Outbound Contact Server
with events.

The user can prioritize the following record types in the
Predictive/Progressive dialing mode and in the Preview dialing mode.

* General records—All records are initially marked General in an Outbound
Contact calling list. The status may change after the record has been dialed.
Either an agent or a treatment in response to a call result can change the
status of a record.

* Campaign Callback records—An agent reschedules a campaign callback
record at the customer’s chosen time. The callback may be dialed
automatically or delivered to an agent's desktop softphone as a preview
record depending on the value of the predictive_cal Lback option. See
page 246 for more information about this option.

Note: Sce the “Communication Protocols” chapter of the Outbound
Contact 8.0 Reference Manual for information on the events
distributed when rescheduling records.

e Campaign Rescheduled records—Treatments reschedule these records based
on the detected call results. A campaign rescheduled call is dialed
automatically and handled by any agent who is working on that particular
campaign.

Record types can be prioritized in Genesys Administrator (Outbound Contact

section) or in a third-party application that manages the campaigns. You
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control record-type priorities in Genesys Administrator (Outbound) through
the Operations > Outbound Contact > Dialing Sessions > Priorities tab.

Note: In release 8.0, you can also configure SCXML treatments to select
which record in a chain is dialed first and which is dialed next. For
more information, see Chapter 13 on page 357.

If you are using a third-party application (instead of Genesys Administrator) to
communicate with OCS, you must use the KeyValue List from the Genesys
Common Library with the events to transfer the priority information to OCS.

You must define the priorities in the following user requests, that are sent
through the Communication DN:

* CM_ReqlLoadCampaign
* CM_ReqStartDialing
* CM_ReqSetDialingMode

For more information about these user requests, see “Communication DN
API” in the Outbound Contact 8.0 Reference Manual.

Note that flexible prioritization does not apply to Personal Callback records or
Personal Rescheduled records. An agent schedules or reschedules a personal
call back record at the customer’s chosen time. OCS automatically delivers a
Personal record to the agent’s desktop at the specified time, and the same agent
who initially handled the record processes the Personal Call Back or Personal
Rescheduled record.

The term calling list has two meanings in Outbound Contact:

e A subset of records from a table in a relational database that satisfies the
conditions of a filter that might be associated with it.

* A configuration object in Genesys Administrator.

The two meanings converge in the following way: the Table Access Point
configuration object in Genesys Administrator contains the name of the table
in the database. Each table in the database requires a separate Table Access
Point object. The Table Access Point object is a property of the Calling List
object in Genesys Administrator. One or more Calling List objects can share
the same Table Access Point object.

Each Calling List table contains a number of mandatory fields that, for
example, identify customers and the status of each record.

The user can add a number of user-defined fields; these typically store
business-related data.
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Do Not Call

The Do Not Call (DNC) function prevents a particular telephone number or
customer ID from being dialed. Record-blocking can occur in Outbound
Contact either by customer request or by a decision on the part of a contact
center manager.

A Do Not Call request can be handled during either an outbound call or an
inbound call—for example:

* During a conversation initiated by an outbound call, a customer tells an
agent that he or she does not want to be called anymore. In outbound
mode, the agent uses a unique record identifier generated by OCS
(GSW_RECORD_HANDLE) to refer to the record.

* A customer calls the contact center (inbound call) and explicitly asks not to
be called. In inbound mode, the phone number or customer ID serves as a
reference to the record.

In both cases, having received a Do Not Call request, OCS makes an entry in a
special table (referenced in the gsw_donotcall_List Table Access) in the
database. OCS reads all of the records from this table and populates two
separate tables (buffers) in memory with unique values from the phone field
and from the customer_id field. These tables can also be populated by Do Not
Call requests to OCS from the following sources:

* An agent desktop—If an agent belongs to a Campaign Group, and a dialing
session for that Campaign Group is loaded, Outbound Contact Server uses
the OCS-Agent Desktop protocol to handle DNC requests.

* A third-party application, through the Communication DN API — If an
agent is not associated with a Campaign Group, OCS uses the
Communication DN API.

* A routing strategy can insert records into the DoNotCall list.

* GVP can insert records into the DoNotCall list when OCS is running in
Power GVP dialing mode.

A Do Not Call request (by phone number or customer ID) from the agent’s
desktop updates not only the records that are in the database, but also retrieved
records that are currently in the memory buffers of the Outbound Contact
Server.

If a manual update to gsw_donotcall_List is required, OCS must be restarted in
order to acknowledge the changes. Most administrators choose to update the
Do Not Call table (gsw_donotcall_Llist) during off-hour periods, so that
restarting the server does not disrupt calling activities.

Outbound Contact makes a provision for several customers with the same
phone number in a calling list. The value of the customer_id option can specify
a user-defined field in the Calling List table in order to identify DNC
customers by a customer ID instead of by a phone number. You define the field
name in the Field object with the send attribute assigned to it. (For more
information, see“Field Object” on page 165.) You then specify the field name
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as the value of the customer_ID option in the 0CS Application object. The new
field is part of the Format object. Through these configurations, you can apply
the DNC restriction to a particular customer as an alternative to placing the
restriction on a particular telephone number.

To enable this enhanced Do Not Call functionality in Outbound Contact, see
“User-Defined Field for Do Not Call” on page 383.

OCS stores records marked as NoCall in the gsw_donotcall_Llist (one per
tenant) and monitors them in the following way:

1. When an Dialing Session that is associated with an outbound campaign is
running, OCS retrieves records that are ready to dial and checks them
against the gsw_donotcall_List.

2. Ifarecord that is retrieved from the calling list matches any record from
the gsw_donotcall_List, OCS does not dial this record. Instead, it returns
the record to the calling list and changes its record_type to NoCall.

Primary and Backup Impact

When OCS switches from the backup to the primary, OCS rereads the Do Not
Call records that were added after the Do Not Call list was initially read by
OCS for all Tenants that have active/ running dialing sessions associated with
campaigns whose Do Not Call list(s) were imported. This action synchronizes
the Do Not Call list between the backup OCS and the primary OCS if the
primary OCS updates the list after the backup OCS reads it, because of the
addition of new records to the Do Not Call list. No call requests will be created
by OCS until the Do Not Call list table is completely read.

Dealing with a Large Do Not Call List

Outbound Contact uses a database table to store Do Not Call contact numbers
and other information related to DNC customers’ requests. This table serves as
a persistent storage of Do Not Call-related information. While loading a
Dialing Session for a campaign, OCS retrieves the data that is stored in this
table, puts it into memory, and checks each phone number from the calling list
against this table to determine whether a phone number should be dialed.

Generally this Do Not Call database table is intended to hold information
regarding only internal Do Not Call requests rather than external Do Not Call
requests.

An internal DNC request is one that is specific to a particular contact center. For
example, a Do Not Call request is internal if either of the following is true:

* A called party requests to be marked as Do Not Call when an agent
contacts him or her through an outbound call.

* A called party contacts (through an inbound phone call, e-mail, or personal
visit) the organization that makes outbound calls and requests to be marked
as Do Not Call.
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An external DNC request is one that is submitted to an authority that collects
such requests and distributes them to contact centers.

The number of internal Do Not Call requests is relatively small compared to
the number of external ones. A contact center may receive several thousand
DNC requests from customers. The number of DNC requests nation-wide could
number in the tens of millions. Because OCS stores all phone numbers from
the Do Not Call table in memory (RAM), the following OCS performance
factors are affected as the size of the table increases:

* The amount of time that OCS takes to load a Dialing Session for a
Campaign—or, more specifically, the amount of time that it spends reading
the table data for a campaign and storing it in memory.

* The amount of memory that is allocated by OCS after it reads the whole
table.

To improve the performance of OCS, minimize the amount of data stored in
the Do Not Call database table (accessible to OCS through gsw_donotcall_Llist
Table Access). Ideally, this table would contain only internal DNC records.
Information about external Do Not Call requests would be kept in a separate,
custom DNC database table.

Note: Sce the “Recommended DBMS Optimizations” chapter in the
Outbound Contact 8.0 Reference Manual for more information about
tuning your database(s).

To address potential performance issues, Genesys recommends two methods
for handling large Do Not Call tables (over 1 million records):

* Use a dialing filter To improve OCS handling of large database tables.

* Run an SQL query to This avoid completely any performance problems.

Method 1: Use a Dialing Filter

Dialing filters are used to bypass records from the Calling List table that
should not be dialed. Each calling list can have its own dialing filter. Suppose
that a custom DNC database table contains the field dnc_phone for storing all
phone numbers that should not be dialed. In this case, the dialing filter will be
as follows:

* phone NOT IN (SELECT dnc_phone FROM <custom_do_not_call_table))

* NOT EXISTS (SELECT dnc_phone FROM <custom_do_not_call_table)> WHERE
dnc_phone = phone)

Note that you must complete the following steps:

* Replace the <custom_do_not_call_table) placeholder with the actual name
of the custom Do Not Call table.

* Replace the column name phone (in the Outbound 6.X format) with
contact_info if you are using the Outbound 7.X format for the calling list.
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The second dialing filter might be faster, but your Database Management
System (DBMS) might not support an EXISTS SQL clause. Check your DBMS
documentation or consult your Database Administrator if necessary.

Method 2: Run an SQL Query

You can run an SQL query directly on calling lists in your database, before
loading a Dialing Session for a Campaign. This query marks as NoCall any
records in a calling list with phone numbers matching those in a custom Do
Not Call table. Run the following SQL query on all Calling Lists that you plan
to use for dialing:

UPDATE <calling list table> SET record_type = 7 WHERE phone IN (SELECT
dnc_phone FROM <custom do not call table»)

Note that you must complete the following steps:

* Replace the placeholder <custom_do_not_call_table> with the actual name
of the custom Do Not Call table.

* Replace the placeholder <calling_list_table> with the actual name of the
Calling List table.

* Change permissions, as needed, for modifying tables through the execution
of the UPDATE SET statement.

Note also that if you choose to maintain Do Not Call support manually, you
must run this SQL query every time after you modify the calling list (by
changing record_type to General and record_status to Ready) while preparing
a calling list for the next campaign.

Note: For more information about working with Do Not Call lists, see
Chapter 14 on page 383.

Outbound Contact uses two kinds of filters: dialing filters and viewing filters.

Dialing Filter

A dialing filter customizes a calling list so that only certain phone numbers are
dialed during a campaign. One use of dialing filters is to divide records that
share the same calling list (database table) between two or more campaigns. As
a configuration object in Genesys Administrator, each Calling List object
requires its own filter in order to select records according to specific criteria.
For example, if you intend to divide records in the same table between two
campaigns, you must create two Calling List objects, each with its own filter.

You create dialing filters and apply them to calling lists in either Genesys
Administrator or Configuration Manager.
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OCS supports WHERE and ORDER BY clauses in dialing filters that are longer than
255 characters. For more information, see “Filter Object—Options Tab Fields”
on page 180.

Viewing Filter

A viewing filter selects records in a calling list for display in Genesys
Administrator. One use of viewing filters is to display records in a certain order
—for example, alphabetically by the name of the city. Another use of viewing
filters is to select customers by specific criteria that you define—for example,
all records that have a call_result value of NoAnswer.

It is possible to combine a dialing filter and viewing filter for browsing records
in on the Operations tab of Genesys Administrator (Outbound Contact) when
both filters are enabled. For more information, see Framework 8.0 Genesys
Administrator Help (Operating Your Call Center > Outbound Contact
Operations).

When OCS receives notification from Configuration Server that a dialing filter
has changed, OCS removes the retrieved records from the buffer (memory),
returns them to the Calling List database, and then retrieves the records that
meet the criteria of the newly applied filter. Records on which the agent is
already working remain in OCS memory until they have been processed.

Treatments define options for handling calls by describing sets of actions to be
performed on each call result. For example, if the call result for an outbound
call is NoAnswer, a treatment might be to redial the number at a later time or to
dial a different phone number for the customer.

In addition to the standard treatments for busy signals, no answers, and so on,
Outbound Contact gives the user the option to route, to an alternate DN, calls
answered by fax machines or answering machines. For example, it can run a
fax-on-demand campaign along with a campaign that plays messages to
answering machines. This scenario requires a separate application that is
responsible for playing prerecorded messages (for example, [VR or voice
mail). You can create treatments and assign them to a calling list by using
Genesys Administrator or Configuration Manager.

In release 8.0, you can design customer-focused treatments by using SCXML
scripts that allow you to customize contacting customers according to time of
day, contact type/first contact, dial attempts, call results and so on.

For more information on treatments, see Chapter 12 on page 335 and
Chapter 13 on page 357.
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Campaign Group

A Campaign Group is the main configuration object in Outbound Contact. It
can be found within the Campaign object in Genesys Administrator. A
Campaign Group is defined as a Campaign (a set of calling lists) that is
assigned to work resources such as an Agent Group or a Place Group.

A Campaign Group can be associated with Agent Groups or Place Groups.
Agents are individuals who are set up as Person objects in Genesys
Administrator in order to handle customer contacts. Places can be telephone
sets. There are two ways to group these individual objects:

* An Agent Group is a logical grouping of agents. Agents can be grouped by
skill (for example, language or marketing knowledge) or time (for
example, shifts). If the Agent Group is configured as “virtual,” Outbound
Contact uses the information that is provided by the Stat Server to monitor
the Agent or Place Group and the Agent Status. Outbound Contact
monitors the virtual agent group through the Stat Server that is configured
in the Campaign Group object in Genesys Administrator. If it is not
specified, the group will not be processed, and Outbound Contact Server
prints an error message in the log and stops processing the group. If
Outbound Contact Server disconnects from the specified Stat Server, it will
stop dialing for that group because of the unavailability of agent-state
information. Dialing will resume when reconnection to the Stat Server is
reestablished.For more information on creating virtual agent groups, see
the Framework 8.0 Stat Server User s Guide.

* A Place Group is a logical grouping of telephone sets. An example of a
place group is a group of telephone sets (sets shared by agents) in a contact
center. When a place group is configured for a Campaign Group, Outbound
Contact Server does not validate who logs in to the group. For its purpose,
all that matters is that someone has logged in to the place group to handle
outbound calls. A place group is commonly configured when a contact
center requires a generic group (in other words, a physical group of phone
sets) for a performance report on a campaign and does not need to know
who participated in the campaign. In Contact Center Pulse Plus
(CCPulse+t), the Genesys real-time reporting software where outbound
statistics are reported, the place group report shows activities and statistics
of the DNs that belong to places that are related to the Campaign Group.

The Agent Group or Place Group must be assigned to a campaign as a
Campaign Group object.

Stat Server provides status information about these configuration objects (real
or virtual) to Outbound Contact Server. When loading a dialing session for a
particular campaign group, OCS registers and monitors the following DNs:

* All DNs of type Extension, ACD Position, and Voice Treatment Port that
are associated with Places and belong to a Switch object associated with a
T-Server application to which OCS is connected.

* The DN specified as the Voice Transfer Destination (VTD) on the
Advanced tab of the Campaign Group configuration object.
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* For VoIP environments in the 8.0 release, a Trunk Group DN configured
on the Advanced tab of the Campaign Group configuration object. For
more information, see “VoIP Environment Configuration”.

If any other DNs of the ACD Queue, Routing Point, External Routing Point,
Service Number, Virtual Queue types or any others are involved in an
outbound call flow, they must be monitored by OCS. These DNs should be
specified as an Origination DN in the Advanced tab of the Agent Group or
Place Group object that is linked to the Campaign Group in order for OCS to
register those DNs with T-Server and to receive call-related events on those
DN:ss.

Note: If a Voice Transfer Destination DN and a T-Server used as a Dialer,
belong to one switch in a multi-site environment, but the call is
distributed by external routing to an agent who is on a different site, at
least one queue from this site should be listed in the Origination DN
list of the corresponding Agent or Place Group. This forces OCS to
register regular DNs on the remote site and receive related events.

VoIP Environment Configuration

When running Outbound Contact in a VoIP environment, you must configure
the Campaign Group so that it is VoIP-ready by doing the following:

* A Trunk Group DN is configured.

*  The SIP Server, that controls the Trunk Group DN, is listed in the
Configuration tab/Connections section of the OCS application object in
Genesys Administrator.

Notes: * If these conditions are not met, the dialing modes function in the
traditional, non-IP mode for that dialing session/Campaign Group.
» For more information about the Outbound-VoIP environment, see
Chapter 3 on page 87.

A campaign is a flexible master plan that organizes calling lists for dialing
calls and handling call results. An outbound campaign specifies what kind of
work the agents perform (for example, collections, telemarketing, or
fund-raising). A campaign is structured as follows:

* An Agent or Place Group may be assigned to multiple active campaigns.
An agent can participate in multiple active campaigns. You can reassign
agents between any active campaigns. Only one Dialing Session that is
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associated with a campaign can run in Predictive or Progressive dialing
mode. Other dialing sessions for other campaigns must run in Preview
mode. See “Campaign Group” on page 42 for more information.

*  One campaign can use several calling lists, and one calling list can be
shared among several campaigns. A special record-level locking
mechanism prevents simultaneous dialing of the same dialing record for
different campaigns.

These configuration elements can be modified at runtime without stopping the
Dialing Session that is associated with a campaign.

Interaction with Agents

Outbound Contact maintains a documented protocol of interactions between
itself and an agent’s desktop application. To simplify desktop application
architecture and development, this protocol is based on the user events that
T-Server distributes at the client application’s requests. The supported types of
interactions between Outbound Contact and the desktop application are
described in the following subsections. For more information about these
interactions, see “Communication Protocols,” in the Outbound Contact 8.0
Reference Manual.

Agent Assignment in Multiple Campaigns

Outbound Contact 8.0 supports agent assignment in multiple campaigns for
both the “Transfer Mode” and “ASM Modes.”

Transfer Mode

Universal Routing Server (URS) must be used in order to support agent groups
in multiple campaigns. OCS will attach Camp6roupID data to every outbound
call to represent the CampaignGroup DBID. For every agent assigned to more
then one active CampaignGroup, Outbound Contact designates only one
Campaign Group for this agent. OCS will change the Campaign Group
designation when the configuration of campaign priorities and the staffing
limits have been changed, when agents have been logged in/out, or when
dialing sessions for some Campaign Groups have been started/stopped.

Stat Server uses the same information in the CurrentCampaignGroupDBID
statistic.
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URS can then target agents by using the CampaignGroup target.

Notes: * A Campaign Group routing target should be used only when
routing calls to groups with an agent assignment.

* When URS receives agent-assignment statistics from Stat Server, it
might not apply them immediately to the strategy. This can cause
the outbound call to be abandoned during processing by the
strategy. Set URS pulse_time option to a very low value (for
example, 1 second) to prevent such calls from being abandoned.
For more information on this URS option, see the Universal
Routing 8.0 Reference Manual.

ASM Modes

OCS also supports agent assignments in multiple campaigns in ASM modes.
When you set the agent-assignment option to true, OCS includes the
Campaign Group name and DBID in its request for an engaging call. This
ensures that a customer call will be merged only with an engaging call that
originated for the same Campaign Group.

When OCS is making assignment decisions in ASM modes, OCS considers an
engaged agent eligible for reassignment to other Campaign Groups and can
make a reassignment decision and release the engaging call.

ASM Modes & CPD Server attaches the Campaign Group identifiers to the user data of the
CPD Server  engaging call as follows:

* For ISDN conventional configurations, CPD Server monitors the Voice
Transfer Destination DN and requests an update of user data that has these
identifiers when EventRouteRequest is signaled for the engaging call.

*  When using CPD Server with HMP, the identifiers are attached during the
call-setup phase, as SIP Server can attach data to new a call whenever this
data is provided in the SIP header of the initial call-setup message. SIP
Server must be properly configured to attach these identifiers to an
engaging call. In the configuration section of the SIP Server Application
object, INVITE section must contain the following options (example):

+ userdata-1 = GSW_CAMPAIGN GROUP NAME
+ userdata-2 = GSW_CAMPAIGN GROUP DBID

Note: Because user data is passed via SIP headers, the name of the
Campaign Group used for agent assignment can contain only
English letters, numbers and underscores.

When CPD Server bridges an outbound call to an engaging call, CPD Server
gives first priority to the Campaign Group DBID (6SW_CAMPAIGN_GROUP_DBID) in
order to match calls associated with the same Campaign Group.
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Because all VoIP ASM modes do not use CPD Server, OCS can attach
Campaign Group identifiers to both engaging and outbound calls when they
are created. As a result, these calls can be routed and bridged to the correct
Campaign Group. To enable this, the routing strategy must be designed to
route engaging calls to Campaign Group targets.

Routing Strategy Design and CampaignGrouplD

For agent assignment, you should design the routing strategy to distribute only
outbound calls and engaging calls (if running a dialing session/campaign in an
ASM mode) that contain the correct Camp6roupID attached data to agents who
meet the following criteria:

* The agent belongs to the specified group that is configured for that
CampaignGroup.

* The agent’s current statistic in Stat Server contains the
CurrentCampaignGroupDBID, which is equivalent to the CampGroupID.

Both requirements can be achieved by using routing targets of Campaign
Group type. In addition, for engaging calls placed in conventional ISDN
scenarios in which an engaging call arrives to the Route Point DN without
attached data, you must include the SuspendForEvent function
(EventAttachedDataChanged) in the routing strategy before the routing decision
is made.

Note: This SuspendForEvent function should be applied only to engaging
calls, (that is, those calls that originated from a certain DN list.)

Campaign Prioritization

Campaigns are prioritized according to the following definitions:

* Anunderstaffed campaign is one in which the number of assigned agents is

less than what is required to maintain a minimum service-level agreement
(SLA).

* A staffed campaign is one in which the number of assigned agents is
sufficient to maintain a minimum SLA, but is less than the maximum SLA.

* An overstaffed campaign is one in which that the number of assigned
agents is sufficient to maintain the maximum SLA.

Agents are assigned based on the following priorities:

* All active campaigns that are configured with an equal priority will have
an equal number of agents assigned to each campaign if all of the
campaigns are equally understaffed or equally staffed.

*  When some campaigns with equal priority are understafted, all
non-assigned agents are assigned to the understaffed campaigns only. If
there are several understaffed campaigns, an equal number of agents are
assigned to each campaign that has equal priority.
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*  When there are no understaffed campaigns, all non-assigned agents are
assigned to staffed campaigns only. If there are several staffed campaigns,
an equal number of agents are assigned to each campaign that has equal
priority.

* Agents are not assigned to overstaffed campaigns.

Refer to “Outbound Contact Server Options” on page 209 for more
information about how the following options help to configure agent
assignment:

* agent-assignment

* agent-assignment-priority

* agent-assignment-min-num

* agent-assignment-max-num

* inbound-agent-assignment-priority

* inbound-agent-assignment-min-num

Personal and Campaign Callbacks

The OCS-Desktop protocol enables the agent to schedule personal or
Campaign callbacks for specific records. A personal callback is delivered to
the agent who scheduled it. A Campaign callback is sent to any agent working
in the specified Campaign. The records scheduled as either personal or
Campaign callbacks are marked accordingly in the calling list, so that reports
can be generated.

For personal callbacks, if a Campaign is stopped but not unloaded, OCS
follows up on them.

For Campaign callbacks, if the predictive_callback option is set to false,
OCS processes them only while the Dialing Session that owns them is running.
This varies according to the dialing mode, as follows:

* In the Predictive or Progressive modes, if the Dialing Session is active
(that is, loaded), then Campaign callbacks are retrieved and waiting in
OCS memory buffers for the Campaign to start, even if the scheduled time
arrives.

* In the Preview mode, if the Dialing Session is active (that is, loaded),
Campaign callbacks wait until an agent desktop requests them, which only
occurs when the Dialing Session is running.

Note: Sece the “Communication Protocols” chapter of the Outbound Contact
8.0 Reference Manual for information on the events that are
distributed when an agent reschedules records.
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Campaign Sequencing

Outbound Contact supports dynamic manual sequencing of running campaigns
(campaign sequencing). Only one campaign per dialing session can be running
at a time, but multiple campaigns can be loaded into memory. This enables the
user to stop a previous dialing session for a campaign and automatically start
the next one without disrupting the agents’ work. When the new dialing
session starts, the agents who are working in the group are notified. If new
agents log in to the group after a dialing session for an outbound campaign has
started, they are informed of the name and status of the currently running
dialing session. OCS sends the name and status of a dialing session for a
campaign as user events by means of a communication protocol.

Campaign sequencing can be configured according to the following
parameters:

e Stop at Contacts—This counter is increased when a dialed record is
updated in the database with the Answer call result. As soon as the counter
exceeds the campaign threshold, the dialing session for the campaign is
stopped and unloaded.

e Stop at Dials—This counter is increased when a dialing request or a
PreviewRecord user event is issued. When the counter exceeds the
campaign threshold, the dialing session for a campaign is stopped and
unloaded.

* Stop at time—This occurs when a dialing session for a campaign is
stopped and unloaded after it had been running up to the specified time.

Dialing Overview

A typical Genesys system consists of agent desktops, a T-Server or a
SIP Server, one or more OCS applications, and a calling list database.

For an enterprise that uses T-Server, this central component, a
computer-telephony integration (CTI) server provides a transport layer for all
the system’s telephony information. All information to and from the desktop
and other servers passes through T-Server. The agent desktop and OCS are
clients of T-Server. For an Outbound-IP environment, SIP Server functions as
the transport layer.

Note: For information on a VoIP environment that uses SIP Server instead of
T-Server, see Chapter 3 on page 87.

General Agent Desktop Interaction with OCS

48

Figure 3 illustrates the data flow for a typical customer record.

Note: This figure is not specific to any particular sequence of events.
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Figure 3: Data Flow for Typical Customer Record

Check Against Do Not Call List

OCS reads all records from the table that is referenced in the
gsw_donotcall_List Table Access and populates separate tables in memory
with the unique values from the phone and customer_id fields. The tables in
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memory mirror the DNC List in the database. OCS checks these tables in
memory during a Do Not Call predial check.

If OCS finds a phone number in the Do Not Call table in memory during a
predial check, it applies the DNC restriction to the phone number and does not
check the customer ID. The phone number has a higher priority than the
customer ID if they are both in a dialing record. Figure 4 illustrates the predial
check process.

Record
retrieved for
dialing

Mark in DB
Phone in DNC Yes type=NoCall
phones in
A 4
No
End
Is customer_id .
defined? No— Dialing
Yes
Customer_id n Mark in DB
Yes type=NoCall
vy v
End

Dialing

Figure 4: Predial Check by Phone and Customer ID

Dialing Modes

50

Outbound Contact supports the following dialing modes:

* Predictive (a Transfer mode). For a standard environment, see page 53; for
a VoIP environment, see page 61.
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* Predictive with seizing (an Active Switch Matrix or ASM) mode). For a
standard environment, see page 53; for a VoIP environment, see page 61.

* Progressive (a Transfer mode). For a standard environment, see page 58;
for a VoIP environment, see page 61.

* Progressive with seizing (an ASM mode). For a standard environment, see
page 59;for a VoIP environment, see page 61.

* Preview. See page 59.
*  Push Preview. See page 60.

* Power GVP. For a standard environment, see page 60; for a VoIP
environment, see page 61.

*  Progressive GVP (VoIP only environment) see page 62.

Note: For more information about a VoIP deployment, see Chapter 3 on
page 87.

After a dialing session for a campaign has started, the user can change the
dialing mode in the following ways:

* From Predictive to Progressive, and vice versa

Note: If you change the mode from Progressive to Predictive while the
Campaign is running, the Campaign switches to the new mode
when it reaches the value set by the history_length option (see
page 239). If that value has already been reached at the time of the
change, the mode changes immediately.

* From Predictive with seizing to Progressive with seizing, or vice versa

To change from any Predictive or Progressive dialing mode to Preview dialing
mode, you must stop and restart the dialing session for the campaign group.

Outbound Contact supports call blending in any dialing mode. Among other
considerations, OCS takes into account queued inbound calls. By using the
progressive_blending_reserved_agents option, you can specify the number of
reserved agents in Progressive dialing mode that should be available for
inbound traffic. For more information about the
progressive_blending_reserved_agents option, see Chapter 9 on page 201.

Dialing Modes and Third-Party Clients

Outbound Contact 8.0 supports communication with Interaction Server, as a
third party client, over a dedicated ESP port. For Campaign Groups in Push
Preview and autodial modes the following third party client operations are
supported if they meet the “Request Attribute Requirements”:

e Cancel records
e Mark records as Do Not Call
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* Update records

*  Process records

* Reschedule records
* Add records

Request Attribute Requirements

To support all operations of third-party clients:
* For requests to cancel records or mark records as Do Not Call, the request
must include one of the following to identify the target record(s):
+ Avvalid record handle.
If the record handle is specified in the request and OCS finds a record

that has that record handle, the record or the entire chain is marked as
canceled in the Calling List(s).

+ Contact Info.
If Contact Info is specified in the request without the record handle, all

records that have that Contact Info (and all chains, if any, that include
these records) are marked as canceled in the Calling List(s).

+  Customer ID.
If Customer ID is specified in the request without the record handle, all

records that have that Customer ID (and all chains, if any, that include
those records) are marked as cancelled in the Calling List(s).

Notes: * Optionally, the Campaign name can also be specified to limit
record cancellation to a Campaign that has the specified name.
* Interaction ID should be specified if URS is processing an
interaction that was created by Interaction Server.

* For all other records, the request must include a valid record handle.

Routing Strategy Design

You can enhance your strategies which are used to route outbound call to the
group of agents or group of places. You do so by using strategy blocks from
the Outbound folder in Interaction Routing Designer (IRD). As with all the
other blocks that you use in the strategy, you select the block you want to use,
—for example, Update record—and set the properties within this block, such
as the name of Outbound Contact Server, the record handle (which you can
extract from the user data of the outbound call), and user data values that you
want to pass to OCS for update.

Predictive Dialing Modes

There are two predictive dialing modes:
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*  “Predictive Dialing Mode”
e “Predictive with Seizing Dialing Mode”

In the predictive dialing modes, Outbound Contact can dial more calls than the
number of available agents in a group—making use of the predictive algorithm
(see page 54) to determine the pacing.

Predictive Dialing Mode

The Predictive dialing mode predicts agent availability when it dials calls
from a calling list. Predictive mode is recommended for high-volume,
low-value campaigns.

Predictive with Seizing Dialing Mode

In the Predictive with seizing dialing mode (an ASM mode), a call is dialed
automatically, based on a prediction of agent availability, and the agent is
“seized” (engaged) before the called party answers. There is no delay time
after the customer is connected. Predictive with seizingis an Active
Switching Matrix (ASM) mode.

Agent Feedback for the Predictive Dialing Modes

To improve dialing efficiency in the predictive modes (for example, to increase
the Busy Factor for a given value of the Abandon Rate), OCS supports better
optimization by accepting estimated call-completion time notifications from
agents through the ReadyTime event. In this event, the agent desktop provides
OCS with preliminary information on the time remaining for an agent to
complete call processing.

As a result of these notifications, OCS evaluates whether an agent is trusted or
distrusted.

A trusted agent is one with a calculated trust factor that is less than the
Overdial Rate optimization parameter for that campaign. In other words, the
agent is available to handle another call when OCS expected the agent to be
available.

A distrusted agent is one with a trust factor that is greater than the Overdial
Rate for that same campaign.

The trust factor is the percentage of false notifications in comparison to all
ReadyTime events received. A notification is considered false when an agent is
not ready within the tolerance set in the time-to-ready-tolerance option (see
page 254) after OCS receives the ReadyTime event. This tolerance is the
allowed accuracy in the agent's estimation of when that agent will complete
call processing and become Ready .
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OCS and the predictive algorithm rely on the accuracy of this information to
determine when the agent will become Ready.

Notes: * All agents are distrusted when a dialing session for a campaign first
starts.

* The predictive_algorithm option (see page 244) must be set to
advanced_small_group for the time estimate (when the agent will
become Ready) that is delivered to OCS from the agent desktop to
be considered by the predictive algorithm.

» Time to going Ready estimates are taken into account only if the
Overdial Rate is used as the optimization parameter.

Predictive Algorithm

The predictive dialing algorithm performs real-time pacing calculations based
on continuously sampled values for the following parameters:
»  Statistics:
+ Average talk time (for both outbound and inbound calls)
+ Average not ready time
¢+ Average wrap-up time
+ Average contact rate per campaign (percentage of answered calls
over total dialed calls)
+  Number of currently queued calls (both inbound and outbound)
+ Average inbound traffic volume based on the value of the
history-length option
* Resources:
+ Number of available agents logged in the group
+ Number of available dialing ports

* Controllable parameters:

+ Optimized parameter (Agent Busy Factor, Overdial Rate, Average

Waiting Time)

+ Goal value of the chosen optimized parameter
Outbound Contact can support an unlimited number of agent groups, each of
which has its own independent dialing engine. In other words, each group can
run its own outbound campaign with its own pacing based on real-time,
campaign-specific statistics. By default, Outbound Contact treats all agent
groups with which it works as blended groups—immediately adjusting pacing
if both inbound and outbound calls are routed to the same group.

Optimization In predictive dialing modes, Outbound Contact offers optimization parameters.
Parameters  These parameters directly affect the performance of dialing algorithms in the
predictive dialing modes. These parameters include the following:

* Agent Busy Factor
* Overdial Rate
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* Average Waiting Time

You specify these parameters as part of the campaign group configuration
process within Genesys Administrator » Provisioning tab » Outbound
Contact > Campaign > Campaign Group.

Predictive Algorithm for Small Groups

Outbound Contact provides you with two predictive algorithms for dialing
outbound calls during a campaign that are specifically designed to handle
small groups of agents.

*  Small group algorithm—This algorithm waits until all dialed calls are
completed before dialing new calls.

* Advanced small group algorithm—This algorithm accounts for all inbound
calls and also allows calls to be initiated, even if one or more calls remain
in the dialing stage, instead of waiting until all dialed calls are completed.

You specify the small group algorithm by configuring the

predictive_algorithm option with either the small_group or

advanced_small_group value. For more information on the

predictive_algorithm option, see page 244.

Predictive Algorithm Self-Diagnostic

In release 7.6.101 and higher, the predictive algorithm has been enhanced with
self-diagnostic capabilities to limit performance degradation, which could
result in a deviation from the optimization parameters (Busy Factor, Overdial
Rate, and Average Waiting Time) that are associated with the loss of a dialing
pace.

Four options are associated with this self-diagnostic capability:
pa-selfcheck-awt-threshold (see page 243), pa-selfcheck-bf-threshold (see
page 243), pa-selfcheck-odr-threshold (see page 244), and
pa-selfcheck-interval (see page 244).

Diagnostic results are reported using log events that identify the expected

cause of the degradation and addresses four areas:

* 12-50131: call-related factors, which include the following scenarios:
+ Unexpected call-related agents’ activity, which can be caused by:

+ Agent state PA_StatAgentBusyRingOrDial that is not caused by
Outbound, OutboundOther, or Inbound call types.

+ Agent goes to the Not Ready state from the Ready state but is not
checked out.

+ Agents log out from the Ready state, but does not use Smart LogOut.
+ Low Hit Ratio.
+ Transferring outbound calls to another campaign.
+ Receiving outbound calls that are transferred from another campaign.
+ Engaging call duration influence.

A sample log event of this type might be:
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12:35:49.844 Std 50131 Campaign Group 'Alpha
CampaigneAlphaAgentGroup', Busy Factor defined 80, actual 50,
call-related reason: Hit Ratio is Llow

* 12-50132: configuration factors, which include the following scenarios:

+ Long calls, which last more than outbound_agent_outlier_Limit (see
page 241) on agents and thus agents become Not Available.

+ A dials-per-second limitation on the switch or Campaign Group level

+ Violation of Overdial Rate limitation (predictive_max_overdial_rate,
page 250) with a transition to the Progressive-in-Predictive mode.

* 12-50133: malfunctions, which include the following scenarios:

*

Abandoned calls in the presence of Ready agents.

*

Cleaning or removing outbound calls (calls that are frozen in either a
Dialed or Queued state and removed by the Garbage Collector).

*

Not Ready agents become Busy with new outbound calls (usually
caused by an inadequate telephony event sequence).

The Outbound dialing rate is greater or less than predicted.

*

* 12-50134: external conditions, which include the following scenarios:
+ Lack of dialing ports.
+ Campaign Group—related waits:
+ Lack of dialing records.

+ Lost connections to important supporting servers (for example,
T-Server or Stat Server).

+ Missing connection to the Do Not Call list.

Time Optimized Predictive Algorithm

This new time-optimized predictive algorithm provides contact centers with
the flexibility to adjust the dialing pace for a specific period. The main benefit
of this new algorithm is that it allows you to increase the Busy Factor but still
keep the overdial rate (ODR) within legislative limits. This improves the daily
performance for the Busy Factor and the wait time for each agent.

In releases prior to 8.0, the classical predictive algorithm calculated the
required dialing pace only based on the ODR that was set in the Campaign
Group object. However, the actual overdial rate might be less at any given time
because of factors such as:

* A non-zero waiting time for accepted outbound calls in a queue that the
classical predictive algorithm does not take into account.

* A decrease in the hit ratio and in the average call duration and an
associated increase in the number of available agents.

* The loss of dialing and queued outbound calls due to errors or transfers to
other campaigns.

This time-optimized algorithm optimizes predictive dialing by recalculating
the dialing rate so that the overdial rate criteria is met for a specific period of
time (day, month, and so on). For example, if the target value for the overdial
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rate is 3 percent for an eight-hour business day, a new target value can be
calculated and the dialing rate can be adjusted every hour so that the overdial
rate for the eight-hour period meets the target value for that 8-hour period (as
configured in “predictive_max_overdial rate” on page 250). This increases the
predictive dialing efficiency.

Depending on the current overdial rate, this time-optimized algorithm
functions as follows:

If the current overdial rate is less than the target, the acceptable overdial
rate can be greater than the target for this time period. Therefore, the new
dialing rate can be greater than the dialing rate that is predicted by the
classical predictive algorithm. With this new algorithm, OCS increases the
dialing rate by the difference between the target and the current overdial
rates. This dialing rate increases the agent-busy factor. As a result,
outbound campaigns that run under legislative limitations on the overdial
rate can be more efficient.

If the current overdial rate is greater than the target, the acceptable overdial
rate must be less than the target in order to average out ultimately to meet
the target value.

Therefore, the new dialing rate must be less than the dialing rate predicted
by the classical predictive algorithm. In this case, the algorithm evaluates
whether it can maintain the higher dialing rate, which increases the
agent-busy factor, but at the same time meets the overdial rate target. If it
cannot achieve the target, the algorithm chooses the dialing rate that
produces the minimum predicted overdial rate. Decreasing the dialing rate
decreases the overdial rate; hence, outbound campaigns that run under
legislative limitations on overdial rate are more reliable as they take into
account the busy factor, the overdial rate, and the changing call load over
the course of a time period (such as an eight-hour day).

Note: If the predicted busy factor for the chosen dialing rate is less than
the predicted busy factor for the Progressive dialing mode, the
time-optimized algorithm switches to the Progressive dialing
mode, because it will result in a zero overdial rate for the
remainder of the time period.

Configure the following three options are for the new algorithm:

predictive_algorithm (see page 244)—Set the option to
time_optimized_odr (a new value that was added in 8.0) that enables the use
of this algorithm.

pa-odr-interval (see page 243)—Specify the period of time, in minutes,
over which OCS averages the overdial rate that must match the target
overdial rate.

predictive_max_overdial_rate option (see page 250)—Specify the
maximum allowed overdial rate for dialing in Predictive mode.
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Predictive Algorithm and Engaging Call Dialing Duration

In release 7.6.101 and higher, OCS calculates the average engaging dialing call
duration (defined as the time between an agent going ready and becoming
ASM Engaged when the engaging call is delivered to the agent) for a given
Campaign Group. The predictive algorithm takes this value into account when
it calculates dialing pacing. With this enhancement, OCS changes the dialing
rate based on the optimization parameters:

*  When using the Overdial Rate optimization parameter, OCS can restrict
the dialing rate so that its growth will be less than 10 percent.

*  When using Average Waiting Time or Busy Factor, OCS can increase the
dialing rate.

In addition, be aware of the following:

* As part of the self-diagnostic capability (“Predictive Algorithm
Self-Diagnostic” on page 55), if OCS detects that the target value of the
optimization parameter cannot be reached or that the dialing rate is
restricted, OCS sends the STANDARD 12-50131 event, identifying the impact
of the engaging call dialing duration.

* In a primary/backup configuration, OCS passes the value of the average
engaging call dialing duration to the backup Predictive Algorithm.

* For the advanced small group predictive algorithm, when using the ASM
dialing modes, after OCS receives the agent’s ReadyTime notification
specifying when the agent will become ready for engaging calls, OCS
increases the value by the average engaging call dialing duration to predict
when the agent will actually become ready for new outbound calls. OCS
uses this corrected ReadyTime value when it compares the value to the value
when the agent actually becomes ready to determine the agent’s trust
factor.

Progressive Dialing Mode

The Progressive dialing mode dials calls from a calling list when an agent is
actually available. Progressive mode is recommended for low-volume,
high-value campaigns. The number of calls that are dialed depends on the
number of Ready agents. The next dialing attempt is triggered by either of the
following factors:

e The AGENT_VOICE_MEDIA_STATUS - WaitForNextCall Stat Event message is
received from Stat Server

* A non-positive call-progress result is received from the dialer
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Progressive with Seizing Dialing Mode

In the Progressive with seizing dialing mode (an ASM mode), a call is dialed
automatically when an agent is already on the line and ready to take the call.
Progressive with seizing means Progressive dialing in ASM mode.

In both Progressive with seizing and Predictive with seizing modes, the
agent should be on the line before the customer answers; however, there is a
distinct difference between these two dialing modes:

* Inthe Progressive with seizing mode, the agent is already reserved for
the call when it is dialed.

* Inthe Predictive with seizing mode, the agent is predicted to be
available when the dialer places the call.

Preview Dialing Mode

In Preview dialing mode, an agent requests one or several records from OCS,
previews each record, and decides whether to dial a call. The agent interacts
with the records by using the desktop application that communicates (via
T-Server) with OCS. The OCS-desktop communication protocol enables the
desktop application to perform the following tasks:

» Request and receive a record for preview.
* Update certain record fields.
* Schedule campaign or personal callbacks.

e Receive a scheduled record as an unsolicited event from Outbound
Contact.

* Reject, cancel, or mark a record as Do Not Call.

Preview mode is recommended for low-volume, high-value applications for
which individual ownership of accounts is the highest priority.

Preview dialing mode supports treatments based on call results.

Outbound Contact supports simultaneous participation by agents in multiple
preview campaigns, including one Predictive/Progressive-mode campaign
based on the following behavior:

*  Outbound Contact Server distributes Campaign Status Notification
messages for every campaign with which an agent is associated.

» If the agent participates in multiple preview campaigns, the record request
for a specific campaign may be specified explicitly in the
GSW_CAMPAIGN_NAME attribute of the PreviewRecordRequest. If not specified,
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Outbound Contact Server will select a record from any of the campaigns in
a round-robin fashion. In this scenario, the 6SW_CAMPAIGN_NAME attribute
should have empty string value, or a NULL string value.

Note: To take effect for the round-robin algorithm, an agent must be
configured for the single group that is assigned to multiple
campaigns.

* Ifanagent wants to retrieve preview records from multiple campaigns, and
the agent_preview_mode_start option is set with a value of yes, the
PreviewDialingModeStart and PreviewDialingModeOver campaign requests
should be submitted from the desktop for every campaign.

Notes: * The preview_release_nocontact_action option (see page 267),
instructs OCS on what action to apply to an agent’s DN when the
agent releases an outbound call that was placed manually in the
Preview dialing mode but could not be established. For this option
to take effect, the attached data of this manually placed call must
contain the 6SW_RECORD_HANDLE attribute with the record handle,
which OCS had passed previously to the agent desktop.

* Inrelease 8.0, OCS can process records with an Instant Messaging
phone type for preview campaigns.

Push Preview Dialing Mode

The Push Preview dialing mode uses Interaction Server to “push” records to
agents. The number of records that are “pushed” depends on the value of the
Max Queue Size parameter. See “Genesys eServices (formerly, Multimedia)” on
page 80 for more information about this dialing mode.

Note: In release 8.0, OCS supports stopping the processing of interactions
and also updating records that have not been processed (that is, an
agent did not receive the interaction) when the dialing session for an
outbound campaign is unloaded. As a result, OCS updates the Calling
List with the appropriate status. When the dialing session for a
Campaign Group is started again, no customer receives duplicate
contacts for the associated campaign.

Power GVP Dialing Mode (with GVP 7.6)

The Power GVP dialing mode uses GVP’s 7.6 Outbound Notification Manager
(OBN) to dial outbound calls, detect call results, and further process
successfully connected calls. In this Power GVP mode, OCS sends OBN the
number of requests to dial an outbound call equal to the Max Queue Size
setting of the Campaign Group. This dialing mode can be very effective when
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running agent-less campaigns, because it enables you to use custom-created
VXML scripts to automate call processing and allow for self-service of the
contacted outbound customers. See “Genesys Voice Platform” on page 82 for
more information.

Note: OBN is a component specific to the 7.5 and 7.6 releases of GVP and is
not a part of the GVP 8.0 architecture.

VoIP Dialing Modes

Outbound Contact 8.0 supports the following VoIP dialing modes: Predictive,
Progressive, Predictive with seizing, Progressive with seizing, Power GVP, and
Progressive GVP.

In these VoIP dialing modes, the call control/flow is as follows:

o The call is dialed from the Trunk Group DN.

* OCS controls the call.

e In Transfer modes, OCS transfers the call to VTD.

* In ASM modes, OCS bridges the call with engaging call.

* In GVP modes, OCS also controls the Treatment VXML application.

Notes: * If a Campaign Group is not Outbound-VolIP-ready, these dialing
modes function like the non-VoIP dialing modes (with the exception
of the Progressive GVP mode which is not available in non-VoIP
dialing modes).

* For information on how OCS works with VXML applications in
these modes, see “VXML Applications.”

* For information on how OCS handles Apply to Call treatments in
these modes, see “Apply to Call Treatments” on page 63.

* For more information on Outbound in a VoIP environment, see
Chapter 3 on page 87.

Progressive, Predictive, Progressive with Seizing, and Predictive with Seizing
Dialing Modes

When a Campaign Group/environment is Outbound-VoIP-ready (see page 43),
these modes function like their standard, non-VoIP counterparts, but in a VoIP
environment with its associated components. See their associated descriptions
described earlier.

Power GVP Dialing Mode

The Power GVP dialing mode uses SIP Server to dial outbound calls, to detect
call results, and to further process successfully connected calls. This Power GVP
mode dials calls so that the number of calls in progress equals the Max Queue
Size setting of the Campaign Group.
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Like the non-VoIP usage, this dialing mode can be very effective when running
“agent-less” campaigns, because it enables you to use custom-created VXML
scripts to automate call processing and allow for self-service of the contacted
outbound customers. See “Genesys Voice Platform” on page 82 for more
information.

Progressive GVP Dialing Mode

The Progressive GVP dialing mode dials calls from a Calling List when a GVP
port is available. The dialing pace is calculated based on port availability; so
this mode dials calls equal to the number of Call Progress Detection ports
configured for the Campaign Group.

This dialing mode requires SIP Server for placing outbound calls, instead of
T-Server, and uses GVP Voice XML applications for call processing.

Note: In this dialing mode, the predictive algorithm does not calculate the
dialing rate based on agent availability. Instead, it calculates the
number of dial requests to maintain the total number of customer calls
in any state (for example, dialing or established) that is not greater
than the number of ports available for the Campaign Group, in
accordance with Resources assignment (see “Resources” on page 89).

OCS considers a port available when it is notified as such by SIP
Server.

VXML Applications

When running Outbound Contact using the VoIP dialing modes, OCS
identifies which VXML application that GVP should start by including the
URI of that application in the TAppLlyTreatment function.

*  (All call results) OCS determines the URI based on the value set in the
initial-page-url option of the Voice Platform Profile configuration object
and whose DBID is specified in the IVR Profile ID attribute for the
Campaign Group.

* (Answering Machine call results only) If you want to use a dedicated
VXML application for Answering Machine call results, OCS determines
the URI based on the value set in the am-initial-url option of the Voice
Platform Profile configuration object and which is associated with the
Campaign Group. If a URI is not specified in the am-initial-url option,
OCS uses the URI set by the initial-page-url option.

Note: The URI Answering Machine VXML application is never passed
in ivr-profile-id pair to SIP Server, which means that it cannot be
prefetched (that is, preretrieved) by GVP.

In addition, for Answering Machine Detection call results, OCS can instruct
GVP on how to handle beep detection. The am-beep-detection option (see
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page 228) specifies whether GVP is forced to detect an answering machine
beep before starting the VXML application. This information is passed on to
GVP in the Extensions KV list of the same TApplyTreament function.

Notes: ¢ For information on the initial-page-url and am-initial-url
options, see the Genesys Voice Platform 8.1 User’s Guide.

* For information on the IVR Profile ID attribute for the Campaign
Group, see “IVR Profile” on page 199.

Apply to Call Treatments

In a VoIP environment, after an outbound call is established on the Trunk
Group DN, OCS can apply Transfer/Connect or Drop treatments to the call.
These treatments—which you configure by using the Treatment configuration
object with an Apply to Call action—always have a higher priority than
VXML application call handling.

This approach is helpful in the following scenarios:

* A Connect treatment is configured for an Answering Machine call result. A
Destination DN is also configured. OCS receives EventEstablished with
an AM call state. Despite the configured IVR Profile ID, OCS issues
RequestSingleStepTransfer to the Destination DN and completes
call/record processing.

* A Drop treatment is configured for an Answering Machine call result. OCS
receives EventEstablished with an AM call state. Despite the configured
IVR Profile ID, OCS issues RequestRe leaseCal L and completes call/record
processing.

Apply to Call treatments offer an alternative mechanism for call handling.
Although it is possible to perform the same call processing in the VXML
application (transfer or drop), treatments can be used to improve performance,
so that GVP does not need to fetch (or retrieve), parse and execute the VXML
application in these basic scenarios.

Outbound Call Transfer by Treatment Application after Processing by the
VoiceXML Script

OCS can now apply a treatment of type Transfer or Connect as a step of
processing of an outbound call when running in VoIP environment in Power
GVP or Progressive GVP dialing modes, if requested by the Voice XML script.
Whenever the processing of a successful outbound call is completed by a
VoiceXML application, and further processing of this call is still required, the
call can be transferred by OCS to a pre-configured arbitrary destination DN.
For example, an outbound call can be transferred to an ACD queue for delivery
to a live agent for assisted service after the call has been self-serviced by
VoiceXML script execution.
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The advantage of this feature is that the transfer is handled by OCS after
receiving a specific message from the VoiceXML application. There is no need
to implement the transfer by means of the VoiceXML application itself or by
any other system component.

Enabling this functionality requires that the Calling List reference the
Treatment configuration object. This object should have the Apply to Call
action set to Transfer or Connect, a destination DN specified (for example,
ACD queue), and the Number in sequence property setto 1. The Apply to
Record action of the Treatment configuration object can be set to either No
Treatment or Update all records in chain.

Note: A treatment of type Transfer or Connect can be configured for certain
call results only. It is supported for Answer, Answering Machine,
Pager, Fax, and OK call results. Genesys recommends that you
configure it to the Answer call result, since other call results might
affect how OCS makes outbound call on the first stage of call
processing (when requesting SIP Server to make an outbound call and
when processing EventEstablished on the Trunk Group DN for a
successful call results).

The following is an example of a RecordProcessed request which will be
delivered to OCS by the VoiceXML application so that OCS can attempt a
Transfer treatment application:

POST http://host1.domain1:8080/records/15?req=RecordProcessed HTTP/1.1
Host: host1.domain1:8080

User-Agent: GVP/8.0 Banking self-service #4

Content-type: application/json

Content-Llength: 116

{
"GSW_CALL _RESULT":33,
"GSW_TREATMENT": "RecordTreatCampaign"”,
"CUSTOMER_CODE": 22,
"DATE_LAST_SERVED": "10/30/2008"

}

If the VoiceXML application delivers the RecordProcessed notification to OCS
by using HTTP with the GSW_TREATMENT attribute that is specified and the
treatment is configured as described in the example above, OCS uses a single
step transfer to deliver the call to the destination DN that is specified in the
Treatment configuration object.

The Apply to Record property of the treatment controls how OCS treats the
chain of records after the transfer. If this property is set to Update all records
in chain, OCS finalizes the chain of records in the Calling List and the
transferred call processing can no longer affect the chain. If the Apply to

Outbound Contact 8.0 @



Chapter 2: Architecture Dialing Overview

Record property is set to No Treatment, OCS does not finalize the chain and
awaits further updates for this chain through HTTP from the Voice XML
application or through Desktop protocol from the agents desktop.

Note: If the chain of records is not finalized by this treatment and the call is
passed to an agent for the further processing, OCS only processes the
Desktop protocol requests from the agent if this agent belongs to a
Group that is associated with the current Campaign Group and is
properly logged in.

Typical Data Flow Scenarios

The following sections describes typical dialing scenarios for Predictive mode
(or Progressive mode) and Preview mode.

Predictive Mode (or Progressive Mode)

The following is a typical data flow scenario for Predictive mode or
Progressive mode:

1. When an outbound dialing session for the Campaign Group is started, OCS
places the call.

2. [Ifthe call is answered by a “live” voice, it is connected to an agent. User
data attached to the call is delivered to the agent’s desktop.

3. The agent updates the user data and the call result. The agent then either
processes the call or, if requested by the customer, reschedules the call for
a later time as a personal or campaign callback.

Figure 5 illustrates the data flow for a typical Predictive mode or Progressive
mode call. In this instance, the switch has Call Progress Detection (CPD)
capability, and T-Server requests the switch to dial the customer number.
Alternatively, you could configure the system with the CPD Server, which uses
a Dialogic board to dial the call. In either case, the agent is already logged in to
the system.
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Figure 5: Predictive Mode Data Flow

OCS sends a request to the database to retrieve a record.

A record is sent back to OCS, which forwards it to T-Server along with a
request to initiate a call.

T-Server 1nitiates the call.

T-Server, or another device, interprets the call and determines that the call
should be forwarded to an agent. The call result information goes back to
OCS.

At the same time, T-Server transfers the call and customer-specific
information to an agent. The agent and the customer are now connected.

The customer provides data to the agent, who updates the record. This
information might include a rescheduled call date and time, a do not call
back request, or other data. The agent sends the updated record to OCS.

After receiving the request, OCS sends an acknowledgment or error
message back to the agent.

Note: The agent can update the record as many times as necessary. With
each update, OCS stores the data to its internal buffer and
responds with an acknowledgment or error message.
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8. When the agent and customer have finished, and the call ends, the agent
sends the final event to OCS that the record is completed.

9. OCS responds to the agent desktop with either an acknowledgement that
the transaction is complete or with an error message.

10. At the same time, the final update goes to the database.

Preview Mode

The following is a typical data flow scenario for Preview mode:

1. The agent requests that Preview mode begin.

2. The agent requests a preview record.

3. The agent either rejects the record or makes the call.

*

If the agent rejects the record, it is returned to OCS. The agent then has
two choices:

+ Request the end of Preview dialing mode and log out.

+ Return to Step 2.

If the agent makes the call and if the customer requests no further calls
for this campaign or no more calls ever, the agent requests OCS to
mark the record as RecordCancel or DoNotCall. The agent then has two
choices:

+ Return to Step 2.

+ Request the end of Preview dialing mode and log out.

If the call reaches the customer, the agent updates the call results and
custom fields. Next, the agent can terminate the call, sending the final
call transaction back to OCS, or the customer can ask to reschedule the
call. The agent then receives the rescheduled record. The agent then
has two choices:

+ Return to Step 2.

+ Request the end of Preview dialing mode and log out.

If the call does not reach the customer, the agent can call an alternate
(chained) record.

If there are additional records in the chain, the agent requests a chained
preview record and returns the beginning of this Step 3.

If there are no additional records in the chain, the agent updates the call
results and custom fields, sending the final call transaction back to
OCS. The agent then has two choices:

+ Return to Step 2.

+ Request the end of Preview dialing mode and log out.

The data flow for Preview mode starts differently from that of the data flow for
Predictive mode or Progressive mode, but is identical once the agent is
connected to the customer. Figure 6 illustrates the data flow for a typical
Preview mode call. The agent is already logged in to the system.
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Figure 6: Preview Mode Data Flow

1.

The agent reports to OCS that the agent is ready to begin work in Preview
mode.

OCS sends back an acknowledgment or error message.

The database sends a record or records to OCS, which forwards the records
to the agent. These records might include previously scheduled calls.

The agent signals T-Server to initiate a call. T-Server initiates the call.

T-Server determines that the call is connected and signals the agent. The
agent determines the status of the connection (fax, answering machine,
modem, or customer). If the call is connected to a customer, the agent
proceeds with the call.

The customer provides data to the agent, who updates the record. This
information might include a rescheduled call date and time, a Do Not Call
request, or other data. The agent sends the updated record to OCS.

OCS either sends an acknowledgment or error message back to the agent.

Note: The agent can update the record as many times as necessary. With
each update, OCS stores the data to its internal buffer and
responds with an acknowledgment or error message (Steps 6
through 8).
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8. When the agent and customer have finished, and the call is terminated, the
agent sends the final event to OCS that the record is completed.

9. OCS sends the agent either an acknowledgment that the transaction is
complete or an error message.

10. At the same time, OCS sends the final update to the database.

Separate Tracking of Engaging CPD Ports

OCS allows you to explicitly set a limitation on the maximum number of ports
that will be used for agent engagements. This feature is only applicable to
Campaign Groups that run with CPD Server or SIP Server in Progressive with
Seizing (see page 59) or Predictive with Seizing (see page 53) dialing
modes. When this configuration is in effect, the number of CPD ports that are
used for dialing outbound calls and the number of CPD ports that are used for
agent engagement can be configured and tracked separately by the OCS
Predictive Algorithm. This allows more precise control of the dialing resources
in the configurations where engaging lines and regular lines are separated. It
also allows more flexibility if a number of Campaign Groups (possibly with
different logical priorities) simultaneously share the same SIP Server or CPD
Server and the same set of hardware lines.

Provisioning

Separate tracking of the engaging ports is controlled by the asm_channel_num
option. For a complete description of this option see page 228.

Dynamic Port Allocation Between Campaign Groups

Deployment Guide

Dynamic port allocation allows the optimization of dialing ports usage in
configurations where multiple Campaign Groups share the same dialing and
call progress detection resources (for example, Switch ports or CPD Server
ports). This feature is only available for Campaign Groups running in the
Progressive, Predictive, Progressive with Seizing and Predictive with
Seizing dialing modes.

When dynamic port allocation is in effect, OCS performs the proportional
dynamic allocation of ports, based on the estimated average numbers of ports
required for each Campaign Group. OCS periodically recalculates these
estimated numbers in accordance with the current dialing parameters, the
number of available agents, and historical statistics. OCS calculates the
maximum number of ports available for each Campaign Group so that this
value is directly proportional to the estimated average number of ports required
for this Campaign Group so that the sum of all these numbers for all Campaign
Groups equals the total number of available ports.
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Provisioning

Dynamic port allocation is configured by several parameters that combine to
form a distinct configuration. The dynamic-port-allocation option defines
whether dynamic allocation is in effect. For a complete description of this
option, see page 219.

Dynamic Port Allocation with CPD Server

In ASM mode with separated regular and engaging ports, OCS performs a
dynamic allocation of ports when the Number of CPD ports property of the
Campaign Group or the asm_channel_num option (see page 228) is set to 0.

For ASM mode with separated regular and engaging ports, the
asm_channel_num option for these Campaign Groups can also be set to a
desired value greater than 0. For these Campaign Groups, OCS will not
perform dynamic allocation of ports, regardless of the
dynamic-port-allocation option setting. In this case, OCS reserves ports for
these running Campaign Groups in accordance with their Number of CPD ports
property and the asm_channel_num option setting.

To restrict the maximum number of engaging ports that can be used for a
Campaign Group in ASM mode, the asm_channel_num option can be set to a
desired value greater than 0. In this case, OCS performs dynamic allocation for
this Campaign Group only if the Number of CPD ports property is setto 0.

To restrict the total maximum number of regular and engaging ports that can
be used for a Campaign Group in ASM mode with separated regular and
engaging ports, the Number of CPD ports property can be set to a desired value
greater than 0. In this case, OCS performs dynamic allocation for this
Campaign Group only if the asm_channel_num option is set to 0.

Examples

The following three examples describe how ports are allocated dynamically

between Campaign Groups that share the same dialing and CPD resources:

* OCS runs two Campaign Groups which dial calls in Predictive mode
through the same Switch using T-Server as a dialer. The channel_num
option (see page 264) for the Switch configuration object is set to 100, and
the dynamic-port-allocation option is set to true for the same Switch
object. Both Campaign Groups have the Number of CPD Ports property set
to 0. OCS estimates the required number of ports for those Campaign
Groups to be 20 and 30. Since the total number of ports is configured as
100, the maximum number of ports allowed for the Campaign Groups are
40 and 60, respectively.
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Example 3

Multiple Sites, Users, and Tenants

¢ OCS runs two Campaign Groups which dial calls in Progressive mode
through the same CPD Server. CPD Server is configured to use a total of 25
ports. The dynamic-port-allocation option is set to true at the CPD
Server Application level. Both Campaign Groups have the Number of CPD
Ports property set to 8. OCS estimates the required number of ports for
the Campaign Groups to be 20 and 30. The total number of available ports
is 25, therefore, the maximum number of ports that are actually available
for the Campaign Groups are 10 and 15.

*  OCS runs two Campaign Groups which dial calls in Progressive mode
through the same CPD Server. CPD Server is configured to use a total of 50
ports. The dynamic-port-allocation option is set to true at the CPD
Server Application level. Both Campaign Groups have the Number of CPD
Ports property set to 8. OCS estimates the required number of ports for
the Campaign Groups to be 5 and 100. OCS considers the number of ports
required by the first Campaign Group as small, since 5 < (50 / 2 * 0.3).
Therefore, the maximum number of ports available for the Campaign
Groups are 5 and 45.

Multiple Sites, Users, and Tenants

Multi-Sites

Deployment Guide

Outbound Contact Server supports multi-site operation. Multi-site operation
means that you can run several dialing sessions for Campaigns independently
in different locations using only one Outbound Contact Server, or you can run
one dialing session from different sites at the same time. A site is a location
with a contact center and an agent group.

OCS also supports environments in which agent groups or place groups are
distributed across multiple sites. In this scenario, dialing is performed by one
CPD Server or T-Server. OCS relies on ISCC call distribution to deliver
successful calls to agents in multiple sites. If the value of the
transfer_to_unknown_dn option is set to true or yes, OCS correctly processes
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the route of successful outbound calls or transfer calls between agents on
different switches. See page 255 for more information about this option.

Note: ° The use-data-from option must be configured with the value
consult-user-data in the extrouter section of all T-Servers used
with OCS. This value enables OCS to correctly process transferred
calls between agents/DNs on different switches. When this value is
set, AttributeUserData and AttributeConnID values are identified
from the consultation call before the transfer or conference is
completed. After the transfer or conference is completed, the
EventPartyChanged message is generated, and then the
AttributeUserData and AttributeConnID values can be taken from
the original call.

» Ifa Voice Transfer Destination DN and a T-Server, used as a Dialer,
belong to one switch in a multi-site environment, but the call is
distributed by external routing to an agent who is on a different site,
at least one queue from this site must be listed in the Origination
DN list of the corresponding Campaign Group. This forces OCS to
register regular DNs on the remote site and receive related events.

In multi-site scenarios, OCS generates statistical user events only on the
Communication DN that is configured under the same Switch object as the Voice
Transfer Destination DN.

OCS makes multi-site operation possible because it connects to the T-Server at
each site and tracks the campaign data that is assigned to each agent group at
each site.

One example of a multi-site campaign is as follows: A customer has three sites
with agents at each site. One campaign is assigned to three agent groups and
runs concurrently at all three sites.

Multi-site does not necessarily mean that a dialing session for a Campaign
Group is started at one site from which calls are distributed to agents in one of
three sites; however, with a centralized CPD Server, it is possible to run a
dialing session for a campaign from the central location and connect to agents
who are at outlying sites.

Multiple Users

OCS can support multiple instances of Genesys Administrator or Outbound
Contact Manager that run concurrently.

Multi-Tenant Environment

A tenant is typically a contact center (single-site or multi-site). In a
multi-tenant site, the administrator can grant permissions to other users to view
their own tenant and run their own campaigns. Outbound Contact supports

72 Outbound Contact 8.0 @



Chapter 2: Architecture

Deployment Guide

Multiple Sites, Users, and Tenants

multiple tenants. However, Genesys Administrator (Outbound) works with
only one tenant at a time.

Genesys Administrator supports the Environment tenant, which can be used by
administrators of multi-tenant sites or by a user with permission that is granted
by an administrator. When multiple tenants are set up, an administrator can
select any tenant, including the Environment tenant, from the Select Tenant
dialog box. The Select Tenant dialog box displays the tenants that are
available to each user, based on that user’s permissions.

The Environment tenant is created during the installation of the Configuration
Layer. Although the Environment tenant is on the same level as all other
tenants in the directory, it provides the administrator of a multi-tenant site with
the following:

* A single location for all the configuration objects that are shared by
sub-tenants (for example, Applications, Application Templates, and so
on).

* Preset templates in some folders (for example, the Formats folder includes
a preset format).

* Privacy through restricted access to all users except the administrator.

The elements of the Environment tenant simplify the process of adding new
tenants.

Centralized Configuration and Shared HMP Resources

In release 7.6.101 and higher, Outbound Contact supports a centralized
configuration and sharing of HMP resources in multi-tenant deployment. This
functionality can be used for HMP deployment in the ASM mode and the
Transfer mode because of rapid ISCC call routing between SIP Servers.

This functionality includes the ability to:

* Have a centralized configuration of HMP in a multi-tenant environment.
* Share HMP resources among multiple Tenants.

* Isolate HMP configuration from Tenant access.

* Configure a capacity-based resource allocation. (This configuration
involves dedicating one CPD Proxy Server for each Tenant or any subset
of Outbound Campaigns in a Tenant, as described in “Managing Dialing
Resources.”)

* Configure a demand-based resource allocation. (This configuration is
based on one CPD Server shared among all Tenants.)

Configuration Requirements:

* All configuration of HMP must be accomplished under Environment/SIP
switch and is not accessible by Tenants.
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* The Tenant configuration contains only Outbound/agent-specific
configurations.

Figure 7 provides a sample architecture of this configuration environment.

Environment

— CPD Server [«——

Central SIP
Server

Tenant 1
Premise SIP

HMP

HMP
configuration

Outbound
Contact
Server

> Server

Capacity
configuration

Tenant
Outbound
configuration

Figure 7: Sample Architecture

Note: Figure 7 does not show component connections. Be aware that
CPD Proxy Server, which is used by the Tenant and connects OCS
with CPD Server, is configured under Environment. The Tenant is not
able to change its configuration.

Managing Dialing
Resources

To restrict the number of dialing resources available for each Tenant or for any
subset of Outbound Campaigns in a Tenant:

* Configure CPD Proxy Server that controls the usage of dialing resources:

+  One for each Tenant that is used by all Campaign Groups for that
Tenant, or

+  Multiple CPD Proxy Servers, one for each subset of Outbound
Campaigns for the Tenant. For example, CPD Proxy Server 1 may
have a maximum of 30 channels to handle Campaign A and B.

CPD Proxy Server 2 might have a maximum of 50 channels to handle
Campaigns C, D, and E.

* For each CPD Proxy Server, configure the max-dialing-channels option
(see page 278) and the max-engaging-channels option (see page 278),
which set the maximum number of dialing and engaging channels for that
CPD Proxy Server.

When OCS starts a dialing session for a Campaign Group, it requests and
receives the maximum number available for these respective channels from
CPD Proxy Server, as configured in these options.
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Figure 8 illustrates how restricted dialing resources might be configured for
two or more Tenants.

Tenant A

Campaign Group A
Connections -> CPD Proxy
Server for Tenant A

CPD Proxy Server for
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max-engaging -channels =10
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Campaign Group N
Connections -> CPD Proxy
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Figure 8: Dialing Resources for Tenant Campaigns

Dialingand When OCS is running a dialing session associated with a campaign for a
Distribution of  particular Tenant, it sends requests to make transfer calls (for HMP Transfer
Engaging Calls  y0de) or make engaging calls (for HMP ASM mode) to the Route Point under
Environment SIP switch, instead of the Voice Transfer Destination (VTD) on
the Tenant SIP switch that is associated with a specific Campaign Group. A
routing strategy (loaded on the Route Point)/URS routes these calls to the VITD
under the Tenant SIP switch.

This two step process is required because CPD Server cannot manage calls
across multiple switches. By using this method, CPD Server works with the
Environment/SIP switch only and OCS works with the premise SIP Servers
only.
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In order to accomplish this:

* For every VTD on the Tenant (premise) SIP switch, configure a
corresponding Voice Transfer Destination on Environment SIP switch.

* Configure at least one VoIP Service DN for each Tenant to handle
engaging calls.

* Create a routing strategy for each Environment/SIP Switch Route Point to
route calls to the associated Route Point (VTD) on the Tenant switch.

* Configure the vtd-override option (see page 257) to specify the dialing
number that OCS sends to CPD Server and that it will use as the
destination number where a transfer call (HMP Transfer mode) or an
engaging call (HMP ASM mode) is delivered.

Two Tenant Configuration Example

Figure 9 provides an example of a two Tenant configuration for handling
engaging call distribution in HMP ASM mode.

Environment/SwitchEnv/SIPServer Env Tenant 1/Switch1/SIPServer1
Eng.
—ISCC— cal P AgentGroup 1
Eng. call
Eng. Eng.
HMP -l (RP2 ISCC C’;ﬁ» AgentGroup 2
Eng. call
@ Tenant 2/Switch2/SIPServer2
~ISCC
—
ig?l'-b AgentGroup 1

Figure 9: Engaging Call Dialing and Distribution Diagram

In this configuration:

* Tenantl includes the following:

+ Switchl, SIPServerl, two Campaign Groups (CampaignGroup! and
CampaignGroup2), and two Agent Groups.

+ Two route points, as VTD.
+  One external route point for the switch used by that Tenant (not shown
in Figure 9).
¢ Tenant2 includes the following:

+  Tenant2 has Switch2, SIP Server2, one Campaign Group
(CampaignGroup3), and one agent group.
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+ One route point as the VTD.
+  One external route point (not shown in Figure 9).

¢ The Environment SIP switch DNs includes the following:
+ Three route points. Two route points are the central VTDs for the two
Campaign Groups for Tenantl. The third route point is the central
VTD for the Campaign Group for Tenant2.
+ Two VoIP Service DNs for transferring engaging calls to premise SIP
Servers.

Outbound Contact and HTTP Server

Deployment Guide

OCS now supports communication with OCS clients, such as GVP using
HTTP requests/responses.

This enables an HTTP client to send requests to update records over the HTTP.

The HTTP interface in OCS, HTTP Proxy is a gateway between HTTP version
1.1 and outbound protocols (Desktop protocol and Third Party protocol). At its
startup, when OCS determines that an HTTP port is configured (see Procedure:
Configuring OCS for HTTP), OCS automatically starts the HTTP Proxy. As
the end user, you do not need to start this child process manually.

In OCS, this HTTP Proxy translates:
* HTTP requests into OCS proprietary protocols.
*  OCS proprietary protocols responses into HTTP responses.

At OCS startup, OCS starts HTTP Proxy, and HTTP Proxy opens the
associated port that is configured in the OCS application object. If HTTP
Proxy cannot open the port, HTTP Proxy terminates. If the HTTP Proxy
terminates unexpectedly, OCS tries to restart the HTTP Proxy after the
Reconnect Timeout, as specified on the OCS Configuration tab/Server Info
section (in Genesys Administrator).

HTTP Proxy does not have its own log, but passes log messages to OCS,
which logs them into the OCS log file.

Procedure:
Configuring OCS for HTTP

Purpose: To configure the OCS application object to communicate with
clients using HTTP requests/responses.
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Start of procedure

1. In Genesys Administrator, go to Provisioning > Environment >
Applications and double-click your OCS application object.

2. Configure a separate listener port on the Configuration tab/Server Info
section with the Connection Protocol set to http.

End of procedure

Configuration Changes

Dynamic changes to this port are not supported. As a result, any such changes
are not communicated to an HTPP Proxy that is already running. However, any
HTTP Proxy started that is after that port change will reflect the change.

HTTP terminates if the HTTP listener port is removed from the OCS

Configuration tab/Server Info section or if the connection is lost between
OCS and HTTP Proxy.

Primary and Back OCS and HTTP Proxy

If you have configured primary and backup OCS applications, each instance
starts an associated HTTP Proxy.

Other Supporting Solutions

This section describes other Genesys applications that enable and support
Outbound Contact. They include the following solutions:

*  “Framework 8.0” on page 78
*  “Genesys eServices (formerly, Multimedia)” on page 80
*  “Genesys Voice Platform” on page 82

* “Reporting” on page 85

Framework 8.0

78

Outbound Contact 8.0 is built on Framework 8.0, which includes DB Server,
Configuration Server, the Management Layer, T-Server, and Stat Server.

DB Server

Outbound Contact relies on the DB Server for access to data in the Calling List
database tables, any Do Not Call list, and any other additional lists that are
stored in the database.
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Configuration Server

Outbound Contact is configured through the Configuration Layer of
Framework. More specifically, you use Genesys Administrator to configure the
components (applications and configuration objects) that enable Outbound
Contact. OCS reads the configurations from the Configuration Server in order
to perform its operations. Outbound Contact supports dynamic
reconfiguration—that is, you can make changes to Outbound objects (such as
Calling List, Table Access, and Campaign objects) in Genesys Administrator
or Outbound Contact Wizard without stopping and restarting Outbound
Contact. Messages that notify the user of changes are displayed in Genesys
Administrator. For information about configuring Outbound objects, see
Chapter 8 on page 157.

Management Layer

The Management Layer of Framework includes Local Control Agent (LCA),
Message Server, Log Database, Solution Control Server (SCS), and Solution
Control Interface (SCI). LCA is used to start and stop applications. Message
Server provides centralized processing and storage of every application’s
maintenance events. Log Database stores events as log records, so that they are
available for further centralized processing. SCS is the central processing
center of the Management Layer. SCI displays the status of all installed
Genesys solutions and provides information about each active alarm condition.

Note: Genesys Administrator can be used instead of SCI.

T-Server

T-Server is the key element of Genesys computer-telephony integration (CTI)
because it handles call traffic. Each T-Server is linked to a switch, which it
monitors. T-Server is also a “messenger” that enables communication among
Outbound Contact components. For details, see the “Communications
Protocol” chapter in the Outbound Contact 8.0 Reference Manual.

Network T-Server

Outbound Contact supports Network T-Servers in deployments that do not
include CPD Server. To enable this functionality in Predictive dialing mode:

e The Service Number DN type, in addition to any applicable DNs of type
ACD Queue and Route Point in Genesys Administrator must be identified on
the appropriate place group or agent group.
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* The Campaign object must specify the same Service Number DN as the
Voice Transfer Destination within the place group or agent group that is
specified on the Group tab.

Note: Outbound Contact Server does not support the load-balancing
capabilities of the Network T-Server.Outbound Contact Server should
not be configured to connect to multiple Network T-Servers that are
associated with the same switch.

Stat Server

Stat Server provides the data source for the CCPulse+ application. It also
provides agent-state information to Outbound Contact Server so that it can dial
effectively.

Optional Solution Integration

80

In addition to the Framework components, Outbound can work with the
following Genesys solutions:

*  “Genesys eServices (formerly, Multimedia)”
*  “Genesys Voice Platform” on page 82

* “Reporting” on page 85

Genesys eServices (formerly, Multimedia)

Outbound Contact Calling List and Campaign management are now integrated
with the Customer Information Management (CIM) platform. This feature
extends the Outbound Contact Calling List and Campaign management to
multimedia channels, and it improves agent efficiency by pushing preview
records to agents without waiting for an agent request. Therefore, it enables the
prioritization of outbound interactions with other interaction types for blending
purposes. This dialing method can also be referred to as “proactive routing” or
“push preview”. Figure 10 illustrates how Outbound Contact integrates with
the CIM platform.
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Figure 10: CIM Integration with Outbound Contact

The basic process for completing a proactive interaction is as follows:
1. OCS submits a preview interaction request to Interaction Server.

2. Interaction Server requests that Universal Routing Server execute a
strategy to determine which agent to send the interaction to based on skill
abilities. The agent must be logged in to Interaction Server and can still
process other interactions during this process. The communication between
the agent desktop and OCS is through Interaction Server in this scenario.

3. The agent processes the preview record appropriately, transfers the call to
another agent, or places the call back into the queue.

4. Special strategy blocks enable the routing strategy to process the preview
call interaction automatically without agent involvement.

Note: Refer to the Universal Routing documentation for more information
about configuring strategies for proactive interaction routing.

Refer to “Campaign Group Object” on page 196 for more information
about configuring a Campaign Group object for proactive routing (or
push preview) campaign.

ESP Port

In the Push Preview dialing mode, Interaction Server must be specified in the
Connections tab of the CampaignGroup object to establish a client-server
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relationship between OCS (as the client) and Interaction Server (as the server).
However in order for OCS to process requests and responses from Interaction
Server, OCS must be a server for Interaction Server and receive these
responses on a special ESP-type port rather than its default listening port.

Create this additional port PortID—called ESP—on the Server Info tab of the
0CS Application object. Use this ESP PortID instead of the default PortID,
when you are configuring a connection to the 0CS Application object on the
Server Info tab of the Interaction Server Application object. In effect, this
makes OCS a server for Interaction Server and Interaction Server a client for
OCS.

Note: This ESP PortID will be available as a connection in the Interaction
Server Application object only after you configure PortID in the 0CS
Application object.

Interaction Media Type

Interactions that are submitted to Interaction Server must contain a certain
media type. By default, OCS creates interactions with the outboundpreview
media type. However, OCS can assign other media types to interactions from
particular calling list or to interactions that were created for the entire
campaign. Refer to the interaction-media-type option on page 261 for more
information.

Note: Refer to the direct-personal-callback option in “Campaign
Group-Level Options for OCS” on page 226 when you are
configuring this solution.

Refer to the “Proactive Interaction Support” section in the Outbound
Contact 8.0 Reference Manual for more information about Proactive
Interactions with Outbound Contact.

Genesys Voice Platform

Outbound Contact can integrate with Genesys Voice Platform (GVP) in order
to run campaigns in the Power GVP or the Progressive GVP dialing mode.

Proactive Contact with GVP 7.6 Deployment

In a T-Server deployment that is running in the Power GVP dialing mode, OCS
uses the Outbound Notification Manager (OBN) application as a connector to
GVP to request that GVP dial records. The 0BN Manager GVP application
should be created in Genesys Administrator to provide its host and port
information to OCS. This application must be specified on the Configuration
tab/Connections section of the Campaign Group configuration object (in
Genesys Administrator) to enable GVP integration. This configuration will
enable basic connection capabilities.
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If full connection abilities—including Advanced Disconnect Detection
Protocol (ADDP) is required— this application also should be present on the
Configuration tab/Connections section of the 0CS application, where the ADDP
connection protocol can be specified.

Note: For more information about how to configure the Campaign Group
configuration object for the Power GVP dialing mode, see “Campaign
Group Object” on page 196.

When configured to enable connections, OBN opens a predefined port (for
listening purposes) and then accepts requests from OCS in a client-server
fashion.

In a GVP-assisted campaign, dialed outbound calls are dialed from GVP ports,
and they can be completely processed and released by GVP. GVP issues
information about call processing (such as call results and modified user data)
to OBN Manager, which relays this information to OCS. OCS processes this
information accordingly, applies any necessary treatments, and updates the
records.

OCS issues an Event0BNRecordStopProc message to OBN when it receives a
DoNotCall request and determines that records are currently being processed
by OBN. OBN immediately attempts to stop processing the specified record.

The procedure that OCS uses to calculate the number of records (or chains) to
retrieve from the database when a dialing session for a Campaign group is
loaded, is similar for both Push Preview and Power GVP modes, but differs from
traditional Predictive, Progressive, or Preview modes.

For the Power GVP dialing mode, when a dialing session is loaded for a
Campaign Group object configured to use this dialing mode, OCS calculates
the number of records for retrieval from the database as a percentage (specified
in the Optimal Record Buffer Size dialog box) of the MaxQueueSize parameter
for this Campaign Group. If more than one Calling List is used in the
Campaign, the number of records retrieved from each Calling List is
determined by the specified list weight.

OCS then submits the records to OBN Manager using the following criteria:

* The total number of dialing requests that are submitted is equal to the
MaxQueueSize value for the Campaign Group.
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*  OCS retrieves records from the Calling List table in the database to
replenish its buffer when the number of Calling List records in the OCS
buffer is less than the number calculated as the percentage (specified in the
Minimum Record Buffer Size dialog box) of the MaxQueueSize value for this
Campaign Group.

Note: Refer to the dialer-ttl and dialer-num-attempts options in
“Campaign Group-Level Options for OCS” on page 226 when you are
configuring this solution.

Refer to the GVP 7.6 documentation for more information about using
Outbound Contact with the 0BN application.

GVP 8.0 VoIP/SIP Server Deployment

GVP 8.0 uses SIP Server and MCP/Media Server(s) call processing in a VoIP
environment. It can perform call-progress detection on outbound calls and can
process those calls that are connected to customers, based on the logic that is
built into VXML scripts. These scripts allow GVP to manipulate user data and
perform call control; for example, the call can be completed or transferred to
the live agent for further processing. GVP 8.0 can also communicate with OCS
by using the HTTP (see “Outbound Contact and HTTP Server” on page 77),
which enables automated outbound record processing.

Dialing Algorithm  This deployment supports two dialing modes: Power GVP and Progressive
GVP. In this environment, calls originate on the Trunk Group DN and are
communicated to the GVP platform after the established CPD is completed
using the ApplyTreatment T-Library API.

Calculating the ¢ For the Power GVP (VoIP) dialing mode, the number of records is
Number of calculated the same way they are calculated when using the Power GVP
Records dialing mode with GVP 7.6.

*  For the Progressive GVP dialing mode: When a dialing session is loaded
for a Campaign Group object configured to use this dialing mode, OCS
calculates the number of records for retrieval from the database as a
percentage (specified in the Optimal Record Buffer Size dialog box) of the
total number of channels that are available for this Campaign Group. If
more than one Calling List is used in the Campaign, the number of records
retrieved from each Calling List is determined by the specified list weight.

OCS then submits outbound call requests to SIP Server based on the total
number of channels that are available, while trying to keep as many calls in
progress as there are available channels.

OCS retrieves records from the Calling List table in the database to
replenish its buffer when the number of records in the OCS buffer is less
than the number calculated as a percentage (specified in Minimum Record
Buffer Size dialog box) of the total number of channels that are available
for this Campaign Group.
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Reporting

The Genesys Reporting solution contains tools for collecting historical and real
time data, and for viewing and analyzing contact center performance. In
Outbound Contact, the calculation of some real-time metrics is provided by the
OCC Extension. All data that is required for the OCC Extension is directly
submitted by OCS through the OCS DataStream protocol. For more
information about the Genesys Reporting solution and the templates provided
with Outbound Contact, see the Reporting Technical Reference Guide for the
Genesys 7.2 release.

Deployment Guide 85



Chapter 2: Architecture Other Supporting Solutions

86 Outbound Contact 8.0 @



N

GENESYS

AN ALCATEL-LUCENT COMPANY

Chapter

Outbound-VolP Deployment

This chapter explains the architecture and configuration when you use
Outbound Contact in a VoIP environment. It contains the following sections:
«  Overview, page 87

« Dialing Modes and VoIP Deployment, page 90

«  Outbound-VoIP in ASM Dialing Modes, page 91

+  Outbound-VoIP in Transfer Modes, page 97

Note: Outbound/VoIP deployment is not supported in a multi-tenant
environment due to a limitation with GVP 8.1.1, associated with this
release of Outbound Contact.

Overview

Deployment Guide

Outbound Contact supports a VoIP deployment that enables automated
outbound dialing when using SIP Server 8.0 and GVP 8.1 applications (Media
Control Platform and Resource Manager).

In this environment, Outbound Contact and Universal Routing components
function on top of SIP Server, Media Control Platform (MCP), Resource
Manager, and a SIP Media Gateway. Figure 11 illustrates the architecture.

Instead of requiring new dialing modes for a VoIP deployment, Outbound
Contact uses the existing dialing modes and runs these as VoIP modes when
Outbound Contact is configured as VoIP-ready (see Procedure: Configuring
Outbound Contact and SIP Server for a VoIP Deployment, on page 90).
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In a VoIP-ready deployment, OCS is responsible for initiation of outbound and
engage calls dialing and partial control of call distribution.

Notes: * For more information on dialing modes functioning in a VoIP
environment, see “VoIP Dialing Modes” on page 61.
+ If the Campaign Group object is not configured with a Trunk
Group DN, the dialing modes function as they would in a
non-VoIP environment.

The Genesys components/applications function as follows:

Outbound Inbound /
Contact Universal Routing

TLib TLib

A

SIP Server
sn/ SIP
Media Gateway / \ GVP

Figure 11: VolP Environment/Outbound Contact Architecture

¢ Outbound Contact components handle the following:
+ Outbound call pacing

+  Outbound call initiation toward the customer (Transfer, ASM, and
Proactive Contact modes)

+ Engaging call initiation toward agents (ASM mode)

+ Outbound call distribution toward agents (Transfer and ASM modes)
and toward the voice platform (Power GVP and Progressive GVP
modes)

* The Universal Routing components handle routing outbound and engaging
calls to the agent.

» SIP Server controls all SIP signaling for initiated calls and also acts as an
interface between solution components.
*  GVP components—and in particular, MCP—handle the following:
+ Playing the basic announcement (ASM Mode)
+ Call recording
+ Call-progress detection
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+ Media bridging (ASM mode)

+ Playing voice applications (Power GVP and Progressive GVP dialing
modes)

In addition to MCP, the GVP components also include Resource Manager,
Fetching Module, and Squid and Reporting Server. For more information
on the GVP components, see the Genesys Voice Platform 8.1 Deployment
Guide.

Note: GVP Resource Manager manages MCP resources. If two or more
MCP are configured to serve a Trunk Group, Resource Manager
distributes the engaging calls and customer calls among them.

Supported Deployments

Resources

Deployment Guide

Outbound supports several types of VoIP deployments for agent connectivity
including:

» [P agents who located on the same SIP Server
* [P agents who are on a different SIP Server

* TDM agents who are located on another T-Server

The resources available for each dialing session/outbound campaign are
determined by the Trunk Group DN that is specified in the Advanced tab of the
Campaign Group object (see page 196).

Note: For GVP 8.1.1, the Trunk Group DN must be named Environment
working in any tenant; in GVP 8.1.2 there is no restriction for Trunk
Group DN name.

On behalf of the Trunk Group DN, SIP Server provides OCS with
media-resources usage (total ports and available ports). OCS initially receives
this information in EventRegistered when it registers this DN with SIP Server.
Once OCS registers Trunk Group DNs, SIP Server automatically provides
updated resource/port information for Trunk Group DNs, which OCS uses to
run dialing sessions/campaigns. In addition to this information, a dialing
session limits the number of ports it can use to the number specified in the
Number of Channels parameter in the Campaign Group object (Configuration
tab/Advanced section).
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Dialing Modes and VolP Deployment

An Outbound-VoIP environment supports all auto-dialing modes.

Table 2 provides a comparison of the modes in both a traditional and an IP
environment.

Table 2: Dialing Mode Comparison

Dialing Mode Traditional Outbound-VoIP - Ready
Predictive Predictive [P-predictive
Progressive Progressive IP-progressive

Predictive with seizing

Predictive ASM using CPD
Server

IP-ASM (predictive)

Progressive with seizing

Progressive ASM using CPD

IP-ASM (progressive)

Server
Power GVP Power GVP using OBN IP-VXML (based on the calls per
second setting)
Progressive GVP Not applicable IP-VXML (based on port
availability)
Configuration
Procedure:

Configuring Outbound Contact and SIP Server for a
VoIP Deployment

Purpose: To configure Outbound Contact and SIP Server so that a Campaign
Group is VolP-Ready.

Configure a Trunk Group DN on the SIP Server switch object. For more
information, see Framework 8.0 Genesys Administrator Help.

Configure a Campaign Group object with the Trunk Group DN. For more

Start of procedure
1.
2.
information, see page 196.
3.

90

Configure a SIP Server application object that controls the Trunk Group

DN.
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4. In the OCS application object, add this SIP Server on the Configuration
tab/Connections section.

End of procedure

Outbound-VolIP in ASM Dialing Modes

In a VoIP environment in which Campaigns are running in ASM modes,
agents are engaged by the RTP stream from MCP. MCP bridges the engaging
and outbound calls, connecting the two RTP streams.

Campaign Group Configuration

In the Outbound-VoIP ASM modes, configure a Campaign Group object the
same way that you would for the standard Predictive with seizing or
Progressive with seizing dialing modes, but with the addition of the Trunk
Group DN configuration. For more information, see page 196.

Note: If the Trunk Group DN is not configured in the Campaign Group
object, OCS processes that Campaign Group by dialing on behalf of
the Voice Transfer Destination (VTD), as it did in 7.x releases.

Engaging Calls

In a VoIP environment, OCS requests that an engaging call be dialed. OCS
sends this request to SIP Server (using TLibrary) for it to make a call from the
Trunk Group DN to VTD. Similarly to the standard ASM mode, the engaging
call is then delivered from VTD to the agent’s DN.

Note: For engaging calls, the TMakeCall request includes the Trunk Group
DN and the Voice Transfer Destination DN.

The following option affect how the engaging call is dialed:

* beep-on-merge (see page 230)—Controls whether a beep is played to the
agent immediately before the agent is bridged to the customer call.

* call_wait_agent_connected_timeout (see page 233)—Specifies the
timeout, in seconds, between when the engaging call is dialed and when
the agent answers the call.

For a successful engaging call (that is, one that is established with an agent),
when SIP Server sends EventEstablished to OCS, it includes the Media Server
ID (GSW_MEDIA_SRV_ID) as a user data attribute. This enables OCS to bridge
only engaging and customer calls that reside on the same Media Server.
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For an unsuccessful engaging call (that is, one that is not established with an
agent), note the following:

* If an engaging-call request cannot be made, SIP Server issues an
EventError on the Trunk Group DN identifying the reason for the failure.
Error codes include 50 (Unknown error), 53 (Invalid attribute), and 415
(Invalid destination).

In a VoIP environment, the most likely cause of the failure is the
unavailability of resources required to make the call (for example, a lack of
available ports on Media Server or the Media Gateway).

» If an engaging-call request is successfully placed but the engaging call is
released because the agent is busy, SIP Server issues
EventDestinatationBusy and EventRe leased on the Trunk Group DN.

+ Ifthe engaging-call request is successfully placed but the agent does not
answer within the timeout specified by the
call_wait_agent_connected_timeout option (see page 233), OCS releases
the call.

Note: No announcements are supported for engaging calls.

Customer Calls

92

For customer calls, OCS uses the TMakePredictiveCall request to initiate
customer calls. This request includes the Trunk Group DN and the Voice
Transfer Destination DN.

Call Progress Analysis

Call progress analysis (CPA) occurs based on the setting of the
call_answer_type_recognition option (see page 230), which specifies what
has to be detected on the pre-connect (SIT tones) and post-connect (for either a
fax or an answering machine) phases of the call, as well as answering machine
detection sensitivity.

Note: Ifa record is configured with a call_answer_type_recognition value
(see “Per-Record Basis” on page 354) that is not supported by SIP
Server (for example, ISDN messages that are based on
answering-machine detection only), or if the record does not specify a
value, OCS applies instead the no_am_detection value.

The following options affect CPA for VoIP dialing modes:

* cpd-recording (see page 236), which allows you to specify whether the
call progress detection phase of the call should be recorded.
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call_timeguard_timeout option (see page 233), which specifies the
maximum time that is allowed for CPA after the call is connected.

cpd-on-connect option (see page 236). which specifies that CPA begins
after the call is connected. Set this option to yes.

Note: Setting this cpd-on-connect option to yes accounts for the use of
color ring back tones. If cpd-on-connect is not configured or its
value is set to false or no, CPA starts as soon as the media stream
is available.

A color ring back tone (CRBT) refers to the ability to play other
audio sounds (music, voice, and so on) for a busy signal for
example, instead of a standard ring back tone.

OCS receives the results of CPA (performed by the Media Gateway or the
GVP Media Control Platform) in the Cal LState attribute of EventEstabLished
(the call has been connected), EventDestinationBusy (the call has been
rejected) or EventReleased (call was not answered or it was released by SIP
Server) and assigns a call result.

For information on attributes that are specific to VoIP environment, see the
Outbound Contact 8.0 Reference Manual.

Successful Call Flows

For a successful customer call, SIP Server passes the Media Server identifier to
OCS.

Unsuccessful Call Flows

For an unsuccessful customer call, note the following:

If a customer call (RequestMakePredictiveCall) cannot be placed,

SIP Server issues an EventError on the Trunk Group DN, providing the
reason for the failure in the ErrorCode and the ErrorMessage attributes.
Error codes include 50 (Unknown error), 53 (Invalid attribute), and 415
(Invalid destination).

In a VoIP environment, the most likely cause for the failure is the
unavailability of resources required to make a call (for example, a lack of
available ports on Media Server or the Media Gateway).

If the call is initiated but is released because of a negative call-progress
result (usually due to the detection of a SIT tone or a busy response),
SIP Server issues EventDestinationBusy and EventRe leased on the Trunk
Group DN with the associated CallState attribute.
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If the call is initiated successfully, but the call is released because it was
not answered or is answered by a fax or answering machine, according to
the SIP Server configuration, SIP Server issues EventRe Leased on the
Trunk Group DN with the associated Cal LState attribute.

Merging Engaging and Customer Calls
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For all dialing sessions, OCS maintains information about the distribution of
engaging and customer calls among Media Servers. There are two methods—
bridging and transfer—for merging an engaging call with a customer call when
these calls might be on different Media Servers.

You specify the merge method (bridging or transfer) using the merge-method
option (see page 240) at the Campaign Group Level or the OCS Application
Level.

Note: In a multi-site environment, to maintain the correct Events and ensure

user data propagation when merging these calls, configure the SIP
Server user-data-from option with a value of current. For more
information about this option, see the Framework 8.0 SIP Server
Deployment Guide.

Bridging Method

OCS controls when and how do bridge the engaging and customer calls. As the
default method, when a customer call is connected and call-progress analysis is
completed, OCS attempts to find an established engaging call on the same
Media Server as the customer call and responds as follows:

If OCS finds an established engaging call, it bridges the two calls.

If OCS does not find an established engaging call (for example, in the
Predictive mode) on the same Media Server, OCS releases the customer
call, with the option to play a configured announcement before releasing it,
as configured in either the asm_drop_announcement_data option (see

page 211) or the asm_drop_am_announcement_data option (see page 229).

Notes: * While the asm_drop_announcement_data option allows you to
play the same announcement for all call results, the
asm_drop_am_announcement_data option allows you to play a
different announcement for Answering Machine call results
than the one used for Answer call results.

» For SIP Server, if the asm_drop_announcement_data option
and/or the asm_drop_am_announcement_data is configured, OCS
releases the call only after the announcement is played, which
occurs after OCS receives EventTreatmentEnd from SIP Server.
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You can configure OCS to handle a scenario in which it cannot find an
established engaging call on the same Media Server by setting the
on-bridging-unable option (see page 241) to transfer. By doing so, OCS
connects the customer call to the first established engaging call, regardless
of the Media Server on which the engaging call is established. You
configure this option at the Campaign Group Level OCS Application
Level.

Note: When the bridging method is used, no SIP messaging is provided to

OCS if the agent’s SIP endpoint fails and the calls are not merged. As
a result, OCS is unable to identify the call with a Transfer error.

Transfer Method

For the transfer method, OCS attempts to find an established engaging call on
the same Media Server as the customer call and responds as follows

If OCS finds an established engaging call on the same Media Server, it
connects it with the customer call.

If OCS does not find an established engaging call on the same Media
Server, OCS selects any established engaging call on any Media Server
and connects it with the customer call.

Figure 12 illustrates the event flow for the engaging and customer call legs and
their merging.

95



Chapter 3: Outbound-VolP Deployment

Outbound-VolIP in ASM Dialing Modes

OCS Trunk DN Agent DN Agent
EventRinging
(ConnID 1)
Engaging Call, ConnID 1,
GSW_CALL_TYPE =
ENGﬁSE EventEstablished ASM
S~ao ConnlD 1 Engaged
- ( ) 5| L Engag
Customer Call, ConniID 2,
GSW_CALL_TYPE =
REGULAR
EventEstablished
(ConnlID 2) RequestMergeCalls
(ConnID 1, ConnID 2
EventReleased
ConnID 1
EventReleased (ConnlD 2) >l ( )
EventPartyChanged ASM
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Figure 12: Event Flow—ASM Engaged and Outbound Call

Transferring a Customer Call

If OCS determines that the customer call must be transferred to another
destination (for example, a treatment with a transfer call action), OCS uses a
single-step transfer. OCS considers the transfer complete when the customer
call is transferred from the Trunk Group DN to the VTD. Then, OCS finalizes
the chain processing with a call result.

SIP Server and High Availability Limitation
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When you are running a dialing session in an ASM mode for an outbound IP
campaign and SIP Server is part of a Network Load Balancing cluster that is
operating in hot-standby mode, use the Switchover command instead of the
Stop command in Solution Control Interface (SCI) to switch from the primary
to the backup SIP Server.

If you use the Stop command, the primary SIP Server will generate
EventLinkDisconnect and of all its associated clients will re-register all DNs on
the backup SIP Server. If the primary SIP Server had established calls for
Outbound VoIP agents and the agents received an Engaged status, the
re-registration process will change the agent status to Busy Unknown or Ready,
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depending on whether the agent was engaged before starting the backup SIP
Server.

Outbound-VolP in Transfer Modes

For Outbound-VoIP functioning in Transfer modes (Predictive or Progressive),
the Campaign Group also needs to be Outbound-VoIP-ready (see “Dialing
Modes and VoIP Deployment” on page 90).

In these dialing modes, OCS dials outbound calls using SIP Server on behalf of
the Trunk Group DN and controls the transfer of successful outbound calls
(that is, those calls answered by a person) to VTD for further delivery to
agents.

Customer Calls

Deployment Guide

In an Outbound-VoIP Transfer mode, the dialing and transfer of a customer
call are handled in the same way as Outbound VoIP ASM mode for the
following:

» Call progress analysis (see page 92)

»  Unsuccessful call flow (see page 93)

* Call transfer (“Transferring a Customer Call”)

For transferring to a Voice Transfer Destination DN, see the next section.

Transferring to a Voice Transfer Destination DN

You can use either a single-step or a two-step transfer. Upon a positive
call-progress detection, OCS transfers an outbound call to a Voice Transfer
Destination (VTD) DN according to the setting of the call_transfer_type
option (see page 232). You define the transfer process by setting the option to
one_step for a single-step transfer and to two_step for a two-step transfer.

Single-Step Transfer

A single-step transfer is quicker than a two-step transfer, but it does not give
the user control over how the transfer occurs. When the call_transfer_type
option is set to one_step, OCS looks to the call_wait_in_queue_timeout
option (see page 234), which determines how long the call should wait (in the
queue) before an agent answers. If the timeout expires, OCS aborts the transfer
by dropping the call, and the record is marked with the Dropped call result.

Note: Some switches do not support this type of transfer.
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Two-Step Transfer

A two-step transfer is slower than a single-step transfer, but it creates a consult
call that allows the user more control over the transfer (for example, to cancel
it). This type of transfer depends on the following:

* The SIP Server consult-user-data option must be set to inherited. For
more information on the SIP Server consult-user-data option, see the
Framework 8.0 SIP Server Deployment Guide.

* The OCS call_wait_in_queue_timeout option must be specified (see
page 234).

Notes: For the consult call, if the timeout expires, OCS aborts the
transfer, tries to reconnect to the call and releases the call if
unsuccessful. OCS also assigns the Transfer Error call result.

If the timeout expires while OCS is waiting for the call to be
established at the Trunk Group DN, OCS aborts the transfer,
releases the call, and assigns the Dropped call result.

OCS applies a treatment to the chain-call result, if the treatment is configured.

It does not attempt to play any voice file for an outbound call before it is
released.

Outbound calls that do not reach a destination (for example, an agent DN or an
IVR port) are considered abandoned and reported as overdialed to the
predictive algorithm.
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Chapter

Deployment Planning

This chapter provides an overview of the deployment process for Outbound
Contact 8.0, and includes tools for deployment planning. It contains the
following sections:

- About the Deployment Process, page 99

«  How to Use This Chapter, page 100

«  System Requirements, page 101

«  Worksheet Definitions, page 107

«  Outbound Deployment Planning Worksheet, page 114
«  Other Resources, page 121

Note: The Outbound Contact 8.0 installation uses information that was set
up during Framework 8.0 configuration and installation. You can
install Outbound Contact 8.0 only after Framework 8.0 is installed.
For more information, see “Outbound Object-Creation Sequence” on
page 158.

About the Deployment Process

The deployment process involves the configuration and installation of the
applications and components that are needed for a functional setup of
Outbound Contact 8.0.

Before deploying Outbound Contact, review the “System Requirements” on
page 101, as well as the following documents, which contain information
about licensing requirements, supported platforms, and sizing specifications:

*  Genesys Licensing Guide
*  Genesys Supported Operating Environment Reference Manual
*  Genesys Supported Media Interfaces Reference Manual
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Also, use the “Worksheet Definitions” on page 107 to gather information for
the configuration and installation of Outbound Contact 8.0. The Outbound
Contact deployment process involves the following components:

*  Outbound Contact Server (OCS)

* Genesys Administrator

Note: Outbound Contact 8.0 supports Outbound Contact Manager 7.6.

¢ CPD (Call Progress Detection) Server (optional)
* CPD Proxy Server (optional)
During installation, test each component before you continue to the next.

Make sure that you install all Framework components, including Configuration
Server, Configuration Manager, T-Server, the Management Layer, DB Server,

and Stat Server. In addition, install Genesys Administrator, which can be used

instead of Configuration Manager to handle all configuration requirements.

For information about configuring and installing Framework products, see the
Framework documentation.

If necessary, install Dialogic boards and software for call-progress detection.
For more information about installing Dialogic boards, see “Introduction to
Dialogic Boards” on page 387.

For additional information about Formats, Calling Lists, Campaigns,
Campaign Groups, and how to start or stop a Dialing Session, see Framework
8.0 Genesys Administrator Help.

How to Use This Chapter
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Before beginning Outbound Contact 8.0 configuration and installation, review
the “System Requirements” on page 101, and then complete the “Worksheet
Definitions” beginning on page 107.

The worksheet provides space for your notes, and multiple boxes (cells)

provide room to write additional values, if needed. If you need to provide
additional information, you can make copies of the worksheet

This chapter’s structure is based on the configuration sequence found in the
Outbound Configuration Wizard. Outbound properties for Genesys
Administrator are also included.

After completing the installation, keep the worksheet as a reference. In the
future, if you need help from Genesys Technical Support, you can fax the
worksheet to a support engineer in order to provide the complete system
configuration.
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System Requirements

This section describes some of the system sizing requirements for the
installation of Outbound Contact 8.0. It contains the following sections:

*  “Environmental Sizing” on page 101
* “Database Sizing” on page 103
*  “Network Traffic” on page 103

In addition, the following documents on the Technical Support website provide
detailed information about the operating systems and databases supported by
Outbound Contact 8.0:

*  Genesys Supported Operating Environment Reference Manual
*  Genesys Supported Media Interfaces Reference Manual

Environmental Sizing

The information provided in this subsection helps you create the most effective
environment for running Outbound Contact in your contact center.

Table 3 shows the recommended sizing requirements for various contact
centers.

Table 3: Outbound Contact Environmental Sizing for Components

Outbound Contact CPU Memory Network Transactions per Second
Component
Outbound Contact Pentium III, 400 (128 MB 10 mbps Not applicable
Manager MHz (Windows minimum)
(recommended) 2000 or
'Windows
XP)
Outbound Contact Pentium III, 400 [512 MB 10 mbps 0.5—1 transactions per agent
Server MHz (minimum) |(minimum) [per second
(recommended)
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System Requirements

Table 3: Outbound Contact Environmental Sizing for Components (Continued)

Outbound Contact CPU Memory Network Transactions per Second

Component

CPD Server Single or dual 512 MB 10 mbps 0.5—1 transactions per agent

Supported interfaces: processor, 1GHz (minimum)  (minimum) per second

° LSI

* Line-side (E1/T1)

* PRI

- HMP

The CPD Server and the

Dialogic cards and drivers

it controls must be

installed on the same

computer.

Environmental Dual processor 256 MB 100 mbps 0.5—1 transactions per agent

recommendation for 240 [Pentium III, 600 per second

Ports MHz

Number of Agents

25-100 Pentium III, 400 128 MB 10 mbps 0.5—1 transactions per agent
MHz minimum) per second

100-200 Pentium II1, 400 256 MB 10 mbps 0.5—1 transactions per agent
MHz minimum) per second

200-600 Pentium II1, 400 256 MB 10 mbps 0.5—1 transactions per agent
MHz minimum)  per second
(minimum) +
100 MHz for
every 200
agents

600-1000 Single/dual 512 MB 100 mbps 0.5—1 transactions per agent
processor, per second
1 GHz

1000-2000 Dual processor, [512 MB 100 mbps 0.5—1 transactions per agent
1GHz (minimum) per second

2000-4000 Dual processor, [512 MB 100 mbps 0.5—1 transactions per agent
1.5 GHz (minimum) per second
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Note: The list of Dialogic boards might be extended based on their support
by the CPD Server. Refer to the Genesys Supported Media Interfaces
Reference Manual for the current list of supported boards.

Database Sizing

Outbound Contact Server supports IBM’s DB2 database, in addition to the
previously supported database management systems (Oracle, Microsoft SQL
Server, Informix, and Sybase).

The sizing of your database can affect the performance of the Outbound
solution. The term sizing pertains to how the database is tuned, the available
memory, and the number of processors. The term tuning pertains to the
indexing of the calling list. The higher the number of transactions that the
database processes, the more the database performance is affected, unless it is
properly sized.

When sizing your database, consider the factors shown in Table 4.

Table 4: Database Sizing

Format Estimated Size for Each

Record 1 KB

Transaction 1 KB

Database 100 MB per 100,000 records per campaign

If the size of one record is equal to the size of one transaction (1 KB) and if the
size of the calling list is 100,000 records, the estimated size of the database is
100 MB. See the Outbound Contact 8.0 Reference Manual for more
information about database tuning.

Network Traffic

Deployment Guide

Table 5 provides basic data about network traffic produced by Outbound
specific activities among various Framework and Outbound components. This
information can help you determine the optimal component location on the
network.
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Table 5: Network Traffic Among Framework and Outbound Components

System Requirements

Primary Data
Types

Average
Message
Length

Messages Per
Transaction

Elements
Determining Total
Message

TrafficTotal
Traffic Volume

OCS <-> DB Server

Record from
Calling List

0.25 KB + total
length of Field
Names +
average Record
Data length

Number of Records
requested per Select =
<Number of Agents
in Campaign Group>
* <Optimal Buffer
Size Coefficient> -
Minimum Buffer Size
Coefficient>

<Number of
Records from all
Calling Lists in
Campaign> *
<Average Number
of Attempts per
Record>

Update of
Record
Attributes

0.5 KB

1 if OCS is not
configured to save
intermediate results,
otherwise, 1 per
treatment

Hit Ratio, Treatments

<Number of
Records from all
Calling Lists in
Campaign> *
<Average Number
of Attempts per
Record>

OCS <-> CPD Server

Dialing Request

0.25 KB + User
Data

1 per Dial Attempt

Hit Ratio, Treatments

<Number of
Records from all
Calling Lists in
Campaign> *
<Average Number
of Attempts per
Record>

Agent Seize
Request (ASM
mode only)

0.5KB

1 per AgentReady
TEvent

Conversation
Duration

Total Number of
successful
Contacts

Call Progress
Result

0.25 KB

1 per Dial Attempt

Hit Ratio, Treatments

<Number of
Records from all
Calling Lists in
Campaign> *
<Average Number
of Attempts per
Record>
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Table 5: Network Traffic Among Framework and Outbound Components (Continued)

Primary Data | Average Messages Per Elements TrafficTotal
Types Message Transaction Determining Total | Traffic Volume
Length Message

OCS <-> Agent Desktop

Record 0.25 KB + User | 1 per Answered Call | Number of Records | Total Number of
Data or Preview Record processing Desktop | successful
Request sessions Contacts, in

Predictive or
Progressive
mode, <Number
Records from all
Calling Lists in
Campaign> *
<Average Number
of Attempts per
Record>, in
Preview mode

Desktop 0.25 KB Typically 2 Number of Records | Total Number of
Protocol processing Desktop | successful
Requests sessions Contacts in

Predictive or
Progressive
mode, <Number
Records from all
Calling Lists in
Campaign> *
<Average Number
of Attempts per
Record>, in
Preview mode

OCS <-> T-Server

Requests (no 0.25 KB + User | 1 per Dial Attempt Hit Ratio, Treatments | <Number of

CPD Server) Data Records from all
Calling Lists in
Campaign> *
<Average Number
of Attempts per
Record>
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System Requirements

Table 5: Network Traffic Among Framework and Outbound Components (Continued)

Primary Data | Average Messages Per Elements TrafficTotal

Types Message Transaction Determining Total | Traffic Volume
Length Message

TEvents 0.25 KB + User | 5 for simple Hit Ratio, Treatments | <Number of

Data

call-distribution
scenario

Records from all
Calling Lists in
Campaign> *
<Average Number
of Attempts per
Record>

CPD <->T-Server

Dialing Request

0.25 KB + User
Data

1 per Dial Attempt

Hit Ratio, Treatments

<Number of
Records from all
Calling Lists in
Campaign> *
<Average Number
of Attempts per
Record>

Transfer Request

0.25 KB

1 per Dial Attempt

Hit Ratio, Treatments

<Number of
Records from all
Calling Lists in
Campaign> *
<Average Number
of Attempts per
Record>

Agent Seize
Request (ASM
mode only)

0.5 KB + User
Data

1 per AgentReady
TEvent

Conversation
Duration

TEvents

0.25 KB + User
Data

10 for simple
call-distribution
scenario, 1 for
unsuccessful dial
attempt

Hit Ratio, Treatments

<Number of
Records from all
Calling Lists in
Campaign> *
<Average Number
of Attempts per
Record>
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Worksheet Definitions

For more information about the following items, see “Other Resources” on
page 121.

Logging In to Genesys Administrator

* User name—Enter the user ID authorized to log in to Configuration Server.

*  User password—Enter the password for the user ID authorized to log in to
Configuration Server.

* Application—Enter the name of the Genesys Administrator Application
object.

*  Host—Enter the host name of the computer on which the Configuration
Server is installed.

* Port—Enter the port that the Configuration Server uses for client
connections.

License Manager

* Path to License Manager—Enter the path to the License Manager. License
Manager must be available for licensed application.

Outbound Solution Object

* Name—Enter a name for the Outbound solution object.

* Solution Control Server—Enter an existing Solution Control Server.

Tenant

e Name(s)—If this a multi-tenant environment, enter the names of the tenant
to be used for Outbound Contact 8.0.

Switches

As part of the Framework 8.0 configuration and installation, you will have
already assigned agent names, agent logins, and DNs (see “DNs” on page 115)
to switches.

In most systems, the telephone directly notifies the switch when the telephone
set (teleset) status changes—for example, when agents begin or end a call. By
default, Outbound Contact registers teleset states internally. Older PBX
software does not enable the teleset to notify the switch directly when its status
changes. If the contact center’s PBX software does not enable direct
notification, you must customize the contact center’s teleset state disposition.
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Special DNs

Applications

108

Use configuration settings that instruct Outbound Contact to send
Framework’s T-Server a notice for each teleset status change. For more
information, see Chapter 9 on page 201.

The following refer to the capabilities of a switch:

* Name(s)—A switch set up during Framework configuration. Other
switches can include numbers and types of all telephony devices (DNs) to
be monitored and controlled through the CTI (computer-telephony
integration) link. Enter the switch name(s) to be used for Outbound
Contact 8.0. If new switches are needed, they must be added through
Framework 8.0.

* CPD capability—Does the switch have call-progress detection (CPD)
capabilities? If the switch does not provide call-progress detection, and you
wish to use CPD Server as a part of Outbound Contact 8.0 for the contact
center, collect the following information about the Dialogic boards:

» Call transferring—Does the switch have this capability
» Call conferencing—Does the switch have this capability
» (all forwarding—Does the switch have this capability?
* Do Not Disturb—Does the switch have this capability?

Communication DN

Outbound Contact 8.0 reports on outbound activity by using a DN that is set up
as a Communication DN.

*  Number—Enter the name or number of the Communication DN.

* Type—Always enter “Communication DN.”

Overflow DN

Outbound Contact 8.0 monitors calls that cannot be handled by available
agents. It does this through a DN set up as an Overflow DN.

* Existing DN name—Enter the name or number of the overflow DN.

Each application name must be unique, and it can contain alphanumeric
characters and underscores. the properties for most applications are the same;
therefore, definitions are given only once for the “Applications” section of the
worksheet.

* T-server name(s)—Enter the name of the T-Server.

» Stat Server name(s)—Enter the name of the Stat Server.
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* DB Server name(s)—Enter the name of the DB Server.

*  OCS name—Enter the name of the Outbound Contact Server.

* CPD Server name(s)—Enter the name of the CPD Server.

* Genesys Administrator name—Enter the name of Genesys Administrator.

* Reporting—See the Reporting documentation.

Tenants

* Tenant name(s)—If this is a multi-tenant environment, select the name of
the tenant.

Server Info

* Host—Select the host computer on which your application will be running.

* Communication port—Enter the port number that the application’s clients
will use to establish connections to the named server.

* Back up Server—Select the back up server to be contacted if connection to
the primary server fails.

Options
¢ Option names—Options are changed according to the user’s needs. For

detailed information about options, see Chapter 9, “Outbound Contact
Configuration Options,” on page 201.

Database Access Point(s)

* Name—Enter the name of the Database Access Point (DAP) object.

Server Info

* DB Server name—Select the name of an existing DB Server.

* DB Server host—Select the host computer on which the DB Server will be
running.

Tenants

* Tenant name(s)—If this is a multi-tenant environment, select the name of
the tenant.
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DB Info

* DBMS name—Select the name of the host computer on which the database
resides.

* DBMS type—Select the type of database.
* Database name—Enter the name of the database.

* User name for login to DB—Enter the user name for accessing the
database.

* Password for login to DB—Enter the password for access the database.

User-Defined Fields

Formats

110

A calling list must contain Genesys mandatory fields, and it can also contain
user-defined fields. For more information about mandatory fields, see “Field
Object” on page 165 and “Format Object” on page 170.

The user must create additional fields, containing business information that is
used for sorting and chaining records—for example, Last_Name.

* Name—Enter the name of the user-defined field—for example, cust_id.

* Data type—Enter the type of data, for example, the data type for cust_id
would be int, and must always be numeric.

* Length—Enter the number of characters needed for field contents—for
example, cust_id can be limited to five numeric characters.

* Default value (optional)—Enter the value that will be assigned to the field
unless it is changed.

A format contains a collection of Genesys mandatory fields and user-defined
fields. It defines the layout of a calling list. More than one format can be
created and named for the specific needs of particular calling lists.

Identify the number of formats that you need, assign names to them, and
identify the user-defined fields required for each.

Note: Plan and create your formats and all custom fields carefully. You
cannot modify existing fields or add new fields after the calling list
table is created in Genesys Administrator.

¢ Name—Enter the name of format.

e User-defined field names—Enter the names of the user-defined fields to
each format.
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Table Access

¢ Name—Select the name of the Table Access object.
* Table type—Select “Calling List.”

* DB access point name—Select the name of the database access point
through which the table can be accessed.

* Format name—Enter the name of the format applied to this table.

* Database table name—Enter the name as specified in the database.

Dialing Filters

Treatments

Deployment Guide

Dialing filters select records from a calling list for dialing, based on specified
criteria. They can be created in Configuration Manager or in Genesys
Administrator and stored in the Filters view in Genesys Administrator )
Provisioning tab > Outbound Contact.

For more information, see “Filter Object” on page 179.
* Name—Enter the name of the dialing filter.

* Criteria SQL statement—Enter the SQL statements that give the criteria
for the filter.

*  Order by SQL statement—Enter the field on which the list will be sorted.

Decide on treatments to use for unsuccessful call results. For more details and
examples, see Chapter 12 on page 335.

* Name—Enter the name of the treatment.
* Call result—Enter the result of dialing a calling list record.

*  Apply to record—Enter the action to be applied to a calling list record,
based on the call result.

*  Apply to call (very limited use)—Enter the final outcome of attempts to
dial a record.

* Destination DN (if “Apply to call”)—Enter the DN to which a treatment
will forward a call.

* Number in sequence—In a treatment sequence, each treatment contains a
unique number that determines the order in which it will be applied to the
same call result, on calls from the same calling list.

* Cycle attempt (only for redial}—Enter the maximum number of
consecutive times that the treatment will be performed on the record.

* Interval—Enter the time interval, in minutes, that the application will wait
between the first dialing attempt and the first treatment attempt, or between
consecutive attempts.
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Calling Lists

Campaigns

* Increment—Enter the number of minutes that the application will add to
the interval (see the previous item) after the first treatment attempt, and
after each consecutive attempt.

* Date/Time—Enter the date/time when another treatment attempt will be
performed.

Calling lists contain dialing records. Decide where you will store the calling
lists. They can be located either in the Genesys Configuration Database or in a
separate database. The size of the calling lists and the ease of maintenance are
the deciding factors when identifying the appropriate location. Very large
calling lists should be maintained in a database other than the Genesys
Configuration Database.

* Name—Enter the name of the new calling list.

* Table Access Point name—Enter the name of the Table Access object to
which the calling list refers.

* Dialing filter name (optional)—Enter the name of default dialing filter to
apply to the calling list.

* Script property—The Script property in the campaign, in the calling list,
and in the Campaign Group defines the Script object, which contains all of
the attributes that are required by Agent Scripting.

Treatments

e  Treatment names (optional)—Identify or create treatments that will be
applied to the records on the calling list if calls are unsuccessful.

Campaigns are collections of callings lists and agent or place groups. Agent
skills that might be considered during the processing of customer interactions
include language or marketing knowledge.

* Name—Enter the name of the campaign.

* Calling list name(s)—Enter the names of the calling lists to be used by
each campaign.

* List weight (if more than one list)—Enter the percentage of call records to
be retrieved from a calling list for a campaign. For more information, see
Framework 8.0 Genesys Administrator Help.

Campaign Group
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*  Group name(s)—Enter the names of the agent or place groups assigned to
each campaign.
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Group type—Enter the type (agent or place) of each group assigned to each
campaign.

Dialing mode—Decide on a dialing mode to use as the default for the
agent groups in a campaign. The dialing modes are Progressive,
Predictive, Preview, Push Preview, and Power GVP.

Voice Transfer Destination (“Origination DN” in previous releases)
Enter the queue or Routing Point to which a call is transferred after a “live”
answer.

Optimization method—Sets the default dialing optimization method for the
Campaign Group and applies only to Predictive dialing mode.

Target value—Enter the percentage value of the optimization method.

Buffer size coefficient minimum—Enter the minimum number of chains
per active agent that OCS can keep on hand for dialing.

Buffer size coefficient optimal-—Enter the optimal number of chains per
active agent that OCS can keep on hand for dialing.

Number of CPD ports—Enter the number of dialing ports that can be used
for dialing on behalf of a Campaign Group. If you are using ASM mode, at
least one port is required for each agent for the engaging calls, in addition
to ports for outbound dialing.

CPD Server name (if more than one)—Enter the name of the CPD Server
to use for this Campaign Group.

Script property—The Script property in the campaign, calling list, and
Campaign Group defines the Script object, which contains all of the
attributes that are required by Agent Scripting.

Note: For an Outbound-IP environment, configure Trunk Group DNs on the

Configuration tab/Advanced section. For more information, see
Chapter 3 on page 87.

Reporting (Optional)

Deployment Guide

Real-time reporting—If you install real-time reporting (CCPulse+), see
also the Reporting 7.5 Deployment Guide and the Reporting 7.5 CCPulse+
Administrator s Guide.

Note: You can also use CCPulse+ to view historical reports.

CCPulse+ name—Enter the name of the CCPulse+ to be used.

Stat Server name—Enter the name of the Stat Server to be used with
CCPulse+.
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Outbound Deployment Planning Worksheet

» Historical reporting—If you install historical reporting (ICON and/or
CCPulse+t), see the Reporting 7.5 Deployment Guide and/or the Interaction
Concentrator 7.5 Deployment Guide (or later versions).

Outbound Deployment Planning Worksheet

This planning worksheet provides a single place in which to record the

information that is required to configure and install Outbound Contact 8.0. The
cells on the worksheet provide room to write additional values. After it is
completed, the planning worksheet expedites the installation and configuration
process. It serves as a “look-up” sheet for critical information that you will
need in order to complete the process. The information about the items in the
“Sample Planning Worksheet” is important to have on hand.

Sample Planning Worksheet

Table 6 is a sample planning worksheet in which to record information that you

need to have on hand during the configuration process.

Table 6: Planning Worksheet

Name Item | ltem | ltem | ltem
Logging In to Genesys Administrator
1. User name
2. User password
3. Application
4, Host
5. Port

License Manager

6. Path to License Manager

Outbound Solution Object

7. Name
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Table 6: Planning Worksheet (Continued)

Name Item | Item | ltem | ltem

Tenant

8. Names

Switches

8. Name(s)

9. Type of switch

10. Internal or External CPD capability

11. T-Server connected to each switch
(one-to-one relationship)

12. Special DNs—for example,
Communication DN and Overflow DN

DNs

13. ACD positions

14. Extensions

15. Call processing Ports (CPP)

16. ACD Queues

17. Routing Points

18. Virtual Queues

19. Communication DNs

20. Trunk Group DNs (for Outbound-IP
dialing modes)

Note: For more information, see
Chapter 3 on page 87.

Applications

T-Server(s)

21. T-Server name(s)
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Table 6: Planning Worksheet (Continued)

Name Item | ltem | ltem | ltem
22. Host
23. Port
24. Back-up
25. Designated switch (one-to-one
relationship)

Stat Server(s)

26. Stat Server name(s)
27. Host
28. Port

29. Back-up server

DB Server

30. DB Server name(s)

31. Host
32. Port
33. Back-up server

34, Options (see page 109.)

35. DBMS type

Outbound Contact Server (OCS)

36. OCS name

37. Host

38. Communication port

39. Back-up server

39. Name(s) of T-Server(s) to which OCS
connects

116 Outbound Contact 8.0 @



Chapter 4: Deployment Planning Outbound Deployment Planning Worksheet

Table 6: Planning Worksheet (Continued)

Name Item | Item | ltem | ltem

40. Name of Message Server to which OCS
connects (optional)

CPD Server

41. CPD Server name(s)

42. Host

43. Communication Port

44. Back-up server for CPD Server

45. Name of T-Server to which CPD Server
connects

46. Type of Dialogic board(s)

47. DTI Ports (DNs for Dialogic board).
(See “DNs” on page 115.)

Genesys Administrator

48. Genesys Administrator name
(application)

49. Name of OCS to which Genesys
Administrator connects

Objects

Database Access Point(s)

50. Name

51. DB Server name (See page 116.)

52. DB Server host (See page 116.)

53. DB Server communication port (See
page 116.)

54. DBMS name

55. DBMS type (See page 116.)
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Outbound Deployment Planning Worksheet

Table 6: Planning Worksheet (Continued)

Name Item | Item | ltem | Item
56. Database name
57. User name for login to DB
58. Password for login to DB
59. Case Conversion
User-Defined Fields
60. Name
61. Data type
62. Length
63. Default value (optional)
Formats
64. Name
65. User-defined field names (See above.)
Table Access
66. Name
67. Table type
68. DB Access Point name (See page 117.)
69. Format name (See page 118.)
70. Database table name
Dialing Filters
71. Name(s)
72. Criteria SQL statement
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Table 6: Planning Worksheet (Continued)

Name Item | Item | ltem | ltem

73. Order by SQL statement

Treatments

74. Name

75. Call result

76. Apply to record

77. Apply to call

78. Destination DN (if “Apply to call”)

79. Number in sequence

80. Cycle attempt (only for redial)

81. Interval

82. Increment

83. Date/Time

84. Range

Calling Lists

85. Name

86. Table Access Point name

87. Dialing filter name (optional)

88. Script property (optional)

89. Treatment names (optional) (See
“Treatments” on page 111.)

Campaigns

90. Name

91. Calling list name(s)
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Outbound Deployment Planning Worksheet

Table 6: Planning Worksheet (Continued)

Name Item | Item | ltem | Item

92. List weight (if more than one list)

Campaign Group

93. Session name(s)

94, Session type

95. Dialing mode

96. Voice Transfer Destination
(“Origination DN” in previous releases)

97. Optimization method

98. Target value

99. Buffer size coefficient minimum

100. | Buffer size coefficient optimal

101. | Number of CPD ports

102. | CPD Server name (if more than one)
(optional)

103. | Script property (optional)

104. | Stat Server name

105. | OBN Manager name (optional
component)

106. | Interaction Server (optional component)

107 | Trunk DNs (for Outbound-IP dialing
modes)
Note: For more information, see
Chapter 3 on page 87.
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Table 6: Planning Worksheet (Continued)

Name Item | Item | ltem | ltem

Reporting (Optional)

108. | Real-time reporting; if yes, see
Reporting documentation.

109. | Historical reporting; if yes, see
Reporting documentation.

Other Resources

You may want to use the following additional resources for reference.

*  Framework 8.0 Genesys Administrator Help—This Help system contains
details about setting up application and component objects, and performing
other important configuration tasks.

*  Framework 8.0—You can obtain information for the Outbound
Deployment Planning Worksheet from Framework 8.0. For example,
Tenants and Switch objects usually are created in the Framework 8.0
Wizard, but sometimes they are created in Genesys Administrator.
Outbound Contact uses some Framework 8.0 AppLication objects that are
created in the Framework 8.0 Wizard or Genesys Administrator—for
example, the Stat Server and DB Server. For some objects, you only need
to identify their names in Framework 8.0 and write those names on the
worksheet.

*  Outbound Contact 8.0 Reference Manual—This document explains the
constants and communication protocols for Outbound Contact.

*  Wizard Advisories for Outbound Contact, Framework, and Reporting, also
contain useful information, and are located on each specific solution CD.
All other documents are provided on the documentation library software
CD that is specific to Outbound Contact as well as to other Genesys
software products.

Note: Refer to the appropriate GVP and Interaction Server documentation if
you are implementing Power GVP or Push Preview dialing modes.
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Outbound Solution Wizard

This chapter explains how to use the Outbound Solution Wizard, also known
as the Outbound Contact Configuration Wizard.

Note: Genesys recommends that you use Genesys Administrator instead of
the Outbound Contact Configuration Wizard for configuring your
enterprise, because much of the wizard functionality is integrated into
Genesys Administrator.

This Wizard was not updated for release 8.0. The Outbound Contact
Configuration Wizard 7.5 is included in the Outbound Contact 8.0
package.

This Wizard creates a standard configuration of the Outbound Contact
components (Outbound Contact Server, Outbound Contact Manager, and Call
Progress Detection Server). The wizard creates all mandatory options with
their default values. You can easily redefine these default values based on the
specific needs of your contact center.

The Wizard also provides a method for setting up the Dialogic board channels
(ports) for CPD Server.

Note: Use this Wizard for standard configurations only, instead of for
complex configurations (for example, in an environment that has two
Dialogic boards for the same CPD Server or when configuring two or
more DNs on a switch that has the same dtiB number).

This chapter contains the following topics:

«  Before You Begin, page 124
«  Creating an Outbound Solution, page 124
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Before You Begin

First, complete the Framework installation and configuration. Be sure to refer
to the “Worksheet Definitions” on page 107. New changes for the Outbound
Configuration Wizard include:

Introduces new component definitions in the Solution object for the GVP
0BN Manager and Interaction Server applications.

Supports the Campaign Group object. The CampaignGroupInfo object is no
longer supported.

Dynamically adds new components in the Solution object.
Supports the HMP configuration in the CPD Server Wizard.

Note: Only one instance of CPD Server using HMP software can be
executed on a host machine.

Creating an Outbound Solution

As mentioned, the Outbound Solution Wizard enables you to create an
Outbound solution. The wizard is accessible through the Genesys Wizard

Manager.

Procedure:

Using the Outbound Solution Wizard to create a

solution

Start of procedure

1. Insert the Genesys 8.0 Outbound CD.

2. In the root directory, double-click setup.exe to install the Outbound
Contact Configuration Wizard.

3. Open the Genesys Wizard Manager.

4. On the left pane of the Genesys Wizard window, select Outbound Contact.
The Genesys Wizard Manager displays existing solutions, if any, and a
prompt to deploy a new Outbound Contact Solution.

5. Create an Outbound Contact Solution or reconfigure an existing one:

124
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* To create a new Outbound Contact Solution, click Outbound Contact
on the right pane of the Genesys Wizard Manager page.

The Outbound Solution Wizard launches and leads you through the
process of creating a new Outbound Contact Solution. Skip the
remaining steps below.

*  To reconfigure an existing Outbound Contact Solution object, click the
object name on the right pane of the Genesys Wizard Manager page.

The Properties dialog box opens for the Outbound Contact Solution
object. Proceed to Step 6.

Note: Complete Steps 6 through 10 only if you are reconfiguring an
existing Outbound Contact Solution object.

6. Click the Components tab and select a specific component.
7. Click Properties.
8. Click More.

The Properties dialog box opens for the component that you selected in
Step 7.

9. Change the configurations, as needed.

For full explanations of the options in this dialog box, see Chapter 9,
“Outbound Contact Configuration Options,” on page 201. Also refer to the
information in your “Sample Planning Worksheet” on page 114.

10. Click Apply.

End of procedure

Recommended Configuration for CPD Server

The Wizard will not allow you to create an incomplete configuration. If you
abort the configuration, the Wizard removes the incomplete configuration.

Resources Configuration Activity

The Wizard implements a list of supported board types for selection. As more
than one board may be installed, the Wizard allows selection of a few boards
for configuration, instead of one-by-one configuration.

When configuring a virtual board, the Wizard assigns a DN to every channel of
the board. The Wizard assigns the DNs in sequence, one by one.

Figure 13 illustrates the recommended configuration process for the CPD
Server Application object.
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Figure 13: Recommended Configuration for CPD Server Application Object
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Notes: * Do not mix different board technologies.

* Do not use different protocols (such as ISDN and Melcas) in one
box.

* The CPD Server Installation Wizard will not recognize that the
Dialogic drivers had been already installed if its version is different
from the version of the drivers that are packaged on the Genesys
CPD Server CD.

* The CPD Server Installation Wizard will not create the Dialogic
DN configuration if you do not create a CPD Server application.

» CPD Server supports only the Dialogic drivers (for Service Release
6) that are provided on the CPD Server CD.

Procedure:
Deleting a previously configured Dialogic board

If you are creating a new configuration, you must first delete the previously
configured Dialogic boards.

Start of procedure

To delete a previously configured board:

1. When the Wizard displays a list of configured boards, select the boards
you want to delete.

2. Ifaboard is associated with a CPD Server application, then the Wizard
will warn you and ask for a confirmation.

If the Wizard receives a confirmation, it clears the value of the location option
in all applications that match the board name.

End of procedure

CPD Server Application Sections and Options

For information about the sections referenced in Figure 13, and their
corresponding options, see “CPD Server Options” on page 270.
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Manually Configuring and
Installing Outbound
Applications

This chapter describes how to configure and install Outbound Contact 8.0
manually. It contains the following sections:

«  Overview, page 129

- Configuration, page 131

« Installing on Windows, page 145
« Installing on UNIX, page 151

Overview

This chapter provides instructions for a manual, first-time configuration and
installation of the Outbound Contact components, which include Outbound
Contact Server (OCS), CPD (Call Progress Detection) Server, CPD Proxy
Server, and Outbound solution objects. This chapter also describes an
Outbound-specific aspect of Stat Server.

Note: This chapter includes instructions for installing Outbound Contact
Manager (OCM), even though Genesys Administrator replaces OCM
in release 8.0. OCM 7.6 can be used with Outbound Contact 8.0. For
installation instructions for Genesys Administrator, see the
Framework 8.0 Genesys Administrator Deployment Guide.
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Use the completed “Worksheet Definitions” on page 107 in this guide, as well
as the other relevant chapters in this guide, to configure and install Outbound
Contact applications (components) and objects.

Note: Genesys does not recommend installing its components via a
Microsoft Remote Desktop connection. You should perform the

installation locally.

The overall process of configuring and installing Outbound Contact
components involves the following steps:

Task Summary: Configuring and Installing Outbound Contact

Components

Objective

Related Procedures and Actions

1. Configure application
objects.

1. Configure and install all Framework 8.0
components, which include Configuration
Server, T-Server, the Management Layer,
DB Server, and Stat Server.

Configure and install Genesys Administrator.
Start Configuration Server.
Start Genesys Administrator.

Configure OCS as described on page 133.

A

Configure CPD Server as described on page
137.

7. Configure Genesys Administrator 8.0. See the
Framework 8.0 Genesys Administrator
Deployment Guide.

Note: If you are using OCM 7.6, configuration
instructions are described on page 136.

2. Install Outbound
Contact components.

1. Install OCS as described for Windows (page
146) or for UNIX (see page 152).

2. Install CPD Server as described on page 147.

3. Install Genesys Administrator 8.0. See the
Framework 8.0 Genesys Administrator
Deployment Guide.

Note: If you are using OCM 7.6, installation
instructions are described on page 149.

3. Configure and install
real-time and historical
reporting.

Refer to page 151.
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Configuration
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Note: All of the information in this section is based on using Genesys

Administrator to configure and install your Outbound applications.
However, you can still use Configuration Manager.

Before you create an Application object, make sure that an application
template exists. The template provides most of the application’s configuration
options and default values.

To locate an existing template, open the Environment view in Genesys
Administrator and then the Application Templates view. If the template is
absent, import one from the Temp Lates folder on the Outbound Contact Center
CD.

Procedure:
Importing a template

Start of procedure
1. Select the Application Templates view.
2. Open the Tasks panel, if necessary, and click Import Application
Temp late.
3. In the file-selector dialog box, do the following:
a. Ifnecessary, navigate to where the template is stored.
b. Select the appropriate .apd file.
c. Click open.
4. On the Configuration tab, enter or modify information as required.
5. On the Options tab, enter or modify information as required.
6. Ifthe Templates folder also contains a metadata file, import that metadata
into the Application Template.
7. To save the new Application Template and register it in the Configuration

Database, perform one of the following:
a. Click Save and Close to return to the list of Application Templates.
b. Click Save to continue configuring the Application Template.

c. Click Save and New to save the new Application Template and start
creating another one.

End of procedure
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Configuration Advisory

Application objects represent software components in Genesys Administrator.
This chapter describes four Outbound Contact application objects:

*  Outbound Contact Server (OCS)
* CPD Server (optional)
* CPD Proxy Server (optional)

¢ Outbound Contact Manager (optional if you are using Genesys
Administrator)

Outbound Contact also requires the following applications:

* Genesys Administrator—Allow you to configure all Outbound Contact
applications and objects, run dialing sessions, and monitor all related
activities

* Stat Server (Reporting)—Determines what agents are assigned to which
Agent or Place Groups, identifies the current Agent State, and for reporting
purposes.

¢ CCPulse+ (Reporting)—Calculates real-time and historical
Outbound-specific statistics

¢ ICON (Reporting)—Calculates historical Outbound statistics

The person who will run or change an Outbound dialing session/campaign
requires access permissions that include Read access privileges to all
campaign-related configuration objects. Click the Permissions tab of each
configuration object to view the Access Groups that have permission to read it.

Client-Side Port Security Configuration

To increase security, you can define a fixed port for the connection between an
Outbound Contact component and another server that is behind a firewall. The
client-side port definition feature allows a server application to control the
number of client connections, preventing the server from an excessive number
of malicious requests to the same server-side port.

For configuration instructions, see the “Client-Side Port Definition” chapter of
the Genesys 8.0 Security Deployment Guide.

Table 7 identifies which Outbound Contact-specific components support this
configuration.
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Table 7: Component Support of Client-Side Port Security

Server Clients Configuration T-Server
Server/Configuration
Server Proxy

OCS Yes Yes
CPD Server Yes Yes
CPD Proxy Server | Yes Not Applicable

Connections to Configuration Server

During the application installation, new command-line arguments are added to
connect to Configuration Server using the port designated during installation,
which are then used during application startup. The arguments include:

-transport-address and -transport-port.

The command-line format for starting a connection to Configuration Server
would be:

cm_server.exe -host <host_name) -port <{port_number)
-transport-address <IP address) -transport-port <{port number) -app
<application_name)

After installation, these arguments appear in three places:

* Configuration Server Application object > Configuration tab > Server
Info section.

* (Windows operating system) startServer.bat file; (UNIX operating
systems) run.sh

* In the Registry when the application (OCS, CPD Server, or CPD Proxy
Server) is started as a Service

Note: To support reconnection to Configuration Server, you must still create
or update the existing connection to Configuration Server in the OCS
Configurations tab of the OCS Application object, following the
standard procedure for configuring connections to other servers. For
specific instructions associated with client-side port connections, see
the Genesys 8.0 Security Deployment Guide.

Outbound Contact Server

Outbound Contact Server (OCS) is the main component of Outbound Contact.
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Procedure:
Configuring OCS

Start of procedure

1. In Genesys Administrator, open the Environment view and then select the
Applications view.

2. From the toolbar, click New.

3. Inthe Browse dialog box, select the Application Template for this

application (navigating to the appropriate folder if necessary), and click
OK.

Note: If an Application Template for OCS is not available, click Cancel
and import or create a template. Then restart this procedure to
create the new template.

4. On the Configuration tab, enter the following information for the OCS

application:
¢ Name: Enter the name of the OCS application

* Connections: Click Add, and then add a T-Server application.
Optionally, you can also add a Message Server application.

The only servers for which OCS searches in the Connections section of
its application at startup are T-Server and Message Server (optional).
Connection to other servers that are required to run an outbound
dialing session (such as CPD Server, Stat Server, and Interaction
Server) can be specified on the Configuration tab of a Campaign Group
object
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Notes: * If you are configuring OCS to support TLS, see the Genesys
8.0 Security Deployment Guide for configuration instructions;
also, see “Transport Layer Security Connections” on page 434
for information on which Outbound Contact components
support TLS connections for this 8.0 release.

+ Ifyou are configuring a connection to Interaction Server, create
a port called ESP. Use this ESP PortID instead of the default
PortID, when you configure a connection to the OCS
Application object of the Interaction Server Application
object. This makes OCS a server for Interaction Server and
Interaction Server a client for OCS.

* Ifyou are configuring TLS between OCS and DB Server, add a
Database Access Point (DAP) to DB Server on the
Configuration tab/Connections section of the OCS Application
object.

* If you are configuring TLS between OCS and CPD
Server/CPD Proxy Server, add a connection on the
Configuration tab/Connections section of the OCS Application
object to CPD Server/CPD Proxy Server respectively.

5. Inthe Server Info section of the Configuration tab, do the following:

a. Enter the host name of the computer on which this application will be
installed, and enter the port that the application will use for client
connections.

b. Ifyou plan to use another server as a backup, in the event that the
primary server fails, enter the name of the backup server and adjust the
value of the Reconnect Timeout option.

¢. Ifyouneed OCS to support communication with clients when using
HTTP requests (for example, to update records over HTTP), configure
the interface by specifying a separate listener port for HTTP Proxy
Server with the Connection Protocol set to http. For more information
about HTTP requests and HTTP Server, see “Outbound Contact and
HTTP Server” on page 77 and the Proactive Contact 8.0 Solution
Guide.

Note: Dynamic changes to this port are not supported. As a result, any
such changes are not communicated to an HTPP Proxy that is
already running. However, any HTTP Proxy started after that
change will reflect the change.
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d. Define the Working Directory and Command-Line properties - for
example:

Working Directory: C:\GCTI\Outbound Contact Server

Command Line: cm_server.exe

Command Line Arguments: -host <host_name) -port <{port_number)
-app <application_name)

Note: If you are implementing the client-side port security feature,
specify the additional arguments described in “Client-Side Port
Security Configuration” on page 132.

6. Click the Options tab, and change the values of the configuration options
according to your configuration.

For detailed information about OCS options, see the “Outbound Contact
Server Options” on page 209.

End of procedure

Genesys Administrator

For configuration and installation procedures for Genesys Administrator, see
the Framework 8.0 Genesys Administrator Deployment Guide.

Outbound Contact Manager

Outbound Contact Manager (OCM) is the graphical user interface (GUI) that
contact center managers can use to control and manage outbound dialing
sessions/campaigns.

Note: If you are using Genesys Administrator, you do not have to configure
and install OCM.

Procedure:
Configuring OCM

Start of procedure

1. In Genesys Administrator, open the Environment view and then select the
Applications view.

2. From the toolbar, click New.
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CPD Server

Deployment Guide

3. Inthe Browse dialog box, select the Application Template for this
application (navigating to the appropriate folder if necessary), and click
0K.

Note: If an Application Template for OCM is not available, click Cancel
and import or create a template. Then restart this procedure to
create the new template.

4. On the Configuration tab, enter the following information for the OCM
application:

a. Name: Enter the name of the OCM application

b. Connections: Click Add, and then add a 0CS application to which this
application will connect.

5. Click the Options tab, and then define the OCM options in a section folder
called 0CManager.

For detailed information about the options for OCM, including the new
inactivity-timeout option, see “Outbound Contact Manager Options” on
page 202.

For more information on any of the security features, including some
configuration information, see the Genesys 8.0 Security Deployment Guide.

Note: If you are using the Active Switching Matrix (ASM) mode, see
page 205 for more information about how to enable it.

End of procedure

Outbound Contact 8.0 requires hardware that recognizes call results, a
capability known as call progress detection (CPD). Outbound Contact works
with a CPD device provided by the switch vendor, or with CPD hardware from
Dialogic.

If the switch does not have call progress detection capability, you must install
switch-extending equipment (a Dialogic board) to perform this function. Install
the GlobalCall Dialogic package before installing the CPD Server.

Notes: * Beginning with release 7.5, you can also install the Dialogic Host
Media processing (HMP) software.

* Only one instance of CPD Server using HMP software can be
executed on a host computer.
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Before you configure CPD Server, have on hand the “Worksheet Definitions”
on page 107. Refer also to “CPD Proxy Server” on page 139 and “Dialogic
Board Setup” on page 388.

Procedure:
Configuring CPD Server

Start of procedure

1.

In Genesys Administrator, open the Environment view and then select the
Applications view.

From the toolbar, click New.

In the Browse dialog box, select the Application Template for this
application (navigating to the appropriate folder if necessary), and click
0K.

Note: If an Application Template for OCS is not available, click Cancel
and import or create a template. Then restart this procedure to
create the new template.

On the Configuration tab, enter the following information for the CPD
Server application:

a. Name: Enter the name of the CPD Server application.

b. Connections: Click Add, and then add a T-Server application and a
Message Server application to which this server will connect.

In the Server Info section of the Configuration tab, perform the following,

a. Enter the host name of the computer on which this application will be
installed, and enter the port that the application will use for client
connections.

If you plan to use another server as a backup in the event that the
primary server fails, and if a Dialogic board is installed, enter the name
of the backup server and adjust the value of the Reconnect Timeout
option.

Note: If you are configuring CPD Server to support TLS, see the
Genesys 8.0 Security Deployment Guide for configuration
instructions. Also, see “Transport Layer Security Connections” on
page 434 for information on which Outbound Contact components
support TLS connections for this 8.0 release.
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b. Define the Working Directory and Command Line properties—for
example:

Working Directory: C:\GCTI\cpd_server

Command Line: cpdserver.exe

Command Line Arguments:

-host <host_name) -port <port_number) -app <application_name>

Note: If you are implementing the client-side port security feature,
specify the additional arguments described in “Client-Side Port
Security Configuration” on page 132.

Click the Options tab, and change the values of the configuration options
according to your configuration.

For detailed information about the options for CPD Server, “CPD Server
Options” on page 270.

End of procedure

CPD Proxy Server

Deployment Guide

CPD Proxy Server is the core load-distribution component of CPD Server. The
main task of this optional component is to distribute client requests among
various CPD Servers, in order to balance the call load and optimize the use of
hardware resources within the system.

You must configure CPD Proxy Server before you install it.

Procedure:
Configuring CPD Proxy Server

Start of procedure

1. In Genesys Administrator, open the Environment view and then select the
Applications view.

2. From the toolbar, click New.

3. Inthe Browse dialog box, select the Application Template for this

application (navigating to the appropriate folder if necessary), and click
OK.

Note: If an Application Template for OCS is not available, click Cancel
and import or create a template. Then restart this procedure to
create the new template.
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4. Onthe Configuration tab, enter the following information for the CPD
Proxy Server application:

a. Name: The name of the CPD Proxy Server application.

b. Connections: Click Add, and then add the CPD Server(s) and the
Message Server to which CPD Proxy Server will connect.

5. Inthe Server Info section of the Configuration tab, perform the following,

a. Enter the host name of the computer on which this application will be
installed, and enter the port that the application will use for client
connections.

If you plan to use another server as backup, in the event that the
primary server fails, enter the name of the backup server and adjust the
value of the Reconnect Timeout option. See “Connection and
Reconnection” on page 424 for more information.

Note: If you are configuring CPD Proxy Server for TLS, see the
Genesys 8.0 Security Deployment Guide for configuration
instructions. Also, see “Transport Layer Security Connections” on
page 434 for information on which Outbound Contact components
support TLS connections for this 8.0 release.

b. Define the Working Directory and Command Line properties—for
example:

Working Directory: C:\GCTI\cpd_proxy

Command Line: cpdproxy.exe

Command Line Arguments:

-port <port_number) -host <host_name) -app <application_name

Note: If you are implementing the client-side port security feature,
specify the additional arguments described in “Client-Side Port
Security Configuration” on page 132.

6. Click the Options tab, and change the values of the configuration options
according to your configuration.

For detailed information about these options, see Chapter 10 on page 315.

Note: If you have a multi-tenant environment and want to share HMP
resources, you can also configure options to restrict dialing and
engaging channels. For more information, see “Centralized
Configuration and Shared HMP Resources” on page 73.

End of procedure
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DM3 Boards with CPA Functionality

If you are using ASM mode, and if you are using the DM3 families of boards
with CPA functionality that CPD Server supports, you must install the
GlobalCall Dialogic package before you install CPD Server. These families
include the following:

« DM/VI1200-4E1 (number of ports = 120)
« DM/V600-2E1 (number of ports = 60)
*  DM/V960-4T1 (number of ports = 96)
*  DM/V480-2T1 (number of ports = 48)

Outbound-Specific Statistics for Stat Server

Deployment Guide

In addition to determining which agents are assigned to which Agent or Place
Groups and identifying the current Agent State, Stat Server requires Outbound
statistic definitions in order to monitor the Outbound activities of Campaigns,
Calling Lists, Dialing Sessions, ACD Queues, and agents.

Procedure:
Importing Outbound-Specific Statistics into the Stat
Server Object

Start of procedure

1. In Genesys Administrator, open the Environment view and then open the
Applications view.

2. On the Details panel, double-click the Stat Server object.
3. Click the Options tab.

4. Locate and import StatProfile.cfg from the
\solution_specific\ocs\templates\realtime folder on the Reporting
Templates 7.2 CD. For more information on Outbound-specific statistics,
see “New Real-Time Statistics” and the Reporting Technical Reference
Guide for the Genesys 7.2 Release.

Note: Stat Server is usually configured using the Framework 8.0
Configuration Wizard or in Configuration Manager. In release 8.0,
you can also configure it in Genesys Administrator and using the
Outbound Contact Wizard.

End of procedure

141



Chapter 6: Manually Configuring and Installing Outbound Applications Configuration

As of Release
7.6.1

As of Release 7.5
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New Real-Time Statistics

This section provides information on Outbound-specific real-time statistics
that are not documented in the Reporting Technical Reference Guide for
Genesys 7.2 Release.

Note: These statistics require Stat Server version 7.6.1 or higher with OCC
Extension 7.6.1 or higher.

CurrentTrustFactor

Category: JavaCategory
JavaSubCategory: 0CCStatExtension.jar:CurrentTrustFactor
Objects: Agent, Place

This metric, with values ranging from 0% to 1007%, defines the trust factor for a
specific agent. For more information about how this factor is calculated and
when it is used, see the time-to-ready-tolerance option (see page 254).

This statistic is calculated based on the following formula:

Aindiv = (1 - trust factor) * 100 = Negrrect notifications’ Mtotal notifications *
100%

CurrentFeedbackAccuracy

Category: JavaCategory
JavaSubCategory: 0CCStatExtension.jar:CurrentFeedbackAccuracy
Objects: CampaignGroup

This metric, with values ranging from 0% to 100%, defines the current accuracy
of the agent’s ready time feedback for a session.

This statistic is calculated based on the following formula:
Agegs = (1 - Total Number of False Notifications/ Total Number of
Notifications) * 100%

CurrentAgentAssignment

Category: JavaCategory
JavaSubCategory: OCCStatExtension.jar:CurrentAgentAssignment
Objects: Agent, Place

The metric value identifies the current agent assignment to the outbound
Campaign Group. Possible values include:

* Inbound—Agent is only assigned to inbound calls and is not assigned to
any outbound Campaign Group.
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* <CampaignGroup name>—The configuration object name for the Campaign
Group.

Note: In an environment that uses Universal Routing Server (URS) to
distribute outbound calls to a Campaign Group as a target and where
OCS does not have a backup server, the CurrentAgentAssignment
statistic will not be modified after OCS exits. Therefore, URS may not
be able to route inbound calls to some ready agents because these
agents will remain assigned to the outbound activity. When OCS starts
up again, URS will receive current agent assignment information
again.

CurrentNumberAgentsAssigned

Category: JavaCategory
JavaSubCategory: OCCStatExtension.jar:CurrentNumberAgentsAssigned
Objects: CampaignGroup

This metric value is the number of agents assigned to a particular Campaign
Group.

CurrentCampaignGroupDBID

Category: JavaCategory

JavaSubCategory: OCCStatExtension.jar:CurrentCampaignGroupDBID

Objects: Agent, Place

This metric value identifies the current agent assignment to an outbound

Campaign Group.

Possible values for this statistic include:

* 0—This value means that the agent is not assigned to any outbound
Campaign Group.

* <CampaignGroup DBID>—This value is the DBID of Campaign Group
configuration object.

The Outbound Solution Object

You can start Outbound Contact through Solution Control Interface (SCI), a
Framework application. SCI uses the Outbound Solution object to start and
stop the Outbound Contact components.

Note: You can also start Outbound Contact through Genesys Administrator.
For more information, see Framework 8.0 Genesys Administrator
Help.
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In Genesys Administrator > Provisioning tab > Environment, select the
Solutions folder, and determine if the Outbound Solution object is in the list. If
it is not, you must import it from the product CD and then configure it.

Procedure:
Importing and Configuring the Outbound Solution
Object

Start of procedure

1. In Genesys Administrator, select Provisioning > Environment >
Solutions.

2. From the Tasks panel, select Create > Upload solution.

3. IntheClick Add and choose. .. dialog box, click Add and navigate to the
Template folder on the product CD.

4. Select the 0CSolution_80.sd file, click Open and then Up load.
5. Double-click the solution to open the Outbound Solution object.
6. On the Configuration tab:

* In the Name field, enter a name.

e Inthe Assigned Tenant field, select a tenant.
e Inthe Solution Control Server field, select a server.

7. Click the Components section and then add the applications that Outbound
Contact needs in order to run (see Table 8).

8. Click Save and Close.

End of procedure

Table 8 shows the applications that you could add to the Components section for
the Outbound Solution Object. The table heading definitions are as follows:

* Application—The name of the application that Outbound Contact needs in
order to run.

*  Optional—The requirement status for the application: False means that the
application is mandatory in order for Outbound Contact to be able to run;
True means that the application is optional, and that it is not mandatory for
Outbound Contact to be able to run.

* Priority—The order in which the application starts, relative to the other
applications.
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Table 8: Outbound Solution Object - Components Tab

Application Optional Priority
T-Server False 1
Interaction Server True 2
DB Server False 2
Stat Server False 2
Data Sourcer True 2
ETL Proxy True 2
Outbound Contact Server False 3
Message Server True 4
CPD Server True 4
Outbound Contact Manager or True 5
Genesys Administrator

Installing on Windows

The Genesys 8.0 Outbound CD contains the installation packages for the OCS

and OCM applications. The CPD Server installation package is located on the
Genesys 8.0 Outbound CPD Server CD.

The setup files for these components are located in the following folders:

* OCM: \\solution_specific\outbound_contact_mgr\windows

Note: The OCM release 7.6.x is packaged with Outbound Contact 8.0.

*  OCS:\\solution_specific\outbound_contact_server\windows
e CPD Server: \\solution_specific\cpd_server\windows

If you downloaded Outbound Contact from an FTP site, the installation
package is contained in a ZIP file and you must extract it using the WinZip
utility. After you extract the files, the setup files for the applications will be in
the Windows folder.
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Procedure:
Installing OCS on Microsoft Windows 2003 or 2008

Note: The OCS Application object must already be configured before you

begin the installation.

Start of procedure

1.

From the product CD, open the following folder:

solution_specific\outbound_contact_server\windows and run setup.exe

Note: If you are installing a new version of the same release, you will
need to select Install new instance of the application as the
Setup Type.

If you are setting up client-side port configuration for the initial connection
to Configuration Server, select the Use Client Side Port check box and
then specify the following parameters:

* Port—Enter the port number for the client, as preconfigured on your
firewall. (This is not the Listening port of the OCS application.)

* IP Address—Enter the I[P Address of the computer on which you are
installing and running the OCS application.

Note: After selecting this option, the installation process will add the
necessary command line arguments (-transport-address and
-transport-port) for connecting to Configuration Server at the
application startup.

Enter the host name, port, username and password of the Configuration
Server.

Select the ApplLication object that you created in Genesys Administrator.
Select the license options:

* License Manager—Enter the port and name for the license server.
* License File—Use the Browse button to locate the license file.

To select the destination directory, either click Next to accept the default
(displayed) or click Browse to locate another directory.

Click Install to start the installation.

On Windows operating systems, all servers are installed as services.
Therefore, during installation, you will not be asked whether you want to
install OCS as a Windows service. See “Using Windows Services” on
page 151, for more information.
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8. Click Finish to complete the installation.

End of procedure

Procedure:
Installing CPD Server on Microsoft Windows 2003 or
2008

CPD Server is an optional application.

Notes: It is not advisable to mix board technologies.

* Do not use different protocols (such as ISDN and Melcas) in one
box.

* The CPD Server Installation Wizard may not recognize that the
Dialogic drivers had been already installed if its version is different
from the version of the drivers that are packaged on the Genesys
CPD Server CD.

* CPD Server supports only the Dialogic drivers (for Service Release
6) that are provided on the CPD Server CD.

Start of procedure
1. From the product CD, open the following folder:
solution_specific\cpd_server\windows and run setup.exe

2. AstheMaintenance Setup Type, select either Install new instance of the
application or Maintenance of the existing installation.

3. Select Call Progress Detection Server asthe component to install.

4. Ifyou are setting up client-side port configuration for the initial connection

to Configuration Server, select the Use Client Side Port check box and

then specify the following parameters:

* Port—Enter the port number for the client, as preconfigured on your
firewall. (This is not the Listening port of the CPD Server application.)

* IP Address—Enter the [P Address of the computer on which you are
installing and running the CPD Server application.

Note: After selecting this option, the installation process will add the
necessary command line arguments (-transport-address and
-transport-port) for connecting to Configuration Server at the
application startup.
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Enter the host name, port, username, and password of Configuration
Server.

Select the application object that you created in Genesys Administrator.
Select the license options:

* License Manager: Enter the port and name for the license server.

* License File: Use the Browse button to locate the license file.

To select the destination directory, either click Next to accept the default
(displayed) or click Browse to locate another directory.

Click Install to start the installation.

On Windows operating systems, all servers are installed as services.
Therefore, you will not be asked whether you want to install CPD Server
as a Windows service. For more information, see “Using Windows
Services” on page 151.

10. Click Finish to complete the installation.

End of procedure

Procedure:
Installing CPD Proxy Server on Microsoft Windows
2003 or 2008

CPD Proxy Server is an optional application. CPD Proxy installation does not
require Dialogic hardware to be installed on the target computer.

Start of procedure

1.
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From the product CD, open the following folder:
solution_specific\cpd_server\windows

As the Maintenance Setup Type, select either Install new instance of the
application or Maintenance of the existing installation.

Select Call Progress Detection Proxy asthe component to install.

If you are setting up client-side port configuration for the initial connection

to Configuration Server, select the Use Client Side Port check box and

then specify the following parameters:

* Port—Enter the port number for the client, as preconfigured on your
firewall. (This is not the Listening port of the CPD Proxy Server
application.)
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* IP Address—Enter the I[P Address of the computer on which you are
installing and running the CPD Proxy Server application.

Note: After selecting this option, the installation process will add the
necessary command line arguments (-transport-address and
-transport-port) for connecting to Configuration Server at the
application startup.

5. Enter the host name, port, username, and password of the Configuration
Server.

6. Select the Application object that you created in Genesys Administrator.

7. To select the destination directory, either click Next to accept the default
(displayed) or click Browse to locate another directory.

8. Click Install to start the installation.

On Windows operating systems, all servers are installed as services.
Therefore, during installation, you will not be asked whether you want to
install CPD Proxy Server as a Windows service. See “Using Windows
Services” on page 151 for more information.

9. Click Finish to complete the installation.

End of procedure

Procedure:
Installing OCM on Microsoft Windows 2003, 2008, 7,
Vista, or XP

Notes: * Genesys Administrator replaces OCM in the 8.0 release. However,
Outbound Contact Manager 7.6 is still packaged with Outbound
Contact 8.0. If you are using Genesys Administrator, refer to the
Framework 8.0 Genesys Administrator Deployment Guide.

* OCM and Configuration Manager share some
configuration-related components. As a result, if you plan to install
them on the same computer, in general you must be the same major
release number (7.x and higher). However, if you are using OCM
7.6.101, you can use Configuration Manager 8.0 on the same
computer.

Start of procedure

1. From the product CD, open the following folder:
solution_specific\outbound_contact_mgr\windows

2. Locate and double-click setup.exe to start the installation.
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3. On the WeLcome dialog box, click Next when you are prompted to continue

with the setup program.

At this point, the Install Shield performs a check for the presence of
Microsoft Data Access Components 2.8 or higher.

Note: If the Microsoft Data Access Components are not present, the
following message appears: Microsoft Data Access Components
(MDAC), version 2.8 or higher, must be installed. Do the
following:

1. Click oK. The following message appears: The installation
procedure will now terminate.

2. Click OK.

3.In a web browser, go to http://www.microsoft.com, browse to
the Downloads page, and find and install MDAC 2.8.

4. When the setup program is finished, reboot the system if
InstallShield prompts you to restart Windows.

5. Start the OCM installation procedure again from Step 1.

After you click Next, the Security Banner Configuration dialog box
appears.

On the Security Banner Configuration dialog box, choose whether you
want to configure a Security Banner for this application. Refer to the
Genesys 8.0 Security Deployment Guide for detailed information about the
security banner.

Do one of the following:

* Ifyou do not want to configure a Security Banner for this instance of
OCM, clear the Enable Security Banner check box if it is selected, and
then click Next.

* Ifyou want to configure a Security Banner for this application:
i. SelectEnable Security Banner.

ii. Follow the instructions in the procedure “Installing and
configuring the Security Banner” in the Genesys 8.0 Security
Deployment Guide. When you are finished that procedure, return
here and finish this procedure.

When the Choose Destination Location dialog box appears, to select the
destination directory, either click Next to accept the default (displayed) or
click Browse to locate another directory.

Click Install to proceed with the installation.

Click Finish to complete the installation.
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8. When the setup program is finished, reboot the system if InstallShield
prompts you to restart Windows.

End of procedure

Real-Time and Historical Reporting

The Reporting Technical Reference Guide describes the Reporting templates.
For information about importing templates, refer to the following resources:
* Reporting 7.5 CCPulse+ Help, “Using the Import/Export Utility”

* Reporting 7.2 Data Modeling Assistant Help, “Importing and Exporting
Templates”

For information about actions the user should take if the CCPulse+
Import/Export Utility is disabled, refer to the Reporting 7.5 CCPulse+
Administrator's Guide.

Using Windows Services

An application that is set up as a Windows Service starts automatically when
the computer is started and runs in the background, without a console window.

Procedure:
Stopping or Modifying the Startup Type for an
Application Running as a Windows Service

Start of procedure

1. On the Windows taskbar, click Start and then select Control Panel >
Administrative Tools > Services.

2. Double-click the application to open its Property dialog box window.

3. Under Service Status, click the appropriate button to change the
operational status of the service.

4. From the Startup type drop-down list, select the desired startup type.
5. Click Apply.

End of procedure

Installing on UNIX

The only Outbound Contact component that can be installed on a UNIX
operating system is Outbound Contact Server.
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Procedure:
Installing OCS on UNIX

Start of procedure

1.

9.

10.

11.

On the Outbound Contact 8.0 CD, locate the directory for your UNIX
vendor:

solution_specific/outbound_contact_server/<UNIX directory>
Copy the directory into a temporary directory.
In the temporary directory, locate the install.sh shell script.

Note: All files require permission to execute.

Run the script by executing the following command: sh install.sh

Type the host name of the computer on which Outbound Configuration
Server will be installed, or press Enter to accept the default.

When/if prompted, enter the host, network port, user name, and
password of Configuration Server.

When prompted, specify whether you want to use the Client Side Port

option. Then specify the following parameters:

* Port—Enter any free port number. (This is not the Listening port of the
OCS application.)

* IP Address—Enter the [P Address of the computer on which you are
installing and running the OCS application. (The installation script will
propose an IP Address for you to use.)

Note: After selecting this option, the installation process will add the
necessary command line arguments (-transport-address and
-transport-port) for connecting to Configuration Server at the
application startup.

From the list of applications configured for this host, select a specific OCS
application.

Select the destination directory into which OCS will be installed.

When prompted, enter either 32 or 64 to specify the version that will be
used.

Enter the full path to the license file.

After the installation process is complete, a message appears, indicating that
the installation was successful.

End of procedure
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Chapter

Silent Setup

This chapter describes the purpose and configuration of Silent Setup.

It contains the following sections:

« Introduction, page 153

«  Creating the Response File, page 153

«  Running the Silent Installation, page 154
« About the Silent Setup Log File, page 155

Introduction

InstallShield Silent allows for an automated electronic software distribution,
also known as a Silent Setup. InstallShield Silent only works on Windows
operating systems. With InstallShield Silent, you do not have to monitor the
setup or provide input via dialog boxes. Once this information is stored in a
response file, an InstallShield Silent setup runs on its own, without any
intervention by the end-user. An installation procedure for a server application
differs slightly from an installation procedure for a GUI application. Both,
however, require that you create a response file with the necessary parameters
and then use it for the actual installation. Outbound Contact Manager supports
Silent Setup installation.

Note: Genesys Administrator also supports silent installation.

Creating the Response File

To select setup options and automatically record the InstallShield Silent
response file, run your setup with the following command line:

setup -r
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Running the Silent Installation

Your responses to the dialog boxes are recorded and used to create a response
file. By default, the response file is named Setup.iss, and is stored in the
Windows directory of your computer. To specify a different directory or file
name for the response file, add /f1"[full_path to iss file\l<FileName)" to
the setup command. Include the double quotes and do not put a space between
/1 and the path—for example:

setup -r /f1"C:\GCTI\silent_response_files\mySetup.iss"

Note: In the optional argument, the /f1 portion uses the numeral one (1),
not the letter L.

Subsequently, use the response file any time you need to install an application
with the configured parameters.

Sample Response File (setup.iss)

[InstallShield Silent]

Version=v7.00

File=Response File

[File Transfer]

OverwrittenReadOnly=NoToALl
[{C660F232-38A4-45AF-AE08-A332091BDC91}-DLg0Order]
DLg0={C660F232-38A4-45AF-AE08-A332091BDC91}-gctiGdWelcome-0
Count=4

DLg1={C660F232-38A4-45AF-AE08-A332091BDC91} -gctiGdAskPath-0
Dlg2={C660F232-38A4-45AF-AE08-A332091BDC91}-gctiGdReadyTolnstall-0
DLg3={C660F232-38A4-45AF-AE08-A332091BDC91}-gctiGdFinish-0
[{C660F232-38A4-45AF-AE08-A332091BDCI91}-gctiGdWe Lcome-0]
Direction=1
[{C660F232-38A4-45AF-AE08-A332091BDCI91}-gctiGdAskPath-0]
Direction=1

Path=C:\Program Files\GCTI\Outbound Contact Manager
[{C660F232-38A4-45AF-AE08-A332091BDC91}-gctiGdReadyTolnstall-0]
Direction=1
[{C660F232-38A4-45AF-AE08-A332091BDC91}-gctiGdFinish-0]
Reboot=0

[{45805BA8-94DF-4C49-A49E-9CC2179FDB8D}-D Lg0rder]

Count=0

The response file contains saved information about the number of dialog boxes
displayed, the order in which the dialog boxes were displayed, the values of
any data entered or selected by the end user, and which button the user clicked
to close the dialog box.

Running the Silent Installation
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Launch the InstallShield Silent Installation with this command line:
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About the Silent Setup Log File

Setup.exe -s /f1"<full path to Setup.iss)" /f2"<{full path to setup log
filed"

Where:
*  <full path to Setup.iss>

The full path to the Setup. iss file put within double quotation marks. For
example: c:\windows\setup. iss.

By default, Setup.exe looks for a response file called Setup. iss in the
same directory as Setup.exe.

o <full path to setup log file>

The full path to the setup log file put within double quotation marks. For
example: c:\windows\setup. Log

By default, setup. Log generated in the same directory as the response file
being used.

A silent installation program does not display a dialog if an error occurs. The
status information for the silent installation is recorded (by default) in a file
called setup. Log.

Note: Do not enter a space between the f1 or f2 parameter and its value in
double quotation marks.

The log file generated as a result of the Silent Setup procedure is described in
the following section.

About the Silent Setup Log File

Deployment Guide

InstallShield Silent prints installation results into a setup. Log file. The default
name for the silent setup log file is Setup. Log, and its default location is the
same folder as Setup. iss. You can specify a different name and location for
your setup log file using the f2 switch when launching Setup.exe. The
Setup. log file contains three sections:

* In the first section, the first entry, [InstallShield Silent], identifies the
version of InstallShield Silent used in the silent setup. The second entry
identifies the file as a log file.

* Entries in the second section, [Application], identify the installed
application's name and version and the company name.

*  The third section, [ResponseResult], contains the result code indicating
whether the silent setup has succeeded. Table 9 describes the integer return
values that is assigned to the ResultCode key name.
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About the Silent Setup Log File

Table 9: Silent Setup Result Codes

Result Code Description
0 Success
1 General error
2 Invalid mode
3 Required data not found in the Setup.iss file
4 Not enough memory
5 File does not exist
6 Cannot write to the response file
7 Unable to write to the uninstallation log file
8 Invalid path to the InstallShield Silent response file
9 Not a valid list type (string or number)
10 Data type is invalid
11 Unknown error during setup
12 Dialog boxes are out of order.
51 Cannot create the specified folder
52 Cannot access the specified file or folder
53 Invalid option selected

Sample Setup Log File
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An example of a Setup. Log file is as follows:
[InstallShield Silent]
Version=v8.00.000

File=Log File

[Application]

Name=Genesys Outbound Contact Manager
Version=7.6

Company=GCTI

Lang=0009

[ResponseResuLt]

ResultCode=0
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Manually Defining
Outbound Configuration
Objects

This chapter explains how to create and configure each of the
Outbound-related objects in Genesys Administrator.

Note: You can also use Configuration Manager to configure these objects.

It contains the following sections:

«  Overview, page 158

«  Outbound-Specific Configuration of Framework Objects, page 159
« Table Access Object, page 163

« Field Object, page 165

«  Format Object, page 170

« Calling List Object, page 171

«  Filter Object, page 179

+ Time Zones, page 185

«  Treatment Object, page 187

«  Campaign Object, page 194

«  Campaign Group Object, page 196

Note: Because the Dependencies and Permissions tabs for these
configuration objects do not contain any information that is specific to
Outbound Contact, they are not described in this chapter. For
information about these tabs, see Framework 8.0 Genesys
Administrator Help.
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Overview

After you configure and install the component applications for Outbound
Contact, you configure additional objects in Genesys Administrator to support
and run dialing sessions for campaigns.

The following Framework objects should already exist before you create the
Outbound-specific objects: Tenants, Persons, and telephony configuration
objects (Switches, Agent Logins, DNs), Places, Place Groups and/or Agent
Groups.

Outbound Object-Creation Sequence

Genesys recommends that you create the Outbound-specific objects in the
following order:

1.

Sl A

Fields. Create user-defined fields (if necessary) before you create the
Format object that will contain them.

Format. Create a Format before you create the Table Access Point object
to which it will be applied.

Table Access Point. Create the Table Access Point before your create the
Calling List object to which it will be applied.

Filters.
Treatments.
Calling Lists.
Campaigns.

Campaign Groups.

Permissions in Campaign-Related Objects
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For users to run or change a dialing session for an outbound campaign, they
must be assigned to an Access Group object that has special access privileges to
all campaign-related configuration objects. Special access is the default value.

Procedure:
Verifying or Changing Permissions for an Access
Group Object

Start of procedure

1.
2.

Open each campaign-related object.

Select the Permissions tab.
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3. Make the necessary changes.

For more information about setting permissions, see Framework 8.0 Genesys
Administrator Help.

End of procedure

Outbound-Specific Configuration of
Framework Objects

The following Framework objects require additional configurations for
Outbound Contact:

* Special DNs
* Place Groups or Agent Groups
* Places

This section discusses the configuration of each of these objects in turn.

Special DNs

The DNs that require Outbound-specific configurations include
Communication DNs and Overflow DNs.

Communication DN

Outbound Contact reports on outbound activity through a DN set up as a
Communication DN. This type of DN enables communication between
Outbound Contact Server (OCS) and Stat Server (which determines what
agents are assigned to which Agent or Place Groups, identifies the current
Agent State, and provides the statistics for Outbound real-time and historical
reporting). This DN type also enables communication between OCS and other
parties, using a Communication DN API. It is a virtual DN, meaning that it
does not exist in a switch. The name of this DN type can be either text or
numeric.

Procedure:
Creating a Communication DN

Start of procedure

1. Open the Switch object and select the DNs tab.
2. Click New.
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3. Onthe Configuration tab of the DN, define the fields as follows:
* Name

— Required; default value is [DN]. Specifies the name of the DN. The
name that you enter must be unique within the tenant and it must
not match any actual directory number in the switch.

*  Type
— Required; default value is [Unknown DN Typel. Specifies the type
of DN. Select the Communication DN type from the drop-down
menu.

4. On the Options tab, create a default section.

5. Inthe default section, create an outbound_contact_server option
(page 270) by entering the Option Name and Option Value in the Edit
Option dialog boxes.

6. Click Save and Close.

End of procedure

Overflow DN

A predictive campaign sometimes overdials and, as a result, has outbound calls
waiting in the queue. Some contact centers define (by using Virtual DN or
routing strategy) business rules to send these outbound calls to another queue.
This other queue is commonly known as an overflow queue. There are two
types of overflow DNs:

* ACD Queue or Routing Point; used to mark the record as dropped.

* Extension or Position; used to send RequestReleaseCall to T-Server.

Procedure:
Designating an Overflow DN

To designate an existing DN as an Overflow DN, you must configure an
overf low_dn option on the Options tab of a particular DN object.

Start of procedure

1. Onthe Switching tab, select Switches > DNs > {specific DN).
2. On the Options tab, create a section that is named default.

3. Create the overflow_dn option with a value of true.
4

After you configure the overf Low_dn option—depending on your overflow
DN type—do the following:

* For a Position or Extension type DN, create a Place and add this
overflow DN into this Place.
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* For an ACD Queue or Routing Point type DN, add your overflow DN
to the list of origination DNs of the group(s) that will be used when
you run your dialing session for campaigns.

End of procedure

Agent and Place Group Objects

Deployment Guide

Agents, Places, and Agent/Place Groups are configured in Framework;
however, Agent Groups and Place Groups still need to be configured
specifically for Outbound Contact. The following sections pertain to these
Outbound-specific configurations.

Agent or Place Group Object—Advanced Tab Fields

An Agent/Place Group object needs at least one DN (directory number)
associated with it in an Origination DN list (see “Origination DNs”). An ACD
(automatic call distribution) queue is a required DN for an Agent/Place Group.
Other DN(s) in the list could be VQ (virtual queue) or Routing Point.

Outbound Contact Server (OCS) monitors queues to determine how to pace
outbound calls and to determine which group an agent logs into for a particular
campaign. OCS monitors the telephony events EventQueued, EventDiverted,
and EventAbandoned to determine the number of calls that are waiting in the
queue. Stat Server notifies OCS about agent logins, that provides information
about which queue or group an agent exists.

Note: As of OCS version 7.6.101.18, OCS no longer considers the number
of inbound calls in a queue when it calculates the outbound dialing
pace in the Progressive with seizing and the Predictive with
seizing dialing modes for the Small Group and Advanced Small
Group predictive algorithms.

Origination DNs

Found in Genesys Administrator: Agent/Place Group object > Configuration
tab, Advanced section, Origination DNs

The primary role of an Origination DN is for OCS to monitor it for
EventQueued and EventDiverted so that calls can be properly tracked as they are
dialed and moved to agents (or Abandoned). For this reason, if a Route Point is
used, it may be necessary to use a Virtual Queue also if the Route Point on the
T-Server does not support the correct events.

The origination DNs can be of the following types:
e ACD Queue
* Routing Point
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Place Object
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*  Virtual Queue
e Service Number

Any DN of these types will be registered in the relevant T-Server on start up or
when they are added to the Origination DN (if OCS is already started). OCS
will not allow a dialing session/campaign group to be loaded unless the
Origination DNs for a Campaign Group are monitored.

Agents log into an ACD queue that has a DN number. OCS recognizes that DN
as an identifier for an Agent/Place Group and might use that DN as the point of
origin for Outbound calls. OCS might use an alternate DN (for instance, a
Routing Point) as the point of origin for Outbound calls.

Note: Do not share DNs in the Origination DNs List among Agent/Place
Groups. Assign each Agent/Place Group to a unique Origination
DN.The pacing of outbound calls in the Predictive dialing mode can
cause unpredictable results if DNs are shared.

Procedure:
Adding DN(s) to the Origination DNs List

Start of procedure

1. In Place Group (on the Provisioning tab > Switching) or Agent Group
object (on the Provisioning tab > Accounts) > Configuration tab >
Advanced/Origination DNs section, click Add.

2. Select (that is, highlight) the DN(s).
3. Click 0K in the DN dialog box.
4. Click Save and Close.

End of procedure

Telesets are assigned to Place objects. A Place might contain more than one
DN. Prepare an actual layout of the numbering plan to configure the Places and
assign DNs to them.

OCS works only with DNs that are assigned to places. Genesys recommends
that you do not assign more than two telephony DNs (extension and position)
to one place and that you do not assign telephony DNs from several switches
to one place.
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Note: Beginning with release 7.6, OCS does not take into consideration or
monitor the configuration state (State Enabled or State Disabled) of
the DN included in Places where agents log in to both an Agent
Group and a Place Group that are used for a campaign. OCS considers
an agent valid and available if the Place and Person configuration
objects indicate State Enabled. In release 7.5, OCS checked the state
of the first DN only in the DN list configured for the Place where an
agent logged in.

Table Access Object

A Table Access object defines the relationships among calling list(s), formats,
and the database. This object points to a database table of a specified format by
providing a Database Access Point.

Note: You cannot delete a Table Access object as long as it is associated
with at least one calling list.

Procedure:
Creating a New Table Access Object

Start of procedure

1. In Genesys Administrator, go to Provisioning » Outbound Contact >
Table Access.

2. Click New.
3. Onthe Configuration tab, define the fields as described in the following
subsection.

4. Click Save and Close.

End of procedure
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Table Access Object—Configuration Tab Fields

Name

Required; the default value is [Table Access]. Specifies the name of the Table
Access object. The name that you enter must be unique within the tenant.

Note: You can define the Table Access names for calling lists but the Table
Access object for the Do Not Call table has a gsw_donotcall_List
fixed name.

Table Type

Required; the default value is [Unknown Table Typel. Specifies the type of
Table Access in the database. Select either Calling List or Log Table for the
Do Not Call list.

Note: After you define and save the table type for a Table Access object, you
cannot change it.

Description

Optional; the default value is [Blank]. A brief description of the Table Access
object.

DB Access Point

Required; the default value is [None]. Specifies the Database Access Point
through which the table is accessed. Enter a value by locating an existing
Database Access Point object.

Format

Required; the default value is [None]. Specifies the name of the format to be
applied to the table. Enter a value by locating an existing Format object.

Note: After you define and save the format, you cannot change it. The Do
Not Call table has a fixed structure, and therefore, it does not require
format or field configurations.
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Database Table

Required; the default value is [Blank].Specifies the name of the table in the
database.

Note: The name of table must conform to SQL language rules, which may
vary for each supported database management system (DBMS).

State Enabled

Required; by default, this checkbox is selected. Indicates whether a check box
that indicates a customer interaction can be directed to this target. For a more
complete description of this check box, see Framework 8.0 Genesys
Administrator Help.

Field Object

Deployment Guide

The Field object defines a field in a Calling List database table. Fields are
single pieces of data (for example, a telephone number) within a record.

There are two types of fields in a calling list:

* Genesys mandatory fields—These fields must exist in all Calling List
tables. See “Identifying Mandatory Fields in the “Formats” topic in
Framework 8.0 Genesys Administrator Help (Provisioning Your
Environment > Outbound Contact Objects > Formats). This topic contains a
list of mandatory fields and associated data types, as well as a short
description for each field.

e User-defined fields—These custom fields contain business-related data.

Procedure:
Creating a New Field Object

Start of procedure

1. In Genesys Administrator, go to Provisioning > Outbound Contact »>
Fields.

2. Click New.
3. Onthe Configuration tab, define the fields as described in the following
subsection.

4. On the Options tab, define option(s) in the default section.
5. Click Save and Close.

End of procedure
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Field Object—Configuration Tab Fields

Name

Required; the default value is [Field]. The field name is the name of the
column in the database table. This value must be unique within the tenant.
Depending on the database management system (DBMS), the field name in
this object has to conform to the same rules as the field’s name in the database
table.

Tenant

Automatically populated by the system.

Data Type

Required; the default value is [Unknown Data Typel. You must select a value
other than default for this object. The type of data stored in this field
corresponds to a data type supported by the relational database management
system. Table 10 provides information on data type values. Table 11 provides
information on DATETIME formats.

Table 10: Campaign Data Type Values

Data Type Description

Value

char Character string with a fixed length

datetime Date and time®

float Real number

- 4b

int Integer

varchar String of variable length

[Unknown Data | Default value. You must change this default value and
Type] replace it with another value from this table.

a. Data for the DATETIME field type is presented in the specific format of the Calling
List when it is populated. This format is database dependent.

b. The maximum value for this field with this data type that OCS can handle is
4294967295, which is 232-1.
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Table 11: DATETIME formats

DBMS Data type for Date/Time User Required Format Example
Field
MSSQL | DATETIME YYYY.MM.DD hh:mm:ss | 2003.04.15 11:32:56
Sybase DATETIME YYYY.MM.DD hh:mm:ss | 2003.04.15 11:32:56
Oracle DATE MM/DD/YYYY 04/15/2003 23:32:56
HH24:MI:SS

Informix | DATETIME YEAR TO SECOND YYYY-MM-DD hh:mm:ss | 2003-04-15 12:32:56

DB2 TIMESTAMP 2003-04-15-12.32.56

yyyy-mm-dd-hh.mm.ss.nn | .123456
nnnn

Description

Optional; the default value is [Blank]. A brief description of the field.

Length

Required for char and varchar data types only; not used for any other data
types. The default value is [0]. The length of the field in the database.

Field Type

Required; the default value is [Unknown Field Typel. You must select a
different value than the default for this object. Outbound business-specific
information is stored in this field. Table 12 provides information on field type
values.

Table 12: Field Type Values

Field Type Value Description

Agent Login ID of the last agent who handled an outbound call associated with this
record.

Application Unique Application identifier (DBID).

Call Time Time of the actual dialing attempt.

Campaign Campaign database identification number (DBID) with which this record is
associated.

Deployment Guide
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Table 12: Field Type Values (Continued)

Field Type Value Description

Chain ID of records that are linked in a chain. All records associated with one
customer account have the same chainlD.

Contact Info Contact telephone number (home, work, cell), FAX number, or e-mail address.

Contact Info in 7.1 was Phone Number in 6.5.1.

Contact Info Type Type of contact information, such as telephone, FAX, or e-mail address.
Contact Info Type in 7.1 was Phone Type in 6.5.1.

Dialing Result Result of a dialed call.

From Earliest time after midnight to dial a call.

Group Unique Agent Group or Place Group identifier (DBID).

Number in Chain Priority assigned to a given record in the chain. The smallest number is

processed first.

Number of Attempts | Number of dialing attempts.

Record ID Unique ID number for the current record.

Record Status Status of the record.

Record Type Type of record, such as General, Scheduled, Personal CallBack, NoCall
Scheduled Time Time at which scheduled call should be dialed

Switch ID Unique Switch identifier (DBID).

Time Zone Time-zone database identification number (DBID) of the record.

To Latest time after midnight to dial a call.

Treatments History History of applied treatments for the given chain (see the
treatment_sched_threshold option, page 263).

User-Defined Field An optional field that contains custom business data.

[Unknown Field Default value. You must replace this value with another value from this table.
Type]

Default Value

Optional; the default value is [Blank]. The default value for the field. All
formats that include the field will use this default value. The value should be
consistent with the data type of the field. For example, if the data type is
integer, the default value should be an integer value only. When Genesys
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Administrator imports records from an ASCII file in which a field is missing or
has no value, Genesys Administrator populates the field with this default
value—if the nullable checkbox is not selected. If the field is nullable,
Genesys Administrator accepts a blank value. See also Framework 8.0
Genesys Administrator Help (Provisioning Your Environment > Outbound
Contact Objects > Calling Lists > Overview).

Primary Key

Optional; the default is unchecked. The checkbox indicates whether the field
is a primary key in a database table. In Outbound Contact, the only primary
key fields are chain_id and chain_n. For more information about these fields,
see Framework 8.0 Genesys Administrator Help.

Note: In the 6.5 Calling List table, phone and phone_type were primary keys.
With release 7.1, chain_id and chain_n replaced phone and
phone_type, respectively, as primary keys to accommodate different
persons with the same combination of contact_info (formerly phone)
and contact_info_type (formerly phone_type) in one Calling List.

Unique

Optional; the default is unchecked. The checkbox indicates whether the field
value is unique within the table.

Nullable

Optional; default is unchecked. The checkbox indicates whether the field value
can be set to NULL.

State Enabled

Required; default is checked. Unchecking this checkbox disables the entire
format object. Do not change the default.

Editing Fields in the Field Object

Default and Description are the only fields in the Field object that you can edit
after you save the object. To modify the Default and Description of a field,
double-click the Field object. A field cannot be deleted as long as it is
associated with at least one format. Field objects are closely related to Format,
Table Access, and Calling List objects. Refer to the “Calling List Objects” and
“Format Objects” topics in this chapter for more information.

Deployment Guide 169



Chapter 8: Manually Defining Outbound Configuration Objects Format Object

Format Object
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Format objects contain fields that form a structure for a database table.
Outbound Contact provides two default Format objects: Default_Outbound_ 6
(for backward compatibility) and Default_Outbound_70. By default, both of
these objects contain Genesys mandatory fields only.

Procedure:
Creating a New Format Object

Start of procedure

1. In Genesys Administrator, go to Provisioning > Outbound Contact >
Formats.
Click New.

On the Configuration tab, define the fields, as in the following subsection.
On the Options tab, define option(s) in the default section.
Click Save and Close.

AN o

End of procedure

Format Object—Configuration Tab Fields

Name

Required; the default is value [Format]. The name must be unique within the
tenant. When the name is specified, it cannot be changed.

Tenant

Automatically populated by the system.

Description

Optional; the default value is [Blank]. A brief description of the named
format.

State Enabled

Required; default is checked. A check box that indicates a customer interaction
can be directed to this target. A more complete description can be found in
Framework 8.0 Genesys Administrator Help.
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Procedure:
Populating Format with Fields

Purpose: To populate a newly created Format object (currently empty) and
with fields (all mandatory and perhaps some custom fields).

Start of procedure

1. After creating and saving a Format object, in the Details panel, double-click
the format.

2. In the Navigation panel, click the Fields tab.
3. In the Details panel, click Add.

4. From the Field dialog box, select one or more fields that you want to
include in the Format object.

Note: These fields were created by default as part of the
Default_Outbound_ 6 and Default_Outbound_70 formats.

5. To customize this format with user-defined field(s), in the Field dialog
box, click New.

6. Define the field(s) following the procedures in the section “Creating a New
Field Object” on page 165.

Note: Do not remove mandatory fields.

You cannot delete a format if it is associated with a Table Access
object or Fi Lter object. You cannot modify existing fields after you
associate the format with a Table Access object.

7. Click 0K in the Field dialog box.
8. Click Save and Close.

End of procedure

Calling List Object

Deployment Guide

Calling Lists are tables that contain customer contact information, including
telephone numbers to be called during an outbound campaign. Calling Lists are
also configuration objects in Genesys Administrator. Define a Calling List
object after you have created the Format and Table Access objects. If you need
user-defined fields in your Calling List, create those fields and add them to the
Format object before you create the Table Access object. When a format is

171



Chapter 8: Manually Defining Outbound Configuration Objects Calling List Object

associated with a Table Access object, you cannot add or delete fields in that
format. You can create Fi Lter and Treatment objects before, while, or after you
define the Calling List object and add or remove these objects at any time.

Note: Only calling lists based on a 7.1 or 7.2 format can be migrated to
Outbound Contact 8.0. OCS release 7.1 supports calling lists based on
the 6.5.2 to 7.1 formats. OCM release 7.1 also allows the importation
of 6.5.2 calling lists into the 7.1 format.

Calling lists that are associated with formats that do not contain the
switch_id, group_id, and treatments fields (such as those from
version 7.0 or earlier), or that contain the phone and phone_type fields
instead of the contact_info and contact_info_type fields
(respectively) must be migrated to Outbound Contact solution 7.1
first, and then migrated to release 8.0. See the Genesys 8 Migration
Guide for more details.

Calling List Object
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Create the Calling List object before the Calling List table exists in the
relational database. This approach enables Genesys Administrator to create the
Calling List table according to the properties of the Calling List configuration
object. If the table does not exist yet, OCM displays this message

The table [table name] does not exist. Create it?

Click Yes to create the Calling List table.

If the Calling List table already exists in the database, the properties of the
Calling List object must exactly match the structure of the table (as defined by
its Format and Table Access objects) in the database.

Procedure:
Creating a New Calling List Object

Start of procedure

1. In Genesys Administrator, select Provisioning » Outbound Contact »
Calling List.

2. In the Details pane, click New.

3. Define the field values the associated tabs, including the Configuration
tab, the Options tab (see page 176), the Campaigns tab (see page 176), the
Format tab (see page 176), and the Treatments tab (see page 176).

Note: For other tabs, see the Framework 8.0 Genesys Administrator
Help.
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General Section

Deployment Guide

4. Click Save and Close.

End of procedure

Calling List Object—Configuration Tab Fields

Name

Required; the default value is [Calling List]. The name of the calling list.
This value must be unique within the tenant.

Description

Optional; the default value is [Blank]. A brief description of the calling list.

Tenant

Automatically populated by the system.

State Enabled

Required; default is checked. A check box indicating that a customer
interaction can be directed to this target. You can find a more complete
description in Framework 8.0 Genesys Administrator Help.

Calling Time From

The default value is [8:00:00 AM]. Not used at the list level, at this time.

Calling Time To
The default value is [6:00:00 PM]. Not used at the list level, at this time.

Maximum Attempts

Required; the default value is [10]. The maximum number of attempts to call a
single record in this Calling List during one campaign. You cannot set this
value to zero.

Note: This parameter is taken into account by Outbound Contact Server
when applying treatments only. If the record is being processed again
as a Personal or Campaign Callback, this parameter is not used by
OCS.

Script

The Script Property in the Campaign, Calling List, and Campaign Group
defines the Script object, which contains all of the attributes that are required
by Agent Scripting. For more information, see the section, “Attaching Script
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Data Base and
Query Sections
/Calling List object
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Information to OCS User Events and Telephony Events,” in the Qutbound
Contact 8.0 Reference Manual.

Note: For descriptions of the fields in the Data Base and Query sections of

the Configuration tab, see Framework 8.0 Genesys Administrator
Help.

Format
The Format for the Calling List.

These entries are associated with using SQL queries to create a Calling List.

Table Name

The name of the table in the database.

Data Access Point

Required; the default value is [None]. Specifies the Database Access Point
through which the table is accessed. Enter a value by locating an existing
Database Access Point object.

DB Server

Required; the default value is [None]. Specifies the name of the DB Server
associated with the database.

SQL Server

Required; the default value is [None]. Specifies the name of the SQL Server
used for running the SQL query.

Type

Required; the default value is [None]. Specifies the type of database: MSSQL,
Informix, DB2, Oracle, or Sybase.

DB Name

Required; the default value is [None]. Specifies the name of the database in
which the table exists.

Login

Required; the default value is [None]. Specifies the login name for the
database
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Calling List
Advanced Entries

Deployment Guide

Password

Required; the default value is [None]. Specifies the password for the database

Case Conversion

Case conversion method for key names of key-value lists coming from DB
Server. This value specifies whether and how a client application converts the
field names of a database table when it receives data from DB Server. If you
select upper, field names are converted into uppercase; if you select lower,
field names are converted into lowercase; and if you select any, field names are
not converted. This value corresponds to the dbcase option in a configuration
file.

Note: This setting does not affect the values of key-value lists coming from
DB Server. That is, actual data is presented exactly as it appears in the
database tables.

Warning! Use the default value (any) unless directed to do otherwise by
Genesys Technical Support.

SELECT FROM

Required; the default value is [None]. Specifies the table name from which to
select records for the Calling List.

WHERE

Required; default value is [Nonel. Specifies the SQL query to identify the
records.

ORDER BY

Required; the default value is [None]. Specifies how to order the records
identified, based on the query.

If you use the Calling List Advanced object instead of the Calling List object,
you create lists based on specified Table Access and Filter objects rather than a

SQL query.

Table Access

Required; the default value is [None]. The Table Access object to which the
Calling List refers. The Table Access object defines the format of the Calling
List and identifies the DB Access Point used to access the Calling List table.
Use the Browse button to locate an existing value.
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Log Table Access

The default value is [None]. Not used at this time.

Filter

Optional; The default value is [Nonel. The filter to be applied to this calling
list. A filter defines which call records within the Calling List table will be
dialed by the campaign.

Note: The Filter field becomes enabled only when the Table Access field is
populated.

Calling List Object—Options Tab

Use this tab to define Outbound Calling List-related options.

Calling List Object—Campaigns Tab

This tab lists the Campaigns that include this Calling List.

Calling List Object—Format Tab

On the Calling List object only (not Calling List Advanced object), use this tab
to add the fields that define the Format for this calling list.

Calling List Object—Treatments Tab Fields

You can add an existing treatment to the Calling List by clicking the Add button
and selecting an available treatment. You can delete an applied treatment by
selecting a displayed treatment and clicking Remove. Click Save and Close to
the changes.This tab displays the following information for applied treatments.

Name

Name of applied treatment.

State

Indicates whether the Treatment is enabled or disabled.

See “Treatment Object” on page 187 for more information about setting up
treatments for unsuccessful calls.

Outbound Contact 8.0 @



Chapter 8: Manually Defining Outbound Configuration Objects Calling List Object

Changing the Structure of a Calling List

The database administrator can make changes directly to the Calling List table
using the database management system (DBMS) tools; however, Genesys
Administrator will no longer be able to access this table. Genesys recommends
that you create a new Calling List object, which will match the new physical
structure of the table, as described on page 172.

Fine-Tuning a Calling List

When Genesys Administrator creates a physical table for the Calling List, It
also creates appropriate indexes on the table; however, if the structures of the
dialing filters require additional indexes, the customer must create them. The
customer also must perform tune-up procedures, such as updating index
statistics and maintaining transaction logs. To assign a List Weight to a calling
list, see “List Weight (in Configuration Manager); Share (in Genesys
Administrator)” on page 196.

Record Cancellation Requests and Customer ID

In addition to making record cancellation requests according to the record
handle and the phone number, they can now be made according to the
customer ID, which is currently leveraged by the Do Not Call feature.

Both the Desktop protocol and the 3rd party protocol have been extended to
include (optionally) the 6SW_CUSTOMER_ID attribute in the RequestRecordCancel
and the CM_ReqCance LRecord requests respectively.

With this ability, record cancellation requests can identify sets of records not
only by the record handle and the telephone number, but also by the customer
ID. If more than one record identifier is included in the same request, the
identifiers are prioritized as follows: record handle (highest), telephone, and
customer ID (lowest). OCS processes RequestRecordCancel by customer ID in
the same way that the other types of RequestRecordCancel are processed. The
only difference is that the records that are subject to cancellation are
determined by the value of the customer ID field in the Calling List table.
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Procedure:
Configuring Objects to Identify Records by Customer
ID for Record Cancellation Requests

Purpose: To configure object to enable identification of record cancellation
requests by customer ID.

Note: Ifyou have already use the Customer ID for Do Not Call requests, you

do not need to configure anything else.

Start of procedure

1.
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Create a new user-defined field object. On the Configuration tab, define
the fields as follows:

* Name = <user-specific name)

¢ Data Type =varchar

* Length= 64

e Field Type =User-Defined

Also select the Nullable and State Enabled options.

On the Options tab for the Field object, assign the send_attribute to it by
adding a default section.

On the Option tab, define the fields as follows:

* Option Name = send_attribute

e Option Value= GSW_CUSTOMER_ID

Designate the new user-defined field as the customer_id option in the 0CS
Application object.

In Genesys Administrator > Provisioning > Environment > Applications >
Outbound folder> OCS application > Options tab > 0CServer section,
create and define the customer_id option. Use the name of the new
user-defined field as the value of customer_id.

e Option Name = customer_id
* Option Value =<name of new user-defined field>
Add the new field (defined inStep 1) to a new Format object.

In Genesys Administrator > Provisioning > <Tenant> > Format object,
create a new format for a Calling List table that will include the new
user-defined field.
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5. CreateaCalling List object with the new format. In Genesys
Administrator > Provisioning > <Tenant) > Calling Lists, configure a
Calling List Advanced object with the following:

In the Configuration tab, specify the following:
* Table Access: <New Calling List>
This is a new Calling List, formatted with the customer_id field.

End of procedure

Filter Object

Deployment Guide

Filters specify the criteria for data selection from a database table. Outbound
filters are applied to Calling Lists. See the Fi Lter field under “Calling List
Object” on page 176.

Procedure:
Creating a New Filter Object:

Start of procedure

1. In Genesys Administrator, select Provisioning > Outbound Contact >
Filters.

In the Details pane, select New.

Define the fields in the Configuration tab.
Define options in the Options tab.

Click Save and Close.

A I

End of procedure

Filter Object—Configuration Tab Fields

Name

Required; the default value is [Filter]. The name of the filter. This value
must be unique within the tenant.

Tenant

Automatically populated by the system.

Description

Optional; the default is [Blank]. A brief description of the filter.
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Format

Required; the default value is [None]. The format to which this filter is
applied. When it is specified, it cannot be changed. You assign a Filter object
to a Calling List object with the same format. Use the Browse button to locate
an existing value.

State Enabled

Required; the default value is checked. A check box that indicates that a
customer interaction can be directed to this target. A more complete
description is in Framework 8.0 Genesys Administrator Help.

Filter Object—Options Tab Fields

Two options on the Options tab define a Dialing Filter: criteria and order_by.
Create a section called default on the Filter object’s Options tab; then add the
options criteria (see “Configuring the criteria Option”) and order_by. (see
“Configuring the order by Option to Sort Records”).

Procedure:
Configuring the criteria Option

The criteria option defines the where clause of a SQL statement. It defines
the restricting conditions for the records to be dialed by a campaign. The
syntax for values in the criteria option is SQL syntax.

Notes: * The Outbound Contact Wizard was not updated for release 8.0.

* The criteria option is called WHERE in the Outbound Contact 7.5
Configuration Wizard.

Start of procedure

1. Double-click the filter and select the Options tab.
2. Click Add.

3. Inthe New Option dialog box, enter default in the Section field and
criteria in the Name field.
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4. Add a SQL statement in the Value field.

For example, to restrict the dialing records to contact only platinum credit
card holders, type card_type="platinum' in the Value field.

Note: When using Genesys mandatory fields in SQL statements, the value
must be in enum format. Refer to “Genesys Enumeration Tables” in
the “Communication Protocols” chapter of the Outbound Contact 8.0
Reference Manual. (When creating viewing filters in Genesys
Administrator, this only applies on the Expert Mode tab.)

5. Click 0K to save and close the option to this Fi Lter object.

End of procedure

Procedure:
Configuring the order_by Option to Sort Records

The order_by option defines the sort order of the records that meet the
restrictions defined in the criteria option.

Start of procedure

1. Click Add.

2. Inthe New Option dialog box, enter default in the Section field and
order_by in the Name field.

3. Inthe value field, type the name of the field by which you want to sort.

For example, to order records by telephone number, enter phone in the
Value field.

4. Click 0K to save and close the option to this Fi Lter object.

Note: If you use a filter on a large Calling List with more than 1,000 records,
Genesys recommends that the Administrator create an index using
DBMS tools. This dramatically improves data-retrieval performance.

End of procedure

Defining a Dialing Filter that Exceeds 255 Characters
for Configuration Server 7.6.x and Earlier

If you are using Configuration Server 7.6.x or earlier and the dialing filter
exceeds 255 characters, you must divide the long string into several shorter
strings. To do so, use configuration options with the same name and add
sequential numbers at the end of the option's name. OCS, OCM, and Genesys

181



Chapter 8: Manually Defining Outbound Configuration Objects Filter Object

Example 1

Resulting Filter 1
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Administrator builds a dialing filter by concatenating the values of these
options.

Note: Configuration Server 8.0 supports configuring options with values
greater than 255 characters. If you are using Configuration Server 8.0
or higher, you can configure a single option with a dialing filter that
exceeds 255 characters.

Sample Configuration:

In the following example, the values of these configuration options
* criteria

* criterial

* criteria2

are the first, second, and third parts, respectively, of the dialing filter’s WHERE
clause.

In the following example, the values of these configuration options
e order_by

e order_by1

e order_by2

are the first, second, and third parts, respectively, of the dialing filter ORDER BY
clause.

Note: When parts of the filter are concatenated, a single space is added
between the parts. As a rule, when configuring these options, divide
your SQL clause only at points where insertion of the whitespace is
permitted by the SQL standard, otherwise the result of concatenation
will yield an invalid SQL clause.

criteria = phone Like '415%"' AND tz_dbid IN (116, 118,
122) AND customer_priority IN (10, 9, 4,
3, 2, 18) AND customer_type = 1

order_by = phone_type ASC, tz_dbid DESC,

criterial

criteria2

order_by1 = customer_priority ASC, customer_policy_n DESC,

order_by2 = customer_id DESC

The options configured as shown above result in the following dialing filter:

WHERE phone like '415%' AND tz_dbid IN (116, 118, 122) AND
customer_priority IN (10, 9, 4, 3, 2, 18) AND customer_type = 1 ORDER
BY phone_type ASC, tz_dbid DESC, customer_priority ASC,
customer_policy_n DESC, customer_id DESC
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Record Cancel for
Broken Chain
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Filters that Break a Chain of Records

You can write a filter so that it breaks a chain of records into two logical
chains: one chain that satisfies the filtering expression and a second chain that
does not. For example:

List:
Record 1:phone = '111', phone_type = 1, chain_id = 1, chain_n = 0
Record 2:phone = '222', phone_type = 2, chain_id = 1, chain_n = 1
Record 3:phone = '333', phone_type = 1, chain_id = 1, chain_n = 2
Record 4:phone = '444', phone_type = 3, chain_id = 1, chain_n = 3
Example: The following filter
where phone_type = 1
will break the given chain into two logical chains:
+ Logical chain 1 includes records 1 and 3, which satisfy the filter
condition.
+ Logical chain 2 includes records 2 and 4, which do not satisfy the filter
condition.

You should avoid such filtering conditions, if possible.

Under particular conditions, records with the same chain_id are not all
canceled by a cancel by phone request (RequestRecordCancel with 6SW_PHONE
attribute).

This behavior occurs when four conditions coexist:

*  The RequestRecordCancel has the ALL Chain attribute, which means to
update the whole record chain, not just the single record,

but

* afilter applied to the calling list breaks a single chain into two logical
chains

while

* the dialing session for a campaign group with a campaign (to which the
calling list belongs) is loaded or running,

and
* aphone number specified in the 6SW_PHONE attribute is filtered out.

The records that are not filtered out are also not canceled even though the
chain attribute is ALL Chain.

Take, for example, these conditions applied to the list that follows:
e Filter: where phone_type = 1

* RequestRecordCancel: Phone = '222'

* ChainAttr = 'AlLChain’
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List:
Record 1: phone = '111', phone_type = 1, chain_id = 1, chain_n = 0
Record 2: phone = '222', phone_type = 2, chain_id = 1, chain_n = 1
Record 3: phone = '333', phone_type = 1, chain_id = 1, chain_n = 2
Record 4: phone = '444', phone_type = 3, chain_id = 1, chain_n = 3

Records 1 and 3 meet the filter condition where phone_type = 1. Records 1 and
3 compose logical chain 1. These two records (with chain_n = 0 and chain_n =
2) are retrieved from the database and dialed.

Record 2 (with chain_n = 1) and record 4 (with chain_n = 3) compose the
second logical chain. Record 2 is subject to the RequestRecordCancel where
Phone = '222'. Because RequestRecordCancel has the ALL Chain attribute
(ChainAttr = 'ALL Chain'), both records 2 and 4 are canceled.

Full Chain Update
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The full chain update feature applies to configurations in which chains of
records are separated by the dialing filter and, therefore, are partially processed
by OCS. After OCS finishes processing this type of chain, by default it marks
the records that were filtered out by the dialing filter (such as Record 2 in the
following example) as record_status = Ready.

Ordinarily, if a dialing filter is changed and the chain processing is resumed,
such an update will cause repetitive dialing of other records that belong to the
same chain. This could lead to contacting the same customer again within that
dialing period. Using the full chain update feature prevents this unwanted
behavior of OCS.

The following provides an example of the configuration when a chain of
records is separated by the dialing filter:

Chain:
* Record 1: Phone = 4155551212, phone type = Home Phone, Chain ID =1,
Chain N=0

* Record 2: Phone = 6505551212, phone type = Direct Business Phone,
Chain ID=1, Chain N =1

Dialing Filter Applied:
criteria = ‘phone_type =1’

Outbound Contact provides the option update_all_records to enable control
over how OCS updates the status of records after the chain processing has been
completed, in the following way:

» Ifthe value for the update_all_records option is set to true: OCS updates
all records in the chain, regardless of the dialing filter applied. All records
outside the parameters of the dialing filter are updated with the same status
that the chain receives after OCS has finished processing it.
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» Ifthe value for this option is set to false (default): Records that were
filtered out by the dialing filter are marked as record_status = Ready.

Note: This option can be configured both on the Application- and individual
Calling List-levels. The Calling List-level option takes precedence
over the Application-level.

When in use, Full Chain Update ensures that all records in the chain are
updated with the same status as the chain itself, regardless of the chain’s
currently applied dialing filter, which might separate the chain by filtering out
some records. For example, if the record in the chain has been cancelled with
the flag 'AllChain', then all records, regardless of the dialing filter, will be
marked as Cancel Led.

Time Zones

Deployment Guide

Outbound Contact uses time zones in call records to determine the contact’s
time zone. Genesys Administrator populates the tz_dbid field with the
international three-letter abbreviation for the time zone parameter when it
imports or exports a calling list. Call time, dial schedule time, and valid dial
time (dial from and dial till) are based on the record’s time-zone. For more
information about the time zone abbreviations see Framework 8.0 Genesys
Administrator Help.

Note: If Daylight Savings Time (DST) is configured for time zones located
below the equator using the Current Year or Fixed Date (Local)
properties, define both the Start Date and End Date in the DST
definition as the current year and make the Start Date later than the
End Date.

Outbound Contact dynamically updates time changes from winter to summer
and summer to winter. The default set of Time Zones created during
Configuration Server installation is located in the Time Zones folder under the
Environment (for a multi-tenant environment) or under the Resources folder
(for a single tenant).

Procedure:
Creating a Custom Time Zone for a Tenant

Purpose: To create a custom Time Zone for a Tenant, if necessary.
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Start of procedure

1. In Genesys Administrator, select Provisioning > Environment > Time
Zones.

2. Click New.

3. Define the fields in the Configuration tab. For more information, see
Framework 8.0 Genesys Administrator Help.

4. Click Save and Close.

End of procedure

Time Zones Object—Configuration Tab Fields

Name

Required; defaultis [Time Zone]l. The name of a Time Zone object. This value
must be unique within the tenant.

Tenant

Automatically populated by the system.

Description

Optional; the default value is [Blank]. A brief description of the Time Zone
object.

Time Zone

Required; the default value is [6MT]. Greenwich Mean Time (GMT) plus the
amount of time (in hours and minutes) to add to that standard.

DST Select

Optional; A drop-down list to select Daylight Savings Time definition (GMT)
to indicate that the time zone observes Daylight Savings Time (DST) or
Current Year or Fixed Date (local) to indicate that DST is not observed.

Netscape (in Specific Time Zone section)

Required; Enter the time zone as it appears in Netscape Navigator.

Microsoft Internet Explorer (in Specific Time Zone section)

Required; Enter the time zone as it appears in Microsoft Internet Explorer.
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State Enabled

Required; default is checked. A check box indicating whether or not a
customer interaction can be directed to this target. A more complete
description can be found in Framework 8.0 Configuration Manager Help.

Treatment Object

Deployment Guide

Treatment objects are assigned to Calling List objects. Treatment objects
define what OCS should do with a call that does not reach the intended party.
A treatment, for example, could be that Outbound Contact redials a number
that returns a Busy call result. If no treatments are assigned to a call result, OCS
changes the record status to Updated.

You can add or remove treatments from a Calling List object while a dialing
session for a campaign is running. However, when a treatment is in progress, it
cannot be interrupted. Changes made to that treatment will be applied to the
next record that receives the call result that prompts the treatment.

Procedure:
Creating and Applying Treatments

Start of procedure

1. In Genesys Administrator, select Provisioning » Outbound Contact »
Treatments.

2. Click New.

3. Define the fields in the Configuration tab.
4. Click Save and Close.

End of procedure

Treatment Object—Configuration Tab Fields

Name

Required; the default value is [Treatment]. Type the name of the treatment. It
must be unique within the tenant.

Tenant

Automatically populated by the system.
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Description

Optional; the default is [Blank]. A brief description of the selected treatment.

Call Result

Required; the default value is [Unknown Call Result]. Select a value (the
result of a dialing attempt) for this object. Table 13 provides information on
call result values.

Table 13: Call Result Values

Call Result Value

Description

[Unknown Call Result]

Default value. You must change this default value and replace it
with another value from this table.

Abandoned

Call dropped and will not be redialed.

Agent CallBack Error

OCS generates this call result when a call record is rescheduled
according to a personal callback request from the desktop
application, but OCS cannot find the designated agent to
receive the callback when the scheduled time arrives.

See the “Communication Protocols” chapter in the Outbound
Contact 8.0 Reference Manual for details on the personal
callback request.

All Trunks Busy

No free trunks on the switch for dialing a call.

Answer

Customer was reached at the dialed phone number.

Answering Machine Detected

Answering machine was detected at the dialed phone number.

Bridged Reserved for future use.
Busy Dialed phone number was busy.
Call Drop Error Reserved for future use.

Cancel Record

Record has been marked with Cancel by the agent desktop
application or a third-party application.

Cleared Reserved for future use.
Conferenced Reserved for future use.
Consult Reserved for future use.

Converse-On

Reserved for future use.

Covered

Reserved for future use.
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Table 13: Call Result Values (Continued)

Call Result Value

Description

Deafened Reserved for future use.

Dial Error Hardware error from a Dialogic board or a call progress
detection (CPD) board on the switch.

Do Not Call Record has been marked with DoNotCall by the agent desktop
application or a third-party application.

Dropped Call dropped by dialer after call dialed. Call dropped if/when
the call_wait_queue_timeout option expires.

Dropped on No Answer Reserved for future use.

Fax Detected

Fax machine was detected at the dialed phone number.

Forwarded

Reserved for future use.

General Error

General error occurs when a call is not completed, possibly
caused by an invalid telephone number in the record or a wrong
number according to the switch.

Group CallBack Error

This call result is generated by OCS internally when a call
record is rescheduled according to a campaign callback request
from the desktop application, but OCS cannot find any
available agent to receive the callback record. See the
“Communication Protocols” chapter in Outbound Contact 8.0
Reference Manual for details on the campaign callback request.

Held

Reserved for future use.

No Answer

Ring without answer at destination.

No Dial Tone

Absence of dial tone based on an error returned by the Dialogic
board or the call progress detection (CPD) board on the switch.

No Established Detected

Reserved for future use.

No Port Available

No port is available to place call.

No Progress

Reserved for future use.

No RingBack Tone Reserved for future use.

NU Tone A special Public Switched Telephone Network (PSTN) code
valid only in Europe.

OK OCS treats the call result 0K as undefined, therefore, it

disregards any treatments created for this call result.

Deployment Guide
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Table 13: Call Result Values (Continued)

Call Result Value

Description

Overflowed Reserved for future use.

Pager Detected Pager was reached at the dialed phone number.

Pickedup Reserved for future use.

Queue Full Reserved for future use.

Redirected Reserved for future use.

RemoteRelease Reserved for future use.

Silence Call was dialed, but there is no call progress detection (CPD).

SIT Detected Any type of network tone.

SIT IC (Intercept) Only applies if the network supports this specific standard
information tone (SIT). Check with the switch vendor for
confirmation.

SIT Invalid Number Only applies if the network supports this specific SIT. Check
with the switch vendor for confirmation.

SIT NC (No Circuit) Only applies if the network supports this specific SIT. Check
with the switch vendor for confirmation.

SIT RO (Reorder) Only applies if the network supports this specific SIT. Check

with the switch vendor for confirmation.

SIT Unknown Call State

Only applies if the network supports this specific SIT. Check
with the switch vendor for confirmation.

SIT VC (Vacant Code) Only applies if the network supports this specific SIT. Check
with the switch vendor for confirmation.
Stale Call result is marked as stale if the following timer has

expired:

stale_clean_timeout

OCS will also mark the call result as stale for call records that
have not received a RecordProcessed request from the desktop
application when a dialing session/campaign group is being
unloaded.

Switch Error

No dial tone received.

System Error

Dialing software error from the Dialogic driver or CPD from
the switch.
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Table 13: Call Result Values (Continued)

Call Result Value

Description

Transfer Error

Dialer has a problem transferring calls based on call action.

Transferred Reserved for future use.

Wrong Number Call is answered but the desired person(s) could not be reached
at this number; this call result is sent by the agent desktop
application and not detected by the dialer.

Wrong Party Call is answered but by a wrong party; this call result is sent by

the desktop application and not detected by the dialer.

Apply to Record

Required; default [Unknown Action]. Select a value from the drop-down list.
The action to apply to a Calling List record based on the call result. Applies to
all call results in the Call Results Values table except for call result Answer.
Table 14 provides information on Apply to Record values.

Table 14: Apply to Record Values (Unanswered Call Results)

Apply to Record Value

Description

Assign to Group

Used for the Agent CallBack Error call result. The call record is
treated as a scheduled call of type Campaign. The record type is set
as CampaignCallBack. The call record is sent to one of the desktops
in the Campaign Group. The desktop must be programmed with a
communication protocol to use this feature. See the
“Communication Protocols” chapter in the Outbound Contact 8.0
Reference Manual.

Execute SQL Statement

Used to execute pre-configured SQL statements when certain call
results are received. There is no limitation on the type or complexity
of the SQL statement that can be configured. Macro expressions can
also be used to form the SQL statement. To execute this statement,
OCS connects to the Calling List table from which the associated
dialing record originated.

Mark as Agent Error

Used for the Agent CallBack Error or Group CallBack Error call
result. The record status is set to Missed Callback. See also the
predictive_callback option in this guide.

Note: Although you can set this value to other negative call results
in Configuration Manager, you should only use it for Agent
CallBack Error or Group CallBack Error call results.

Deployment Guide
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Table 14: Apply to Record Values (Unanswered Call Results) (Continued)

Apply to Record Value

Description

Next in chain

Used to set the total number of times that the next-in-chain treatment
cycle occurs, and set the time period to wait before beginning the
cycle again.

Next in chain after

Used to set the interval until the next record in chain is dialed, and
until the next pass through the chain, after the last record in the chain
has been dialed.

Next in chain at specified date

Used to set the date/time to dial the next record in chain.

No Treatment

No treatment will be applied.

Redial Redial number within a specified number of minutes (Interval) for a
specified number of times (Cycle Attempt).

Retry at specified date Record will be redialed at the specified Date and Time.

Retry in Retry once after the specified number of minutes (Interval).

Update all records in chain

No more dial attempts are made for the chain and all records in the
chain are marked as Updated.

[Unknown Action]

Default value. You must change this default value and replace it
with another value from this table.

Apply to Call

Optional; applicable only when call result is Answer, Answering Machine
Detected, or Fax Detected; the default value is [Unknown Action Code].
Allows an alternate path when a dialing attempt is answered or reaches an
answering machine or fax machine. Select a value from the drop-down menu.
Table 15 provides information on Apply to Call values.

Table 15: Apply to Call Values (Answering Machine/Fax Results)

Apply to Call Value

Description

Connect

Call connected to the DN defined as the Destination DN.

Drop

Drop = Unknown. Call is dropped or disconnected.

Mute Transfer

Reserved for future use.

Play a Message Reserved for future use.
Route Reserved for future use.
Send a fax Reserved for future use.
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Table 15: Apply to Call Values (Answering Machine/Fax Results) (Continued)

Apply to Call Value

Description

Send a page

Reserved for future use.

Send an e-mail

Reserved for future use.

Transfer

Call transferred to the DN defined as the Destination DN.

[Unknown Action Code] [Unknown Action Code] = Dropped. Default value. You must change

this default value and replace it with another value from this table.

Deployment Guide

Destination DN

Required for the Apply to Call actions Connect and Transfer; default is
[None]l. The DN to which the call will be connected or transferred. Browse for
an existing DN. If a Destination DN is not supplied, OCS will ignore the
treatment.

Number in sequence

Required; the default value is [0]. Assign the value 1 for a stand-alone
treatment or for the first treatment of a treatment sequence. In a treatment
sequence, each treatment contains a unique number that determines the order
in which each treatment is applied to the same call result.

Cycle Attempt

Required to be other than @ when Apply to Record is set to Next in chain,
Next in chain after, Next in chain at specified date, Redial; the default
value is [0]. The maximum number of consecutive attempts to execute the
treatment on the record.

Interval (minutes)

Required when Apply to Record is setto Next in chain, Next in chain
after, Redial, orRetry in; defaultis [0]. A time interval, in minutes, that
OCS waits between the first dialing attempt and the first treatment attempt.
Increment (minutes)

Required when Apply to Record is setto Next in chain, Next in chain
after, Rerty in, Redial; the default value is [0]. Specifies the number of
minutes added to the previous redial time interval.

Date

Required if the Apply to Record action is set to Next in chain at specified
date or Retry at specified date; the default value is [current datel. The
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date when another treatment attempt will be performed. Select a calendar date
from the drop-down list.

Time

Required if the Apply to Record action is set to Next in chain at specified
date or Retry at specified date; the default value is [current time]. The
time of day that another treatment attempt will be performed. Select a time
from the drop-down list.

Range

This is reserved for future use.

Treatment Sequences

Note the following:

*  You can define treatment sequences (sometimes called linked treatments)
for the same call result by using the Number in sequence field on the
Configuration tab of the Treatment object. The first treatment in the
sequence must have a value of 1 in the Number in sequence field. The
values for this field must be numbered sequentially (1,2, 3, etc.). The
sequence will not work if a treatment sequence is broken, for example,
numbered 1, 2, and 4.

*  You can create two Busy treatments and specify the order (sequence) in
which to apply them. For example, create one Busy treatment that has an
action of Redial and the Number in sequence field set to 1; create a second
Busy treatment that has an action of Retry in and the Number in sequence
field set to 2; then assign both Busy treatments to the same Calling List.

* You can also use the sequence of treatments in combination with cycling
through the chain. To do this, you need to place one of the treatments of
the type Next-In-Chain, Next-In-Chain After, or Next-In-Chain at
Specified Date, atthe end of the sequence of treatments.

Properly configuring one of these treatments to be the last in the sequence
will result in the following: When the chain is completed, OCS will jump
from the last record to the first record in the chain to begin the cycle again.

Campaign Object

A Campaign object contains information about the Calling List(s) and, if
needed, defines campaign-level options.
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Procedure:
Creating a New Campaign object

Start of procedure

1. In Genesys Administrator, select Provisioning » Outbound Contact »
Campaigns.
Click New.

Define the fields in the Configuration tab.
In the Calling Lists section, click Add to add calling lists to the campaign.

Click Save and Close.

AR I

End of procedure

Campaign Object—Configuration Tab

Name

Required; the default value is [Campaign]. Type or choose the name of the
campaign. This name must be unique within the tenant.

Tenant

Automatically populated by the system.

Script

Optional; the default value is [None]. Defines the Script object that contains all
of the attributes that are required by Agent Scripting. For more information,
see the “Attaching Script Information to OCS User Events and Telephony
Events” section in the Outbound Contact 8.0 Reference Manual for more
information.

State Enabled

Required; default is checked. A check box that indicates that customer
interaction can be directed to this target. A more complete description can be
found in Framework 8.0 Genesys Administrator Help.

Calling List

Required; the default value is [None]. The names of Calling Lists that will be
dialed during this Campaign. A Campaign can have zero or more Calling Lists.
Select from defined Calling Lists.
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List Weight (in Configuration Manager); Share (in Genesys Administrator)

Required; default is [10]. This property is applicable for a campaign with
more than one active Calling List. It is the percentage of call records to be
retrieved from a Calling List for a Campaign. Specify what percentage of that
volume will be drawn from each calling list. See the “Understanding Weights”
topic in the Framework 8.0 Genesys Administrator Help.

Note: The List Weight field is the Share field in the Calling List tab.

Active

Required; default is checked. A check box that indicates if the selected
Calling List is involved in this campaign. The check box is used to activate or
deactivate the Calling List dynamically in a running dialing session for a
campaign.

Campaign Object—Options Tab

Use this tab to define outbound campaign-related options. An option defined in
this tab fine-tunes the system on the individual campaign level.

Campaign Group Object
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A Campaign Group is the main configuration object in Outbound Contact. It can
be found in the Campaign Groups tab within the Campaign object in Genesys
Administrator > Provisioning tab > Outbound Contact. The Campaign
Group is defined as a Campaign (a set of calling lists) that is assigned to work
resources such as an Agent Group or a Place Group.

The following sections describe how to configure a Campaign Group object:

Procedure:
Creating a New Campaign Group Object

Start of procedure

1. In Genesys Administrator, select Provisioning > Outbound Contact >
Campaigns.

2. In the Details pane, double-click a Campaign.
3. Select the Campaign Groups tab.
4. Click New.
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5. Define the fields in the Configuration tab.

Note: The following sections (“General Section”, “Advanced Section”,
and “Connection Section”) describe how to configure this tab.

6. Configure the Options tab.
7. Configure the Permissions tab.

8. Click Save and Close.

End of procedure

General Section

Name

Required; The format is [CampaigneCampaignGroup]. Automatically populated
by the system.

Tenant

Required; Automatically populated by the system.

Campaign

Required; The name of the Campaign that will form the Name field above.
Automatically populated by the system.

Group Type

Required; The type of group (agent or place). Automatically populated by the
system.

Group

Required; The name of the group that will form the Name field above.

Note: Ifusing OCS version 7.2.x, 7.5.x, 7.6.0, or 7.6.100 and are running the
same outbound campaign against multiple agent groups, when an
agent schedules a Personal Callback or a Personal Rescheduled, OCS
might fail to deliver a Personal CallBack or Personal Rescheduled
record to the designated agent. As a workaround, Genesys
recommends that you either use Campaign Callbacks or to associate
one campaign with a single agent group.

If you are using OCS version 7.6.101 and higher, this issue is
corrected with the addition of the cal Lback-observe-group option (see
page 223).
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Description

Optional; the default value is [Blank]. A brief description of the campaign.

State Enabled

Required; default is checked. A check box that indicates that customer
interaction can be directed to this target. A more complete description can be
found in Framework 8.0 Genesys Administrator Help.

Advanced Section

Dial Mode

Required; the default value is [Predictive]l. Any of the modes that are
described in “Dialing Modes” on page 50.

Voice Transfer Destination

Required; the default value is [None]. Identifies where calls are to be delivered
for handling. In addition to the Voice Transfer Destination DN, any ACD
Queue, Virtual Queue, Routing Point, or Service Number DN that may be
part of a call flow involving this group of agents or places must be specified as
an Origination DN in the Advanced section of the Agent Group or Place Group
objects in Genesys Administrator. OCS needs to monitor these DNs to identify
“foreign” inbound or outbound calls that are delivered to agents but were not
issued by OCS on behalf of the Campaign Group, or if the ACD Queue DN is
configured as an “overflow” DN.

Notes: * You must avoid situations in which the same DN is configured as
an Origination DN for more than one Agent Group or Place Group
that is part of a predictive or progressive campaign dialing mode
because the pacing algorithm may give incorrect statistics that may
result in poor dialing ratios.

 In addition to the actual Voice Transfer Destination DN, other DN
types such as ACD Queue, Virtual Queue, Routing Point, or
Service Number must be configured as Origination DNs (see page
161) in the Agent Group object or the Place Group object. These
types of DNs need to be specified so that OCS can monitor them in
order to recognize foreign inbound or outbound traffic (such as
calls that seize agents but were not issued by OCS on behalf of the
Campaign Group) or to recognize that the ACD Queue DN is
configured as an overflow DN.

Operation Mode

Required; the default value is [Manuall. Not used at this time.
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Optimization Method and Optimization Method Value

Required in Predictive mode; the default value is [Agent Busy Factor] for
Optimization Method, and the default value is [80] for the Optimization
Method Value. These parameters work together to determine how busy the
campaign will be. They are not applicable to Push Preview and Power GVP
dialing modes.

Maximum Queue Size

Optional; the default value is [0]. Determines the number of records to keep in
the dialer’s queue. It is an internal counter that is used when OCS performs
with Power GVP or Push Preview modes. OCS tries to always keep dialer’s
buffer full with the specified Maximum Queue Size.

IVR Profile

Optional; the default value is [Blank]. Specifies the IVR Profile that is
specified in the GVP EMPS IVR Profile. The ivr-profile-name option uses
the value specified in this field. See page 240 for more information about this
option.

Notes: * In an VoIP environment, OCS provides this IVR Profile to GVP in
the TMakePredictiveCall request before the GVP VXML
application is started for dialing the customer call.

* In an VoIP environment (Power GVP or Progressive GVP modes),
User Data associated with the customer call is delivered through
SIP messages.

Interaction Queue

Optional; the default value is [None]. Specifies a configuration object that is
created in the Scripts section in Genesys Administrator > Provisioning >
Routing/eServices by Interaction Routing Designer when developing a
Business Process to process outbound Preview mode interactions. For more
information, see the Universal Routing 8.0 Business Process User's Guide. An
Interaction Queue is used in Push Preview mode only.

Script

Optional; the default value is [None]. Defines the Script object that contains all
of the attributes that are required by Agent Scripting. For more information,
see the “Attaching Script Information to OCS User Events and Telephony
Events” section in the Outbound Contact 8.0 Reference Manual for more
information.
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Trunk Group DN DBID

Required only if you are using Outbound Contact in an Outbound VoIP
environment. If specified, OCS uses this DN as the DN from on behalf of
which outbound and engaging calls originate. The name of the Trunk Group
DN is the same as the partition-id value specified in SIP Server, which
determines the resource allocation for calls made from this Trunk Group DN.

Note: For additional information about configuring an Outbound-IP
environment, see “Outbound-VoIP in ASM Dialing Modes” on
page 91.

Minimum Record Buffer Size/Optimal Record Buffer Size

Required; the default value is [4] for Minimum and the default value is [6] for
Optimal. Acts as a multiplier for the number of agents that are available for a
campaign. Together, the Minimum and Optimal values determine how many
records OCS keeps in memory when performing traditional campaigns.
Because there might be no agents for the Push Preview and Power GVP dialing
modes, these parameters are used differently by OCS as a percentage of the
desired Maximum Queue Size value. For example, you can set them to Min:

100%, Opt: 150-200%.

Number of Channels

Identifies the maximum number of channels (or ports), that a Campaign Group
can use to place calls. This max number is used in: Progressive, Predictive,
Progressive with seizing, Predictive with seizing, and Progressive GVP dialing
modes.

Connection Section

The Connections section enables you to specify all server connections (besides
T-Server) that are required to run a dialing session for an outbound campaign
in a certain dialing mode for a particular Campaign Group.

Note: This type of connection provides basic host/port connectivity only. It
does not provide features such as Advanced Disconnect Detection
Protocol (ADDP). Also, you can add your application to the
Connections tab of the 0CS Application object in order to configure
any additional connection parameters.
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Outbound Contact
Configuration Options

This chapter describes each of the options that you can configure to ensure that
Outbound Contact performs as needed in your environment. It contains the
following sections:

«  Overview, page 201

«  Outbound Contact Manager Options, page 202

«  Outbound Contact Server Options, page 209

«  CPD Server Options, page 270

«  Changes from Release 7.6 to 8.0.x, page 312

Note: In Genesys Administrator, all Outbound Contact options that were
located on the Annex tab of the respective Outbound Contact objects,
are located on the Options tab.

Overview

In Outbound Contact, you define options at the Outbound Contact Server
(OCS) application level. You can also define options at the object level for
Switch, DN, Agent, Place Group, Calling List, and Campaign objects.
Defining the settings at the object level enables flexibility and fine-tuning for a
campaign setup.

OCS first reads the configuration options in the objects. If an option is not
defined at the object level, OCS checks the configuration at the application
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level. If the option is not specified at the application level, OCS uses the
default value for that option.

Note: When you make changes to an option, the changes take effect
immediately, unless otherwise noted in the option description.

Depending on the needs of the contact center configuration, the Outbound
Contact Administrator can choose to:

* Use default OCS options, if the contact center has no specific
requirements.

» Set options at the OCS application level, if the contact center requires
overriding of OCS settings.

* Set options at the level of a specific object, if the contact center has
specific needs for individual Switch, Agent, Place Group, or Campaign
objects.

OCS stores configuration options in section folders on the Options tab. The
Options tab contains the section folders and options for application objects in
OCS and CPD Server.

This chapter lists the section folders and options according to their general
function, and the name of the object.

Note: Logged data can be truncated to hide sensitive data in the logs by
configuring either the default-filter-type option or any of the
log-filter-data section options to a value other than copy. The
truncation is represented in the log by asterisks. For more information
about these options, see the “Common Configuration Options”
chapter in the Framework 8.0 Configuration Options Reference
Manual.

Outbound Contact Manager Options

Annex Tab

202

The following options are configured in the OCM Application object.

Notes: * Outbound Contact Manager 7.6 can be used with OCS and CPD
Server 8.0. However, OCM 7.6 does not contain any new features
introduced in Genesys Administrator 8.0.

* Genesys Administrator uses the default values specified in the
OCM application template, unless noted otherwise in this section.

The following options are configured on the Annex tab.
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Options Tab

Deployment Guide

AutoReconnect

Type: Optional

Default Value: false

Valid Value(s): true/yes, false/no
Changes Take Effect: Immediately

Determines if OCM performs an automatic reconnect procedure to a given
server. There are two values:

*  When the value of the option is true, OCM does not display the
reconnection dialog and immediately attempts the backup connection.

*  When this option is set to false or it is not present, OCM displays a
message box that provides you with the following choices:
+ Connect to backup (if available)
+ Reconnect to primary
+ Cancel
You can configure this option in the Annex tab of the 0CM Application object.
The Section name can contain the following values:
» DBServer for DB Server connections
* Config for all Configuration Server connections

e 0ocServer for OCS connections

Notes: * The Options tab cannot be used to configure this option.

* In Genesys Administrator, autoreconnect is used but the option
cannot be configured manually.

Security Section
The following option is configured in the security section of the Options tab.

inactivity-timeout

Type: Optional

Default Value: 0 (minutes)

Valid Value(s): Any non-negative integer (0—N)

Changes Take Effect: Immediately

Specifies the amount of time, in minutes, that Outbound Contact Manager
waits for activity before disabling a logged-in user who is not interacting with
the application. If this option is not present or if it is set to 8, OCM will not
disable the user due to an extended period of inactivity.
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OCManager Section

The section folder 0CManager, on the Options tab of the OCM Application
object, stores the options for Outbound Contact Manager (OCM).

addp

Type: Optional

Default Value: false

Valid Value(s): yes/true/on or no/false/off
Changes Take Effect: Immediately

Specifies whether or not Advanced Disconnect Detection Protocol (ADDP)
should be enabled between OCM and any DB Server to which OCM connects.

If set to yes, true, or on, ADDP is enabled.
If set to no, false, or off, ADDP disabled.

addp-timeout

Type: Optional

Default Value: @ (zero seconds)
Valid Value(s): Any positive integer
Changes Take Effect: Immediately

Specifies the timeout in seconds between poll messages. If this option is set to
0 (zero), no disconnection occurs, even if there is no activity.

addp-remote-timeout

Type: Optional

Default Value: @ (zero seconds)
Valid Value(s): Any positive integer
Changes Take Effect: Immediately

Specifies the timeout in seconds between remote poll messages. If this option
is set to 0 (zero), no disconnection occurs, even if there is no activity.

addp-trace

Type: Optional

Default Value: false

Valid Value(s): off/false/no or Llocal/on/true/yes or remote or full/both
Changes Take Effect: Immediately

Specifies the trace (log output) mode for both applications involved in ADDP
messaging.

If setto off, false, or no, there is no trace in the log files.
If set to Llocal, on, true, or yes, a trace occurs on local side only.

If set to remote, a trace occurs on the remote side only.
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If setto full or both, a full trace occurs on both local and remote sides.

Note: The option settings Local or full do not enable the tracing on the local
(OCM) side. OCM is not a server application, and it does not have any

logging.

asm

Type: Optional

Default Value: no/false

Valid Value(s): yes/true or no/false
Changes Take Effect: On restart

Enables or disables Active Switching Matrix (ASM) mode in OCM.

If set to yes or true, ASM mode is enabled in OCM. When a dialing session for
campaign group is loaded, the user can select one of the following dialing
modes: Predictive with seizing, Progressive with seizing, or Preview.

If set to no, false, or if not specified, ASM mode is disabled in OCM. When a
dialing session for a campaign group is loaded, the user can select one of the
following dialing modes: Predictive, Progressive, Preview, Push Preview, or
Power GVP.

Note: This setting takes effect when OCM starts. If you change this option’s
setting, you must restart OCM, or you must close and reopen a
session.

db_timeout

Type: Optional

Default Value: 60 (seconds)

Valid Value(s): Any positive integer
Changes Take Effect: Immediately

Specifies the timeout, in seconds, for the DB Server operation. This option is
particularly useful when the Modify All operation is applied to calling lists
containing 15,000 or more records.

<any string that is a “Field Type” attribute>
Type: Optional

Default Value: none

Valid Value(s): Any regular expression

Changes Take Effect: Immediately

Enables you to add various configuration options for validating or restricting
the values entered into fields. A regular expression is a pattern of text that
consists of ordinary characters and special characters. Go to the Microsoft
website and enter the search phrase “Regular Expression Syntax” for more
information about regular expressions.
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The values that you assign to the configuration option must be in the same
format as the regular expression. The regular expression indicates the
characters that are acceptable as input into the field.

For example, if you want the contact_info field to accept only numbers 0
through 9, commas, and pound (#) signs, you would add the following option:

Contact Info ="[0-9, #]+$

When you add a configuration option, the name that you assign to it must be
identical to the name of the field type that appears in Genesys Administrator
that requires the validation.

For example, the field type Contact Info indicates that the contact_info field
stores contact information.

For information about field types, see Genesys Administrator Framework 8.0
Genesys Administrator Help.

force_unload_timeout

Type: Optional

Default Value: 5 (seconds)

Valid Value(s): Any positive integer of 5 or more

Changes Take Effect: After OCM restarts.

Specifies the timeout, in seconds, between when OCS is requested to unload a
dialing session for a campaign or a campaign sequence, and when the
Unloading status and the Force Unload command become available in Genesys
Administrator or OCM’s Graphical User Interface.

Note: This timeout cannot be shorter than 5 seconds. If this option is set to
less than 5 seconds, Genesys Administrator or OCM automatically
increases the value to 5 seconds.

rej-file-path

Type: Optional

Default Value: . (the current directory)

Valid Value(s): Any valid path to the directory in which *.rej files will be
stored

Changes Take Effect: Immediately

Specifies the storage location path to the log files ({calling List name).rej)
that are created when records are imported or exported. If the option is set to a
period (.), the default value, or to an empty string, the files are stored in the
same directory as the OCM executable. You can specify either an absolute or a
relative path to the directory. The option value should include the path to the
directory but not the log file name. The user must also have write permissions
to the specified directory.
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Two option value examples include:
C:\RejFiles\
..\RejFiles\

rej-file-path
rej-file-path

Note: This option was added in OCM release 7.6.101.07.

OCManager Section—Options for Record Prioritization

The following options control record-type prioritization:
* record_priority
e default_general_priority

e default_campaignrescheduled_priority
default_campaigncallback_priority

Note: In Genesys Administrator, you can configure priorities for General,
Campaign Rescheduled, and Campaign CallBack record types in the
Operations > Outbound Contact > Campaign Groups > Priorities
tab.

Dynamic Modification

At start-up, OCM sets the prioritization parameters for all campaigns and
sequence items that are not configured. After that, the user can change these
values for each campaign individually.

When either Campaign details or Group details is selected, the dialog box
appears on the Priority pane in the lower-left corner of the OCM user
interface. If the user assigns an incorrect value or a @ (zero), the dialog box
displays the value in red text.

Note: OCM supports dynamic modification of the parameters for
stand-alone campaigns. If you assign dynamic modifications to
individual campaigns, these values apply only during the time that
OCM is running. Changing the priorities in the dialog box does not
change the default values for OCM at start-up. The default values are
persistent in the Configuration Database.

record_priority

Type: Optional

Default Value: no/false

Valid Value(s): yes/true or no/false

Changes Take Effect: Immediately

Specifies whether Outbound Contact Manager sends priority-related

parameters to Outbound Contact Server when sending
Load/Start/0OptimizationModeUpdate requests.
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If set to yes, true, or on, OCM passed the priority parameters for the given
Campaign Group or a sequence item to OCS.

If setto no, false, oroff, OCM does not pass the priority parameters to OCS.

This option controls the optional Priority dialog box in the OCM user
interface.

If set to yes, true, or on, the Priority dialog box is displayed.
If set to no, false, or of f, the Priority dialog box is not displayed.

default_general_priority

Type: Optional

Default Value: 1; 2

Valid Value(s): Any two non-negative integers separated by a semicolon:
<an integer Llarger or equal to 0>;<an integer larger or equal to 0>
Changes Take Effect: Immediately

Specifies the priority of record types and the number of records to fetch for
dialing.

The two numbers that make up this option’s value are separated by
semicolons, and they represent two parameters: priority and n_records.

The first number defines the priority of the record_type; the second number
specifies the number of records of this type to fetch from the buffer for dialing.

* In the priority parameter—The value 1 is the highest priority; 0 (zero) means
do not dial. The recommended values for priority are 0, 1, 2, or 3.

* Inthe n_records parameter—A valid value is any positive number or 0. 0
(zero) means do not dial.

OCS does not dial the record types with a @ (zero) value for any parameter. If
the user assigns an incorrect value or a 0 (zero), the dialog box displays the
values in red text.

default_campaignrescheduled_priority

Type: Optional

Default Value: 1;1

Valid Value(s): Any two non-negative integers separated by a semicolon—
<an integer Llarger or equal to 0> ;<an integer Llarger or equal to 0>
Changes Take Effect: Immediately

Specifies the priority of record types and the number of records to fetch for
dialing.

The two numbers that make up this option’s value are separated by
semicolons, and they represent two parameters: priority and n_records.

The valid values for this option are similar to the default_general_priority
option.
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default_campaigncallback_priority

Type: Optional

Default Value: 1; 1

Valid Value(s): Any two non-negative integers separated by a semicolon—
<an integer larger or equal to 0>; <an integer larger or equal to 0>
Changes Take Effect: Immediately

Specifies the priority of record types and the number of records to fetch for
dialing.

The two numbers that make up this option’s values are divided by semicolons,
and they represent two parameters: priority and n_records.

The valid values for this option are similar to the default_general_priority
option.

Outbound Contact Server Options

The Outbound Contact Server options are defined in various configuration
objects. These option descriptions are organized according to configuration
objects in the following subsections:

*  “OCS Application Object Options™ on page 211

e “Multi-Level Options for OCS” on page 219

* “Host-Level Options for OCS” on page 222

*  “Campaign-Level Options for OCS” on page 222

*  “Campaign Group-Level Options for OCS” on page 226
*  “Place Group-Level Options” on page 257

* “Field-Level Options for OCS” on page 258

e “Calling List-Level Options for OCS” on page 259

» “Switch-Level Options for OCS” on page 264

*  “DN-Level Options for OCS” on page 269

Section Names

Deployment Guide

The Options tab of the configuration object needs to contain a section that is
named in one of the following ways:

¢ <0CS application object name>, which specifies the name of the current
OCS Application object.

e default.
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0CServer.

Note: Genesys recommends that you define all OCS options only in the
section folder named 0CServer.

When OCS looks for the defined value of an OCS option, it searches the
sections in a prescribed order until it finds the option in one of the sections.

The prescribed search order is the following:

1.

OCS searches the designated sections on the Options tab of the
configuration object, as follows:

a. <0CS application object name> section
b. default section
c. 0CServer section

If OCS does not find the option, it follows the same procedure to search in
the Options tab of its own Application object.

If OCS does not find the option, it uses the option’s default value.

Example of an OCS Option Search

In this example, two different OCS applications (OCS1 and OCS2) work with
the same switch. The options for each OCS application are defined on the
Options tab of the switch configuration object or on the Options tab of the OCS
Application object.

OCSI is searching for the outbound_release_action option.

1.

2.

3.

Options tab of the Switch object:

a. OCSI searches for the outbound_release_action option in the OCS1
section.

b. If the option is not in the OCSI section or if there is no section named
OCS1, OCSI1 searches for the option in the section named default.

c¢. Ifthe option is not in the default section, or if there is no section
named default, OCS1 searches for the option in the section named
0CServer.

Options tab of OCS:

If OCS1 does not find the outbound_release_action option in any of the
three sections on the Options tab of the Switch object, it searches the
Options tab of its own Application object, repeating the search process that
it performed on the Options tab of the Switch object.

Other:
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If OCS1 does not find the outbound_release_action option on either
Option tab, it uses the option’s default value (false).

Note: Most Outbound Contact Server options are dynamic. This means that
the application does not have to be restarted in order for option
changes to take effect, unless otherwise noted in the option
description.

OCS Application Object Options

Deployment Guide

asm_drop_announcement_data
Type: Optional

CPD Server SIP Server
Type: Optional Optional
Default Value: An empty string (") none
Valid Value(s): Path to the voice file A prompt ID for an
(including the name) in the =~ announcement, as configured
VOX format (string) in GVP Media Control
Platform

Specifies the message to be played before releasing the established customer
call in the ASM modes.

If the established customer leg of the call has to be released by CPD Server or
SIP Server (in an Outbound-IP environment) because it could not be bridged
with the agent engaging call leg, a predefined announcement to the customer
can be used before the call is released.

The values are as follows:

* (For CPD Server) The full name (including the path) to the file (in the
VOX format) with the announcement that OCS provides to CPD Server for
all call results.

Note: CPD Server must be able to access this network path so that this
file can be used.

+ Ifno value is specified, OCS does not add the 0CS_DROP_ANNOUNCE _DATA
attribute to the extensions parameter of the Outbound Contact Server
RequestMakePredictiveCall event.

+ Ifavalue is specified, the full path to the voice file will be used by
CPD Server in the following extensions parameter of the Outbound
Contact Server RequestMakePredictiveCall event:

OCS_DROP_ANNOUNCE_DATA
Data Type: String

Contains the full name of the voice file in .vox format.
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CPD Server will play the specified file before releasing the established
customer call. If CPD Server successfully opens the file specified in
the 0CS_DROP_ANNOUNCE _DATA attribute, it prints a dx_playvox success
message to the log file. If there was an error, a dx_playvox fai led
message is printed in the log file.

* (For SIP Server) The Prompt ID for the announcement, as configured in
GVP Media Control Platform. For more information on the Prompt ID, see
the GVP documentation.

This option can be used with the asm_drop_am_announcement_data option
(see page 229). The asm_drop_am_announcement_data option instructs OCS
to play the same announcement for Answering Machine call results, while
the asm_drop_announcement_data option instructs the component to the
same announcement for all other call results.

Note: When using Trunk Group DNs in an Outbound-IP environment,
OCS uses the standard TApplyTreatment event with a MUSIC_DN
parameter, according to SIP Server requirements. In this scenario,
OCS releases the call only after the announcement is played,
which occurs when it has received EventTreatmentEnd from SIP
Server.

check_dnc_callback

Type: Optional

Default Value: no/false

Valid Value(s): yes/true or no/false
Changes Take Effect: Immediately

Enables or disables a special predial check of callback records against the Do
Not Call (DNC) List. This option applies to the Personal CallBack, Campaign
CallBack, and Personal Rescheduled record types. The value set for this option
determines whether a scheduled call is processed or not processed, depending
at which time the DNC restriction was applied.

If the option is set to yes or true, OCS identifies the record type and, after
comparing the timestamps, determines whether the DNC restriction was
applied after or before a customer agreed to a scheduled call from an agent:

» If after, OCS processes the call.
» If before, OCS does not process the call.
See also “DNC Rule for Scheduled Calls”.

This option works only if the check_dnc_List option is set to true. If you set
check_dnc_callback to true, it may override check_dnc_Llist = true for the
Personal CallBack, Campaign CallBack, or Personal Rescheduled records,
based on the timestamp comparison.

Outbound Contact 8.0 @



Chapter 9: Outbound Contact Configuration Options Outbound Contact Server Options

DNC Rule for Scheduled Calls

The purpose of the Do Not Call (DNC) rule for scheduled calls is to determine
whether a Personal CallBack, Campaign CallBack, or Personal Rescheduled
record can be dialed even though the phone number or customer ID on the
record is on the DNC List. The callback might be permissible, for example, if
both of the following conditions are met:

* The check_dnc_callback option is set to true, which enables OCS to
perform a predial check of callback type records.

* The customer had requested a callback before submitting a DNC request.
The algorithm for the predial check is as follows:

1. OCS checks the DNC List to determine whether the record to be dialed is on
it.
2. Ifyes, OCS reads the value of the check_dnc_cal Lback option:

« Ifcheck_dnc_callback = false, OCS marks the record DNC. End of
predial check.

+ Ifcheck_dnc_callback = true, OCS continues the predial check.

3. OCS checks the record type:

+ Ifthe record type is not a callback, OCS marks the record DNC. End of
predial check.

+ Ifthe record type is Personal CallBack, Campaign CallBack, or
Personal Rescheduled, OCS continues the predial check.
4. OCS checks the time stamp:

+ If the timestamp of the original call (when the callback was scheduled)
precedes the timestamp of the DNC request, OCS will dial the callback
record. End of predial check.

+ It the timestamp of the original call does not precede the timestamp of
the DNC request, OCS will not dial the callback record. End of predial
check.

Figure 14 shows the algorithm for the DNC rule for scheduled calls.
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Pre-Dial check

Phone or CustomerID in DNC list

theck_dnc_ca

back = true Mark in DB: No Call

Is record_type in

PersonalReschedule? Mark in DB: No Call

End

Call-time <
dnc.timestamp

Mark in DB: No Call

End

@4

Dialing

Figure 14: DNC Rule for Scheduled Calls

customer_id

Type: Optional

Default Value: An empty string

Valid Value(s): <The name of a user-defined field in the calling list to
serve as a customer identifier)

Configuration Level: Campaign / Application
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Specifies a user-defined field in the Calling List table that will serve as a
customer identifier.

When this option is not present in the Application object, or if the value of this
option is the name of a field that does not exist in the Calling List table, OCS
uses the phone number in order to determine which records cannot be dialed.

Note: ° Configuring customer ID at the Campaign level allows you to
define distinct customer ID fields for different campaigns.

* The Field configuration object that is used as the value for the
customer_id option must specify the send_attribute key-value pair
listed on its Options tab. The section name is created according to
the section naming convention that is described on page 209. The
value of the send_attribute key-value pair must be
6SW_CUSTOMER_ID. For more information, see “Attaching Record
Information to Desktop and OCS User Events” in the Outbound
Contact 8.0 Reference Manual.

* This option can be used to identify customer for both Do Not Call
requests and Record cancellation requests. For more information
about its use for Do Not Call requests, see “User-Defined Field for
Do Not Call” on page 383. For more information about its use for
Record Cancellation requests, see “Record Cancellation Requests
and Customer ID” on page 177.

inbound-agent-assignment-priority
Type: Optional

Default Value: 0

Valid Values: @ ... n

Changes Take Effect: Immediately

Defines the priority of inbound call activities. It is used when determining
agent reassignment. As the value increases, the priority for the specified agent
also increases.

inbound-agent-assignment-min-num
Type: Optional

Default Value: 0

Valid Values: 0 ... n

Defines the minimum amount of agents to perform inbound call activities. It is
used when determining agent reassignment.

When the value is set to @, there are no restrictions for the minimum amount of
agents performing inbound call activities. Agents are assigned to inbound call
activities even when the lowest priority Campaign Groups are understaffed.
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num-of-licenses
Type: Optional
Default Value: 0 (all available licenses)

Valid Value(s): The string max or an integer from 0 to (9999 +
num-sdn-Licenses)

Specifies how many licenses OCS checks out initially. This option is not
OCS-specific. It is specified in the License section. This option, along with the
License-file option, pertains to OCS license control. When the value
increases, OCS will apply the change immediately. When the value decreases,
it will take effect the next time OCS is started.

license-file

Type: Required

Default Value: None

Valid Value(s): Any string

Specifies the license address. This option is not OCS-specific. It is specified in
the license section, which is optional. This option, along with the
num-of-Licenses option, pertains to OCS license control.

The license address format can be entered in either of the following formats:

* The host name and port of the license server, as specified in the SERVER
line of the license file, in the port@host format; for example,

7260ectiserver.
* The full path to, and the exact name of, the license file - for example,
/opt/mlink/license/license.dat.

Note: Changes that you make to this option take effect after an
application is restarted.

log_call_stats

Type: Optional

Default Value: no

Valid Value(s): yes/true or no/false
Changes Take Effect: Immediately

Specifies whether to create a separate logging subsystem.

* Ifyou set this option to yes or true, OCS creates a separate logging
subsystem for Audit Logging, in order to capture additional statistics on
telephony events.

The separate log file is created in the same directory where the OCS
application resides. OCS does not overwrite the existing data in this log or
replace it with new data. The Audit Logging function adds data to a
cumulative log. When the size of this log file reaches 10 MB, a new log
file of the same type is created.
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* Ifyou set the option to no, false, or if the option is not present, OCS
does not create the separate logging subsystem.

snapshot_interval

Default Value: 600 (seconds)
Valid Value(s): Any positive integer
Changes Take Effect: Immediately

Defines the time interval, in seconds, between delivering snapshot statistics to
Interaction Concentrator (ICON).

user_data_section_name

Type: Optional

Default Value: None

Valid Value(s): Any valid name for a configuration section

Enables you to attach additional information as a permanent key-value pairs to
the UserData attribute for dialing requests, preview records, or interactions.

The value of this option identifies the name of a section that you created on the
Options tab of the following configuration objects:

* Calling List

* Campaign Group

* Campaign

* Agent Group or Place Group
* Switch

* OCS application

OCS searches these configuration objects for a section with this value. When
found, OCS attaches any options that are specified within the section as
key-value pairs to the UserData attribute for all dialing requests, preview
records, or interactions that are associated with the configuration object.

The configuration object that you choose depends on the desired level of
distribution:

*  When you specify an option value that is the section name for a Calling
List object, the specified data is attached only to calls for that calling list.

*  When you configure this option for a Campaign Group object, the specified
data is attached to calls for all calling lists in the Campaign Group.

You can explicitly identify the type of data to be attached by adding a specifier
as a prefix to the data (that is, the option's value) for the options listed under
the section name identified by the user_data_section_name option. When OCS
finds these specifiers, it converts the data to the specified type. The 4-character
specifier, however, is removed from the resulting data.
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The type-specifier descriptions are as follows:

* str:—All characters following this specifier are attached as a string. The
value can consist of any characters. (Example: By specifying str:String
example 123, the string value String example 123 is attached.)

* int:—OCS converts the value that follows this specifier to an integer. The
value should consist of digits (0 through 9) only and not exceed the
maximum integer supported by the operating system where OCS is
running. (Example: By specifying int:2563, the integer value 2563 is
attached.)

* bin:—OCS converts the value that follows this specifier to a binary type.
The value should consist of pairs of hexadecimal numbers separated by

spaces. (Example: By specifying bin:0A 0D 22 13 33 FF, the binary value
0A @D 22 13 33 FF is attached.)

Note: If no type specifier is included in the data value, the user data pair is
attached as a string.

Configuration Example

The following example clarifies the relationship between the
user_data_section_name option and configuration object sections associated
with attaching User Data.

If you do the following:

* Configure a section named userdatalist on the Options tab of the Calling
List object.

*  Within that userdatalist section, configure:
+ an key-value pair: name=str:premier
+ an key-value pair: acct=int: 1234

* Configure the user_data_section_name option with a value of userdatalist
in the Options tab of the OCS application object.

When OCS starts processing a specific chain, it searches for the userdatalist
section among the configuration objects, and when it finds this section name, it
attaches the two key-value pairs to the User Data for all dialing requests,
preview records, and interactions associated with this Calling List object. The
pair with the acct key is attached with the integer value of 1234. The pair with
the name key is attached with a string value of premier.

How OCS Prioritizes If Different Configuration Objects Contain the Same Section

If there are different configuration objects that contain options in the same
named sections with the same key and different values, OCS chooses only one
of them, according to the following priorities:

* Calling List (highest priority)
¢ Campaign Group

¢ Campaign
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* Agent Group or Place Group
* Switch
* OCS application (lowest priority)

If there are several configuration objects that are used in a particular campaign
with options that contain different keys, OCS attaches all of these options as a
list of key-value pairs in the UserData attribute.

If you want to indicate that a particular outbound campaign has a higher
priority than other campaigns, you can attach a campaign_priority = high
key-value pair to every call or preview record that OCS generates while
running the dialing session for this campaign. As an example, you can perform
the following steps if you want to configure a Campaign Group to run a dialing
session/campaign called Collections90days that uses an OCS application
called 0CS Western Region:

1. Choose a section name to store the data that you want to attach, such as
collection_options.

2. Create a section with this name on the Options tab of a Campaign Group
configuration object. In this section, add an option specifying the key as
campaign_priority and the value as high.

Note: If more than one dialing session/Campaign Group is going to run
this campaign, configuration objects representing all these
Campaign Groups should have this configuration.

3. Configure the user_data_section_name option and set the value to
collection_options in the 0CServer section of the Options tab of the 0CS
Western Region application object.

Multi-Level Options for OCS

Deployment Guide

dynamic-port-allocation

Type: Optional

Default Values: false/no

Valid Values: true/yes, false/no

Changes Take Effect: Immediately

Configuration Level: Switch / OCS Application / CPD Server Application

Defines whether the dynamic ports allocation is in effect for the Campaign
Groups that dial through a specific Switch (when OCS sends dial requests to
T-Server) or through a specific CPD Server or Proxy (when OCS sends dial
requests to CPD Server or Proxy). The level of the configuration is very
important for this option. For Campaign Groups that use a T-Server associated
with a specific Switch, it should be configured at that Switch or the OCS
Application level. For Campaign Groups that share the same CPD
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Server/Proxy, it should be configured at the CPD Server or Proxy Application
level.

When the value of this option is set to true, OCS performs a dynamic
allocation of ports for all the Campaign Groups that use the corresponding
Switch or CPD Server/Proxy and have the Number of CPD ports property set to
0. This property is defined on the Advanced tab of the Campaign Group
configuration object in Configuration Manager. When the value of this option
is set to false, OCS does not perform dynamic port allocation among any
Campaign Groups and all ports are assigned statically.

OCS dynamically allocates the total number of ports only among running
Campaign Groups. To retain static allocation and reserve ports for specific
Campaign Groups, the Number of CPD ports property for these Campaign
Groups should be set to a value that is greater than 0. As such, the total
number of dynamically allocated ports for Campaign Groups is the total
number of ports available for the corresponding Switch or CPD Server or
Proxy minus the sum of ports reserved for running Campaign Groups with a
static allocation of ports.

If OCS dials through T-Server and the dynamic-port-allocation option is
defined at the Switch level, the total number of available ports is taken from
the channel_num option (see page 264) that is specified in the Annex tab of the
Switch object. If OCS dials through CPD Server/Proxy, OCS receives the total
number of available ports directly from CPD Server or Proxy. In the latter case,
the number of available ports is defined by the CPD Server or Proxy
configuration.

To protect Campaign Groups with small estimated numbers of required ports
relative to other Campaign Groups, OCS uses these small estimated values as
the maximum number of available ports, without further scaling these
numbers. OCS considers the estimated number of ports to be small if this
number is less than 30 percent (%) of the average ports distributed between all
participating Campaign Groups.

When the dynamic-port-allocation option is set to false, OCS uses a static
allocation of ports in accordance with the Number of CPD ports Campaign
Group property and the asm_channel_num option for all Campaign Groups that
share the corresponding Switch or CPD Server/Proxy.

For more information about the asm_channel_num option, see the option
description on page 228 and “Separate Tracking of Engaging CPD Ports” on
page 69.

pre-dial-validation

Type: Optional

Default Value: false

Valid Values: true/yes or false/no
Changes Take Effect: Next dial attempt

Configuration Levels: Individual Record / Calling List / Campaign / OCS
Application
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Specifies whether pre-dial validation is in effect or not for the given record.
When set to true, OCS performs pre-dial validation of the record, for
example, it delivers an HTTP P0OST request to the Web or Application Server,
waits for the response and then, processes the response. When set to false,
OCS starts dialing the record without the pre-dial validation step.

Note: Setting this option at the individual record level requires the use of
an SCXML treatment script. For a complete description, see
“SCXML-Based Treatments” on page 357. See also the
sample06.scxml sample script, which can be found in the OCS
installation folder, in the scxml_samples subfolder.

validation-uri

Type: Optional

Default Values: Empty string

Valid Values: String representing URI of the Web or Application Server, in the
following format: httpl[s]://< host)>:< port)/<path to pre-dial validation
resource)

Changes Take Effect: Next dial attempt

Configuration Level: Calling List / Campaign / OCS Application

Defines the URI of the pre-dial validation processing engine. Supported
schemes are HTTP and HTTPS. The Port part of the configuration is optional
and defaults to 80 for HTTP and 443 for HTTPS schemes.

Note: For pre-dial validation to take place, this option must be set to a
non-empty string (valid URI).

validation-timeout-call-result

Type: Optional

Default Values: 3 (General error)

Valid Values: Positive integer, call result enumeration value (as defined in the
“Call Result Types” table in the Outbound Contact 8.0 Reference Manual).
Changes Take Effect: Next dial attempt

Configuration Level: Calling List / Campaign / OCS Application

Specifies the call result value that is assigned to the dial attempt if pre-dial
validation is turned on and OCS does not receive HTTP response for the
validation request within the specific timeout (defined via the
http-response-timeout option, [see page 222]). In case of the timeout, OCS
does not dial the record and attempts to apply the treatment to call result as
defined by this option.
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Host-Level Options for OCS

http-response-timeout

Type: Optional

Default Values: 3000

Valid Values: Positive integer (milliseconds)
Changes Take Effect: Next dial attempt
Configuration Level: Host / OCS Application

Defines maximum time (in milliseconds) that OCS will wait for the response
from the Web or Application Server for its request for pre-dial validation or
SCXML document.

Note: OCS parses the URI and detects the name of the host at which Web or
Application Server is to be contacted. OCS then attempts to find a
host configuration object with the name that exactly matches the host
setting from the URI. If found, OCS attempts to read this option from
the Annex of the host configuration object. If not found, OCS reads
this option from the OCS Application object.

http-connection-pool-size

Type: Optional

Default Value: 64

Valid Values: Positive integer (number of connections)
Changes Take Effect: Next dial attempt

Configuration Level: Host / OCS Application

Defines the maximum number of simultaneous connections to the Web or
Application Server running on the specified host at the specified port number.

Note: OCS parses URI and detects the name of the host at which Web or
Application Server is to be contacted. OCS then attempts to find the
host configuration object with the name that exactly matches the host
setting from the URI. If found, OCS attempts to read this option from
the Annex of the host configuration object. If not found, OCS reads
this option from the OCS Application object.

Campaign-Level Options for OCS
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You can set the Campaign level options at the Options tab of Campaign
configuration object, using 0CServer, default or <OCS Application name)
section names.

Alternatively, you can set these options in the 0CS application object. Changes
that you make to these options take effect immediately, unless otherwise noted
in the option description.
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OCS can work with many Campaigns. At the Campaign level, you can assign
different values for each Campaign. When set on the Options tab on the
application level, the value applies to all Campaigns.

OCS looks first at the Campaign-Level, and the option setting at this level
overrides the value on the OCS application object Options tab.

callback-observe-group

Type: Optional

Default Value: no/false

Valid Value(s): yes/true or no/false

Changes Take Effect: Upon loading of the Campaign Group

Specifies whether OCS should select Personal Callbacks and Personal
Rescheduled records from the Calling Lists based on both the Campaign DBID
and the Group DBID or just the Campaign DBID. If these records are selected
based on both DBIDs, then it is guaranteed that they will be processed by the
same group to which the agent belonged when these records where initially
scheduled.

*  When set to true, OCS selects them based on the Campaign DBID and the
Group DBID.

*  When set to false, OCS selects them based on the Campaign DBID only.

Note: In a scenario in which one or more Campaign Groups share the same
Campaign, and thus the same Calling Lists, OCS updates the group_id
field in the list with the current Group DBID, in addition to the
campaign_id, when records are marked as Retrieved. The ability to
identify the Campaign Group name associated with personal records is
only available for Calling Lists that have the group_id field included
in the format. To maintain backward compatibility with Calling Lists
using format 6, OCS checks the format for the group_id field and the
callback-observe-group option. If format 6 is being used, the
group-id field is not updated and OCS ignores this option value.

check_dnc_list

Type: Optional

Default Value: yes/true

Valid Value(s): yes/true or no/false
Changes Take Effect: Immediately

Enables or disables a predial check against the Do Not Call list for all types of
records.

* Ifyou set this option to yes or true or if the option is not defined in the
configuration, OCS performs a predial check against the Do Not Call
(DNC) List.
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» Ifthis option is set to no or false, OCS dials without performing a predial
check.

Note: When set to false, OCS also does not check any records that are
already delivered to an agent's desktop against the phone number (or
customer_id) in the newly submitted request (by phone or
customer_id respectively). Therefore, OCS does not issue a
RecordCancel notification to the desktop.

customer_id

Type: Optional

Default Value: An empty string (')

Valid Value(s): <The name of a user-defined field in the calling List to
serve as a customer identifier)

Configuration Level: Campaign / Application

Specifies a user-defined field in the Calling List table that will serve as a
customer identifier.

When this option is not present in the App Lication object, or if the value of this
option is the name of a field that does not exist in the Calling List table, OCS
uses the phone number in order to determine which records cannot be dialed.

Note: ° Configuring customer ID at the Campaign level allows you to
define distinct customer ID fields for different campaigns.

» The Field configuration object that is used as the value for the
customer_id option must specify the send_attribute key-value pair
listed on its Options tab. The section name is created according to
the section naming convention that is described on page 209. The
value of the send_attribute key-value pair must be
GSW_CUSTOMER_ID. For more information, see “Attaching Record
Information to Desktop and OCS User Events” in the Outbound
Contact 8.0 Reference Manual.

* This option can be used to identify customer for both Do Not Call
requests and Record cancellation requests. For more information
about its use for Do Not Call requests, see “User-Defined Field for
Do Not Call” on page 383. For more information about its use for
Record Cancellation requests, see “Record Cancellation Requests
and Customer ID” on page 177.

force-unload-wait-db

Type: Optional

Default Value: false

Valid Value(s): true/yes or false/no

Changes Take Effect: The next time that the dialing session for this campaign
is unloaded forcefully
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Controls how OCS handles requests for a records update sent to the database
when a dialing session for the campaign is unloaded forcefully.

*  When set to false/no, OCS does not wait for a database response for the
records update request and terminates the connection to DB Server
immediately after the last update request is sent. This ensures that the
dialing session/campaign group is forcefully unloaded almost immediately.
However, this may cause some records to be left in the Retrieved state,
even though OCS has requested that those records be returned to either the
Ready state or marked as Stale.

*  When set to true/yes, OCS waits for database responses for all update
requests that were sent before terminating the connection to DB Server.
This ensures that all records are updated properly in the database.
However, this may slow down the forced unloading process and keep the
dialing session/campaign group in an Unloading state longer, depending on
the number of calling list records in the OCS buffers. OCS holds these
records in the buffers to properly mark them when unloading a dialing
session/campaign group.

Note: This is a new option for OCS 7.6.101.

ignore-empty-group

Type: Optional

Default Value: false

Valid Values: true/yes or false/no

Changes Take Effect: Immediately

Specifies how to handle record processing when no agents are logged into

group.

*  When the value is set to false, OCS functions as it did previously and
retrieves callback/rescheduled records when the scheduled time
approaches, regardless of agent availability, and does not return any
records back to the database when a group becomes empty.

e When the value is set to true, OCS behaves as follows:

+  When the last agent logs out of the group, OCS returns all records
retrieved for the Campaign Group back to the calling list with the Ready
status.

+  When there are no agents logged into the group, no records of any type
are retrieved for the Campaign Group.

treatment-preferred-contact-field

Default Value: none
Valid Value: The name of the field in the Calling List table
Changes Take Effect: At the next treatment application
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Defines the field name in the Calling List table that OCS uses for the given
record to determine if this record in a chain should be used for the first chain
dial attempt.

When the specified field exists and is not an empty string (for char/varchar
field data types) or not zero (for integer field data types), OCS assumes that the
associated record has a priority within the chain. If multiple records within the
same chain satisfy the criteria for priority, OCS uses the first record found.

Note: You can also configure this option at the Calling List Level. If
configured at the Calling List Level and the Campaign Level, the
Calling List Level takes precedence.

Campaign Group-Level Options for OCS

226

You can set the Campaign Group level options on the Options tab of Campaign
Group configuration object, using 0CServer, default, or <0CS Application
name) section names.

Alternatively, you can set these options in the 0CS application object. Changes
that you make to these options take effect immediately, unless otherwise noted
in the option description.

OCS can work with many agent or place groups. At the group level, you can
assign different values for each group. When set on the Options tab, the value
applies to all groups.

OCS looks first at the Campaign Group-Level, and the option setting at this
level overrides the value on the OCS application object Options tab.

agent-assignment

Type: Optional

Default Value: no/false

Valid Values: yes/true or no/false

Controls the ability of the Campaign Group to be used in agent reassignment.
The value no/false is used for Campaign Groups that have calls distributed by
the switch and not distributed by Universal Routing Server.

Note: Unlike other options in this section, this option can be configured only
in the Campaign Group-Level section.

agent-assignment-priority
Type: Optional

Default Value: 1

Valid Values: 1 - n
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Defines the priority of the Campaign Group when determining agent
reassignment. As the value increases, the priority for the specified Campaign
Group also increases.

Note: Unlike other options in this section, this option can be configured only
in the Campaign Group-Level section.

agent-assignment-min-num
Type: Optional

Default Value: 0

Valid Values: 0 - n

Defines the minimum number of agents in the Campaign Group when
determining agent reassignment.

When the value is set to 0, there are no restrictions for the minimum amount of
agents in the Campaign Group. Agents are assigned to this Campaign Group
even when the lowest priority Campaign Groups are understaffed.

Note: Unlike other options in this section, this option can be configured only
in the Campaign Group-Level section.

agent-assignment-max-num
Type: Optional

Default Value: 0

Valid Values: 0 - n

Defines the maximum number of agents in the Campaign Group when
determining agent reassignment.

When the value is set to 0, there are no restrictions for the maximum amount of
agents in the Campaign Group.

Note: Unlike other options in this section, this option can be configured only
in the Campaign Group-Level section.

agent_logout_preview_call_result
Type: Optional

Default Value: -1

Valid Values: -1, 0, 1,...n

Enables OCS to change the call result for Preview, Personal CallBack, or
Campaign CallBack records that are on an agent’s desktop after receiving an
EventAgentLogout message from Stat Server.

When the value is -1, OCS updates the record with the previous call result.
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When the value is greater than or equal to 0, OCS updates the record in the
database table with the integer value of this option. For Genesys Administrator
to display the call result as a string, the integer value of this option must match
a call result enumeration value listed in the Outbound Contact 8.0 Reference
Manual.

agent_preview_mode_start
Type: Optional

Default Value: no/false

Valid Value(s): yes/true, no/false

Controls whether agents must send the PreviewDialingModeStart event before
they can receive preview records or callbacks. If set to true, before sending a
personal or group callback, OCS checks the agent’s status to see whether his or
her desktop sent PreviewDialingModeStart.

am-beep-detection

Default Value: no/false
Valid Values: yes/true, no/false
Changes Take Effect: Immediately

Specifies whether GVP is forced to detect an answering machine beep tone
before playing music or starting the VXML application in Outbound VoIP
dialing modes.

When set to true, GVP delays playing music or starting the VXML
application until the beep tone is detected.

When set to false, GVP starts playing music or executing the VXML
application immediately after the answering machine is detected. This may
result in the message being played before the beep tone, which is the indication
for the answering machine to start recording. Depending on the length of the
message, the answering machine may not record all or any of the message.

asm_channel_num

Type: Optional

Default Value:0

Valid Values: 0 or a positive integer less than the Number of CPD Ports
property of the Campaign Group

Changes Take Effect: Immediately

Configuration Level: Campaign Group

Specifies the maximum number of engaging ports that can be used by the
given Campaign Group. This option always works in pair with the Number of
CPD Ports property which is defined on the Advanced tab of Campaign Group
configuration object. OCS considers the Number of CPD Ports to be the total
number of ports available to the Campaign Group, for example, the sum of
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engaging ports and ports for outbound dialing. Table 16 summarizes OCS
behavior for different variations of the CPD Ports setting:

Table 16: OCS Behavior and CPD Port Configuration

CPD port Number of CPD Number of CPD ports > 0
configurations ports =0
asm_channel_num = 0 No restrictions. No restriction on the number

of engaging ports (although
they must not be greater than

'Number of CPD Ports'
property).
asm_channel_num > 0 Only the number of | Both the engaging ports and
engaging ports is the ports for outbound dialing
restricted. are restricted.

This new option can be used with hardware configurations that use a separate
pool of engaging lines (ports for agent engagement). See the CPD Server
use-engaging-Llines option which controls engaging mode of CPD Server.
This option can also be useful for blended environments to limit the number of
agents being engaged and thus allocate some portion of the agents to always be
available to handle inbound calls.

Note: Assigning the asm_channel_num option with a value less than the
number of agents available for the Campaign Group might cause an
excessive overdial rate if the classical Predictive Algorithm is being
used. See the OCS predictive_algorithm option on page 244.

asm_drop_am_announcement_data

CPD Server SIP Server
Type: Optional Optional
Default Value: An empty string (") none
Valid Value(s): Path to the file in the VOX A prompt ID for an
format (string) announcement, as configured
in GVP Media Control
Platform

Configuration Campaign Group/Application Campaign Group/Application
Level:

Changes Take Immediately Immediately
Effect:

(For ASM modes only) Specifies the message to be played if an answering
machine is detected before releasing the established customer call in the ASM
modes.

The values differ depending on whether you use CPD Server or SIP Server, as
follows:
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* (For CPD Server) The full name (including the path) to the file (in the
VOX format). CPD Server plays this announcement and then releases the
established customer call because either of the following occurs:

+  The customer leg could not be bridged with the engage call leg

+ No destination DN is specified for bridging answering machine
detected calls.

* (For SIP Server) The Prompt ID for the message, as configured in GVP
Media Control Platform. For more information on the Prompt ID, see the
GVP documentation.

This option can be used with the asm_drop_announcement_data option (see
page 211). While the asm_drop_announcement_data option instructs OCS to
play the same announcement for all call results, using both options allows CPD
Server to play a different announcement for Answering Machine call results
than for Answer call results.

Note: This option, added in OCS 7.6.101.04, can only be used in the Active
Switching Matrix (ASM) mode.

beep-on-merge

Default value: false

Valid Value(s): yes/true, no/false

Configuration Level: Campaign Group / Application

Changes Take Effect: Immediately

Enables the playing of a beep tone to the agent on the engaging call

immediately before the agent is bridged to the customer call when running in
Outbound VoIP dialing modes.

call_answer_type_recognition

Type: Optional

Default Value: no_am_detection

Valid Value(s): no_progress_detection, no_am_detection,
positive_am_detection, full_positive_am_detection,
accurate_am_detection, telephony_preset

Specifies answer, answering machine, and fax detection settings when dialing
using CPD Server, SIP Server, or OBN Manager.

Note: This option does not apply when OCS uses T-Server for dialing and
PBX equipment for call progress detection.
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The values are as follows:

Table 17: Option Value Description

Outbound Contact Server Options

Option Value

Non-IP Outbound
Environment Description

Outbound-IP Environment
Description

no_progress_detection?

Disables call progress detection,
and the call is transferred as
soon as it is established.

No SIT, answering machine, or
fax tone is detected; the call is
connected, as if it were
answered by an actual person.

no_am_detection

Disables answering machine
detection but detection of all
other devices is still enabled.

SIT and fax tones are detected
but answering machines tones are
not; if no SIT or fax tone is
detected, the call is connected as
if it were answered by an actual
person.

positive_am_detection

Note: This value works only with
tape-based answering machines.
It does not work with modern
digital answering machines.

Enables standard answering
machine detection (Positive
Answering Machine [PAM]
mode).

SIT, answering machine, and fax
tones are detected; answering
machine detection should be
performed with default
parameters for Media Gateway or
Media Server.

full_positive_am_detection

Enables full positive answering
machine detection (Full Positive
Answering Machine [FPAM]
mode).

SIT, answering machine, and fax
tones are detected; answering
machine detection is performed
with the highest probability of
live voice detection, if supported
by Media Gateway or Media
Server. If it is not supported, this
value functions in the same way
as the positive_am_detection
value.

Deployment Guide
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Table 17: Option Value Description (Continued)

Outbound Contact Server Options

Option Value

Non-IP Outbound
Environment Description

Outbound-IP Environment
Description

accurate_am_detection

Enables or disables detection,
based on an analysis of the
duration of the greeting.

SIT, answering machine, and fax
tones are detected; answering
machine detection is performed
with the highest probability of
live voice detection, if supported
by Media Gateway or Media
Server. If it is not supported, this
value functions in the same way
as the positive_am_detection
value.

telephony_preset

Causes the same behavior as the
no_am_detection value. If the
user selects telephony_preset,
this value is automatically
converted to the
no_am_detection value.

Tones are detected in accordance
with the default configuration for
SIP Server and Media Gateway.

a. The call_answer_type_recognition option cannot be set to no_progress_detection on DM3 hardware
because of line-side PDK protocol restrictions.

call_transfer_type

Type: Optional

Default Value: one_step

Valid Value(s): one_step, two_step

Specifies the transfer type that the dialer (CPD Server or OCS) use for
outbound calls. This option applies when OCS uses CPD Server or for
two-step transfers in Outbound IP environment (see page 97). It does not apply
when OCS uses PBX equipment for call progress detection.

For an environment using CPD Server as the dialer, CPD Server translates the
one_step value as either mute or single_step depending on the switch that is
being used; check your switch documentation.

The two_step value is commonly used to overcome some switch transfer
issues such as ring splash on a Meridian switch. Ring splash occurs when a
dialer transfers a connected call to an agent, and the caller hears a ringback
before he or she hears the agent answer. For some switches, this ringback
cannot be turned off, either by a command in the CTI link or by a switch
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setting.

As a workaround to this situation, Genesys uses a two-step transfer. In a
two-step transfer, the switch puts the original leg of the call on hold and starts
to initiate a transfer. For a moment, the caller hears silence or music depending
on whether the music on hold feature is enabled on the trunk or queue. For the
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second leg of the call, the Origination DN (usually a queue), as defined in the
Campaign Group, is dialed. The transfer process is complete when an agent
answers the call. The call_wait_in_queue_timeout option on page 234 is a
timer and the value determines how long the call should wait (in the queue)
before an agent answers. If the timer expires, the dialer drops the call, and the
record is marked with the Dropped call result.

Note: Genesys recommends turning off the music on hold feature on the
trunk or queue when using a two-step transfer.

call_timeguard_timeout

Type: Optional

Default Value: 0 (milliseconds)

Valid Value(s): 0...<N> (milliseconds)

Enables a user to set a timeout for post-connect call progress detection. The
call is transferred to a queue when the timeout expires, regardless of the call
result or the completion of call progress detection. The timeout is calculated
from the moment that CPD Server receives an EventEstablished message. If
this option is set to @ (zero) or if it is not present, CPD Server does not break
call progress detection.

Notes: * This option applies when OCS uses SIP Server, CPD Server or
OBN Manager for dialing. It does not apply when OCS uses
T-Server for dialing and PBX equipment for call progress
detection.

* You must specify a value greater 0 for this option when
configuring Trunk DNs in an Outbound-IP environment. For more
information about Outbound-IP environment requirements, see
Chapter 3 on page 87.

call_wait_agent_connected_timeout
Type: Optional

Default Value: 6 (seconds)

Valid Value(s): Any positive integer

Specifies the timeout, in seconds, from the time the engaging call is dialed to
the time the call is answered by an agent.

This timeout applies only to engaging calls in ASM mode; that is, calls that
engage an agent before the customer answers. If the agent answers the call, the
agent is seized for that call. The value of this option indicates how long to wait
for an agent to be seized after dialing that agent.

Note: This option applies when OCS uses CPD Server for dialing. It does
not apply when OCS uses T-Server for dialing and PBX equipment for
call progress detection.
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call_wait_connected_timeout
Type: Optional

Default Value: 120 (seconds)

Valid Values: 0-7200 (seconds)

Specifies the timeout upon of expiration of which dialer should consider that
call is not answered by call party.

When OCS is dialing calls through CPD Server or OBN Manager:

For ISDN: Specifies the timeout, in seconds, between dialing and the
determination that the called party is not answering.

For analogue and line-side DNs: Specifies timeout between the first ring
and the determination that the called party is not answering.

When OCS is dialing calls through T-Server:

The value of this option is passed to the T-Server as an AttributeTimeout
in the MakePredictiveCall message. The timeout value received in the
request has a higher priority than T-Server's own options, and it is used to
set up the duration of the No Answer interval on the switch.

Set the value between 6 and 99 when using the Aspect switch
classification board. The default value of 120 causes the
RequestMakePredictiveCall requests sent by OCS to fail because the
switch accepts only two digit values.

For a VoIP environment in which SIP Server is used for dialing, the
maximum value of this option is 32 seconds for all dialing modes.

call_wait_in_queue_timeout
Type: Optional

Default Value: 10 (seconds)

Valid Value(s): Any positive integer

Specifies the maximum amount of time, in seconds, that an outbound call is
allowed to stay in a queue. This option applies when OCS uses CPD Server or
for two-step transfers in an Outbound IP environment (see page 97).

Note: For CPD Server usage, after this timeout expires, CPD Server can

release the call only when the two-step transfer is used (see the
call_transfer_type option on page 232), and CPD Server controls the
consult leg of the transferred call.

call_wait_original_establish_timeout
Type: Optional

Default Value: 4 (seconds)

Valid Value(s): Any positive integer

Specifies the timeout, in seconds, between the end of a positive call progress
detection response from Dialogic—such as Answer, Answering Machine (AM),
or Cadence Break—and an EventEstablished from T-Server.
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This option applies only when OCS uses CPD Server. It does not apply when
OCS uses PBX equipment for call progress detection.

campaign-callback-distr

Type: Optional

Default Value: random

Valid Value(s): random, equal-from-zero, or equal-from-avg
Changes Take Effect: Immediately

Specifies how campaign callbacks are distributed to agents when the
predictive_cal lback option is set to false and campaign callback notifications
are distributed as UserEvents.

The option values that define this distribution are as follows:

*  For the random value, OCS randomly distributes callbacks between eligible
agents, as it did previously.

* For the equal-from-zero or equal-from-avg values, OCS monitors the
actual number of campaign callbacks distributed to each agent in the
campaign group from the moment the dialing session/campaign group is
loaded until it is unloaded. When OCS needs to distribute new campaign
callback, it selects an agent who has processed the fewest number of
campaign callbacks since the dialing session/campaign group was loaded.
If two or more agents have processed the same minimum number, an agent
is selected randomly from among them.

If an agent logs out of the group, OCS clears the agent's history, including

the number of callbacks processed. When an agent logs into the group,

OCS assigns the number of callbacks processed by this agent, as follows:

+ Ifyou set the value to equal-from-zero, OCS assigns @ as the number
of callbacks processed.

+ Ifyou set the value to equal-from-avg, OCS assigns the average
number of callbacks processed by agents in the group. You might use
this value in a scenario in which an agent logs in for the first time at
mid-day and want to ensure that all agents receive callback requests.
Otherwise, this new agent would receive all requests until he or she
reached the group average.

cancel-on-desktop

Default Value: true

Valid Value(s): true, false

Changes Take Effect: Immediately

Specifies how OCS behaves when it receives a RequestRecordCancel request

but finds records on an agent’s desktop that have the specified phone or the
customer ID.

*  When set to true, OCS finalizes these records as cancelled when it
receives a RequestRecordCancel request.
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CPN Options

*  When setto false, OCS does not finalize records on an agent’s desktops
as cancelled when it receives RequestRecordCancel request. As a result,
agents can complete calls and their associated record that are still in
progress, rather than being locked out the record.

OCS also notifies the RequestRecordCancel requester (agent desktop or
third party application) in the RecordCance lAcknowledge response about the
inability to handle cancellation request completely. The 6SW_MESSAGE
attribute displays the following message: “Incomplete processing:
record(s) on desktop.”

Notes: * This functionality does not affect RequestRecordCancel
requests made by the record handle or any DoNotCall requests.

* GSW_MESSAGE is not a new attribute to the desktop protocol, but
it is for third-party protocol. In addition, it is used only in the
desktop request and never in the server’s response.

cpd-on-connect

Default Value: false
Valid Value(s): yes/true, no/false
Changes Take Effect: Immediately

Specifies when call progress analysis is started in Outbound VoIP dialing
modes.

If value is set to no/false, OCS instructs Media Server to start call progress
analysis as soon as the media stream is available,

If set to yes/true, OCS instructs Media Server to delay call progress analysis
until the call is answered.

cpd-recording

Default Value: false

Valid Value(s): yes/true, no/false
Changes Take Effect: Immediately

(For VoIP dialing modes) Enables or disables the recording of the call progress
detection phase of the call. If value is set to no or false, the recording is
disabled; otherwise it is enabled.

CPNType

Type: Optional

Default Value: 0

Valid Value(s): 0 - 7

Specifies the decimal representation of the Type of Number code.

CPNPIlan

Type: Optional
Default Value: 0
Valid Value(s): 0 - 15
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Specifies the decimal representation of the Numbering Plan code.

CPNPresentation
Type: Optional
Default Value: 0
Valid Value(s): 0 - 3

Specifies the decimal representation of the Presentation Indicator code.

CPNScreening
Type: Optional
Default Value: 0
Valid Value(s): 0 - 3

Specifies the decimal representation of the Screening Indicator code.

CPNDigits
Type: Optional
Default Value: Empty string

Valid Value(s): String of characters, according to the formats specified in the
appropriate numbering/dialing plan.

Specifies the Calling Party Number (CPN).

Note: Starting with OCS release 8.0.001, this option can be configured for
individual records or chain-of-records to enable fine-tuning of record
processing. Unlike other options, which can be configured at the
individual record level in the Business Attributes object, this option is
defined using SCXML treatments, which provides greater flexibility
in the calculation of the option value and allows the definition of
complicated business logic, based on that calculation. For example,
record property, time of day, day of the week, or any other parameter
that can be calculated inside the SCXML treatment executable content
(JavaScript) can now affect the value of this option.

Starting with release 7.6, this option can be applied to a campaigns
running in Proactive Contact (Power GVP or Progressive GVP) mode.
Its value can be passed to OBN Manager if GVP 7.5 or 7.6 is used or
SIP Server if GVP 8.0 or later is used.

For more information about the Caller ID Support feature and the CPN
options, see the following resources:

* Extensions related to TMakePredictiveCall () in the “Extensions” section of
the “Unstructured Data” chapter in the Genesys Developer Program
I-Library SDK Developer's Guide, 8.0

o Framework 8.0 T-Server for Alcatel A4400/OXE Deployment Guide
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o Framework 8.0 T-Server for Avaya Communication Manager Deployment
Guide

* Q.931 ISDN user-network interface layer 3 specification for basic call
control

dialer-ttl

Type: Optional

Default Value: 5

Valid Values: 3 - 1440

Specifies the Time To Live (in minutes) during which OBN Manager will

attempt to pass a request to the GVP dialer (IPCS or VCS) for a dial from it's
internal dialing queue.

Note: This option only applies when OCS uses OBN Manager for dialing. It
does not apply when OCS uses T-Server for dialing and PBX
equipment for call progress detection.

dialer-num-attempts

Type: Optional

Default Value: 3

Valid Values: 1 - 25

Specifies the number of attempts that OBN Manager will attempt to pass a

request to the GVP dialer (IPCS or VCS) for a dial from it's internal dialing
queue.

Note: This option only applies when OCS uses OBN Manager for dialing. It
does not apply when OCS uses T-Server for dialing and PBX
equipment for call progress detection.

dialing_rate_limit
Type: Optional
Default Value: 100
Valid Value(s): @ - N

Specifies the maximum number of dialing requests per second. If option is set
to 0 (zero), then OCS does not dial at all.

direct-personal-callback
Type: Optional

Default Value: true

Valid Values: true/yes or false/no

Controls how personal callback records of type are processed in the Push
Preview dialing mode.
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*  When the value is set to true, OCS will submit the personal callback
interaction directly to the agent.

*  When the value is set to false, OCS will submit the personal callback
interaction to an interaction queue assigned to the Campaign Group. This
allows the Universal Routing Server strategy to distribute this interaction.

Note: This option is used with Interaction Server in Push Preview dialing
mode only.

divert_to_unknown_dn

Type: Optional

Default Value: no/false

Valid Value(s): yes/true or no/false
Changes Take Effect: Immediately

Specifies OCS's reaction to a EventDiverted with either an unknown
ThirdPartyDN or without an agent logged in to it.

* Ifsetto no or false, immediately upon receiving this type of
EventDiverted, OCS updates the record with the Stale call result and the
Agent Error record status.

* Ifsettoyes or true, OCS does not update the record, and continues to
monitor the outbound call.

Note: If a call is diverted to a DN, on which OCS has not been registered,
then the corresponding record will not be updated in a calling list upon
call release. Instead, it will stay in a Retrieved status until the timer set
by the stale_clean_timeout option expires.

In release 7.5 and higher, an “unknown DN is a DN that is either
excluded from any Place object, or is included in a Place object but
the P Lace object does not have an associated agent. An agent is
associated to a Place object when a Campaign Group that is
configured with this agent is activated within OCS.

history_length

Type: Optional

Default Value: 30

Valid Value(s): any positive integer from 30 to 300

Specifies the point at which OCS switches from the Progressive mode to
Predictive mode.

OCS always starts a dialing session/campaign group in Progressive mode.
When it starts dialing, it begins collecting call flow statistics/call history for
the predictive dialing algorithm. OCS fills the call history in the order that calls
are established (answered by dialed party). It counts the number of established
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(answered) outbound calls that it has placed, and turns on Predictive mode
when the number exceeds the value of history_length.

For example, if this option is set to 40, OCS switches the Campaign from the
Progressive mode to the Predictive mode when the first 40 established calls
(rather than any established calls) are completed.

For large agent groups (approximately 1000 agents), Genesys recommends
that you set the value of history_Llength to 100 or higher, and that you also
control the number of CPD ports.

These settings help maintain the target busy factor and minimize the number of
abandoned calls in large agent groups.

inbound_agent_outlier_limit

Type: Optional

Default Value: 600 (seconds)

Valid Value(s): Any non-negative integer

Changes Take Effect: Immediately

Specifies the minimum amount of inbound call time, in seconds, before OCS
changes an agent's status changes to Not Avai Llable. If an agent is busy with an
inbound call longer than the specified value (including the After Call Work
state), then the predictive algorithm does not consider this agent available
when calculating the number of predictive calls.

ivr-profile-name

Type: Optional

Default Value: An empty string (' ")

Valid Values: 1- n

Populated after a nine-digit value is entered in the IVR Profi Le field in the

Advanced tab of Campaign Group configuration object. The value itself is the
IVR Profile DBID that is specified in the GVP EMPS IVR Profile.

merge-method

Default Value: bridging

Valid Values: bridging or transfer

Configuration level: Campaign Group/ Application
Changes Take Effect: Immediately

Defines the OCS merge method for outbound and engaging calls in the ASM
mode when dialing using SIP Server.

* By setting this option to transfer, OCS connects the customer call to the
first established engaging call, regardless of the Media Server on which the
engaging call is established.

* By setting this option to bridging, OCS attempts to find an established
engaging call on the same Media Server as the customer call.

If there is no established engaging call on the same Media Server, OCS
releases the customer call, with the option to play a configured
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announcement before releasing it, according to the
asm_drop_announcement_data option (see page 211).

If bridging the customer call is not possible in this scenario, you can
customize this setting using the “on-bridging-unable” option at the
Campaign Group-Level. Using this option, OCS connects the customer
call to the first established engaging call, regardless of the Media Server on
which the engaging call is established using the transfer method in
TMergeCall.

on-bridging-unable

Default Value: drop

Valid Values: transfer or drop

Configuration Level: Campaign Group / Application
Changes Take Effect: Immediately

Defines OCS’s behavior when there is no established engaging call on the
same Media Server and it is not possible to use the bridging method.

outbound_agent_outlier_limit

Type: Optional

Default Value: 600 (seconds)

Valid Values: Any non-negative integer, from @ to the maximum integer
supported by your operating system

Specifies the minimum amount of outbound call time, in seconds, before OCS
changes an agent's status changes to Not Avai Llable. If an agent is busy with an
outbound call longer than the specified value (including the After Call Work
state), then the predictive algorithm does not consider this agent available
when calculating the number of predictive calls.

Note: OCS takes this option into account regardless of the setting for the
predictive-longcalls-truncation option (see page 249).

pa-dial-expire
Type: Optional
Default Value: 2

Valid Values: 1 - 6000

Specifies the timeout (in minutes) that the predictive algorithm uses to clean up
calls that are in a Dialed state. If an outbound call is dialed, and no further

Deployment Guide 241



Chapter 9: Outbound Contact Configuration Options Outbound Contact Server Options

242

events about this call are received by the predictive algorithm within the
timeout specified, the call will not be included when predicting the next call.

Notes: For Push Preview and Power GVP dialing modes, be aware of the
following:

* The Dialed state means that the interaction was submitted to
Interaction Server but was not delivered to the agent desktop or
finalized by the routing strategy (Processes block).

+ Set the value significantly higher than the default value of 2,
because the distribution time for multimedia interactions is
significantly higher than the distribution time for calls.

pa-handle-expire
Type: Optional
Default Value: 30
Valid Values: 1 - 6000

Specifies the timeout (in minutes) that the predictive algorithm uses to clean up
calls that exist on an agent's desktop. If an outbound call is dialled and is
delivered to an agent, and no further events are received about this call are
received by the predictive algorithm, the call will not be included when
predicting the next call.

pa-handle-time-consider

Type: Optional

Default Value: 1800 (seconds)

Valid Value(s): Any positive integer (from 1 to the maximum integer
supported by your operating system)

Changes Take Effect: Immediately

Specifies the maximum call duration for all call types when calculating the
average call duration. If a call’s duration (including the After Call Work state)
is more than the specified value, then the predictive algorithm does not include
this call duration when calculating the average call duration.

pa-inbound-ignore

Type: Optional

Default Value: none

Valid Values: none, outbound, engage, all

Configuration Level: Campaign Group / Application

Changes Take Effect: Immediately

Specifies which method OCS uses to ignore the sampled value of inbound
traffic in dialing pace calculations. This enables users to specify how to handle
dialing-pace calculations for outbound and engaging calls in the Progressive
with seizing and the Predictive with seizing dialing modes with respect to
inbound traffic.

The values function as follows:
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* none—OCS does not ignore the inbound traffic and uses it to calculate the
dialing pace for outbound and engaging call dialing.

* outbound—OCS ignores the inbound traffic for the dialing pace of
outbound calls and uses it only for the dialing pace of engaging calls.

* engage—OCS ignores the inbound traffic for the dialing pace of engaging
calls and uses it only for the dialing pace of outbound calls.

* all—OCS ignores the inbound traffic and does not use it for calculating
the dialing pace for outbound and engaging calls.

Note: This option was added to OCS, version 7.6.101.18.

pa-odr-interval

Default Value: 480 (in minutes; that is, 8 hours for the standard length of a
working day)

Valid Values: 240 to the maximum integer supported by your operating system
Changes Take Effect: Immediately

Specifies the time interval, in minutes, that OCS uses to match the target value
of the Overdial Rate.

In other words, if set this option to the default value, the average overdial rate
calculated at the end of an 8-hour day must meet the overdial rate specified in
the predictive_max_overdial_rate option on page 250.

Note: OCS defines the beginning of a time period to be the moment when
the session is started or restarted or when the optimization method is
changed to Overdial Rate. When the time period ends, the algorithm
starts a new time period.

pa-selfcheck-awt-threshold

Type: Optional

Default Value: 10 (percent)

Valid Value(s): integer >=1

Changes Take Effect: Immediately

Specifies the percentage of the target Average Waiting Time that the predictive
algorithm (PA) uses as the threshold to report a dialing performance
degradation. If the difference between the current and the target Average
Waiting Time is less than the percentage of the expected Average Waiting
Time, the PA does not make a report. Otherwise, the PA reports the

degradation only if a suspicious condition is detected for the Average Waiting
Time.

For more information what a suspicious condition might be, see “Predictive
Algorithm Self-Diagnostic” on page 55.

pa-selfcheck-bf-threshold
Type: Optional
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Default Value: 10 (percent)

Valid Value(s): integer »>=1

Changes Take Effect: Immediately

Specifies the percentage of the target Busy Factor that the PA uses as the
threshold to report a dialing performance degradation. If the difference
between the current and the target Busy Factor is less than the percentage of
the expected Busy Factor specified in this option, the PA does not make a
report. Otherwise, the PA reports the degradation only if a suspicious condition
is detected for the Busy Factor.

For more information what a suspicious condition might be, see “Predictive
Algorithm Self-Diagnostic” on page 55.

pa-selfcheck-interval

Type: Optional

Default Value: 20 (minutes)

Valid Value(s): 2 to the maximum integer supported by your operating system
Changes Take Effect: Immediately

Specifies the time interval, in minutes, that the PA uses to calculate the current
values of the optimization parameters and to track any suspicious condition for
reporting dialing performance degradation.

pa-selfcheck-odr-threshold

Type: Optional

Default Value: 20 (percent)

Valid Value(s): 1 to the maximum integer supported by your operating system
Changes Take Effect: Immediately

Specifies the percentage of the target Overdial Rate that the PA uses as the
threshold to report about a dialing performance degradation. If the difference
between the current and the target Overdial Rate is less than the percentage of
the expected Overdial Rate, the PA does not make a report. Otherwise, the PA
reports the degradation only if a suspicious condition is detected for the
Overdial Rate.

For more information what a suspicious condition might be, see “Predictive
Algorithm Self-Diagnostic” on page 55.

predictive_algorithm

Type: Optional

Default Value: small_group

Valid Value(s): classical, small_group, advanced_small_group,
time_optimized_odr

Changes Take Effect: Immediately
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Controls which predictive algorithm (PA) OCS uses for dialing outbound calls
when a dialing session/campaign is running in the Predictive or Predictive
with seizing dialing mode.

Notes: * If the optimization method is Busy Factor or Average Waiting

Time, OCS uses the classical predictive algorithm regardless of the
value specified for this option.
* A new valid value, time_optimized_odr, was added to release 8.0.

The values function as follows:

Deployment Guide

classical—OCS uses the classical predictive algorithm based on
classical queuing theory, regardless of the current number of available
agents and the optimization parameter that are used.

Small group values: These two values are optimized for small groups of
agents. Either of these values can be used if the Overdial Rate is specified
as an optimization parameter and the number of available agents does not
exceed the number set in the small_group_size option (see page 254). If
the number of agents exceeds the number set in the small_group_size
option, OCS uses the classical predictive algorithm. Also see “Predictive
Algorithm for Small Groups™ on page 55.

The two small group values include:

+ small_group—OCS uses a small group predictive algorithm, which
waits until all dialed calls are completed before dialing new calls.

+ advanced_small_group—OCS uses an advanced predictive algorithm.
This option value activates the new and improved predictive algorithm
for small groups of agents. The advantages of this new algorithm
include:

+ It better tracks inbound calls, because it counts inbound calls that
are at all stages of processing and not just those that are queued.

+ It allows outbound calls to be initiated, even if one or more calls
remain in the dialing stage, rather than waiting until all dialed calls
are completed.

Using the advanced_small_group value may result in busier agents, as
the Busy Factor increases or the waiting time between calls reduces for
agents for the same Overdial Rate.

This value can be set in conjunction with the time-to-ready-tolerance
option (see page 254).
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* time_optimized_odr—OCS uses the time-optimized predictive algorithm.
When using this value, OCS monitors the predictive_max_overdial_rate
(see page 250). If it is greater than zero but less than the current overdial
rate, OCS switches from the Predictive to the Progressive dialing mode.

Notes: * The predictive algorithm self-diagnostic mechanism (see
page 55) considers the situation where the
predictive_max_overdial_rate is greater than zero but less the
the current overdial rate as an incorrect configuration and
reacts with a proper log message.

* For more information about the time-optimized predictive

algorithm, see “Time Optimized Predictive Algorithm” on
page 56.

predictive_callback

Type: Optional

Default Value: no/false

Valid Value(s): yes/true or no/false

Specifies how Outbound Contact Server handles a Campaign Callback.
If this option is set to yes or true:
* In Predictive or Progressive modes, OCS automatically dials callbacks.

* In Preview mode, OCS puts records that are scheduled as Campaign
Callback in the preview records list, and delivers them to the agent’s
desktop upon receipt of a PreviewRecordRequest.

If this option is set to no or false:

* Regardless of the dialing mode, OCS delivers records scheduled for
callback directly to the agent’s desktop through a UserEvent. The agent
then decides whether or not to dial this record. If the desktop application is
not capable of processing preview records and this record remains on the
agent’s desktop, OCS marks the call result of the record as stale when the
timer set by the stale_clean_timeout option expires. Figure 15 illustrates
how Outbound Contact Server handles a Scheduled Call during a
predictive or progressive campaign.

* In the Predictive or Progressive modes, Campaign callbacks are processed
only while the Dialing Session that owns them is running. If the Dialing
Session is active (that is, loaded), then Campaign callbacks are retrieved
and waiting in OCS memory buffers for the Campaign to start, even if the
scheduled time arrives.

246 Outbound Contact 8.0 @



Chapter 9: Outbound Contact Configuration Options Outbound Contact Server Options

* In the Preview mode, Campaign callbacks are processed only while the
Dialing Session that owns them is running. If the Dialing Session is active
(that is, loaded), Campaign callbacks wait until an agent desktop requests
them, which only occurs when the Dialing Session is running.

Note: Sce the “Communication Protocols” chapter of the Outbound Contact
8.0 Reference Manual for information about the events distributed
when rescheduling records.
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Note 2
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Figure 15: Scheduled Call During a Predictive or Progressive Campaign
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predictive_hot_start

Type: Optional

Default Value: false

Valid Value(s): yes/true or no/false

Specifies how OCS uses predefined statistical data in certain circumstances.

If this option is set to yes or true, OCS uses the predefined statistical data to
start predictive dialing, without first using the preliminary dialing in
Progressive mode.This predefined statistical data will be taken from the
following options: predictive_hit_ratio,
predictive_outbound_call_duration, predictive_inbound_rate, and
predictive_inbound_call_duration.

predictive_hit_ratio
Type: Optional

Default Value: 75

Valid Value(s): 1 - 100

Specifies the Starting Value for Hit Ratio, as a percentage (%).

predictive-longcalls-truncation
Type: Optional

Default Value: false

Valid Value(s): false/no or true/yes
Changes Take Effect: Immediately

Instructs the predictive algorithm on how to handle so called “long” outbound
calls, (that is, if a few outbound calls last significantly longer than the majority
of the outbound calls for the given Campaign Group). Although these “long”
calls happen rarely, they are taken in the account by the predictive algorithm
when average call duration is calculated. As a result, these long calls will
increase the average call duration, negatively affecting the dialing efficiency.

When this option is set to true, the predictive algorithm truncates the length of
time associated with these calls when calculating the average call duration,
which may positively effect the predictive dialing efficiency.

Notes: * When configured, this option does not affect OCS’s use of the
outbound_agent_outlier_Limit option (see page 241).

* This option applies only to outbound calls.

predictive_outbound_call_duration
Type: Optional

Default Value: 120

Valid Value(s): 1 - N

Specifies the starting value for the average outbound call duration, in seconds.
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predictive_inbound_rate
Type: Optional

Default Value: 0

Valid Value(s): 0 - N

Specifies the starting value for the average number of inbound calls, per hour.

predictive_inbound_call_duration
Type: Optional

Default Value: 300

Valid Value(s): 1...N

Specifies the starting value for the average inbound call duration, in seconds.

predictive_max_overdial_rate

Type: Optional

Default Value: 0

Valid Value(s): Number between 0 and 100 in decimal format (for example,
3.55)

Changes Take Effect: Immediately

Specifies the maximum allowed overdial rate for dialing in Predictive mode.

If the current overdial rate of a running dialing session/campaign exceeds this

value, OCS switches the dialing mode from Predictive to Progressive. When
the current overdial rate falls below this value, OCS switches the dialing mode
from Progressive to Predictive.

This checking of the limit is performed separately from all predictive
optimization parameters; that is, overdial rate, busy factor and average waiting
time.

If this option is set to 0 (zero) or 100, OCS does not perform separate control
of the overdial rate.

progressive_blending_reserved_agents
Type: Optional

Default Value: 0

Valid Value(s): Any non-negative integer

Enables OCS to keep a specified number of agents who are in the Progressive
dialing mode available for inbound traffic or some other non-outbound
activity.

Outbound Contact initiates the next outbound call when both of the following
are true:

* There is at least one ready agent.

*  The total number of ready or busy non-outbound agents exceeds the value
of the option.

The agent is treated as busy outbound when he or she is in the BusyOutbound,
BusyPaper, or BusyRinging state.
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All other states except the Ready state are treated as non-outbound.
The following is an example of how this option works.

An agent group has a total of four agents:

* One agent is in the BusyInbound state.

* One agent is in the BusyOutbound state.

* Two agents are in the Ready state.

At this time, the progressive_blending_reserved_agents option is setto 2. As
a result, OCS sends one outbound call.

progressive_blending_reserved_status
Type: Optional

Default Value: all_seized_inbound

Valid Values: all_seized_inbound, ready

Specifies how agents are reserved for outbound calls.

e Ifprogressive_blending_reserved_status is setto all_seized_inbound,
OCS reserves all agents that do not have any of the following outbound
statuses: BusyOutbound, BusyPaper, NotReady, and BusyRinging. This value
is similar to the progressive_blending_reserved_agents option
functionality in OCS 7.x

o Ifprogressive_blending_reserved_status is set to ready, OCS reserves
only those agents who are in Ready status. This value is similar to the
progressive_blending_reserved_agents option functionality in OCS 6.5,
which kept a specified number of reserved agents who were in progressive
dialing mode available for inbound traffic. In this scenario, OCS waited
until more than the specified number of reserved agents were in the Ready
status before initiating the next outbound call.

public_network_access_code
Type: Optional

Default Value: An empty string
Valid Value(s): Any character string

Specifies the string that is added as a prefix to each phone number that OCS
sends to a specific switch. The phone numbers in the call UserData remain
unchanged. This number specifies the PSTN access code for the switch to
which T-Server is connected. When an access code is added as a value, the
system always places the access code in front of the phone number that is
dialed. For example, if you set the value 9 into the value field, then the prefix 9
is always dialed before each phone number.

If you are using the Outbound Contact Wizard, it prompts you to enter a value
for this option. To accept the default value for this option, click the Cancel
button on the wizard screen.

You can add Dialogic dialing control parameters as a prefix to the dialed
numbers from a calling list. When combined with the string defined for the
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public_network_access_code option, Dialogic dialing control symbols (prefix)
determine the dialing time.

The following Dialogic symbols are available:

* L—Wait for the local dial tone before dialing

* I—Wait for the international dial tone before dialing
* X—Wait for the special dial tone before dialing

* , (comma)—Pause 2 seconds

For example, suppose that the public_network_access_code is defined as L9. In
this case, the dialer will wait for a dial tone, dial 9, pause for 2 seconds, then
dial the number from the calling list.

Note: Dialing control parameters work only if the CPD Server dials the calls
through the Dialogic card (tscall=false).

This option can be set at three levels: Switch/Application (which has
the lowest priority), Campaign Group (which has a medium priority),
and Calling List (which has the highest priority).

record_processed

Type: Optional

Default Value: true

Valid Value(s): yes/true or no/false
Changes Take Effect: Immediately

Specifies whether OCS waits for the agent’s signal to finalize processing of a
record.

* Ifrecord_processed is set to true or yes, Outbound Contact waits for a
RecordProcessed request from the agent handling the calling list record. A
RecordProcessed request is mandatory from the desktop application to
Outbound Contact Server. This request informs OCS that the agent has
finished with this call record and that OCS can update the database with
the final information about the call record.

Note: If an agent changes his or her state (such as EventAgentReady or
EventAgentLogout), OCS treats the agent state as ReleaseNextCall
or LoggedOut. The change in agent state informs OCS that the
agent has finished with this call record, and that OCS can update
the database with the final information about the call record. OCS
can change an internal agent state after it receives EventRe Leased
from the T-Server.

e Ifrecord_processedis setto false or no, Outbound Contact will assume
that the record is processed when the agent or customer releases the call;
that is, when OCS receives a EventRe leased message for this call, or when
it receives an EventLogout message for the agent who handled the call.
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Usually false is used when agents in an Outbound campaign do not have
desktop phone applications and therefore cannot send the RecordProcessed
event.

This option is used only in Predictive and Progressive dialing modes. In
Preview dialing mode, Outbound Contact Server updates a record only after
receiving a RecordProcessed event from a desktop, regardless of whether the
record_processed option is set to true or false.

Note: The desktop can send multiple UpdateCallCompletionStats requests to
Outbound Contact Server to update the record before sending the final
RecordProcessed request. UpdateCallCompletionStats requests are
stored in OCS memory and are not recorded into the Calling List
Record database until the RecordProcessed request is received.

For more information, see the “Updating Genesys Mandatory Fields and
Custom Fields” section in the Qutbound Contact 8.0 Reference Manual.

record_save_intermediate_results
Type: Optional

Default Value: no/false

Valid Value(s): yes/true or no/false

Specifies whether the calling list should be updated with intermediate dialing
results during the lifetime of a calling list record.

» Ifthe value is set to yes or true, the Calling List table is updated with
intermediate dial results for each calling list record after each dial attempt.
OCS writes the following information to the database: call result,
scheduled time, number of attempts, and other data that is pertinent for
treatment redials and for calls that are rescheduled by an agent.

» Ifthe value is set to no or false (default), OCS updates the record in the
Calling List table with the final result only. Only the information about the

last treatment application result is recorded for each record before the
record is deleted from OCS memory.

remote_release_action

Type: Optional

Default Value: error

Valid Value(s): error, no_contact, abandoned

Specifies how OCS handles calls with the call result of RemoteRe lease.

* Ifsettoerror (default), OCS processes the call as if OCS has received an
EventError. The call result is RemoteRe Lease. The dialing rate does not
change.

* Ifsettono_contact, OCS processes the call as if no contact has been made,
as with call results Busy and NoAnswer. OCS decreases the Hit Ratio. The
call result is RemoteRe Lease.
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* Ifset to abandoned, OCS processes the call as if the customer has hung up.
OCS increases the abandoned rate when the call result is Abandoned.

small_group_size

Type: Optional

Default Value: 7

Valid Values: Any non-negative integer (0 - n)

Note: Inrelease 7.6.1 and higher, the maximum value limit of 50 agents was
removed.

Specifies the maximum number of available agents in a group that can be
treated by OCS as a small group, and therefore have a special type of
predictive algorithm applied.

If the current number of available agents in the group is less than or equal to
this option's value, OCS uses a predictive algorithm specially optimized for
small groups of agents for campaigns that use this group. This algorithm may
provide better optimization results than the general predictive algorithm in
some campaigns if the number of active agents is relatively low.

Note: OCS considers this option's setting only when all of the following are
true:

* The dialing session/campaign is running in Predictive or Predictive
with seizing dialing modes.
* The Overdial Rate is used as optimization parameter.

* The predictive_algorithm option (see page 244) is set to the
small_group or the advanced_small_group value.

stale_clean_timeout

Type: Optional

Default Value: 30

Valid Value(s): Any integer from 1 to 360

Changes Take Effect: Immediately

Specifies a timeout (in minutes) before OCS marks any records that remain in

the buffer as Stale. Such records may have been sent for processing, but were
not processed.

time-to-ready-tolerance

Type: Optional

Default Value: 2 sec

Valid Value(s): Any positive integer of 2 sec to the maximum integer
supported by your operating system

Change Take Effect: Immediately
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Specifies the allowed variance, in seconds, on the time estimate for when an
agent will become Ready.

OCS uses the value for this option in its calculations to determine whether an
agent delivers correct (or “trusted”) estimations on when the agent will
complete the processing of the given call and become Ready. The calculations
are based on information provided by the agent desktop to OCS about each
agent. For more information on trusted versus distrusted agents, see “Agent
Feedback for the Predictive Dialing Modes™ on page 53.

Note: OCS uses this information to further improve the dialing efficiency in
Predictive modes; for example, to increase the Busy Factor for a given
value of the Abandon Rate.

transfer_to_unknown_dn

Type: Optional

Default Value: no /false

Valid Value(s): yes / true or no / false
Changes Take Effect: Immediately

Specifies OCS’s behavior when an outbound call is transferred to an unknown
DN or a DN without an agent logged into it.

This is important in multi-site group deployments, because OCS cannot
properly resolve the destination DN. This option prevents OCS from treating
such transfers as transfers to an unknown DN.

* Ifsetto no or false, immediately after the transfer is completed, OCS
updates the record with the Stale call result and the Agent Error record
status.

* Ifsetto yes or true, OCS does not update the record, and it continues to
monitor the outbound call.

Note: If a call is transferred to a DN that OCS has not registered, the record
will not be updated in the calling list upon call release and its status
will remain Retrieved until the timer set by the stale_clean_timeout
option expires.

In release 7.5 and higher, an “unknown DN” is a DN that is included
in a Place object, but this Place object does not have an associated
agent. An agent is associated to a Place object when a Campaign
Group that is configured with this agent is activated within OCS.

treatment-holidays-table

Default Value: No default value

Valid Value: The name of the Statistical Table configuration object for
holidays

Changes Take Effect: At the next treatment application
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Defines the name of the Statistical Table configuration object that OCS uses to
determine the dates and time ranges for holidays.

treatment-uri
Default Value: none

Valid Value: A string that represent the URI of the SCXML treatment script
resource

Changes Take Effect: At the next treatment application

Defines the URI to the SCXML treatment script resource on the Application
Server, which specifies the treatment used for this Campaign Group.

The URI can contain treatment parameters and values that are applied to the
instances of the treatment script created when running a dialing session for a
campaign. The parameters can include any of the following:

* Contact type to use when starting the dialing session/campaign
(start_contact_type).

*  Maximum number of dialing attempts (max_dial_attempts).

» User-defined variables, as identified in the script—for example, Type1 and
Type2 used in the script example described in “Script Example” on
page 373.

Separate all parameters and their values using the and (&) symbol. For
example:

treatment-uri=http://server/ocs/treatment1?start_contact_type=HOME&
max_dial_attempts=8

Notes: * This option can also be configured at the Calling List Level (see
page 262), which has a higher priority than when it is configured at
this Campaign Group Level.

+ If this option is not defined here or at the Calling List Level, OCS
uses the treatment configuration described in Chapter 12 on
page 335.

* If the value for this option contains parameters/values that are
defined in the script and the script values differ, the values in the
treatment-uri option take precedence.

treatment-weekdays-table

Default Value: No default value

Valid Value: The name of the Statistical Table configuration object for
weekdays

Changes Take Effect: At the next treatment application

Defines the name of the Statistical Table configuration object that OCS uses to
determine the time ranges for business weekdays.
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vtd-override

Type: Optional

Default Value: No default value

Valid Value(s): Any string that represents a valid DN name

Defines the name of the Voice Transfer Destination (VTD) DN that OCS sends
to CPD Server in the extensions of RequestSeizeAgent and
RequestMakePredictiveCall.When CPD Server receives it, that number will be
used as the destination number to which an engaging call is delivered and for
the T-Server registration as the Voice Transfer Destination (VTD) DN.

If this option is not configured, OCS does not add the corresponding key-value
pair in to RequestSeizeAgent and RequestMakePredictiveCall extensions and
CPD Server takes the destination number from the Voice Transfer Destination
DN configured for the Campaign Group.

Place Group-Level Options

Deployment Guide

The following options can be set in the Options tab of the PLace Group
configuration object only. The options determine if OCS provides simplified
resource availability management for IVR groups. This model does not require
agent login to DN that are assigned to Places in this group.

ivr_group

Type: Optional

Default Value: false

Valid Value(s): true/yes, or false/no

Changes Take Effect: After OCS reloads a dialing session for a campaign
group

Configuration Object: Place Group (only)

Specifies whether OCS provides simplified resource availability management
for IVR groups.

When this option is set to true or yes, OCS uses the simplified resource
availability model when running a campaign for a Campaign Group linked to
this Place Group. Places in that group can contain DNs of type Position,
Extension, orVoice Treatment Port.

ivr_update_on_release

Type: Optional

Default Value: false

Valid Value(s): true/false, yes/no

Changes Take Effect: After set to true or yes, when the ivr_group option is
set to true or yes.

Configuration Object: Place Group (only)

Enables OCS to update the calling list record with values from the outbound
call’s UserData.
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When this option is set to true or yes, OCS updates the fields from the calling
list record with values from the corresponding UserData key-value pairs that
are received in the EventRe leased message. This is similar to

UpdateCal LCompletionStats UserEvent processing.

Field-Level Options for OCS
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You set the following options on the Options tab of the Field object. They are
stored in a section folder called 0CServer or default.

send_attribute
Type: Optional
Default Value: "'

Valid Value(s): Any name that Outbound Contact Server can use as a key in a
key-value pair in UserData.

OCS sends the data attached to a call (UserData) as a key-value pair. The value
of this option defines the key in the pair. The value of the field is the value of
the pair. For example, a user-defined field LastName may have the
send_attribute option with name in the Option Value field. OCS attaches the
key value pair name = <LastName) to the UserData. Suppose the <LastName) in a
record is Smith. When OCS processes this record, it attaches the UserData name
= Smith to a call.

The value of this option should not be an empty string (string of length 0).
Also, all fields should have different values for this option in order to
distinguish them from UserData.

For additional information on attaching field values using this option, see the
“Attaching Record Information to Desktop and OCS User Events” section in
the Outbound Contact 8.0 Reference Manual.

icon_attribute
Type: Optional
Default Value: 0
Valid Value(s): 0, 1,2

Defines how the field’s value will be stored by ICON.

* Ifsetto 0, ICON will not store the value of this field.
o Ifsetto 1, ICON will use a non-secured table.

o Ifsetto 2, ICON will use a secured table.

Note: For ICON to receive and store a field’s value, you must configure the
icon_attribute and the send_attribute options (see page 258) for that
field.

GIM requires the following two options to be configured in order to calculate
metrics: “right_person” and “conversion.”
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right_person
Type: Optional
Default Value: "'

Valid Value(s): Any value that can be stored in the field for which this option
is configured

Marks the field that indicates that the answered call was with the proper
contact. If it is updated with a value equal to what is configured in this option's
value, it will be recognized by GIM as a right person contact indicator.

conversion
Type: Optional
Default Value: empty

Valid Value(s): Any value that can be stored in the field for which this option
is configured

Marks the field that indicates that the answered call was a successful
transaction. If it is updated with a value equal to what is configured in this
option's value, it will be recognized by GIM as a conversion indicator.

Warning! Each of these two options should be specified for only one field
within a calling list.

Calling List-Level Options for OCS

Deployment Guide

You can set the following options as configuration objects on the Options tab
of the Outbound Contact Server ApplLication object, or they can be stored at
the Calling List level.

The folder(s) can be named as follows:

* 0CServer

* default

o <0CS application object name) (see page 209)

OCS can work with many calling lists. At the Calling List level, you can
assign different values for each calling list. When set on the Options tab, the
value applies to all calling lists. OCS looks first at the Calling List level.
When set at this level, this value overrides the value on the Options tab.

am-detection-map

Type: Optional

Default Value: An empty string (' ")

Valid Values: Any name of a Business Attribute value configuration object,
or default

Specifies the name of the Business Attribute value configuration object that
contains the AM-detection map to be used for a particular Calling List or to be
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used application-wide. See “Per-Record Basis” on page 354 for more
information.

campaign_name_field
Type: Optional
Default Value: An empty string (')

Valid Value(s): A valid field name from the Calling List table with an
appropriate data type to store the campaign name.

All calling list records in Genesys Administrator and the Calling List table
include the campaign name and the campaign ID. OCS stores the campaign
name in a user-defined field in the Calling List table. This option specifies the
name of that field in the Calling List table.

If the value of the campaign_name_field option is any string (not an empty
string), when OCS updates the campaign_id field with the DBID of the
campaign, it also updates the field specified by this value with the name of the
campaign.

Warning! Misuse of this option can cause statements from OCS to fail on a
SQL Server.

dial_log_buffer

Type: Optional

Default Value: 16384 (bytes)

Valid Value(s): 2 - 32768

Changes Take Effect: When the next dial log file is opened

Specifies the size of the buffer used for the Record History Log file output, and
the frequency within which OCS updates the History Log file.

The smaller the setting of the size limit for the OCS buffer, the more frequently
OCS must empty the buffer by unloading the data into the file.

dial_log_delimiter

Type: Optional

Default Value: An empty string (' ")

Valid Value(s): Any character combination

Changes Take Effect: When the next dial log file is opened

Specifies the delimiters that are used between the fields of the log for the
calling list (the Record History Log text file). Because the flat files are
produced for this option, delimiters must be added to the log. The default value
is an empty string. If the value of the option is an empty string (string length of
0), the ASCII TAB character (code 9) is used.

You can place this option in the OCS Application object or in a specific list.
OCS first looks for the option in the 0CServer section on the Options tab of a
list. If it does not find the option there, it looks on the Option tab (0CServer
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section) of the application object. For additional information, see
“Log Options Defined” on page 316.

dial_log_destination

Type: Optional

Default Value: An empty string (')

Valid Value(s): <directory path>

Changes Take Effect: When the next dial log file is opened

Specifies the path to the directory that stores a log for the calling list (the
Record History Log text file).

You can put this option in the OCS Application object or in a specific list.
OCS first looks for the option in the OCServer section on the Options tab of a
list. If it does not find the option there, it looks on the Option tab (OCServer
section) of the AppLication object. If OCS still does not find the option, then
OCS does not maintain a log for the list. For additional information, see “Log
Options Defined” on page 316.

interaction-media-type

Type: Optional

Default Value: outboundpreview

Valid Values: Any valid value for the media type business attribute
Changes Take Effect: When the next interaction is created

Defines the media type of the interaction submitted to Interaction Server in the
Push Preview dialing mode.

public_network_access_code
Type: Optional

Default Value: An empty string (')
Valid Value(s): Any character string

Specifies the string that is added as a prefix to each phone number that OCS
sends to a specific switch. The phone numbers in the call UserData remain
unchanged. This number specifies the PSTN access code for the switch to
which T-Server is connected. When an access code is added as a value, the
system always places the access code in front of the phone number that is
dialed. For example, if you set the value 9 into the value field, then the prefix 9
is always dialed before each phone number.

If you are using the Outbound Contact Wizard, it prompts you to enter a value
for this option. To accept the default value for this option, click the Cancel
button on the wizard screen.

You can add Dialogic dialing control parameters as a prefix to the dialed
numbers from a calling list. When combined with the string defined for the
public_network_access_code option, Dialogic dialing control symbols (prefix)
determine the dialing time. The following Dialogic symbols are available:

¢ L—Wait for the local dial tone before dialing.
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* I—Wait for the international dial tone before dialing.
* X—Wait for the special dial tone before dialing.
e , (comma) — Pause 2 seconds

For example, suppose that the public_network_access_code is defined as L9. In
this case, the dialer will wait for a dial tone, dial 9, pause for 2 seconds, then
dial the number from the calling list.

Notes: Dialing control parameters work only if the CPD Server dials the
calls through the Dialogic card (tscall=false).

This option can be set at three levels, Switch/Application (which has
the lowest priority), Campaign Group (which has a medium priority),
and Calling List (which has the highest priority).

treatment-preferred-contact-field

Default Value: none

Valid Value: The name of the field in the Calling List table

Changes Take Effect: At the next treatment application

Defines the field name in the Calling List table that OCS uses for the given
record to determine if this record in a chain should be used for first chain dial
attempt.

When the specified field exists and is not empty string (for char/varchar field
data types) or not zero (for integer field data types), OCS assumes that the

associated record has priority within the chain. If multiple fields of the same
name and for the same chain exist, OCS uses the first record found.

Note: You can also configure this option at the Campaign Level. If
configured it at the Calling List Level and the Campaign Level, this
Calling List Level takes precedence.

treatment-uri
Default Value: none

Valid Value: A string that represents the URI of the SCXML treatment script
resource

Changes Take Effect: At the next treatment application

Defines the URI to the SCXML treatment script resource on the Application
Server, which specifies the treatment used for this Calling List.

The URI can contain treatment parameters and values (key/value pairs
separated by &) that are applied to the instances of the treatment script created
when running a dialing session/campaign. The parameters can include any of
the following:

* Contact type to use when starting the dialing session/campaign
(start_contact_type).
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¢ Maximum number of dialing attempts (max_dial_attempts).

*  User-defined variables, as identified in the script; for example, Type1 and
Type2 used in the script example described in “Script Example” on
page 373.

Separate all parameters and their values using the and (8) symbol. For
example:

treatment-uri=http://server/ocs/treatment1?start_contact_type=HOME&
max_dial_attempts=8

Notes: * You can also configure this option at the Campaign Group Level
(see page 256), which has a lower priority than if is configured at
this Calling List Level.

* Ifno SCXML script is defined in the Campaign Group/Calling List
or if this option is not defined here or at the Campaign Group
Level, OCS uses the treatment configuration describe in
Chapter 12 on page 335.

+ If the value for this option contains parameters/values that are
defined in the script also and the script values differ, the values in
the treatment-uri option take precedence.

treatment_sched_threshold

Type: Optional

Default Value: 30 (minutes)

Valid Value(s): Any non-negative integer (0 and higher)

Determines the threshold for OCS to either:

» Keep rescheduled chains in its memory.

* Remove rescheduled chains from its memory and return them to the
database in the Ready status. OCS will store the treatment application

history information so that it can continue to processing the chains at the
scheduled time.

If the difference between the current time and the scheduled time exceeds the
specified value, OCS will:

* Remove the chain from memory.
* Update it in the database as Ready.

» Store the treatment’s application history info in a calling list's treatments
field for each record in this chain.

OCS retrieves this chain back into memory shortly before the scheduled time
of the next attempt and continues processing the chain of records in treatment
sequence.

If the value is 0, this functionality is disabled and prevents OCS from removing
rescheduled chains from its memory until the dialing session/campaign group
is stopped and unloaded.
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update_all_records

Type: Optional

Default Value: false

Valid Value(s): true/yes, false/no
Changes Take Effect: Immediately

Specifies if a dialing filter determines the set of records that OCS updates after
the chain processing is completed.

* Ifsetto true or yes, OCS updates all records in the chain, regardless of the
dialing filter applied. All records in the chain that are outside the
parameters of the dialing filter are updated with the same status that the
chain receives after OCS has finished processing it.

* Ifsetto false or no, records in the chain that were filtered out by the
dialing filter are marked as record_status = Ready.

Switch-Level Options for OCS

264

You can set the following options as configuration objects on the Options tab
of the Outbound Contact Server Application object, or they can be stored at
the switch level. OCS can work with many switches. At the switch level, you
can assign different values for each switch. When set on the Options tab, the
value applies to all switches.

OCS looks first at the switch level. The option setting at this level overrides the
value in the Options tab.

Switch options are stored in a section folder called 0CServer or Default on the
Options tab of the Switch object.

channel_num

Type: Optional

Default Value: @ (Switch Level); 40 (Application Level)

Valid Value(s): @ or any positive integer

Specifies the total number of available channels (CPD ports) to be used by a

Campaign Group or on the switch when using the Predictive or Progressive
dialing mode.

* If OCS dials a call through T-Server, the value of this option is taken from
the Options tab of the Switch object.

* If OCS dials through CPD Server, the option is not used. OCS derives the
proper number of CPD ports directly from CPD Server through the
protocol events.

This option works as follows:

1. Before requesting the next call from T-Server, OCS calculates the number
of busy channels on the switch.
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2. OCS dials an outbound call when the number of busy channels is less than
the value specified for the channel_num option.

If the default value @ (zero) is assigned to channeL_num, there are no restrictions
on the switch, and OCS dials continuously.

dialing_rate_limit

Type: Optional

Default Value: 100

Valid Values: 0 - N (maximum integer)
Changes Take Effect: Immediately

Specifies the maximum number of calls per second that are shared among all
dialing sessions/Campaign Groups running in the auto dialing modes
(Progressive, Predictive, Progressive with seizing, and Predictive with seizing)
that use the switch. The option is not applicable to engage call legs. If the
option is set to 0, OCS does not dial for any of the Campaign Groups that use
the switch.

Note: The dialing_rate_Limit options set at Campaign Group and
application levels are not affected.

engaged_answer_action

Type: Optional

Default Value: soft_answer

Valid Value(s): hard_not_ready, hard_ready, soft_answer
Changes Take Effect: Immediately

Determines the agent’s place state after an engaging call is established.

*  When set to hard_not_ready, OCS sends a request to T-Server to force the
teleset to a Not Ready state.

*  When set to hard_ready, OCS sends a request to T-Server to force the
teleset to a Ready state.

*  When set to soft_answer, OCS uses the agent state provided by Stat Server.

Note: When using this option, OCS takes the value of
“hard_request to login dn” option into account. In other words, if
hard_request_to_Llogin_dn is set to true, OCS sends
RequestAgentReady to the login DN instead of the DN where the call
was answered.

engaged_release_action

Type: Optional

Default Value: soft_previous

Valid Value(s): soft_previous, hard_ready, hard_not_ready
Changes Take Effect: Immediately
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Determines the agent’s place state after an engaging call has been released.

*  When set to soft_previous, OCS uses the agent state provided by Stat
Server.

*  When set to hard_ready, OCS sends a request to T-Server to force the
teleset to a Ready state.

*  When set to hard_not_ready, OCS sends a request to T-Server to force the
teleset to a NotReady state.

Note: When using this option, OCS takes the value of
“hard_request to login dn” option into account. In other words, if
hard_request_to_Llogin_dn is set to true, OCS sends
RequestAgentReady to the login DN instead of the DN where the call
was released.

hard_request_to_login_dn
Type: Optional

Default Value: no/false

Valid Value(s): yes/true or no/false
Changes Take Effect: Immediately

Determines which DN receives the AgentReady or AgentNotReady request when
an agent's Place in the database has more than one DN associated with it.

You can use this option when Outbound Contact is configured as follows:
* An agent’s Place is configured with an ACD Position and an Extension.

* The “outbound release action” option is set to hard_ready or
hard_not_ready.

When both of these conditions are met, OCS sends an AgentReady or
AgentNotReady request after receiving an EventRe leased message on either of
the agent's DNs, depending on the value of this option.

*  When set to yes or true, OCS sends an AgentReady or AgentNotReady
request to the DN where the agent is logged in.

*  When set to no or false, OCS sends an AgentReady or AgentNotReady
request to the DN that received the EventRe Leased message.

outbound_answer_action

Type: Optional

Default Value: soft_answer

Valid Value(s): hard_not_ready, hard_ready, soft_answer, hard_acw
Changes Take Effect: Immediately

Determines the agent’s place state after an outbound call is established.

*  When set to hard_not_ready, OCS sends a request to T-Server to force the
teleset to a Not Ready state.
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*  When set to hard_ready, OCS sends a request to T-Server to force the
teleset to a Ready state.

*  When set to soft_answer, OCS uses the Agent State provided by Stat
Server.

*  When set to hard_acw, OCS sends a request to T-Server to force the teleset
to the After Call Work state after an outbound call is established on an
agent’s DN.

Notes: * When using this option, OCS takes the value of the
“hard_request to login_dn” option into account. In other words, if
hard_request_to_Llogin_dn is set to true, OCS sends
RequestAgentReady to the login DN instead of the DN where the
call was answered.

* The hard_acw value was added in OCS version 7.6.101.29.

outbound_release_action

Type: Optional

Default Value: soft_previous

Valid Value(s): hard_ready, hard_not_ready, soft_previous, hard_acw
Changes Take Effect: Immediately

Determines the agent’s place state after an outbound call is released.

*  When set to hard_ready, OCS sends a request to T-Server to force the
teleset to the Ready state.

*  When set to hard_not_ready, OCS sends a request to T-Server to force the
teleset to the Not Ready state.

*  When set to soft_previous, OCS uses the Agent State provided by Stat
Server.

*  When set to hard_acw, OCS sends a request to T-Server to force the teleset
to the After Call Work state after an outbound call is released from an
agent’s DN.

Notes: * When using this option, OCS takes the value of the
“hard_request to login dn” option into account. In other words, if
hard_request_to_Llogin_dn is set to true, OCS sends
RequestAgentReady to the login DN instead of the DN where the
call was released.

e The hard_acw value was added in OCS version 7.6.101.29.

preview_release_nocontact_action

Type: Optional

Default Value: soft_previous

Valid Value(s): hard_ready, hard_not_ready, soft_previous
Changes Take Effect: Immediately
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Determines the agent’s place state after an agent releases an unsuccessful
outbound call that the agent had placed manually in the Preview dialing mode.

*  When set to hard_ready, OCS sends a request to T-Server to force the
teleset to the Ready state.

*  When set to hard_not_ready, OCS sends a request to T-Server to force the
teleset to the Not Ready state.

*  When set to soft_previous, OCS does not send any requests to T-Server.

Note: When using this option, OCS takes the value of the
“hard_request to login dn” option into account. In other words, if
hard_request_to_Llogin_dn is set to true, OCS sends
RequestAgentReady to the login DN instead of the DN where the call
was released.

public_network_access_code
Type: Optional

Default Value: No default value
Valid Value(s): Any character string
Changes Take Effect: Immediately

Specifies the string that is added as a prefix to each phone number that OCS
sends to a specific switch for dialing. The phone numbers in the call UserData
remain unchanged. This number specifies the PSTN access code for the switch
to which T-Server is connected. When an access code is added as a value, the
system always places the access code in front of the phone number that is
dialed. For example, if you set the value 9 into the value field, then the prefix 9
is always dialed before each phone number.

If you are using the Outbound Contact Wizard, it prompts you to enter a value
for this option. To accept the default value for this option, click the Cancel
button on the wizard screen.

You can add Dialogic dialing control parameters as a prefix to the dialed
numbers from a calling list. When combined with the string defined for the
public_network_access_code option, Dialogic dialing control symbols (prefix)
determine the dialing time. The following Dialogic symbols are available:

* L—Wait for the local dial tone before dialing.
* I—Wait for the international dial tone before dialing.
* X—Wait for the special dial tone before dialing.

e , (comma)—Pause 2 seconds.
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For example, suppose that the public_network_access_code is defined as L9. In
this case, the dialer will wait for a dial tone, dial 9, pause for 2 seconds, then
dial the number from the calling list.

Note: Dialing control parameters work only if the CPD Server dials the calls
through the Dialogic card (tscall=false).

This option can be set at three levels, Switch/Application (which has
the lowest priority), Campaign Group (which has a medium priority),
and Calling List (which has the highest priority).

DN-Level Options for OCS

Deployment Guide

You set the following options at the DN level. DN options are stored in section
folders on the Options tab of the DN object. The section folder(s) can be
named as follows:

e (0CServer
e default
* <0CS application object name) (see page 209)

overflow_dn

Type: Optional

Default Value: false

Valid Value(s): yes/true or no/false

Designates a DN to which the switch reroutes overflow calls.

Outbound calls that are answered by the called party but remain in an ACD
Queue too long before an agent answers are recognized by the switch as
overflow calls

If this option is set to true or yes, Outbound Contact treats such call as
overflow calls.

Outbound Contact supports two different methods of handling these overflow
calls. The DN configuration in Genesys Administrator determines which
method OCS uses. The two methods are as follows:

o Ifthe overflow DN is an Extension/Position DN, OCS instructs T-Server to
release the call. To use this method, set the overf Low_dn option to true on
the Options tab of the Extension/Position DN to which the switch delivers
overflow calls. When OCS receives an EventRinging message on this DN,
it automatically sends a request to T-Server to answer the call, and then
updates the record with the Dropped call result. After receiving the
EventEstablished response from T-Server, OCS sends a request to
T-Server to release the call.
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* Ifthe overflow DN is a Queue or a Routing Point, the call is transferred to
a Destination DN such as voicemail or IVR for a prerecorded message. To
use this method, set the overf Low_dn option to true on the Options tab of
the ACD Queue or Routing Point from which the overflow calls are
distributed to the destination DNs. When OCS receives an EventQueued on
this DN, it automatically destroys the call in its memory, and then updates
the record with the Dropped call result.

If you set the value of this option to false or no, OCS does not treat calls as
overflow calls if they remain in an ACD Queue (waiting for an agent) beyond
the timeout period. OCS does not update the record as Dropped, and the call is
not released as an overflow call.

outbound_contact_server

Type: Optional

Default Value: undefined

Valid Value(s): yes/true, no/false, or undefined
Changes Take Effect: Immediately

Controls which Communication DNs are used by OCS.

Applying this option to the Communication DNs (CommDNs) reduces the
number of DNs used for OCS. OCS uses CommDNs to communicate with the
Stat Server, the backup OCS, and third-party applications. Set this option to
true or yes if you want OCS to communicate with a third-party application
through this DN. The value undef ined has the same effect as if this option is
absent.

CPD Server Options

270

The CPD Server options are located in section folders on the Options tab of the
CPD Server application object in Genesys Administrator » Provisioning »
Outbound Contact. These sections include new options that allow you to
configure the CPD Server 8.0 to meet the needs of your contact center.

Each of these sections has its own set of configuration options:
*  “General Section” on page 271

o “HMP Section” on page 279

e “ISDN Section” on page 279

* “Line-Side Section” on page 282

* “Tones Section” on page 283

* “License Section” on page 292
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Notes: * Ignore messages about dynamic option changes when the
keep-channe Ls-open option is set to yes, or if Dialogic DM3
hardware or HMP software is used.

* CPD Server does not read options that are not supported for a
particular line type.

* The pre-connect-cpd-priority (page 276) and

post-connect-cpd-priority (page 276) CPD Server options are
ignored when the Line-type option (page 273) contains the hmp

value.

General Section

Deployment Guide

continuous-no-signal

Type: Optional

Default Value: 20

Valid Value(s): unsigned integer

CPD Server Options

Specifies the time, in seconds, of continuous silence (no ring back timeout).

Note: You can configure CPD Server to create two voice files for each

outbound call that it dials on a Dialogic port. The next two options

define the prefixes in the file names for two types of voice recording

files.

cpd-recording

Type: Optional

Default Value: no/false

Valid Value(s): yes/true or no/false

Enables recording of call progress detection.

conversation-file-name-prefix

Type: Required if the cpd-recording option is enabled
Default Value: conv_
Valid Value(s): Any ASCII string

Specifies the prefix for the file name for the conversation recording file.

cpd-file-name-prefix

Type: Required if the cpd-recording option is enabled
Default Value: cpd_

Valid Value(s): Any ASCII string

Specifies the prefix for the file name for the call result recording file.
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cpd-if-established

Type: Optional

Default Value: false

Valid Value(s): true/false, yes/no

Part of the OCS support for uncommon CPD/CTI event flows. It controls the
way the preconnect Call Progress Analysis (CPA) is performed. This option
defines when Dialogic voice resource should be engaged for CPA.

» Ifsetto true or yes, Dialogic CPA is engaged after the EventEstablished
message has been received.

* Ifsetto false or no, Dialogic CPA is engaged immediately at the beginning
of the call start.

For increased flexibility in CPA, two additional options,
pre-connect-cpd-priority and post-connect-cpd-priority, work together to
control the outcome of conflicting call results that come separately from
T-Server (CTI) and Dialogic (CPD).

Notes: * The cpd-if-established option is ignored when CPD Server is
used with Dialogic DM3 hardware. It is also ignored for
Springware hardware with an isdn line-type.

* When you are using the Line-side-dm3, isdn-dm3, cas-dm3, or hmp
line types, the value for this option automatically adjusts to false.

destination-busy-timeout

Type: Optional

Default Value: 2000 (miLLliseconds)

Valid Value(s): <A numeric value representing milliseconds>

CPD Server normally waits for both of the following indicators that a dialed
number is busy before it terminates call progress detection.

* Busy call result from the Dialogic board

* EventDestinationBusy from T-Server

This option prevents CPD Server from waiting indefinitely for a Busy call
result by specifying the length of time (in milliseconds) that CPD Server
waits for confirmation of the call result from the second source after the
first has arrived. When the timeout expires, CPD Server accepts the Busy
call result as correct.

keep-channels-open

Type: Optional

Default Value: no

Valid Value(s): yes, no

Changes Take Effect: Immediately

Determines how CPD Server uses Dialogic channels.
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When set to yes, CPD Server keeps all Dialogic channels open and reuses them
for the next call. CPD Server is unable to process dynamic option changes
when this value is specified.

When set to no, CPD Server closes the Dialogic channels after use and reopens
them for the next call.

Note: Please ignore messages about dynamic option changes when the
keep-channe Ls-open option contains a value of yes.

line-type

Type: Required

Default Value: None

Valid Value(s): analogue, Line-side, Lline-side-dm3, isdn, isdn-dm3,
cas-dm3, sip-hmp, sip-hmp-asm

Specifies the type of line (Dialogic card) that is being used. It also specifies the
type of the protocol used to connect the Dialogic board to the switch or PSTN;
for example: dm3, analogue, Line-side, or isdn.

The analogue value represents analog Dialogic boards that are supported in
transfer mode only because answer supervision is not supported by analog
lines.

The Line-side-dm3 and sip-hmp values are for transfer mode only.

The isdn-dm3, cas-dm3, and sip-hmp-asm values are for ASM-mode only.

Notes: * The sip-hmp and sip-hmp-asm values prompt CPD Server to process
the sip-proxy option. See page 279 for more information about this
option.

* Please ignore messages about dynamic option changes when
Dialogic DM3 hardware is used.

location

Type: Required

Default Value: None

Valid Value(s): Any string

Specifies the name of the folder under the DN section of the Switch object of the
T-Server application that CPD Server uses when dialing.

max-number-ports-to-record
Type: Optional

Default Value: 0

Valid Value(s): 0 - k

Enables CPD Server to record files in a plain VOX format
(PCM/8000Hz/8bps). It creates the following two voice files for each
outbound call:
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* File I contains the line recording for the call progress detection stage.

* File 2 records the conversation between an agent and the called party if the
call result is answer (ASM mode only).

CPD Server records these voice files on the Dialogic ports used for outbound
dialing. Specific ports are not dedicated for reporting, but the number of ports
to use for recording is configurable. The max-number-ports-to-record option
specifies the maximum number of agent ports on which to record at the same
time. A value of 1 or more enables voice file recording on that number of ports
concurrently. A value of 0 (zero) disables the voice file recording function.

CPD Server keeps track of the ports that are being recorded and stops
recording when the specified number of ports are engaged for this purpose.
CPD Server will not record on another port until one is disengaged. The
number of times that the same call transfers from Agent DN to Agent DN does
not increase the number of ports being used for the recording of that call. The
call remains on the same port when it passes from agent to agent.

The value of the max-number-ports-to-record is limited by two factors:
* The number of configured recording ports
* The hardware limit for the number of Dialogic ports per box

For example:

switch
DNs
'location_name'
regular
engaging
recording
dxxxBl1
dxxxB1Cl1
dxxxB2C2

When a number of voice channels are reserved for recording, the same number

of digital channels should be disabled so that CPD will report the correct

number of available ports for dialing. This should be done if the following is

true:

* CPD Server is working in transfer mode and the number of either digital or
loop start channels is equal to the number of voice channels.

* CPD Server is working in ASM ISDN mode and the number of
non-engaging channels is equal to the number of voice channels.

* CPD Server is working in ASM Melcas mode and the number of digital
channels is equal to the number of voice channels.
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You can upgrade the number of voice channels by adding more Dialogic voice
only boards.

Note: The extended port usage for recording might necessitate the allocation
of more Dialogic resources—that is, an increased number of ports to
be used for outbound dialing in general.

off-hook-delay

Type: Optional

Default Value: -1

Valid Value(s): Any integer

Specifies the delay, in seconds, between off-hook and TMakeCall:
If set to a negative value,: of f-hook, and then tmakecall is sent.
If set to a positive value: tmakecall, and then off-hook is sent.

off-hook-timeout

Type: Optional

Default Value: 1

Valid Value(s): Any positive integer

Specifies the amount of time to wait, in seconds, that CPD Server waits before
assuming that the channel is in the off-hook state.

on-hook-timeout

Type: Optional

Default Value: 1

Valid Value(s): Any non-negative integer

Specifies the amount of time, in seconds, that CPD Server waits before
assuming that the channel is in an on-hook state.

out-of-service-attempts

Type: Optional

Default Value: 2

Valid Value(s): Any non-negative integer; minimum 2

Specifies the number of failed attempts to use a port (channel) before CPD
Server marks it out of service.

out-of-service-timeout

Type: Optional

Default Value: 1

Valid Value(s): Any non-negative integer, with no upper limit restrictions;
minimum 0>
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Specifies the amount of time (in minutes) that CPD Server waits before trying
to use an out-of-service port again. If the value is 0, CPD Server ignores
out-of-service conditions and continues to attempt to use the port.

post-connect-cpd-priority
Type: Optional

Default Value: tserver

Valid Value(s): tserver, dialogic

Defines the CPD priority for post-connect CPA. This option works together
with the pre-connect-cpd-priority option.

pre-connect-cpd-priority
Type: Optional

Default Value: tserver

Valid Value(s): tserver, dialogic

Defines the source of Call Progress Information that is used for preconnect
CPA.

For increased flexibility in CPA for uncommon CPD/CTI event flow support,
the pre-connect-cpd-priority and post-connect-cpd-priority options work
together.

They control the outcome of conflicting call results that come separately from
T-Server (CTI) and Dialogic (CPD). They also define the conclusive source of
CPA. Each of these options controls some possible conflicting CPA outcomes
for the pre- and post-connect CPA.

This option works together with the post-connect-cpd-priority option.

sit-detection

Type: Optional

Default Value: yes/true

Valid Value(s): yes/true or no/false

Defines the SIT signal parameters in the Dialogic DX CAP data structure to
enable CPD Server to more easily identify a SIT signal.

Controls SIT detection under the following conditions: SIT is disabled, and the
tscall option is enabled to determine, from the DestinationBusy event,
whether a number is valid.

tscall

Type: Optional

Default Value: no/false

Valid Value(s): yes/true or no/false

Specifies whether CPD Server sends a request to T-Server (tscall = true or
yes) or to Dialogic board (tscall = false or no) to make a call.
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tsclear

Type: Optional

Default Value: no/false

Valid Value(s): yes/true or no/false

Controls the way in which a call is released. If this option is set to yes,

a RequestClearCall (G3 specific) is issued to release an active call.

This option is useful, but not required, if a two-step transfer fails on a G3
switch.

use-engaging-lines

Type: Optional

Default Value: no/false

Valid Value(s): yes/true or no/false

Applicable only to ASM mode:

» Ifsettonoor false, CPD Server engages agents by using lines from the
regular lines pool—that is, from the regular folder.

» Ifsetto yes or true, CPD Server engages agents by using lines from a
special lines pool that is dedicated to engaging purposes—that is, from the
engaging folder.

You can benefit from this option if, for example, you wants to use special
trunks for agent engagement—for example, lines that connect directly to the
switching office and deliver calls directly to agents, free of charge. When this
value is set to yes, this option provides an alternative to using trunks that incur
a charge for every call.

Notes: * Changes to the engaging folder are not supported while CPD

Server is running.
* All voice channels (dxxx) are used by the regular network channels

(dti) first, and then are used by the engaging channels. If you do
not have more voice channels than network channels in your
regular folder, then there will be no voice channels remaining for
use for the engaging channels. In this case, engaging calls cannot
be made.

use-busy2-as-nu-tone

Type: Optional

Default Value: no/false

Valid Value(s): yes/true or no/false

Controls the way in which the Busy2 tone is detected. This option enables CPD

Server to detect a NU (Number Unobtainable) tone call result by using the
Busy2 tone.

When the value is set to yes, the NU tone call result is assigned to all Busy2 tone
detected calls. You can set this option at the AppLication level.
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use-fax2-as-am-tone

Type: Optional

Default Value: no/false

Valid Value(s): yes/true or no/false

Controls the way in which the Fax2 tone is detected. This option enables CPD
Server to detect an Answering Machine call result by using the Fax2 tone.

When the value is set to yes, the Answering Machine call result is assigned to all
Fax2 tone detected calls. You can set this option at the AppLication level.

wait-off-hook

Type: Optional

Default Value: no/false

Valid Value(s): yes/true or no/false

Specifies whether CPD Server waits (a value of yes or true) or does not wait
(a value of no or false) for an off-hook event from T-Server.

Note: This value is used when the tscall option has a value of true and the
of f-hook-de Lay option has a negative value.

CPD Proxy Server Options
The following options apply to CPD Proxy Server only.

max-dialing-channels

Type: Optional

Default Value: 0

Valid Value(s): 0...n

Changes Take Effect: Immediately

Specifies the maximum number of dialing channels that can be used by the

OCS client of CPD Proxy Server. If the value is 0, there is no restriction to the
number of channels used.

max-engaging-channels

Type: Optional

Default Value: 0

Valid Value(s): 0. ..n

Changes Take Effect: Immediately

Specifies the maximum number of engaging channels that can be used by the

OCS client of CPD Proxy Server. If the value is 0, there is no restriction to the
number of channels used.
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HMP Section

ISDN Section

Deployment Guide

The options in this section are enabled when the Line-type option (page 273)
contains the sip-hmp or sip-hmp-asm values.

audio-codecs

Type: Optional

Default Value: PCMU

Valid Value(s): PCMU, PCMA, or both separated by a comma
Changes Take Effect: After restart

Defines the codec(s) to use for HMP. If more than one codec is listed, the first
codec has priority over the second.

* The PCMU value corresponds to the G.711 mu-law codec.

* The PCMA value corresponds to the G.711 a-law codec.

sip-proxy

Type: Mandatory

Default Value: "'

Valid Value(s): <any valid host name or IP address>

Defines the SIP Proxy host name or IP address.

Note: Please ignore messages about dynamic option changes when HMP
software is used.

The isdn section is ignored when CPD Server is use with Dialogic DM3
hardware.

Note: If you are using the Line-side-dm3, isdn-dm3, and cas-dm3 line
types, all options in this section are ignored, except
calling-party-number.

called-party-number-plan

Type: Optional

Default Value: isdn

Valid Value(s): The string: unknown, isdn, telephony, or private

Identifies the number plan of the party called.

called-party-number-type

Type: Optional

Default Value: national

Valid Value(s): national, international, en-block, overlap

279



Chapter 9: Outbound Contact Configuration Options CPD Server Options

Indicates the type of number for the party called.

calling-party-number-plan

Type: Optional

Default Value: isdn

Valid Value(s): unknown, isdn, telephony, or private

Identifies the number plan of the calling party.

calling-party-number-type

Type: Optional

Default Value: national

Valid Value(s): national, international, en-block, or overlap

Indicates the type of number for the calling party.

calling-party-number

Type: Optional

Default Value: None

Valid Value(s): Any digit string not longer than 31 characters

Specifies the number of the calling party.

Notes: ¢ The calling party number (isdn-dm3) is always sent and cannot be
an empty string when CPD Server is used with Dialogic DM3
hardware.

» If you are using isdn-dm3 and cas-dm3 line types this option is
mandatory, and its value cannot be an empty string.

engage-cpd-on-call-setup
Type: Optional

Default Value: no/false

Valid Value(s): yes/true or no/false

Instructs the CPD Server to engage in Call Progress Analysis during the ISDN
call setup. This option is especially useful in the following situations:

* Setup for ISDN to non-ISDN destination calls.

* In-band signaling is present before the connection is established.
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Note: ° For isdn-dm3, sip-hmp, and sip-hmp-asm line-types, CPD Server
ignores a voice message and detects only tones during preconnect
call progress analysis (CPA), even if the voice message is detected
before the tone. To enable preconnect CPA (that is, the CPA is
performed before the connection is established), set this option to
yes in the isdn section for the isdn-dm3 line-type or in the hmp
section for all HMP line-types.

 If you are reconfiguring specific tones for Dialogic DM3 hardware,
for isdn-dm3, sip-hmp, and sip-hmp-asm line-types, set this option
to yes. For more information, see “Reconfiguring Tones for
Dialogic DM3 Hardware” on page 288.

isdn-trace

Type: Optional

Default Value: no/false

Valid Value(s): yes/true or no/false

Specifies whether CPD Server creates an ISDN board resource (d-channel)
trace log (value = yes or true) or does not create this trace log (value = no or
false).

Genesys recommends that you use this isdn-trace option for log purposes
only when additional call information is required. The default value (no or
false) normally applies.

If the value is set to yes or true, CPD Server receives error messages (Device
busy and/or Invalid device) after approximately 100,000 calls. CPD Server
then stops Outbound calling due to the inability to dial through the Dialogic
channels.

If this happens, complete the following procedure:
1. Stop the CPD Server.

2. Change the value of the isdn-trace option to no to turn off the ISDN board
resource (d-channel) trace log.

3. Restart the Dialogic drivers.
4. Restart the CPD Server.

isdn-trace-file-name-prefix

Type: Optional

Default Value: isdn_

Valid Value(s): Any string

Specifies the prefix for the ISDN trace file.
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presentation-indicator

Type: Optional

Default Value: restricted

Valid Value(s): allowed, restricted, not-available

Specifies whether a presentation indicator (Caller _ID) is allowed, restricted, or
not available for an ISDN call-setup message.

use-channel-state

Type: Optional

Default Value: no/false

Valid Value(s): yes/true or no/false

Specifies whether CPD Server uses a channel state (value = yes or true) or
does not use a channel state (value = no or false). If yes or true, an in-service
message is sent to the switch through the d-channel (ISDN line). Available in
North America only.

user-info-layer-1

Type: Optional

Default Value: g711-ulaw;

Valid Value(s): g711-ulaw; g711-alaw;

CPD Server reads the value of this option from the ISDN section of its

application object and applies the value to the user info Llayer 1 field in the
ISDN call setup message.

Line-Side Section
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The Line-side section is ignored when CPD Server is used with Dialogic DM3
hardware. The /config/fcd/pcd Dialogic files must be used instead.

Note: If you are using the Line-side-dm3 and cas-dm3 line types, you cannot
modify the bit mask parameters through the CPD Server configuration
options. Instead, you use the Dialogic *.config, *.fcd, and *.pcd
files. These files are located at $DIALOGICDIR\data. Consult the

Dialogic documentation for more information on modifying these
files.

off-hook-bit-mask

Type: Optional

Default Value: a-on; b-on;

Valid Value(s): a-off; b-on; a-off;b-off; a-on;b-off; a-on;b-on;
Specifies the mask for a T1/E1 line that is off-the-hook.
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on-hook-bit-mask

Type: Optional

Default Value: a-off; b-on;

Valid Value(s): a-off;b-on; a-off;b-off; a-on;b-off; a-on;b-on;
Specifies the mask for a T1/E1 line that is on-the-hook.

rcv-idle-bit-mask

Type: Optional

Default Value: a-off; b-on;

Valid Value(s): a-off;b-on; a-off;b-off; a-on;b-off; a-on;b-on;

Specifies the mask that indicates a T1/E1 line in an idle state.

snd-idle-bit-mask

Type: Optional

Default Value: a-off; b-on;

Valid Value(s): a-off;b-on; a-off;b-off; a-on;b-off; a-on;b-on;

Specifies the mask that the Dialogic board sends to a switch to make a TI/E1
line idle.

Tones Section

The tones section does not configure the tone definition when CPD Server is
used with Dialogic DM3 hardware, with the exception of the
use-fax2-as-am-tone and forth-tone options. If you need to reconfigure
specific tones for Dialogic DM3 hardware, you can do so by creating a
dm3tones section (see “Reconfiguring Tones for Dialogic DM3 Hardware” on
page 288) or through /config/fcd/pcd Dialogic files.

Note: This section is not used when the Line-type option (page 273) is set to
sip-hmp.

Any of the following can be represented by a tone:
* Busy signal

* Dial tone

* Fax machine

* Ring back

* Beep signal
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Within each of these broad categories of tones, there are specific types of
tones—for example a local dial tone or an international dial tone.

Notes: * The qual templates are configured in the /config/fcd/pcd Dialogic

Tone Options

files when CPD Server is use with Dialogic DM3 hardware.

If you are using the Line-side-dm3, isdn-dm3, or cas-dm3 line
types, you can either reconfigure specific tones using a separate
dm3tones section (page 288) or by changing the tone definition in
the Dialogic #.config, *.fcd, and *.pcd files. These files are
located at $DIALOGICDIR\data. For more information on modifying
these files, consult the Dialogic documentation.

For isdn-dm3, sip-hmp, and sip-hmp-asm line-types, CPD Server
ignores a voice message and detects only tones during pre-connect
call progress analysis (CPA), even if the voice message is detected
before the tone. To enable preconnect CPA (that is, the CPA is
performed before the connection is established), set the
engage-cpd-on-call-setup option (see page 280) to yes in either
the isdn section for the isdn-dm3 line-type or in the hmp section for
all HMP line-types.

There is a Dialogic option for each type of tone, that the Genesys configuration
environment recognizes. These tone options are as follows:

* busy-tone-1

* busy-tone-2

¢ disconnect-tone

e extra-dial-tone

e fax-tone-1

e fax-tone-2

e forth-tone

o intl-dial-tone

e local-dial-tone

* ring-back-tone-1

* ring-back-tone-2

e sjit-tone

“Tone Parameters” provides more details about each of these tone options.

Tone Parameters

For the tone options described in this section, a series of numbers separated by
semicolons represents the following nine parameters for each tone:

284
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* Frequency of first tone

* Frequency deviation for first tone

* Frequency of second tone

* Frequency deviation for second tone
¢ On duration

*  Ontime deviation

*  Off duration

*  Offtime deviation

* Repetition count

Note: All parameters inside string values for CPD Server options are
separated by semicolons.

For examples of tone parameters, see the default values for the following tone
options.

Note: In the following tone option descriptions, parameters are in 10 ms
units.

busy-tone-1

Type: Optional

Default Value: 500; 200; 0; 0; 55; 40; 55; 40; 4;

Valid Value(s): Any string of numbers separated by semicolons and
representing the nine tone parameters. (see “Tone Parameters” on page 284).

Defines a template for the first busy tone.

busy-tone-2

Type: Optional

Default Value: 500; 200; 500; 200; 55; 40; 55; 40; 4;

Valid Value(s): Any string of numbers separated by semicolons and
representing the nine tone parameters. (see “Tone Parameters” on page 284).

Defines a template for the second busy tone.

disconnect-tone

Type: Optional

Default values: 500; 200; 500; 200; 55; 40; 55; 40; 10;

Valid Value(s): Any string of numbers separated by semicolons and
representing the nine tone parameters.

Defines a template for disconnect tone, also known as a “fast busy tone.”
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extra-dial-tone

Type: Optional

Default Value: 401; 125; 401; 125; 0; 0; 0; 0; 0;

Valid Value(s): Any string of numbers separated by semicolons and
representing the nine tone parameters. (see “Tone Parameters” on page 284”).

Defines a template for an extra dial tone.

fax-tone-1

Type: Optional

Default Value: 2150; 150; 0; 0; 25; -25; 0; 0; 0;

Valid Value(s): Any string of numbers separated by semicolons representing
the nine tone parameters. (see “Tone Parameters” on page 284).

Defines a template for the first FAX tone.

fax-tone-2

Type: Optional

Default Value: 1100; 50; 0; 0; 25; -25; 0; 0; 0;

Valid Value(s): Any string of numbers separated by semicolons representing
the nine tone parameters. (see “Tone Parameters” on page 284).

Defines a template for a second FAX tone.

forth-tone

Type: Optional

Default Value: 0; 0; 0; 0; 0

Valid Value(s): Any string of numbers separated by semicolons representing
the following tone parameters: (see “Tone Parameters” on page 284).

Frequency of first tone:

* Frequency range: 200 Hz to 4000 Hz

* Frequency resolution: 1 Hz

Frequency of second tone:

* Frequency range: 200 Hz to 4000 Hz

*  Frequency resolution: 1 Hz

Amplitude of first tone:

* (E-1) -40 dBmO to +0 dBm per tone nominal
¢ (T-1) -43 dBmO to -3 dBm per tone nominal

Amplitude of second tone:

* (E-1)-40 dBmO to +0 dBm per tone nominal
e (T-1) -43 dBmO to -3 dBm per tone nominal

Duration: 10 millisecond increments

The forth-tone option enables or disables a beep signal that alerts an agent
immediately before a customer is connected to him or her. When an agent is in

Outbound Contact 8.0 @



Chapter 9: Outbound Contact Configuration Options CPD Server Options

Deployment Guide

the engaged mode and waiting to be connected to a customer, this
low-frequency tone notifies him or her that a connection is imminent. You can
configure the tone frequency, duration, and amplitude of the signal. CPD
Server supports this signal on DM3 hardware and SIP-HMP-ASM line-type.

intl-dial-tone

Type: Optional

Default Value: 402; 125; 402; 125; 0; 0; 0; 0; 0;

Valid Value(s): Any string of numbers separated by semicolons representing
the nine tone parameters (see “Tone Parameters” on page 284).

Defines a template for an international dial tone.

local-dial-tone

Type: Optional

Default Value: 400; 125; 400; 125; 0; 0; 0; 0; 0;

Valid Value(s): Any string of numbers separated by semicolons and
representing the nine tone parameters (see “Tone Parameters™ on page 284).

Defines a template for a local dial tone.

ring-back-tone-1

Type: Optional

Default Value: 450; 150; 0; 0; 130; 105; 580; 415; 0;

Valid Value(s): Any string of numbers separated by semicolons and
representing nine tone parameters (see “Tone Parameters” on page 284).

This option defines a template for the first ring-back tone.

ring-back-tone-2

Type: Optional

Default Value: 450; 150; 450; 150; 130; 105; 580; 415; 0;

Valid Value(s): A string of numbers separated by semicolons representing nine
tone parameters (see “Tone Parameters” on page 284).

This option defines a template for a second ring-back tone.

sit-tone

Type: Optional

Default Value: 900; 1000; 5;50;0;0; 0;0; 0; 0; 0; 0;

Valid Value(s): Any string of numbers separated by semicolons and
representing the following tone parameters.

Defines the SIT signal parameters in the Dialogic DX CAP data structure.

A series of 12 numbers separated by semicolons representing these 12
parameters for the sit-tone:

* Lower Frequency: Lower bound for 1st tone in an SIT. (Call Analysis)
Length: 2. Default Value: 900. Units: Hz.
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* Upper Frequency: Upper bound for 1st tone in an SIT. (Call Analysis)
Length: 2. Default Value: 1000. Units: Hz.

* Time Frequency: Minimum time for 1st tone in an SIT to remain in
bounds. The minimum amount of time required for the audio signal to
remain within the frequency detection range specified by upper frequency
and lower frequency for it to be considered valid. (Call Analysis) Length:
1. Default Value: 5. Units: 10 ms

*  Maximum Time Frequency: Maximum allowable time for 1st tone in an
SIT to be present. Length: 1. Default Value: 0. Units: 10 ms.

* Lower Bound for 2nd Frequency: Lower bound for 2nd tone in an SIT.
Length: 1. Default Value: 0. Units: Hz.

* Upper Bound for 2nd Frequency: Upper bound for 2nd tone in an SIT.
Length: 1. Default Value: 0. Units: Hz.

* Time for 2nd Frequency: Minimum time for 2nd tone in an SIT to remain
in bounds. Length: 1. Default Value: 0. Units: 10 ms.

*  Maximum Time for 2nd Frequency: Maximum allowable time for 2nd tone
in an SIT to be present. Length: 1. Default Value: 0. Units: 10 ms.

* Lower Bound for 3rd Frequency: Lower bound for 3rd tone in an SIT.
Length: 1. Default Value: 0. Units: Hz.

*  Upper Bound for 3rd Frequency: Upper bound for 3rd tone in an SIT.
Length: 1. Default Value: 0. Units: Hz.

*  Time for 3rd Frequency: Minimum time for 3rd tone in an SIT to remain in
bounds. Length: 1. Default Value: 0. Units: 10 ms.

¢ Maximum Time for 3rd Frequency: Maximum allowable time for 3rd tone
in an SIT to be present. Length: 1. Default Value: 0. Units: 10 ms.

Note: Please note that SIT tone definitions should be customized only if the
default settings are inappropriate for your particular system.

Reconfiguring Tones for Dialogic DM3 Hardware

If you want to reconfigure specific tones for Dialogic DM3 hardware, you can
do so by configuring a dn3tones section and associated options, instead of
changing the tone definition in the Dialogic *.config, #*.fcd, and *.pcd files.

288 Outbound Contact 8.0 @



Chapter 9: Outbound Contact Configuration Options CPD Server Options

Procedure:
Configuring a dm3tones Section

Start of procedure

1. Configure a new dm3tones section.

2. In this new section, configure the following tones, as required:

Notes: * The format for these option differs from those in the tone
section. See “Option Value Format for dm3tones Section” on
page 290.

» For a description of these options, with the exception of the sit
options, refer to their associated descriptions in the tones
section at the page number indicated. For the sit options, the
option is described in this section.

* busy-tone-1 (see page 285)

* busy-tone-2 (see page 285)

* disconnect-tone (see page 285)

* extra-dial-tone (see page 286)

* fax-tone-1 (see page 286)

* fax-tone-2 (see page 286)

* intl-dial-tone (see page 287)

* local-dial-tone (see page 287)

* ring-back-tone-1 (see page 287)

* ring-back-tone-2 (see page 287)

* sit-no-circuit (see page 291)

* sit-operator-intercept (see page 291)
* sit-reorder (see page 291)

* sit-vacant-circuit (see page 291)

Note: The sit-no-circuit, sit-operator-intercept,
sit-vacant-circuit, and sit-reorder tones are specific to DM3
hardware. As such, they do not appear in the tones section (see
page 283).

3. For isdn-dm3, sip-hmp, and sip-hmp-asm line-types, set the
engage-cpd-on-call-setup option (see page 280) to yes.

End of procedure
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Format Example:
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Option Value Format for dm3tones Section

The format for the option values in this dn3tones section differs from those in
the tones section, and is as follows:

treat-as=<tone-name2); numofseg; tn_rep_cnt; (tn_dflag; tni_min;
tn1_max; tn2_min; tn2_max; tn_twinmin; tn_twinmax; tnon_min;
tnon_max; tnoff_min; tnoff_max)

Where:

* The treat-as=<tone-name2) parameter is used to map one tone to another
and is optional. It is applicable for mapping SIT tones to any of the other
tones.

* <tone-name2) can be the name of any of the other tones, whether or not its
value is defined this section.

The text in the parentheses can be repeated any number of times, as specified
by the numofseg parameter.

The format parameters include:

* numofseg—Specifies the number of segments (defined by the parameters in
the parentheses) for a multi-segment tone.

* tn_df lag—Specifies whether the tone is a dual tone (a value of 1) or a
single tone (a value of 0).

* tn_rep_cnt—Specifies the debounce repetition count.

* tn1_min—Specifies the minimum frequency in Hertz (Hz) for tone 1.
* tn1_max—Specifies the maximum frequency in Hz for tone 1.

* tn2_min—Specifies the minimum frequency in Hz for tone 2.

* tn2_max—Specifies the maximum frequency in Hz for tone 2.

* tn_twinmin—Specifies the minimum frequency in Hz of the single tone
proxy for the dual tone.

* tn_twinmax—Specifies the maximum frequency in Hz of the single tone
proxy for the dual tone.

* tnon_min—Specifies the debounce minimum ON time in 10 msec units.

* tnon_max—Specifies the debounce maximum ON time in 10 msec units.

* tnoff_min—Specifies the debounce minimum OFF time in 10 msec units.
* tnoff_max—Specifies the debounce maximum OFF time in 10 msec units.
You can redefine the sit-vacant-circuit tone to treat it as busy-tone-1, and
configure the sit-vacant-circuit option with the following value:

treat—as=busy—tone—1; 3; 1; (0; 950; 1020; 0; 0; 0; 0; 32; 45; 0; 5)
(0; 1310; 1430; 0; 0; 0; 0; 15; 30; 0; 5) (0; 1740; 1850; 0; 0; 0; 0; 0; 0; 0; 0) .

This means that the board’s tone definition for sit-vacant-circuit will be
redefined according to previously listed parameters and, when this tone is
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detected during call progress analysis (CPA), CPD Server will behave as if
busy-tone-1 was detected.

Notes: * Changes to the options in the dm3tones section take effect only after
CPD Server is restarted.

+ Redefined tones remain active in the DM3 board until the Dialogic
service is restarted.

+ Some boards may not support redefining every tone.

* When redefining tones, make sure that their redefinition does not
prevent a protocol from working properly. Consult your Dialogic
manuals for more information.

* There are no default values for the options in this dm3tones section.
The Dialogic driver loads the default tones definition into the DM3
board during startup of the Dialogic system. The values of the
tones definition may depend on Dialogic protocol and other
Dialogic configuration. Consult your Dialogic manuals for more
information.

sit-no-circuit

Type: Optional

Default Value: none

Valid Value(s): See “Option Value Format for dm3tones Section” on page 290

Defines a template for a No Circuit SIT tone.

sit-operator-intercept

Type: Optional

Default Value: none

Valid Value(s): See “Option Value Format for dm3tones Section” on page 290

Defines a template for an Intercept SIT tone.

sit-reorder

Type: Optional

Default Value: none

Valid Value(s): See “Option Value Format for dm3tones Section” on page 290

Defines a template for a Reorder SIT tone.

sit-vacant-circuit

Type: Optional

Default Value: none

Valid Value(s): See “Option Value Format for dm3tones Section” on page 290

Defines a template for a Vacant Circuit (Vacant Code) tone.
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License Section

The License section contains two options that support the licensing of CPD
Server:

license-file

Type: Optional

Default Value: None

Valid Value(s): Any string

Changes Take Effect: After the application is restarted
Specifies the license address in one of these formats:

* The host name and port of the license server, as specified in the SERVER
line of the license file, in the port@host format—for example:

* T7260ectiserver
* The full path to and the exact name of the license file—for example:
/opt/mlink/License/license.dat

num-occ-port-licenses

Type: Optional

Default Value: 0 (all available licenses)

Valid Value(s): max or an integer from 0 to 9999

Specifies how many licenses CPD checks out initially.

» If the value of this option is increased, CPD will attempt to check out an
additional amount of licenses. This change takes effect immediately.

» If the value of this option is decreased, CPD Server will check in the extra
licenses and will not release the ports. CPD Server will not use the ports
until the number of used ports falls below the number of licenses available
for the CPD Server.

Correlation Between CPD Server Options and Dialogic

Boards

292

This section provides information on the correlation between CPD Server
options, Dialogic Board types, and Dialer modes.

In the tables, note the following:

* No indicates that the option is not used in the given Dialing Mode / Board
Type / Line-Type.

* Yes indicates that the Option is used in the given Dialing Mode / Board
Type / Line-Type.

* A dash (-) indicates that the Dialing Mode / Board Type / Line-Type
combination is not possible.
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ASM Dialer Mode

CPD Server Options

The section provides correlation information on the ASM (Active Switching
Matrix) Dialer Mode for the following board types:

* DMV (Table 18)
¢ JCT (Table 19 on page 296)

* HMP (Table 20 on page 299)

Table 18: DMV Dialogic Board Type

Section | CPD Server analogue | line-s| line-s| isdn | isdn- | cas-d| sip-h | sip-h
Option line-type | ide ide-d | line-t | dm3 | m3 mp mp-a
linet m3 |ype |line-t|line-t|line |sm

ype | line-t ype |ype |type | line-t

ype ype
tones busy-tone-1 - - - - No No - -
busy-tone-2 - - - - No No - -
extra-dial-tone - - - - No No - -
fax-tone-1 - - - - No No - -
fax-tone-2 - - - - No No - -
intl-dial-tone - - - - No No - -
local-dial-tone - - - - No No - -
ring-back-tone-1 - - - - No No - -
ring-back-tone-2 - - - - No No - -
disconnect-tone - - - - No No - -
forth-tone - - - - Yes Yes - -
sit-tone - - - - No No - -
line-side | off-hook-bit-mask - - - - No No - -
on-hook-bit-mask - - - - No No - -
rcv-idle-bit-mask - - - - No No - -
snd-idle-bit-mask - - - - No No - -
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Table 18: DMV Dialogic Board Type (Continued)

CPD Server Options

Section | CPD Server analogue | line-s| line-s| isdn | isdn- | cas-d| sip-h | sip-h
Option line-type | ide ide-d | line-t | dm3 | m3 mp mp-a
linet m3 |ype |line-t|line-t|line |sm
ype | line-t ype |ype |type | line-t
ype ype
isdn called-party-number- | — - - - No No - -
plan
called-party-number-t | — - - - No No - -
ype
calling-party-number | — - - - Yes Yes - -
calling-party-number- | — - - - No No - -
plan
calling-party-number- | — - - - No No - -
type
isdn-trace - - - - No No - -
isdn-trace-file-name- | — - - - No No - -
prefix
presentation-indicator | — - - - No No - -
use-channel-state - - - - Yes Yes - -
engage-cpd-on-call-s | — - - - No No - -
etup
user-info-layer-1 — - - - No No - -
hmp audio-codecs - - - - No No - -
sip-proxy - - - - No No - -
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Table 18: DMV Dialogic Board Type (Continued)

CPD Server Options

Section | CPD Server analogue | line-s| line-s| isdn | isdn- | cas-d| sip-h | sip-h

Option line-type | ide ide-d | line-t | dm3 | m3 mp mp-a
linet m3 |ype |line-t|line-t|line |sm
ype | line-t ype |ype |type | line-t
ype ype

general continuous-no-signal | — - - - No No - -
conversation-file-nam | — - - - Yes Yes - -
e-prefix
cpd-file-name-prefix | — - - - Yes Yes - -
cpd-recording - - - - Yes Yes - -
cpd-if-established - - - - No No - -
destination-busy-time | — - - - Yes Yes |- -
out
keep-channels-open | — - - - No No - -
line-type - - - - Yes Yes |- -
location - - - - Yes Yes - -
max-number-ports-to | — - - - Yes Yes - -
-record
off-hook-delay - - - - No No - -
off-hook-timeout — - - - No No - -
on-hook-timeout - - - - No No - -
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Table 18: DMV Dialogic Board Type (Continued)

Section | CPD Server analogue | line-s| line-s| isdn | isdn- | cas-d| sip-h | sip-h

Option line-type |ide ide-d | line-t | dm3 | m3 mp mp-a
line-t | m3 ype |line-t|line-t|line |sm
ype | line-t ype |ype |type | line-t
ype ype

out-of-service-attemp | — - - - Yes Yes - -
ts
out-of-service-timeou | — - - - Yes Yes - -
t
pre-connect-cpd-prior | — - - - No No - -
ity
post-connect-cpd-prio | — - - - No No - -
rity
sit-detection - - - - Yes Yes - -
tscall - - - - No No - -
tsclear - - - - No No - -
use-busy2-as-nu-tone | — — — — No No - -
use-fax2-as-am-tone | — - - - No No - -
use-engaging-lines - - - - Yes Yes |- -
wait-off-hook - - - - No No - -

Table 19: JCT Dialogic Board Type

Section | CPD Server analogue | line-s| line-s| isdn | isdn- | cas-d| sip-h | sip-h
Option line-type |ide ide-d | line-t | dm3 | m3 mp mp-a
line-t | m3 ype |line-t|line-t|line |sm
ype | line-t ype |ype |type | line-t
ype ype
tones busy-tone-1 - - - Yes — — _ _
busy-tone-2 - - - Yes - - — _
extra-dial-tone - — - Yes — _ _ _
fax-tone-1 — - - Yes — — _ _
fax-tone-2 — - - Yes — — _ _

296 Outbound Contact 8.0 @



Chapter 9: Outbound Contact Configuration Options

Table 19: JCT Dialogic Board Type (Continued)

CPD Server Options

Section | CPD Server analogue | line-s| line-s| isdn | isdn- | cas-d| sip-h | sip-h

Option line-type | ide ide-d | line-t | dm3 | m3 mp mp-a
linet m3 |ype |line-t|line-t|line |sm
ype | line-t ype |ype |type | line-t
ype ype

intl-dial-tone - - - Yes - - - -
local-dial-tone - - - Yes - - - -
ring-back-tone-1 - - - Yes |- - - -
ring-back-tone-2 - - - Yes |- - - -
disconnect-tone - - - Yes |- - - -
forth-tone - - - Yes - - - -
sit-tone - - - Yes - - - -

line-side | off-hook-bit-mask - - - No - - - -
on-hook-bit-mask - - - No - - - -
rcv-idle-bit-mask - - - No - - - -
snd-idle-bit-mask - - - No - - - -

isdn called-party-number- | — - - Yes - - - -
plan
called-party-number-t | — - - Yes - - - -
ype
calling-party-number | — - - Yes - - - -
calling-party-number- | — - - Yes |- - — —
plan
calling-party-number- | — - - Yes |- - — —
type
isdn-trace - - - Yes - - - -
isdn-trace-file-name- | — - - Yes |- - - -
prefix

Deployment Guide 297




Chapter 9: Outbound Contact Configuration Options

Table 19: JCT Dialogic Board Type (Continued)

CPD Server Options

Section | CPD Server analogue | line-s| line-s| isdn | isdn- | cas-d| sip-h | sip-h
Option line-type | ide ide-d | line-t | dm3 | m3 mp mp-a
linet m3 |ype |line-t|line-t|line |sm
ype | line-t ype |ype |type | line-t
ype ype
presentation-indicator | — - - Yes - - - -
use-channel-state - - - Yes — — _ _
engage-cpd-on-call-s | — - - Yes |- - - -
etup
user-info-layer-1 - — - Yes — — _ _
hmp audio-codecs - — - No _ _ _ _
sip-proxy - - - No - _ - _
general continuous-no-signal | — - - Yes - - - -
conversation-file-nam| — — — Yes — _ _ _
e-prefix
cpd-file-name-prefix | — — - Yes _ _ _ _
cpd-recording — - — Yes _ _ _ _
cpd-if-established — — - No _ _ _ _
destination-busy-time | — — — Yes — — _ _
out
keep-channels-open | — — — Yes — — _ _
line-type - - - Yes |- — - —
location - - - Yes - - — _
max-number-ports-to | — - - Yes - - - -
-record
off-hook-delay - - - No — _ _ _
off-hook-timeout - — - No _ _ _ _
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Table 19: JCT Dialogic Board Type (Continued)

CPD Server Options

Section | CPD Server analogue | line-s| line-s| isdn | isdn- | cas-d| sip-h | sip-h
Option line-type |ide ide-d | line-t | dm3 | m3 mp mp-a
line-t | m3 ype |line-t|line-t|line |sm
ype | line-t ype |ype |type | line-t
ype ype
on-hook-timeout - - - No - - - -
out-of-service-attemp | — - - Yes - - - -
ts
out-of-service-timeou | — - - Yes - - - -
t
pre-connect-cpd-prior | — - - Yes - - - -
ity
post-connect-cpd-prio| — - - Yes - - - -
rity
sit-detection - - - Yes |- - - -
tscall - - - No - - - -
tsclear - - - No - - - -
use-busy2-as-nu-tone | — - - No - - - -
use-fax2-as-am-tone | — - - No - - - -
use-engaging-lines - - - Yes |- - - -
wait-off-hook - - - No - - - -
Table 20: HMP Dialogic Board Type
Section | CPD Server analogue | line-s| line-s| isdn | isdn- | cas-d| sip-h | sip-h
Option line-type | ide ide-d | line-t | dm3 | m3 mp mp-a
line-t | m3 ype |line-t|line-t|line |sm
ype | line-t ype |ype |type | line-t
ype ype
tones busy-tone-1 - - - - - - - No
busy-tone-2 - - - - - - - No
extra-dial-tone — - — — — — — No
fax-tone-1 - - - - - - - No
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CPD Server Options

Table 20: HMP Dialogic Board Type (Continued)
Section | CPD Server analogue | line-s| line-s| isdn | isdn- | cas-d| sip-h | sip-h
Option line-type | ide ide-d | line-t | dm3 | m3 mp mp-a
linet m3 |ype |line-t|line-t|line |sm
ype | line-t ype |ype |type | line-t
ype ype
fax-tone-2 - - - - - - - No
intl-dial-tone - - - - - - - No
local-dial-tone - - - - - - - No
ring-back-tone-1 - - - - - - - No
ring-back-tone-2 - - - - - - - No
disconnect-tone - - - - - - - No
forth-tone - - - - - - - Yes
sit-tone - - - - - - - No
line-side | off-hook-bit-mask - - - - - - - No
on-hook-bit-mask - - - - - - - No
rcv-idle-bit-mask - - - - - - - No
snd-idle-bit-mask - - - - - - - No
isdn called-party-number- | — - - - - - - No
plan
called-party-number-t | — - - - - - - No
ype
calling-party-number | — - - - - - - Yes
calling-party-number- | — - - - - - - No
plan
calling-party-number- | — - - - - - - No
type
isdn-trace - - - - - - - No
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Table 20: HMP Dialogic Board Type (Continued)

Section | CPD Server analogue | line-s| line-s| isdn | isdn- | cas-d| sip-h | sip-h
Option line-type | ide ide-d | line-t | dm3 | m3 mp mp-a
linet m3 |ype |line-t|line-t|line |sm
ype | line-t ype |ype |type | line-t
ype ype
isdn-trace-file-name- | — - - - - - - No
prefix
presentation-indicator | — - - - - - - No
use-channel-state - - - - - - - No
engage-cpd-on-call-s | — - - - - - - No
etup
user-info-layer-1 - - - - - - - No
hmp audio-codecs - - - - - - - Yes
sip-proxy - - - - - - - Yes
general continuous-no-signal | — - - - - - - Yes
conversation-file-nam | — - - - - - - Yes
e-prefix
cpd-file-name-prefix | — - - - - - - Yes
cpd-recording - - - - - - - Yes
cpd-if-established - - - - - - - No
destination-busy-time | — - - - - - - Yes
out
keep-channels-open | — - - - - - - No
line-type - - - - - - - Yes
location - - - - - - - Yes
max-number-ports-to - - - - - - Yes
-record
off-hook-delay - - - - - - No
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CPD Server Options

Table 20: HMP Dialogic Board Type (Continued)
Section | CPD Server analogue | line-s| line-s| isdn | isdn- | cas-d| sip-h | sip-h
Option line-type | ide ide-d | line-t | dm3 | m3 mp mp-a
linet m3 |ype |line-t|line-t|line |sm
ype | line-t ype |ype |type | line-t
ype ype
off-hook-timeout - - - - - - No
on-hook-timeout - - - - - - - No
out-of-service-attemp | — - - - - - - Yes
ts
out-of-service-timeou | — - - - - - - Yes
t
pre-connect-cpd-prior | — - - - - - - No
ity
post-connect-cpd-prio| — - - - - - - No
rity
sit-detection - - - - - - - Yes
tscall - - - - - - - No
tsclear - - - - - - - No
use-busy2-as-nu-tone | — - - - - - - No
use-fax2-as-am-tone | — - - - - - - No
use-engaging-lines - - - - - - - Yes
wait-off-hook - - - - - - - No
Transfer Mode (TM) Dialer Mode
The section provides correlation information on the TM Dialer Mode for the
following board types:
* DMV (Table 21)
* JCT (Table 22 on page 306)
* HMP (Table 23 on page 309)
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Table 21: DMV Dialogic Board Type

CPD Server Options

Section | CPD Server analogue | line-s| line-s| isdn | isdn- | cas-d| sip-h | sip-h
Option line-type | ide ide-d | line-t | dm3 | m3 mp mp-a
linet m3 |ype |line-t|line-t|line |sm
ype | line-t ype |ype |type | line-t
ype ype
tones busy-tone-1 — — No — _ _ _ _
busy-tone-2 — — No _ _ _ _ _
extra-dial-tone — — No — _ _ _ _
fax-tone-1 — — No _ _ _ _ _
fax-tone-2 — — No _ _ _ _ _
intl-dial-tone — — No — — _ _ _
local-dial-tone — — No — — _ _ _
ring-back-tone-1 - - No - - — — _
ring-back-tone-2 — - No _ _ _ _ _
disconnect-tone - - No - _ _ _ _
forth-tone - - No — — — _ _
sit-tone — — No — — _ _ _
line-side | off-hook-bit-mask - — No — _ _ _ _
on-hook-bit-mask - - No - _ _ _ _
rcv-idle-bit-mask — — No — _ _ _ _
snd-idle-bit-mask - - No - — — _ _
isdn called-party-number- | — — No — — _ _ _
plan
called-party-number-t | — — No — — _ _ _
ype
calling-party-number | — - No — - - _ —
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Table 21: DMV Dialogic Board Type (Continued)

CPD Server Options

Section | CPD Server analogue | line-s| line-s| isdn | isdn- | cas-d| sip-h | sip-h
Option line-type | ide ide-d | line-t | dm3 | m3 mp mp-a
linet m3 |ype |line-t|line-t|line |sm
ype | line-t ype |ype |type | line-t
ype ype
calling-party-number- | — - No - - - - -
plan
calling-party-number- | — - No - - - - -
type
isdn-trace — — No — _ _ _ _
isdn-trace-file-name- | — - No - - - — _
prefix
presentation-indicator | — - No - — - _ _
use-channel-state - - No - _ — _ _
engage-cpd-on-call-s | — - No - - _ _ _
etup
user-info-layer-1 - — No - - — _ _
hmp audio-codecs — — No — — _ _ _
sip-proxy — - No - - - _ —
general continuous-no-signal | — - No - - - - -
conversation-file-nam | — - No - - - _ _
e-prefix
cpd-file-name-prefix | — — Yes |- - - _ _
cpd-recording — - Yes — _ _ _ _
cpd-if-established - - No - - - _ _
destination-busy-time | — - Yes |- — - - —
out
keep-channels-open | — - No — - - _ —
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Table 21: DMV Dialogic Board Type (Continued)

CPD Server Options

Section | CPD Server analogue | line-s| line-s| isdn | isdn- | cas-d| sip-h | sip-h
Option line-type | ide ide-d | line-t | dm3 | m3 mp mp-a
linet m3 |ype |line-t|line-t|line |sm
ype | line-t ype |ype |type | line-t
ype ype
line-type - - Yes |- - - - _
location - - Yes — - _ _ _
max-number-ports-to | — - No - - - - -
-record
off-hook-delay - - Yes — — _ _ _
off-hook-timeout - - Yes — _ _ _ _
on-hook-timeout — — Yes |- — — _ _
out-of-service-attemp | — - Yes | — - - — —
ts
out-of-service-timeou | — - Yes - - - - _
t
pre-connect-cpd-prior | — - No - - - - -
ity
post-connect-cpd-prio| — - No - - - - -
rity
sit-detection — — No — — _ _ _
tscall — — Yes — — — _ _
tsclear - - Yes — - — _ _
use-busy2-as-nu-tone | — — Yes |- - - - -
use-fax2-as-am-tone | — - Yes — - - _ _
use-engaging-lines - - No - - - — _
wait-off-hook — — Yes — — — _ _
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Table 22: JCT Dialogic Board Type

Section | CPD Server analogue | line-s| line-s| isdn | isdn- | cas-d| sip-h | sip-h
Option line-type | ide ide-d | line-t | dm3 | m3 mp mp-a
linet m3 |ype |line-t|line-t|line |sm
ype | line-t ype |ype |type | line-t
ype ype
tones busy-tone-1 Yes Yes - - - - - -
busy-tone-2 Yes Yes - - - - - -
extra-dial-tone Yes Yes |- - - - - -
fax-tone-1 Yes Yes - - - - - -
fax-tone-2 Yes Yes - - - - - -
intl-dial-tone Yes Yes - - - - - -
local-dial-tone Yes Yes - - - - - -
ring-back-tone-1 Yes Yes - - - - - -
ring-back-tone-2 Yes Yes - - - - - -
disconnect-tone Yes Yes |- - - — - -
forth-tone Yes No - - — - - -
sit-tone Yes Yes - - - - - -
line-side | off-hook-bit-mask No Yes - - - - - -
on-hook-bit-mask No Yes |- - - - - -
rcv-idle-bit-mask No Yes |- - - - — _
snd-idle-bit-mask No Yes - - - — - -
isdn called-party-number- | No No - — - - — -
plan
called-party-number-t | No No - — - - — -
ype
calling-party-number | No No - - - - - -
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Table 22: JCT Dialogic Board Type (Continued)

CPD Server Options

Section | CPD Server analogue | line-s| line-s| isdn | isdn- | cas-d| sip-h | sip-h
Option line-type | ide ide-d | line-t | dm3 | m3 mp mp-a
linet m3 |ype |line-t|line-t|line |sm
ype | line-t ype |ype |type | line-t
ype ype
calling-party-number- | No No - - - - - -
plan
calling-party-number- | No No - - - - — _
type
isdn-trace No No — - - - _ _
isdn-trace-file-name- | No No - — - — _ _
prefix
presentation-indicator | No No - - - - _ _
use-channel-state No No - - - — _ _
engage-cpd-on-call-s | No No - - - - _ _
etup
user-info-layer-1 No No - — - _ _ _
hmp audio-codecs No No - - - - — _
sip-proxy No No — - - — — _
general continuous-no-signal | Yes Yes |- - - - - -
conversation-file-nam| No No - — - - — _
e-prefix
cpd-file-name-prefix | Yes Yes |- - — — - -
cpd-recording Yes Yes |- — - — _ _
cpd-if-established Yes Yes - - - - _ _
destination-busy-time | Yes Yes |- - — - — —
out
keep-channels-open | Yes Yes |- - — - _ —
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Table 22: JCT Dialogic Board Type (Continued)

Section | CPD Server analogue | line-s| line-s| isdn | isdn- | cas-d| sip-h | sip-h

Option line-type | ide ide-d | line-t | dm3 | m3 mp mp-a
linet m3 |ype |line-t|line-t|line |sm
ype | line-t ype |ype |type | line-t
ype ype

line-type Yes Yes |- - — - - -
location Yes Yes - - — - - -
max-number-ports-to | No No - - - - — -
-record
off-hook-delay Yes Yes |- - - — - -
off-hook-timeout Yes Yes - - — — - -
on-hook-timeout Yes Yes — - - — - -
out-of-service-attemp | Yes Yes |- — - - — -
ts
out-of-service-timeou | Yes Yes - - - - - -
t
pre-connect-cpd-prior | Yes Yes |- — - - — -
ity
post-connect-cpd-prio| Yes Yes |- — - - — -
rity
sit-detection Yes Yes - - - - - -
tscall Yes Yes - - - - _ _
tsclear Yes Yes - - — - - -
use-busy2-as-nu-tone | Yes Yes - - - — - -
use-fax2-as-am-tone | Yes Yes - - — - - -
use-engaging-lines No No - - - - — _
wait-off-hook Yes Yes - - - - _ _
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CPD Server Options

Table 23: HMP Dialogic Board Type

Section | CPD Server analogue | line-s| line-s| isdn | isdn- | cas-d| sip-h | sip-h
Option line-type | ide ide-d | line-t | dm3 | m3 mp mp-a

linet m3 |ype |line-t|line-t|line |sm
ype | line-t ype |ype |type | line-t
ype ype

tones busy-tone-1 - - - - - - No
busy-tone-2 - - - - - - No
extra-dial-tone - - - - - - No
fax-tone-1 - - - - - - No
fax-tone-2 - - - - - - No
intl-dial-tone - - - - - - No
local-dial-tone - - - - - - No
ring-back-tone-1 - - - - - - No
ring-back-tone-2 - - - - - - No
disconnect-tone - - - - - - No
forth-tone - - - - - - No
sit-tone - - - - - - No

line-side | off-hook-bit-mask - - - - - - No
on-hook-bit-mask - - - - - - No
rcv-idle-bit-mask - - - - - - No
snd-idle-bit-mask - - - - - - No

isdn called-party-number- | — - - - - - No
plan
called-party-number-t | — - - - - - No
ype
calling-party-number | — - - - - - No
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CPD Server Options

Table 23: HMP Dialogic Board Type (Continued)
Section | CPD Server analogue | line-s| line-s| isdn | isdn- | cas-d| sip-h | sip-h
Option line-type | ide ide-d | line-t | dm3 | m3 mp mp-a
linet m3 |ype |line-t|line-t|line |sm
ype | line-t ype |ype |type | line-t
ype ype
calling-party-number- | — - - - - - No -
plan
calling-party-number- | — - - - - - No -
type
isdn-trace - - - - - - No -
isdn-trace-file-name- | — - - - - - No -
prefix
presentation-indicator | — - - - - - No -
use-channel-state - - - - - - No -
engage-cpd-on-call-s | — - - - - - No -
etup
user-info-layer-1 - - - - - - No -
hmp audio-codecs - - - - - - Yes |-
sip-proxy - - - - - - Yes |-
general continuous-no-signal | — - - - - - Yes |-
conversation-file-nam | — - - - - - No -
e-prefix
cpd-file-name-prefix | — - - - - - Yes -
cpd-recording - - - - - - Yes |-
cpd-if-established - - - - - - No -
destination-busy-time | — - - - - - Yes |-
out
keep-channels-open | — - - - - - No -
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CPD Server Options

Table 23: HMP Dialogic Board Type (Continued)

Section | CPD Server analogue | line-s| line-s| isdn | isdn- | cas-d| sip-h | sip-h
Option line-type | ide ide-d | line-t | dm3 | m3 mp mp-a

linet m3 |ype |line-t|line-t|line |sm
ype | line-t ype |ype |type | line-t
ype ype

line-type - - - - - - Yes -
location - - - - - - Yes -
max-number-ports-to | — - - - - - No -
-record
off-hook-delay - - - - - - No -
off-hook-timeout — — — — — — No -
on-hook-timeout — — — — — — No —
out-of-service-attemp | — - - - - - Yes |-
ts
out-of-service-timeou | — - - - - - Yes -
t
pre-connect-cpd-prior | — - - - - - No -
ity
post-connect-cpd-prio| — - - - - - No -
rity
sit-detection - - - - - - Yes -
tscall - - - - - - No -
tsclear - - - - - - No -
use-busy2-as-nu-tone | — — — — — — No -
use-fax2-as-am-tone | — - - - - - No -
use-engaging-lines - - - - - - No -
wait-off-hook - - - - - - No -
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Changes from Release 7.6 to 8.0.x

Changes from Release 7.6 to 8.0.x

Table 24 lists any option changes that occurred between release 7.6 and release

8.0.x.

Table 24: Option Changes in Release 8.0.x

Option Name

Type of Change

Configuration Level/Comments

Outbound Contact Server

am-beep-detection (see page 228) New in 8.0 Campaign Group level or Application
level
asm_channel_num (see page 228) New in 8.0.001 Campaign Group level

asm_drop_am_announcement_data (see
page 229)

New in 7.6.101.14

Campaign Group level or Application
level

beep-on-merge (see page 230)

New in 8.0

Campaign Group level or Application
level

call_answer_type_recognition (see
page 230)

Existing option that
can be used in an
Outbound-VoIP
environment in 8.0

Campaign Group level or Application
level

call_transfer_type (see page 232)

Existing option that
can be used for an
Outbound-VoIP
environment in 8.0.

Campaign Group level or Application
level

call_wait_in_queue_timeout (see
page 234)

Existing option that
can be used for an
Outbound-VoIP

Campaign Group level or Application
level

environment

cancel-on-desktop (see page 235) New in 8.0 Campaign Group level or Application
level

cpd-on-connect (see page 236) New in 8.0 Campaign Group Level or Application
level

cpd-recording (see page 236) New in 8.0 Campaign Group Level or Application
level

customer_id (see page 224) Updated in 8.0 Campaign Level or Application Level;

can now be used to identify customers
for record cancellation
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Table 24: Option Changes in Release 8.0.x (Continued)

Option Name

Type of Change

Configuration Level/Comments

dynamic-port-allocation (see
page 219)

New in 8.0.001

Switch level, OCS Application level,
or CPD Server Application Level

http-connection-pool-size (see
page 222)

New in 8.0.001

Host or OCS Application Level

http-response-timeout (see
page 222)

New in 8.0.001

Host or OCS Application Level

merge-method (see page 240) New in 8.0 Campaign Group Level or Application
level
on-bridging-unable (see page 241) New in 8.0 Campaign Group Level or Application

level

pa-inbound-ignore (see page 242)

New in 7.6.101.18

Campaign Group Level or Application
level

pa-odr-interval (see page 243)

New in 8.0

Campaign Group Level or Application
level

pre-dial-validation (see page 220)

New in 8.0.001

Individual Record level, Calling List
Level, Campaign Level, or OCS

Application Level
predictive_algorithm (see page 244) | New value, Campaign Group Level or Application
time_optimized_odr, | level
added in 8.0
treatment-holidays-table (see New in 8.0 Campaign Group Level or Application
page 255) level
treatment-preferred-contact-field | New in 8.0 Campaign Group Level or Application
(see page 262) level
treatment-uri (see page 256) New in 8.0 Campaign Group Level or Application
level
treatment-weekdays-table (see New in 8.0 Campaign Group Level or Application

page 256)

level

Outbound Contact Manager 7.6

ref-file-path (see page 200)

New in OCM
7.6.101.07

0CManager section of the Options tab.
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Table 24: Option Changes in Release 8.0.x (Continued)

Option Name

Type of Change

Configuration Level/Comments

validation-uri (see page 221)

New in 8.0.001

Calling List Level, Campaign Level,
or OCS Application Level

validation-timeout-call-result
(see page 221)

New in 8.0.001

Calling List Level, Campaign Level,
or OCS Application Level
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Chapter

1 0 Log Files

This chapter discusses three types of log files:
+ General Logging, page 315

- Record History Logging, page 315

«  Extended Audit Trail Log, page 320

- gsw request log, page 324

General Logging

The applications that are part of the Outbound Contact Solution conform to
Genesys logging standards. See the Framework 8.0 Management Layer User'§
Guide for more information about enabling and modifying the output log.

Outbound Contact Server will generate two logs after its first successful start:

* The first log contains initial information about connecting to Configuration
Server.

* The second log contains configuration information and any information
produced by Outbound Contact Server as it processes information.

The level of output is determined by the verbose option in the Log section.

Record History Logging

Record History logging provides you with additional reporting options for
calling lists. This logging process does not use database access to write logs;
instead it uses flat (text) files that the customer defines. With flat files you can
selectively turn logging on or off for different calling lists. Flat files must be
imported into a database in order to generate reports (see your database
administrator for assistance).
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Record History Logging

This section includes the following topics:

*  “Prestart Information” on page 316

* “Configuration Options” on page 316

* “File Structure” on page 317

* “Log File Naming Conventions” on page 319

*  “Generating Record History Log Reports” on page 320

Prestart Information

Before you create a Record History Log for your calling list, make sure that
you have:

* Properly configured the destination for your log (see “Log Options
Defined” on page 316).

* Provided a sufficient amount of free disk space on the target drive.

Configuration Options

316

Two options configure the Record History Logs; they are
dial_log_destination and dial_log_delimiter.

Log Options Defined

This topic describes the Record History Log options dial_log_destination and
dial_log_delimiter. You must configure the option dial_log_destination to
use Record History logging. Then, if the option dial_log_delimiter is omitted,
a tab delimiter is used in the log file.

The dial_log_destination option is used to provide the path where a log for
the calling list is stored. This option can be placed in the OCS application
object or in a specific calling list object. First, OCS looks for this option in the
0CServer section in the Options tab of a list; if does not find the option there, it
looks on the Options tab (0CServer section) in the application object; if it still
does not find this option, then no logging will be performed for the list.

The dial_log_delimiter option is used to create delimiters between the fields
of the log for the calling list. Because the files for this option are flat files,
delimiters must be added to the log. If the dial_lLog_destination option is
configured, but the dial_log_delimiter is omitted, then tabs are used as the
delimiters. By default, if the value of this option is not set, it uses a tab (\t) to
delimit fields.

The dial_log_delimiter option can be placed in the 0CS Application object or
in a specific list. First OCS looks for this option in the 0CServer section in the
Options tab of a list. If OCS does not find this option there, it looks in the
Options tab (0CServer section) in the application object. If it still does not find
this option, then OCS will use a <tab character for the delimiter. For more
information about these options, see page 261.
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Record History Logging

File Structure

The file structure of a Record History Log is shown in columns that include:
* Tracking information.

* Information from Genesys mandatory fields.

* Information from user defined fields.

Information from only some of the Genesys mandatory fields are included
when generating the Record History Log. These fields include:

* record_id

e contact_info

e contact_info_type
* record_type

* record_status

e call_result

e attempt

* dial_sched_time

e call_time

* daily_from
e daiy_till
e tz_dbid

* agent_id

e chain_id
e chain_n

This information is followed by rows of the Actions and Events for a record.
Table 25 shows an example of the Record History log file structure.

Note: The column name that is listed in the history log is not always the
same name as it is in the calling list. For example, the contact_info
field in the calling list corresponds to the phone field in the Record
History Log).

Table 25: Log File Structure

Example
time | action | record | list | campaign| group | ocs_ | tenant | conne | dn | Genesys User
handle |id | _ app_ | _ ction Mandatory | Defined
id id id id id

Deployment Guide
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Record History Logging

For more information about how to configure the user-defined fields so that the
data from the user-defined fields will be written into the flat file, see the
“Attaching Record Information to Desktop and OCS User Events” section in
the Outbound Contact 8.0 Reference Manual for more information.

Tracking Information

The first ten columns in the log represent the tracking information for each
record. Table 26 shows the tracking fields and their descriptions. These fields
are followed by Genesys mandatory fields.

Table 26: Tracking Information Fields

Field Description
1. time The time logging for the record began.
2. action The actions and events logged for the record.
3. record handle The record handle of the record.
4. list id The DBID of the list.
5. campaign id The DBID of the campaign.
6. group id The DBID of the group.
7. ocs_app id OCS’s application DBID.
8. tenant id The tenant ID.
9. connection_id The Connection_id of the call.
10.dn The dn used for this campaign.
Log Data

The subsequent rows in the Record History Log represent the event data for the
record. Table 27 on page 319 shows the actions and events that may display in
the Record History Log. OCS will log numeric data using numeric values.

The fields in the Record History Log are separated by a dialing_log_delimiter,
which is defined with the dial_lLog_delimiter option (see page 260).

The data for each record in the log breaks when:
* The dialing session/campaign group for a campaign stops or starts.

*  The format of the list changes (for example, a send attribute was added or
changed).
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Record History Logging

Table 27: Actions and Events in Record History Log

Action/Event

Value

DA CALL DIALED OUTBOUND

DA _CALL DIALED PREVIEW

DA_CALL DIALED CALLBACK

DA_CALL DIALED CHAIN

DA_RECORD APPLY TREATMENT

DA _CALL_QUEUED

DA CALL ESTABLISHED

DA CALL RELEASED

DA RECORD RESCHEDULED

DA RECORD UPDATED (UpdateCallCompletionStats,
means that user data has changed)

10

DA RECORD_PROCESSED

Usually is associated with a RecordProcessed request from the
Desktop or an EventAgentReady when the record is updated in
a calling list.

DA RECORD PROCESSED action can be also triggered by
other events—for instance, call abandoned, call released with
an unsuccessful call result, record returned to a Calling List
database table while the dialing session/campaign group is
unloading or a call filter is changing.

11

DA CALL COMPLETED (to have an agent’s timing
statistics, not related to a record N.B. abandoned, cancel, do
not call will be logged as DA RECORD PROCESSED with
the corresponding call result)

12

DA_CALL_TRANSFERRED

13

DA RECORD_ PROCESSED EVENT (A desktop
RecordProcesssed event. In the log file, this event is always
followed by DA RECORD_PROCESSED.)

14

Log File Naming Conventions

Deployment Guide

OCS creates a name for each Record History Log. Every log file is named

according to the following rule:
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<ListName> <ListDBID> <CampaignDBID> <GroupDBID>
<OCSServerApplicationDBID> <DateTime>

The angle brackets indicate variables. Substitute the actual values for the type
of data named in brackets.

The <DateTime> field uses this format: mmddyy_hhmmss
Where:
mm is replaced by a two-digit representation of the month.
dd is replaced by a two-digit representation of the day.
yy is replaced by a two-digit representation of the year.
hh is replaced by a two-digit representation of the hour.
mm is replaced by a two-digit representation of the minutes.
ss is replaced by a two-digit representation of the seconds.
For example:
112305_193805

Generating Record History Log Reports

The flat files generated in the Record History Log file must be imported into a
database in order to generate reports. Genesys recommends that you check
with your database administrator for assistance with this process.

Extended Audit Trail Log

320

Outbound Contact provides an audit trail for each outbound call dialed in
preview, progressive, or predictive mode. A new OCS log_call_stats option
creates a separate logging subsystem for Audit Logging to capture additional
statistics on telephony events. OCS does not overwrite the existing data in this
log or replace it with new data. The audit logging function adds data to a
cumulative log.

The extended Audit Trail Log is discussed in detail in the following sections:
¢ “log call stats Configuration Option” on page 321

*  “Configuration of Audit Logging” on page 321

* “Audit Log Record Format” on page 321

* “Timed Events in PBX and CPD Server” on page 322

*  “Timing Data Availability in Preview Mode” on page 324
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Extended Audit Trail Log

log_call_stats Configuration Option

You define the Log_call_stats option in the OCS application object. If you set
this option to yes, OCS creates the separate Audit Log. If you set the option to
no or if the option is not present, the audit log function is not enabled.

Configuration of Audit Logging

The configuration of Audit Logging is hard-coded in OCS as follows:

Audit log file name: CallStats.<MMDDYY_HHMMSS_MS). log
Example: CallStats.072303_182754_216. Log

Audit log file location: OCS Application folder

Audit log file segment size: 10 MB

Audit log file segment expiration: none

Audit Log Record Format

OCS produces log records in a comma-delimited format, which can be easily
imported into third-party applications, such as MS Excel or SQL Server’s BCP
utilities, for further processing.

These are the comma-delimited fields in the log record:

Deployment Guide

Date in this format: 'MM/DD/YYYY'

Tenant name in single quotation marks
Tenant DBID

Campaign name in single quotation marks
Campaign DBID

Phone number in single quotation marks

Call result (name of CallState from GctiCallState enumerable set,
obtained from Configuration Server) in single quotation marks

Time when dialing starts ('HH:MM:SS.MS")
Approximate time when ringing starts ('HH:MM:SS.MS")

Time when an unsuccessful call (such as “no answer”) is released
("HH:MM:SS.MS")

Time when called party picks up the phone ('HH:MM:SS.MS")

Time when call progress detection is completed and when CPD Server
initiates the call transfer to a queue ('HH:MM:SS.MS")

Time when call is placed in a queue ('HH:MM:SS.MS")
Time when ringing starts on an agent’s DN ('HH:MM:SS.MS")
Time when call is established on the agent’s DN ('HH:MM:SS.MS")
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* Time when call is diverted to an auto-answering device ('HH:MM:SS.MS")
(For example, calls that are not connected to an agent in two seconds might
be redirected to a pre-recorded message.)

* Name of the file with CPD recording in single quotation marks

* Name of the voice file that contains the recorded conversation in single
quotation marks

* Approximate time difference between OCS and CPD Server computers (in
milliseconds)

This field cannot be empty. The field value is zero (0) if the data is not
available.

* Time when call is released on the agent’s DN ('HH:MM:SS.MS")

Note: The timestamps (above) are precise to the millisecond and enclosed in
single quotation marks. For example, '15:20:50.245'

To support Audit Logging, the CPD Server conveys its timestamp values to
OCS. For example, CPD Server passes to OCS the values that indicate when
CPD Server has completed call progress detection and when it has initiated the
call transfer to a queue.

Fields cannot be omitted. Two commas with no value between them indicate
that there is no data for that field. That type of placeholder follows, for
example, the time when an unsuccessful call is released. The reason is that the
field represented by this particular placeholder is reserved for the time when a
called party picks up the phone, which does not occur once the call is released.
There is no field value in this case, thus nothing between the commas.

Timed Events in PBX and CPD Server

322

Which telephony events are timed and when the timestamps are issued depend
on the type of hardware (PBX or Dialogic Board) and software (OCS, CPD
Server) that you use for placing and monitoring calls. The next three tables
provide details on timed telephony events for various hardware and software.

Table 28 shows telephony events that trigger the timing mechanisms in a PBX
board/OCS.

Table 28: Timed Events for PBX

Timestamp For: Application
Dialing started OoCS
Ringing started OCS
Unsuccessful call released OCS
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Table 28: Timed Events for PBX (Continued)

Timestamp For: Application
Call answered N/A
CPD completed / Transfer initiated N/A
Call placed in Queue OCS
Agent DN ringing OCS
Connected to an agent OCS
Diverted for auto-answer OCS
Call released on agent's DN OCS

Table 29 shows telephony events that trigger the timing mechanisms in a
CPD Server in transfer mode.

Table 29: Timed Events for CPD Server (Transfer Mode)

Deployment Guide

Timestamp For: Application
Dialing started CPD Server
Ringing started CPD Server
Unsuccessful call released CPD Server

Call answered CPD Server

CPD completed / Transfer initiated CPD Server

Call placed in Queue CPD Server or OCS
Agent DN ringing CPD Server or OCS

Connected to an agent

CPD Server or OCS

Diverted for auto-answer

OCS

Call released on agent's DN

OCS
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Table 30 shows telephony events that trigger the timing mechanisms in a
CPD Server in ASM mode.

Table 30: Timed Events for CPD Server (ASM Mode)

Timestamp For: Application
Dialing started CPD Server
Ringing started CPD Server
Unsuccessful call released CPD Server
Call answered CPD Server
CPD completed / Transfer initiated CPD Server
Call placed in Queue N/A

Agent DN ringing N/A
Connected to an agent CPD Server
Diverted for auto-answer CPD Server
Call released on agent's DN OCS

Timing Data Availability in Preview Mode

In Preview dialing mode, OCS attempts to obtain the data required for audit
logging from the telephony events (EventDialing, EventRinging) on the
agent’s DNs. These events should have outbound-specific pairs in the user
data. Thus, the desktop application has to apply TMakeCall to all the user data
received in Preview Record.

gsw_request_log

324

A gsw_request_Llog table stores outbound dialing activity for reporting,
auditing, and other purposes. During installation, the Wizard prompts the user
to create a gsw_request_Llog Table Access object, which allows OCS to access
the log table.

If the Wizard is not used, than the Table Access object for gsw_request_Llog
table can be created manually by creating a new Table Access object under the
tenant that will contain campaign information. This Table Access object must
be a table of type, Log table and have the name gsw_request_Llog. It must also

Outbound Contact 8.0 @



Chapter 10: Log Files

Deployment Guide

gsw_request_log

contain a reference to a valid database access point. The actual name of the
database table is user-defined.

Note: In multi-tenant environments, each tenant can have a separate
gsw_request_log table.

Outbound Contact Manager and Genesys Administrator checks the
configuration of this log table every time it starts. If the gsw_request_Llog Table
Access object is configured, but the actual table does not exist in the database,
the GUI will create the table.

Outbound Contact Server opens the gsw_request_Log table for a particular
tenant when the dialing session for first campaign/campaign group for this
tenant is loaded.

Outbound Contact tracks the following call request messages in the
gsw_request_Llog table:

* PreviewDialingModeStart

* PreviewDialingModeOver

* PreviewRecord

* UpdateCallCompletionStats
* RecordProcessed

* RecordReject

* RequestRecordCancel

* RecordReschedule

e ScheduledRecordReschedule
e DoNotCall

* ChainedRecord

¢ AddRecord

Outbound Contact includes an expanded list of call request messages in a
gsw_request_Log table. Because the log tracks call request messages for agents,
a gsw_request_Llog table can be used for auditing purposes. The log does not
provide any statistical analysis.

To view a gsw_request_Llog table, use the server’s DMBS SQL features.

For more details, see the “Communication Protocol” chapter in the Outbound
Contact 8.0 Reference Manual.
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1 1 Pre-Dial Validation

This chapter provides an overview of the pre-dial validation feature that is
introduced in Outbound Contact 8.0.001. It describes how to provision and
implement pre-dial validation of the dialing records over secure and
non-secure HTTP connections.

This chapter contains the following sections:

«  Pre-Dial Validation Over Non-Secure Connection, page 327

«  Pre-Dial Validation Over Secure Connection, page 332

Pre-Dial Validation Over Non-Secure
Connection

Preface

Pre-dial validation is an optional first step in the processing of the record. With
pre-dial validation in place, OCS connects to the specific Web or Application
Server using the HTTP or HTTPS and delivers a specifically formed HTTP
POST request for each record before dialing this record. The body of the HTTP
POST request contains properties of the individual record, just as an outbound
call contains record-specific attached data. Based on the information received
in HTTP POST request, Web or Application Server makes a decision whether
or not the record should be dialed, and replies to OCS with either an HTTP 200
OK or a 409 Conflict response. As a next step in processing, OCS dials the
records that were validated successfully (200 0K response) and attempts to
apply treatments (without dialing) to those records that were validated
negatively (409 Conflict response). Only those records that have successfully
passed the validation are dialed by OCS.
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Provisioning

Pre-dial validation is controlled by a number of OCS options, which can be set
at various configuration levels. Unless the options are set correctly, pre-dial
validation will not take place. By default OCS behaves consistently with the
previous release where pre-dial validation is not possible.

Configure the pre-dial validation feature by using the following new options:
* pre-dial-validation (see page 220)

* validation-uri (see page 221)

* validation-timeout-call-result (see page 221)

* http-response-timeout (see page 222)

* http-connection-pool-size (see page 222)

Recommendations for Configuration

328

The pool size and HTTP request handling timeout (http-connection-pool-size
and http-response-timeout options, respectively) must be set in accordance
with the anticipated load on Web or Application Server. OCS will reuse open
connections (although request pipelining is not supported by OCS) and will
never exceed the connection pool size. After a connection has been opened,
OCS will not attempt to close it and will reuse it as long as it's available (no
request which has not yet been responded to is currently submitted for this
connection) and valid (Web or Application Server has not closed this
connection). In case an HTTP request needs to be sent out and no available
(spare) connection is found in the pool and no new connection can be opened,
OCS will queue the request internally until either the spare connection appears
or until the handling timeout for the given request expires. Whenever the
request is queued internally, log message 93100 is produced (see also “Specific
Log Messages” on page 329 for log messages description). When the request
completes due to the timeout, log message 93202 is generated (see also
“Specific Log Messages” on page 329 for log messages description). The
presence of 93100 and/or 93202 messages indicates that the setting is too low
for the timeout, a slow responsiveness on Web or Application Server side,
and/or insufficient connection pool size.

OCS creates a separate connection pool for each host:port pair it needs to
maintain a connection to. This means that HTTP and HTTPS types of the
connections will have separate connection pools, even if the host name is the
same for both (this is due to different port numbers, 80 and 443 [defaults]).
Short and fully qualified domain names for the host are also qualified as
separate hosts by OCS; for example host1 and host1.subdomain1.domain1.com
are treated as different hosts by OCS and will therefore be assigned separate
connection pools.
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Specific Log Messages

OCS logs the following standard messages when processing connections to
Web or Application Server:

e 2102 (data send error)

* 4500 (connecting)

* 4501 (server contacted)

* 4502 (cannot connect)

* 4503 (connected)

e 4504 (connection lost)

* 4541 (message received)

In addition to the standard messages, OCS also logs the result of the pre-dial

validation for each dial attempt (all pre-dial validation results messages are of
Trace Level):

* 93200 Pre-dial check completed with positive result for phone <phone
number>

* 93201 Pre-dial check completed with negative result for phone <phone
number>

* 93202 Pre-dial check aborted (timeout elapsed) for phone <phone number>
Whenever the connection pool limit is reached the following Standard Level
message is logged:

e 93100 Maximum connections limit <number of connection> reached for
server <host:port>

Pre-Dial Validation Protocol Description

Deployment Guide

This section provides a description of the pre-dial validation HTTP requests
and responses.

Requests for Pre-Dial Validation

OCS delivers P0OST request to Web or Application Server that contains BODY in
the application/json format (JavaScript Object Notation). This BoDY holds all
key-value pairs of the record subject to validation in the same fashion that the
outbound call produced by OCS contains key-value pairs in its attached data.
Similarly to the outbound call, OCS packs in the JSON B0DY some mandatory
key-value pairs (those whose keys are prefixed with 6SW_) and all user-defined
fields configured for delivery using the send_attribute field-level option.
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Example:

Validation Request

330

with BODY

The following example is a request with the BODY (mandatory fields begin with
6SW_ and user-defined fields begin with USR_):

POST /validation/validate.php HTTP/1.1
Accept: */#

User-Agent: 0CS/8.0.001

Host: host1.domain1:80

ETag: 390
Content-type: application/json
Content-Llength:720

{
"GSW_TZ_OFFSET":0,
"GSW_PHONE":"01282663420",
"GSW_CALLING_LIST":"PFR_CL_01",
"GSW_CAMPAIGN_NAME": "Campaign One",

"GSW_RECORD_HANDLE": 390,

"GSW_CALL_ATTEMPT_GUID":"00S0VQKQKODHT20518838SDAES000098",
"USR_FIELD1": "John Doe",
"USR_FIELD2": "501-12-4312",

"USR_FIELDT": "2010-05-06 13:25:10.003"
"USR_FIELDN": 1970
)

Notice that the ETag header of the request is always present and holds the value
of record handle of the record being populated.

Processing the Pre-Dial Validation Request

Web or Application Server needs to make a decision about whether or not the
record that has been delivered to it in the POST request by OCS is allowed to be
dialed. This decision is made based on the individual record properties passed
in the JSON B0DY of the POST request, as required by the business logic. Web
or Application Server should reply with 200 0K for a positive validation result
and with 409 Conflict for a negative validation result.

Both positive and negative validation results may contain a BODY that must also
be in the application/json format. This BODY can contain mandatory and
user-defined fields that are to be updated. For example, a negative validation
response might include a call result value that will be assigned to record or a
positive validation response might contain the timestamp of the validation
attempt.
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Example: Positive
Validation
Response

Example: Negative
Validation
Response

Deployment Guide

Positive Response to the Validation Request

The following example is a positive validation response. Notice that the ETag
header must be present in the response and must contain the value of the record
handle of the record being validated.

HTTP/1.1 200 OK

Date: Fri, 30 Apr 2010 19:40:58 GMT

Server: Apache/2.2.14 (Win32) mod_ssl/2.2.14 OpenSSL/0.9.8k PHP/5.2.8
X-Powered-By: PHP/5.2.8

ETag: 390

Content-Length: 112

Content-Type: application/json

"USR_FIELDT": "2010-05-06 15:00:00.000"

}
As a result of this response received by OCS, the record with a record handle
390 will be dialed. The user-defined field of the record with the
send_attribute option set to USR_LFIELDT will be updated in the Calling List
table with the new string value "2010-05-06 15:00:00.000". Notice that the
BODY part of the positive response is optional and should be provided only if
some fields of the record require an update.

Negative Response to the Validation Request

The following is an example of a negative validation response. Notice that the
ETag header must be present in the response and must contain the value of the
record handle of the record being validated.

HTTP/1.1 409 Conflict

Date: Fri, 30 Apr 2010 19:40:58 GMT

Server: Apache/2.2.14 (Win32) mod_ssl/2.2.14 OpenSSL/0.9.8k PHP/5.2.8
X-Powered-By: PHP/5.2.8

ETag: 390

Content-Length: 62

Content-Type: application/json

"GSW_CALL _RESULT":53,
"USR_FIELDT": "2010-05-06 15:00:00.000"
}
As a result of this response received by OCS, the record with a record handle
390 will be marked with call result 53 (Wrong Number) and will not be dialed;

the user-defined field of the record with the send_attribute option set to
USR_FIELDT will be updated in the Calling List table with the new string value
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"2010-05-06 15:00:00.000". After assigning call result 53 to the record, OCS
attempts to apply the treatment to specified call result (if such treatment is
configured). Notice, that the BODY part of the response is also optional. If no
call result is explicitly specified, call result 52 (Cancel Record) is applied.

Timeout While Processing the Validation Request

It is possible that the Web or Application Server will not be able to handle a
validation request during the time period that is specified by using the
http-response-timeout option. In this situation, the validation request will be
aborted, and OCS will treat the timeout situation as a negative validation
outcome (no dialing will take place). OCS will apply the call result that is
specified in the validation-timeout-call-result option (default, 3 [General
Error]) and will attempt to apply the treatment to that call result.

Pre-Dial Validation Over Secure
Connection

Preface

Provisioning

332

This section describes pre-dial validation over a secure connection, including
information about provisioning and secure connection-specific log messages.

For pre-dial validation, OCS supports communication over HTTPS, or strictly
speaking, HTTP over Transport Layer Security (TLS) connection, using a
Genesys TLS implementation.

For a detailed description of a Genesys TLS implementation, see the Genesys
8.0 Security Deployment Guide, Part 3, “Server Integrity - Transport Layer
Security”.

For information about the operating systems that are supported by a Genesys
TLS implementation, see the Genesys 8.0 Security Deployment Guide, in the
“Environment Prerequisites” section.

For the installation procedure of Genesys Security Pack on UNIX, see the
Genesys 8.0 Security Deployment Guide, Chapter 15, “Security Pack
Installation”. On Windows platforms, support for SSL/TLS is integrated into
the operating system.

To force OCS to open a secure connection to the validation service, the
protocol (scheme) part of the URI that is specified in the validation-uri
option must have a value of “https://”. In accordance with HTTPS
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definitions, OCS will connect to port 443 (instead of 80) if a port number is not
explicitly specified in the URI.

In addition to that, the user must create and configure a Host configuration
object, with the same Name property as the host name which is specified in the
validation-uri option.

For a description of the required configuration steps for a Host configuration
object, see the Genesys 8.0 Security Deployment Guide, “Assigning a
Certificate to a Host” section. Please pay attention to the fact that configuration
is different for OCS deployments on UNIX and Windows OS. Also keep in
mind that the referenced document describes only the most typical
configuration with both a self-signed root certificate from the Certification
Authority (CA) and a CA-signed client certificate. Certificate and private key
files for a UNIX deployment have to be Privacy Enhanced Mail
(PEM)-encoded. The Common Name property of the client certificate should
match the corresponding host name in the Genesys configuration.

Secure Connection-Specific Log Messages

Deployment Guide

When a secure connection to the Web or Application Server is established,
OCS prints a specific trace-level message into the log output. As shown in the
following example, this message contains the properties of used certificates:

8103 Secure connection is established. type 'client', info
'1600-135.225.58.18:443", issuer 'C=US, S=California, L=Daly City,
0=Genesys, 0U=0utbound, CN=Outbound Certificate Authority-.

If a secure connection cannot be established, the following standard-level
messages are logged:

* 8100 Certificate is expired
8101 Certificate is not valid

e 8102 Secure connection error
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Call Handling/Treatments

The information in this chapter is divided among the following topics:
+  How Treatments Work, page 335

- Treatment Properties, page 336

+  Rules for Call Results, page 337

«  Apply to Record Actions, page 341

« Treatment Sequences, page 350

«  Apply to Call Outcome, page 352

« Outbound Record Sharing Between Multiple Desktops, page 353
« Answering Machine Call Handling, page 354

How Treatments Work

This section contains a basic description of treatments. The other topics
covered in this chapter contain more complex treatment information for those
who create and change treatments in Genesys Administrator.

A Treatment object tells Outbound Contact Server (OCS) how to respond to an
unsuccessful call result (a call that does not reach the intended party).

A treatment sequence (sometimes called a linked sequence) is a general term
describing a series of treatment actions, each assigned a unique sequence
number and applied to the same unsuccessful call result.

After Treatment objects are created and then applied to Calling List objects in
Genesys Administrator, treatments were generally handled in the following
way in earlier versions of Outbound Contact:

* The chain’s status in the database remained as Retrieved.
*  Outbound Contact kept the chain in memory until the scheduled time.

Since the Outbound Contact 7.2 release, a treatment processing method is
implemented by the treatment_sched_threshold option (see this option’s
description on page 263). Outbound Contact Server stores the information that
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is required to restore the treatment application sequence properly in a
dedicated treatments field for each chain. This information is stored as a
string in format <CfgTreatment DBIDYe<Cycle attempt number)e<Chain
number >e<Treatment sequence number ), where:

* <CfgTreatment DBID) is the DBID of the last treatment applied.

* <(Cycle attempt number) is the number of cycle attempts within the current
treatment starting from 1.

e <chain number) is the chain number value of the record which is to be
dialled when the chain is retrieved by OCS.

e <(treatment sequence number) is the number of cycle through the chain of
records (for more details see Repeat the Treatment Cycle through the
Chain of Records).

OCS retrieves and processes treatments history from the database only for
records of types CampaignRescheduled, PersonalRescheduled,

CampaignCal lback, or Personal Callback. For other types of records (for
example, General), the treatments history field is ignored. When the chain is
selected, Outbound Contact Server retrieves information about the last applied
treatment from the field treatments and use it to determine the next treatment
action that should be applied.

Treatment Properties

Properties are assigned to Treatment objects in the Provisioning > Outbound
Contact tab in Genesys Administrator.

Table 31 defines the primary treatment properties.

Table 31: Primary Treatment Properties

Treatment Definition

Property

Call Result Type of response received after dialing a calling list record’s telephone number.
An unsuccessful call result (for example, Busy or No Answer) is assigned to a call
that does not reach the intended party.

Apply to Record Treatment action applied to the next dialing attempt.
This value identifies the next action (for example, Redial) that OCS will take
when an unsuccessful call result is received.

Apply to Call Connection required. Determine if the Answering Machine Detected or Fax

Detected call result should be transferred or dropped.
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Table 31: Primary Treatment Properties (Continued)

Treatment Definition

Property

Number in A unique number assigned to each treatment in a series of treatments linked to the

Sequence same call result.
This number sorts treatment sequences in the order they are to be applied to
consecutive instances of the same call result. Creating multiple treatments for the
same call result links the treatments.

Cycle Attempt The number of times to apply a treatment action if the first dialing attempt has an

unsuccessful call result.

Interval (minutes)

The number of minutes between cycle attempts if the first cycle attempt has an
unsuccessful call result.

Increment (minutes)

The increment is added to the interval after the first cycle attempt of an
unsuccessful call result. After the second, and all subsequent cycle attempts of an
unsuccessful call result, the increment is added to the sum of the last cycle
attempt.

For example:

The interval = 5 minutes
The increment = 3 minutes

In this scenario the first cycle attempt is 5 minutes. If the first cycle attempt is
unsuccessful, the increment (3 minutes) is added to the interval (5 minutes) and
the second cycle attempt would be in 8 minutes. For all subsequent unsuccessful
cycle attempts, the increment (3 minutes) is added to the sum of the last cycle
attempt:

(8 +3) =11 minutes; (11 + 3) = 14 minutes; and so on.

Rules for

Call Results

Three call result values have special treatment rules: Answer, Answering
Machine Detected, and Fax Detected. A complete list of call results with
descriptions is provided in the Outbound Contact 8.0 Reference Manual.

Treatments are normally applied to a record for unsuccessful calls; however,
under certain circumstances Answer (successful call) does require treatment.

Rules for Answer

Deployment Guide

Answer by a live person is a successful call result and usually does not require
a treatment. Special circumstances, such as the following, do warrant a
treatment for a call result of Answer:
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» Ifacall originates at a Route Point and the call is answered, then the
logical treatment is to direct the call to a queue.

* Ifan answered call is transferred (connected), then a treatment is required.

Rules for Answering Machine Detected or Fax Detected
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These rules apply when a call result is Answering Machine Detected or Fax
Detected.

For a call that is answered, but the call result is Answering Machine Detected or
Fax Detected, the system administrator may assign the “Apply to Call”
treatment and specify the Destination DN to which the call is transferred. Here
the Destination DN is an ACD queue for an Interactive Voice Response (IVR),
such as a recorded message to be left on an answering machine or a fax sent to
a fax machine. The administrator specifies the Destination DN in Genesys
Administrator or through the Outbound Configuration Wizard.

Procedure:
Adding a Destination DN

Start of procedure

1. Add all required IVR DNs and their logins in Genesys Administrator under
the Switching view on the Provisioning tab.

2. Inthe Switches view, add the queue into which the [IVRs log in.

3. Create a Place object for each IVR DN and a shortcut to that DN.

4. Create a Person object for each [IVR DN.

Note: In Step 4, the “person” is actually an IVR that emulates a person;
that is, the IVR does the work of an agent. In Steps 5 and 6 that
follow, the “person” (IVR) is configured as an Agent because
OCS requires a LoginID to facilitate access to a DN.

5. Configure the Person as an Agent.
6. Create a shortcut to the default Place and LoginID for that IVR Person.

7. Under the Agent Group object, add an Origination DN to the queue to
which your IVR DNs log in.

8. Create an Answering Machine or Fax treatment using the following
parameters:

* Call Result: Answering Machine Detected or Fax Detected (depending
on the desired treatment)

* Apply to Record action: No Treatment
*  Apply to Call action: Transfer or Connect
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Rules for Call Results

Notes: * In this context, Transfer and Connect are synonymous. Each

transfers the call to the ACD queue for the [IVR DNs.

For the Answering Machine Detected and Fax Detected call
results, you can specify either No Treatment or Update all
records in chain as the Apply to Record action. For
information on configuring the No Treatment or Update all
records in chain actions, see “Apply to Record: No
Treatment” or Procedure: Apply to Record, Updating All
Records in a Chain respectively.

For the Answering Machine Detected Call Result, you can
combine the Apply to Record actions Next-In-Chain or
Next-In-Chain-After actions with the Apply to Call outcome,
Transfer or Connect. For more information, see Procedure:
Combining the Apply to Call Outcome of Transfer or Connect
Within the Apply to Record Action of Next-in-Chain or
Next-in-Chain-After in One Treatment.

9. Add this treatment to the calling list you are using.

End of procedure

Procedure:

Combining the Apply to Call Outcome of Transfer or
Connect Within the Apply to Record Action of
Next-in-Chain or Next-in-Chain-After in One Treatment

Start of procedure

On the Configuration tab of the Treatment object, do the following:

1. Verify that the Call Result type is set to Answering Machine Detected.

From the Apply to Call drop-down list, select Transfer or Connect.

2

3. Verify that the Apply to Record action is set to No Treatment.

4. Inthe Destination DN drop-down list, select the destination DN.
5

Return to the Apply to Record drop-down list and select Next-In-Chain or
Next-In-Chain-After.

6. Inthe Number in sequence text box, specify a value of 1.

Deployment Guide
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With this configuration, when the Answering Machine Detected call result is
detected, the call is transferred to the specified destination and the next record
in the chain is dialed.

End of procedure

Apply to Record: No Treatment

OCS updates the record at the conclusion of the call; that is, when the IVR
hangs up.

Procedure:
Apply to Record, Updating All Records in a Chain

With Update all records in chain, OCS updates all records in a chain as soon
as OCS detects an answering machine or Fax machine and transfers the call to
a queue for an IVR response.

Start of procedure

If the administrator chooses to Update all records in chain for
Apply to Record, follow this procedure:

1. In Genesys Administrator > Provisioning > Accounts Agent Group >
Configuration tab > Advanced section, add an Origination DN to the queue
to which the IVR DNs log in.

2. Create an Answering Machine treatment using the following parameters:

* Call Result: Answering Machine Detected
* Apply to Record: Update ALL Records in Chain

* Apply to Call: Transfer or Connect (Recall that a call can be transferred
or connected to a queue for an IVR. The two terms are synonymous
here.)

3. Specify the Destination DN: The ACD queue to which the IVR DNs log in.
(See note below.)

Note: Recall that the administrator specifies the Destination DN in the
Genesys Administrator or through the Outbound Configuration
Wizard.

4. Add this treatment to the calling list you are using.

End of procedure
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Apply to Record Actions

When creating a Treatment object in Genesys Administrator, you must assign
an Apply to Record action to unsuccessful call results—for example, busy or
no answer. For configuration instructions and Apply to Record definitions and
configuration instructions, see “Treatment Object” on page 187.

Note: Outbound Contact will update the call_result field of a record as
Answered in the following scenario:

* The Apply to Record action is Assign To Group.
* An agent scheduled a personal RecordReschedu Le and then logs out.

At the scheduled call time, another agent receives and processes the
record without specifiying a all result.

Previously in this scenario, Outbound Contact would update the
record as Agent CallBack Error.

Rules for Next-in-Chain Actions

The three Next-in-Chain actions have special rules. All records in a calling list
are assigned a chain ID and chain number, even if there is only one record in a
chain. These are unlinked records containing a unique chain ID and a chain
number represented by a positive number. These unlinked records are not
considered to be chained records.

The term “chained records” refers to two or more records linked to each other
and assigned the same chain ID. Each chained record has a unique chain
number within its chain.

In the example of chained records in Table 32, the Chain # Column shows the
order of calling. The first number in the chain to be called starts with 1, the
second number in the chain to be called starts with 2, and continues to
increase.

The chain numbers can be in any order, but, by default, they are processed in
ascending order. You can change the order by using a filter for a call list in
Genesys Administrator, by specifying a list of the record fields followed by
ASC or DESC and separated by commas.

Table 32: Example of Chained Records

Phone Type Chain ID Chain #
James Smith (Home) 19 1
James Smith (Work) 19 3
James Smith (Mobile) 19 2
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Table 32: Example of Chained Records (Continued)

Phone Type Chain ID Chain #
Janet Green (Work) 20 3
Janet Green (Home) 20 1
Janet Green (Pager) 20 2

The Next-in-Chain actions are as follows:
* Next-in-Chain (immediately dialed)
* Next-in-Chain after (dialed after a specified interval)

* Next-in-Chain at specified date (dialed at a date set in the treatment
configuration)

The following guidelines apply:

1. To use any of the next-in-chain actions in a treatment, a calling list must
have chain_id and chain_n populated correctly.

2. When creating a treatment sequence, use the next-in-chain action as the
last member in the treatment sequence.

3. When defining treatments for the chained records, treatments of the type
Next-In-Chain are used more often than the Cycle and Redial type of
treatments.

Generally, if an unsuccessful call result is received, you do not want to redial
that number if you have another number to dial for the same contact. However,
the final decision on what type of treatment to apply depends upon the goal
and strategy of the specific outbound campaign.

Repeat the Treatment Cycle Through the Chain of Records
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When applying treatments, Outbound Contact has the capability of cycling
through the chain of records more than once; when the chain has ended, OCS
can start dialing the chain again from the first record. Both of the following
must be true:

* The last record in the chain is dialed and receives a negative call result.

* The current treatment to be applied is either Next-in-Chain, Next-in-Chain
After, or Next-in-Chain at Specified Date.

If both of these are true, OCS can cycle from the last record in the chain to the
first record in the chain, and then start dialing the chain again. The behavior to
cycle through the chain more than once is optional.

To enable this chain cycling, you must properly set the timing properties for
any of the three Next-in-Chain treatments, as follows:
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Cycle Attempt—Determines the total number of times that a chain will
jump from the last to the first record in the chain. The default value for this
property is 0, which means one cycle. The value 1 also means one cycle.
Setting the value to be greater than 1 means that the cycling will occur for
that specific number of times. The initial dialing of the chain is counted as
the first cycle attempt.

Interval—Determines the time period to wait before beginning the cycle
again. The interval measures the time between completing the last record
in the chain and then jumping to begin again with the first record in the
chain.

Increment—Determines the additional amount of minutes to add to the
next interval, beyond the length of the previous interval.

Notes: * The default behavior is one cycle. When a chain ends, it is updated

in the Calling List and OCS stops processing that chain unless
you have configured the system to repeat the cycle through the
chain again.

* The Interval and Increment properties are not applicable to the
Next-in-Chain at Specified Date treatment.

» For the Next-in-Chain After treatment, the Interval property
specifies both the amount of time to wait before dialing the next
record, and also, the time to wait before beginning the cycle again.
The Increment property applies to the time interval before
beginning the cycle again, but not to the time interval between
records.

For more information about the timing properties for these treatments, see
Table 33 on page 345.

Example of the Chain of Records Treatment Cycle Repetition

The following provides an example of the cycle behavior for the chain of
records for a Next-in-Chain treatment. In this example, the calling list has a
Next-in-Chain treatment for a No Answer call result, with the following
configuration:

Cycle Attempts: 3. The total number of times that the cycle through the
chain occurs will be 3 times.

Interval: 30. The time to wait before beginning the cycle again is set for
30 minutes. So, the amount of time between ending the last record in the
chain and jumping to the first record in the chain will be 30 minutes.

Increment: 20. The time period to add to the interval for each subsequent
cycling will be 20 minutes.
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The configurations in the example above will result in the following behavior:

1.

OCS retrieves a chain consisting of three records and dials the first record
in the chain. There is no answer. The treatment is: if there is no answer,
dial the next record in the chain.

OCS dials the next record in the chain. There is no answer. The treatment
is: if there is no answer, dial the next record in the chain.

OCS dials the third record in the chain. There is no answer. The treatment
is: if there is no answer, dial the next record in the chain.

The chain has ended. The number of Cycle Attempts in our example is set
to greater than 1, so OCS will wait for the specified time of 30 minutes
(Interval value in our example), and then proceed.

After waiting 30 minutes; OCS will now jump to the first record in the
chain, and begin with the first treatment step. This cycle will repeat two
more times; a total of three times, because the Cycle Attempts is setto 3 in
our example.

For the next two cycles, the Increments between intervals will now take
effect and they will increase between each cycle. On the second cycle,
OCS will wait 50 minutes (Interval of 30 minutes + Increment of 20
minutes in our example) before jumping to the first record in the chain. On
the third cycle, OCS will wait 70 minutes (Interval of 30 minutes +
Increment of 20 minutes + Increment of 20 minutes) before jumping to the
first record in the chain.

Note: The Next-in-Chain treatment must be the last treatment in the

sequence. If the Next-in-Chain treatment is not the last treatment in
the sequence, all treatments after the Next-in-Chain will be ignored.

Rules for Update All Records in Chain
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The Update all records in chain action can be used even if there are no
chained records in a calling list. It does not have the same restrictions as the
next-in-chain actions for the following reasons:

1.
2.

This action does not require that timing properties be set.

All records contain a chain ID and number even when they are not chained.

Notes: * The No Treatment action can be used for the call result Answering

Machine Detected in a Connect/Transfer treatment only if AM calls
are connected to agents that belong to the OCS Campaign Group.
Otherwise, the treatment Update all records in chain must be
configured for the Apply to Record action.

» The Update all records in chain action does not work for Answer
call results in the Connect/Transfer to treatment.
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Apply to Record Actions

Timing Properties Used with Apply to Record Actions

Understanding timing properties is essential when creating treatments and
applying them to Calling List objects. Table 33 shows which timing properties
are required for each treatment action.

Table 33: Using Timing Properties

Apply to Cycle Attempt Interval Increment Date
Record (minutes) Time
Action
Assign To Group | Not Applicable Not Applicable Not Applicable | Not Applicable
Mark As Agent | Not Applicable Not Applicable Not Applicable | Not Applicable
Error
Next-in-Chain Required Required Required Not Applicable
Set the maximum Set the time interval | Set the time
number of passes until the next pass interval for the
through the chain: through the chain, subsequent chain
values 0 and 1= one after the last record | passes
pass; the next record in | in the chain has been
the chain is dialed dialed.
immediately
Next-in-Chain Required Required Required Not Applicable
after Set the maximum Set the time interval | Set the time
number of passes until the next record | interval for the
through the chain: in chain is dialed, subsequent chain
values 0 and 1= one and until the next passes
pass pass through the
chain, after the last
record in the chain
has been dialed.
Next-in-Chain at | Required Not Applicable Not Applicable | Required
specified date Set the maximum Set the date/time
number of passes to dial the next
through the chain: record in chain
values 0 and 1= one
pass
No Treatment Not Applicable Not Applicable Not Applicable | Not Applicable
Deployment Guide 345



Chapter 12: Call Handling/Treatments

Table 33: Using Timing Properties (Continued)

Apply to Record Actions

Apply to Cycle Attempt Interval Increment Date
Record (minutes) Time
Action
Redial Required Required Required Not Applicable
Set the maximum Set the time interval | Set the time
number of retry until the first cycle | interval for
attempts attempt. subsequent cycle
attempts.
Reschedule Not Applicable Not Applicable Not Applicable | Not Applicable
Retry at Not Applicable Not Applicable Not Applicable | Required
specified date Set the date/time
for the next
attempt
Retry in Not Applicable Required Not Applicable | Not Applicable
Set the time interval
until the next (only
one) attempt
Update all Not Applicable Not Applicable Not Applicable | Not Applicable

records in chain

When OCS calculates the time for the next dial according to the treatment
configuration, it is possible that the new calculated time is out of the “daily

from” —

“daily till” boundaries of the record. If this happens, OCS adds an

appropriate amount of time to the calculated time so that it falls within the

boundaries.

Execute SQL Statement Action Type

346

The Execute SQL Statement action allows executing a specific pre-configured
SQL statement when a certain call result is received. There are no limitations
for the type or complexity of SQL statements. OCS uses its connection to the
Calling List database table, from which the current dialing record originates, to
execute the SQL statement. OCS also allows additional flexibility by
supporting macro expressions that can be used to form SQL statements, for
example, the Calling List name and fields of the record that is being processed
can be replaced with macro expressions. OCS expands those macro
expressions to the actual values before requesting the DBMS to execute the

SQL statement.

Unlike other treatments that affect a chain of records (for example, if it is
rescheduled for a later time or the treatment causes the next record of the chain
to be dialed), this treatment does not affect the record or chain in any way.
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Instead, when the treatment is completed, it passes control to the next
treatment (if one is configured). This enables you to configure the sequence of
treatments, similar to Execute SQL Statement and Reschedule Chain to later
time, for the same dialing attempt.

Provisioning

Treatment is configured by selecting the Execute SQL statement action from
the list of Apply to Record actions in the Treatment configuration object. As
for any other type of treatment, Call Result and Number in sequence
treatment properties must be defined. The actual SQL statement to be executed
upon receiving a specified call result is configured in the Annex tab of the
Treatment configuration object. The section name where the SQL statement
option is configured should be entered as default, 0CServer, or configured
with the specific name for the 0CS Application object. The option itself is
named sql and should contain the SQL statement to be executed by OCS.
Similar to any other Treatment, this Treatment must be referenced in the
Calling List configuration object to take effect for the specific calling list.

Execution

When OCS completes the execution of this treatment, it immediately passes
control to the following treatment, if it is available. The following treatment is
a treatment that is configured for the same Call Result value and has a
property Number in sequence equalto (N + 1) where N is the Number in
sequence property of the Execute SQL statement treatment.

Macro Expressions

The SQL statement that OCS executes for this treatment may contain macro
expressions. Macro expressions are pre-defined words that start with the '$'
sign. OCS automatically expands these macro expressions to their values
before the SQL statement is executed.

The table below summarizes macro expressions supported by OCS:

Table 34: OCS Supported Macro Expressions

Macro Expanded to Type Example
$treat_name Name of the current Treatment string Update Treatments
configuration object. History SQL clause
$treat_dbid DBID of the current Treatment integer 101
configuration object.

Deployment Guide
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Table 34: OCS Supported Macro Expressions (Continued)

Apply to Record Actions

Macro Expanded to Type Example
$camp_group_dbid DBID of the Campaign Group integer 101
configuration object to which the record
being processed logically belongs.
$camp_group_name The name of the Campaign Group string Campaign 1@Agent
configuration object. Group 1
$camp_name The name of the Campaign configuration | string Campaign 1
object to which the record logically
belongs.
$group_dbid DBID of the Group configuration object. | integer 101
$camp_dbid DBID of the Campaign configuration integer 101
object.
$group_name The name of the Group configuration string Agent Group 1
object.
$list_tbl_name The name of the calling list database string calling_Llist_tbl
object (table name) from which the
record was fetched.
$list_name The name of the Calling List string Calling List 1
configuration object to which the record
logically belongs.
$list_dbid DBID of the Calling List configuration | integer 101
object.
$dial_filter_where where clause of the dialing filter that is | string customer_code not in
defined for the Calling List. (1,2,6)
$dial_filter_order_by | order by clause of the dialing filter that | string chain_id ASC,
is defined for the Calling List. chain_n ASC
$<{send_attribute) The value of the field of the current string Customer since 1980

record for which send_attribute is
defined.
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Note: Macro expressions of type string should be enclosed in single quotes

if they are used as string constants in the SQL statement.
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Example 1

Example 2

Deployment Guide

Examples

The treatment can be used for various purposes, for example to insert values
into separate historical tables or to update Calling Lists with treatment-specific
information. Consider the following examples of the SQL queries configured
for execution by this treatment:

insert into treatments_history (treatment_dbid, treatment_name,
List_dbid, chain_id, chain_n, exec_time) values ($treat_dbid,
'‘$treat_name', $list_dbid, $GSW_CHAIN_ID, $GSW_CHAIN_N, '15:00:45")

After all macro expressions are expanded by OCS, this SQL statement will
insert treatment application fact data into the separate treatments_history
table in the same database where the current Calling List table resides.
Notice, that the treatments_history table with proper structure must exist
in the database or the execution will yield an error.

update $list_tbl_name set treatment_appl = '$treat_name' where
chain_id = $GSW_CHAIN_ID and chain_n = $GSW_CHAIN_N and
($dial_filter_where)

This query updates the current calling record in the Calling List table from
which it originated. It sets a user-defined field treatment_appl to the name
of the current treatment.

Note: Both examples use $6SW_CHAIN_N macro. For this macro to be
expanded to the value of the chain_n field of the record, the
send_attribute option with the name GSW_CHAIN_N must be
defined for the chain_n field configuration object.

A Word of Warning

Special care must be taken when SQL statements for the treatment are being
defined. These SQL statements should not consume execution-time or put a
heavy load on the DBMS. Remember that OCS uses the same DBMS for
dialing records retrieval and update purposes. Therefore, database performance
is a key factor in the performance of the whole dialing engine.

Additionally, extra care must be taken if the active Calling List is being
updated by the Execute SQL statement treatment application (see “Example
2” on page 349). As a general rule, mandatory fields of the retrieved records
must not be updated, as this might cause table-level locking and/or erroneous,
repetitive dialing of the records that have just been dialed. For example, setting
a record that could be identified by the clause, “where chain_id =
$GSW_CHAIN_ID and chain_n = $GSW_CHAIN_N" to the Ready state will cause this
record to be dialed again which is usually not the desired behavior.
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Treatment Sequences

Treatment sequences allow you to apply different treatments to each
consecutive instance of the same call result. For example, if a Busy call result
is received four times in sequence, you might want to apply a different action
to each occurrence. Each treatment in the sequence must have a unique
treatment name, an Apply to Record action, and a unique, consecutive
sequence number. Treatments are linked by assigning the same call result to
each treatment in the sequence.

Note: Campaign sequences are not the same as treatment sequences. See

“Campaigns” on page 43 for more information about campaign
sequences.

Rules for Treatment Sequences

Apply these general rules to treatment sequences.

Treatment sequences are compatible with next-in-chain Apply to Record
actions. Next-in-Chain treatments should be the last one in a sequence.
When OCS dials the next record in a chain and receives the same call
result for this record as it did for the previous record, the whole treatment
sequence will be repeated.

Always assign consecutive numbers to treatment sequences and always

begin with 1. If you use non-consecutive numbers—such as 1, 2, and 4—
the treatment sequence stops at the first non-consecutive number, which in
this example is 4. The first two treatments would apply, but not the fourth.

OCS applies each treatment in sequential order until a successful call result
is received, a dialing attempt generates a different unsuccessful call result,
or the number of dialing attempts equals the Maximum Attempts value
assigned in the calling list object.

If a treatment sequence for one call result (for example, Busy) is
interrupted with a different call result (No Answer), the sequence is broken
and the Number in Sequence value for Busy resets to one 1. If the Busy call
result is received again, the treatment sequence restarts at the beginning.

Note: Treatments using the Apply to Call action cannot be sequenced. Set
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the Number in Sequence value to 1, as OCS always identifies this
action with a sequence value of 1 even if another value is specified.
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Treatment Object List

Treatment Sequences

Table 35 shows Treatment objects that will be used in Examples 1 and 2,

which follow.

Table 35: Treatment Objects List

Treatment Call Result Number in | Treatment Action

Object Name Sequence | (Apply to Record)

Busyl Busy 1 Redial

Busy2 Busy 2 Retry in (60 min.)

AnsMachl Answering Machine | 1 Retry in (60 min.)
Detected

AnsMach2 Answering Machine | 2 Retry at specified date
Detected

NoAnswer No Answer 1 Retry in (60 min.)

Example 1: Treatment Sequence Exhausted

In this example, the Maximum Attempts value in the Calling List object is 8,
and a record is dialed five times. The results are shown in Table 36.

Table 36: Example 1, Treatment Sequence Exhausted

Call Result Treatment Action Reached Party?
(Apply to Record)

Busy Redial No
Answering Machine | Retry in (60 min.) No
Detected

Busy Redial No
Answering Machine | Retry in (60 min.) No
Detected

Answering Machine | Retry at specified date No
Detected

Answer No treatment Yes

In Example 1, the call did not reach its intended party and, on the fifth dial
attempt, the second number in the Answering Machine Detected treatment
sequence is executed.
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Example 2: Record Reaches Maximum Attempts Value

When the number of times the telephone number is dialed matches the
Maximum Attempts value from the calling list, the final outcome of the last
attempt is applied and logged in the database.

In this example the calling list object’s Maximum Attempts value is 8. Using
the same Treatment objects from Example 1, a record is dialed eight times,
with the results shown in Table 37.

Table 37: Example 2, Record Reaches
Maximum Attempts Value

Number | Call Result Treatment Reached
of Action Party
Attempt (Apply to
s Record)
1 Answering Machine Retry in (60 min.) | No
Detected
2 Busy Redial No
3 Answering Machine Retry in (60 min.) | No
Detected
4 Busy Redial No
5 Answering Machine Retry in (60 min.) | No
Detected
6 Busy Redial No
7 Answering Machine Retry in (60 min.) | No
Detected
8 Busy Redial No

In Example 2, the call did not reach its intended party after eight attempts.
Because the Maximum Attempts value is 8, dialing stops and OCS applies the
final outcome.

Apply to Call Outcome

When creating a Treatment object in Genesys Administrator, you can assign an
Apply to Call outcome for two call results: Answering Machine Detected or
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Fax Detected. See “Rules for Special Call Results” on page 337 for additional
information. Also see Chapter 8 on page 157 for configuration instructions.

Note: The Apply to Call treatments work when in Transfer mode.

The Apply to Call treatments are:

* Drop. This is the default if no treatment is specified. OCS drops the call and
logs the call result as Answering Machine or Fax Detected in the database.

* Connect or Transfer. This treatment can be user-assigned only to
Answering Machine Detected or Fax Detected call results. OCS transfers
calls to the specified DN.

e Inaddition, OCS checks both the “AnswerClass” data and the call state data
to determine if a dialed call has reached an answering machine. This
process eliminates problems with some switches. For more information,
see “Rules for Answering Machine Detected or Fax Detected” on
page 338.

Rules for Apply to Call

There is one rule for Apply to Call:

The default value is [Unknown Action code]. Do not change this default
unless you are creating a treatment for Answering Machine Detected or
Fax Detected call results and have created and configured a Destination
DN for this purpose.

Note: Treatments using the Apply to Call action can not be sequenced. Set
the Number in Sequence value to 1, as OCS always identifies this
action with a sequence value of 1 even if another value is specified.

Outbound Record Sharing Between
Multiple Desktops

Deployment Guide

Outbound record sharing between multiple outbound-enabled desktops is
possible when the outbound call is made for a certain record (that is, a call with
the GSW_RECORD_HANDLE key and a valid record handle value attached to it) is
transferred or conferenced between two or more agent places. For proper
record sharing, OCS must monitor all of the DN that participate in the call
transfer or conference. In addition, all agents who intend to share the record
must be logged in.

There are three possible scenarios for sharing records.
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Scenario 1: Outbound Call Single Step Transfer or Mute (Blind) Transfer

Upon a successful transfer completion, all rights to the record and chained
records access are revoked from the agent who initiated the transfer and are
granted to the agent who received the transferred call.

Scenario 2: Outbound Call Two-step Transfer with Consultation Call

During the consultation phase of the transfer (or conference), when the
consultation call is established on the agent’s DN who should receive the
transferred call (or be added to the conference), this agent has read-only
permissions for the record. No desktop events will be accepted from this agent,
except for a request for chained records (ChainedRecordRequest), which are
also passed to the agent desktop in the read-only mode.

Scenario 3: Outbound Call Conference

All agents participating in the conference call have full access to the record
(and chained records of the same chain) and the right to update the chain (that
is, by sending desktop protocol events for specific record handling).

Note: During the conference scenario, when more than one agent has full
access to the record, record access is concurrent. This means, that if
one agent sends the RecordProcessed event for the record and receives
an Acknowledgement from OCS, the other agent(s) will not be able to
update this record anymore.

Answering Machine Call Handling

You can handle calls that are detected with an Answering Machine call result
on a per-record basis.

Per-Record Basis

354

OCS supports the ability to assign different types of AM-detection to each
dialing request based on a custom-configured value of an arbitrary field in
Calling List record.

To configure AM-detection on a per-record basis, OCS uses the Business
Attributes configuration object. Use the following for guidelines when
configuring it.

*  Specify the name as 0C AM Detection.
» Specify the type as Custonm.

» Specify the display name and the description attributes as any value.
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Note: Any number of attribute values can be configured under this Business
Attribute object. Each individual attribute value represents a field in
the Calling List with a map of values for this field and the
corresponding values for the desired AM-detection. You can specify
only one map per calling list or OCS application. The name of the
attribute value is arbitrary; however it should be meaningful so that it
is easier to associate a calling list with this attribute value.

The actual map for field values for AM-detection settings translation is
configured in the Options tab of the attribute value as follows:

* The section name must contain the name of the Calling List Field
configuration object.

* The option name corresponds to the value of the Field name. The option
name must contain the actual enumeration value of the field (the value of
the field stored in the database). The supported option values correspond to
the valid values for the call_answer_type_recognition option.

* The option value specifies the desired AM-detection setting.

To specify which Calling List uses which attribute value, the am-detection-map
option can be used. See page 259 for more information about this option.

OCS uses the following approach to determine which AM-detection value to
apply to a dialing request.

* OCS finds the name of the AM-detection map in the Annex tab of the
Calling List that contains the record.

+ Ifitis not found, then the previous Campaign-level
call_answer_type_recognition option is used for AM-detection
settings.

+ Ifitis found, OCS attempts to find the Business Attribute value with
the specified name in the configuration. This attribute value should be
present under the Business Attribute object with the 0C AM Detection
name in the same Tenant where the Calling List resides; if it is not
found, it should be in the Environment section. If the value of the
am-detection-map option is set to default, then OCS looks for the
attribute value with the Default flag turned ON, as configured under the
same Business Attribute object.

e When the map is found, OCS reads through the names of the sections in
the Options tab for this map for the section name that matches a field name
of the given calling list is used.

+ Ifthe field is not found, or the value of this field in the current record
does not have a representation in the option name, then the
call_answer_type_recognition option is used.
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* OCS assigns an AM-detection value to the Calling List record when the
record is retrieved from the database if an AM-detection map is found.
Otherwise, the call_answer_type_recognition option determines the
AM-detection value when it is dialed. Any configuration changes in the
AM-detection map will not affect any records that have been already
retrieved by OCS.

If the attribute value is not found or disabled, then OCS uses the AM-detection
method that is defined in the cal l_answer_type_recognition option.

Note: When working with GVP, the ANSWER_TYPE_RECOGNITION attribute is
added to the dialing attributes. This attribute holds the value for
AM-detection for a given dialing request.
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1 3 SCXML-Based Treatments

Outbound Contact Server (OCS) allows you to create SCXML (State Chart
Extensible Markup Language)-based treatments, instead of configuring
standard treatments (see Chapter 12 on page 335).

Note: You cannot use both SCXML treatments and standard treatments for
the same calling list.

The information in this chapter is divided among the following topics:
«  Overview, page 357

» Architecture, page 358

« Design and Configuration Task Summary, page 370

+  Customer Contact According to Daytime Intervals, page 371

+  Record-Processing Order, page 372

+  Setting Options for Individual Records or Chain of Records, page 379
«  Other Usages of SCXML Treatments, page 380

«  Configuration Tasks, page 380

«  Version Checking, page 382

+  Error Handling, page 382

Overview

Through the use of SCXML treatment scripts, you can configure custom
treatments to handle multiple contact methods and scenarios, providing greater
flexibility for reaching a customer.

Some of the scenarios that custom treatments can address include:

* Selecting the preferred way to reach a customer, according to the time of
day or the day of week (see “Customer Contact According to Daytime
Intervals” on page 371).
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* Specifying the order in which to contact a customer, according to the
contact type (see “Record-Processing Order” on page 372).

* Specifying the first contact type to use when contacting a customer (see
page 380).

* Specifying the maximum number of attempts to dial records (see
page 380).

* Specifying a treatment action according to the call result (see page 380).

What is SCXML?

SCXML is an event-based state machine language that accommodates various

call control/customer service states and the transitions between them. While

relatively new as a notation/language, SCXML is well-proven for building

state-based models and facilitates the process of orchestrating

customer-service solutions.

The core SCXML provides state chart functionality, while Outbound Contact—

specific instructions are specified in the executable content of SCXML in form

of SCXML extensions (action elements) and/or ECMA script extensions

(properties of special ECMA script objects).

For more information about SCXML or ECMA scripts, go to the following

websites:

» State Chart XML (SCXML), State Machine Notation for Control
Abstraction (www.w3.org/TR/scxml/)

* ECMA and ECMAScript Language (www.ecma-international.org)

Architecture

In order to use SCXML-based treatments, Outbound Contact makes use of
three components/applications:

* OCS (see page 26)
* Application Server
* SCXML engine/state machine built into OCS

Application Server

358

SCXML-based treatments are typically hosted/stored on an Application Server
(along with other Genesys SCXML scripts, such as SCXML-based strategies)
and provided to OCS based on parameters contained in HTTP requests. The
treatment-uri option (see pages 256 and 262) identifies the location of these
scripts.

Application Server is a web server used to store and retrieve SCXML scripts.
You deploy SCXML-based treatments to your production environment by
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Deployment Guide

publishing them to an Application Server. Upon an HTTP request, the
Application Server is responsible for providing the treatment logic to OCS in
the form of a document.

Document Retrieval from Web or Application Server

OCS connects to and retrieves SCXML documents (flexible treatments
descriptions) from the Web or Application Server in the following ways:

OCS uses a connection pool and HTTP 1.1 persistent connections. The size
of the pool and connection timeout settings are controlled by the
http-connection-pool-size (see page 222) and http-response-timeout
(see page 222) options. Previously, OCS used HTTP 1.0 non-persistent
connection to the Web or Application Server.

OCS opens only a single connection to the given Web or Application
Server to retrieve all SCXML documents from that server. Previously,
OCS opened as many connections as there were simultaneous requests for
SCXML documents from the loaded chains.

OCS supports secure HTTP (HTTPS) with TLS protocol as a sub layer
under regular HTTP for SCXML document retrieval from Web or
Application Server. For more details about how to configure and use
HTTPS, see “Pre-Dial Validation Over Secure Connection” on page 332.

Supported Application Servers

Genesys supports the following types of Application Server software:

Microsoft Internet Information Services (IIS), formerly called Microsoft
Internet Information Server). Genesys supports IIS 6.0-8.1.

JBoss Application Server (or JBoss AS). This free software/open source
Java EE-based Application Server is usable on any operating system that
Java supports. Genesys supports version JBoss 8.1.

IBM’s WebSphere Application Server (WAS). This software Application
Server, which is built using open standards (such as Java EE, XML, and
Web Services) works with a number of web servers. Genesys supports
IBM Websphere Application Server 5.0-8.1.

Apache/Tomcat

Note: While Web or Application Server is a more common and a more

convenient way to store SCXML documents, you can simply place a
file with the SCXML script in your file system. In this case, the
absolute path to this file is configured as follows (example):

treatment-uri=file:///C|/GCT1/0CS/Scripts/sample®1.scxml
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SCXML Engine/State Machine

360

The SCXML engine is a subcomponent of OCS that leverages the Genesys
SCXML library built into OCS, and which parses the SCXML treatment script.
When each record or chain of records associated with the campaign is accessed
for processing, the engine creates an instance of the state machine and requests
the SCXML treatment from the Application Server. When the record is
processed (for example, the call is answered and then completed), the
associated state machine instance is stopped.

Note: You specify the SCXML document that describes the treatment used
by OCS in the treatment-uri option (see pages 256 and 262) in the
Campaign Group or Calling List object. For more information on
configuring treatments, see “Design and Configuration Task
Summary” on page 370.

A state machine is an SCXML treatment script launched by the SCXML

engine, that includes states, actions, events, and transitions, designed to inform

OCS on how to contact customers during a campaign.

* States provide information on the current status. A state machine operates
in one state at a time, until an OCS event provides information that
requires a state change, according to the design of the treatment script.

* Actions are activities that the state machine performs, according to the
treatment script.

» Events are messages that OCS sends to the state machine in response to an
action.

* Transitions occur when the state changes in response to an event.

Figure 16 illustrates the scenario in which the SCXML engine is used to apply
an SCXML treatment. “SCXML Engine/State Machine Treatment Processing”
describes the diagram.
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Figure 16: SCXML Treatment Processing

Deployment Guide

SCXML Engine/State Machine Treatment Processing

1.

OCS receives a request to start processing a record of a Calling List
associated with a campaign.

As configured in the Campaign Group or Calling List object, OCS requests
the associated treatment from Application Server.

Application Server provides OCS with the SCXML treatment.

OCS requests the Genesys SCXML engine to create and start an instance
of the SCXML state machine for the record.

The SCXML engine creates and starts the instance and requests that OCS
execute customer actions for the record, according to the SCXML
treatment script.

OCS initiates the requested action (for example, make a call, go to the next
record, delay, and so on); for more information on possible actions, see
“Outbound Contact Custom Actions and Events”™).

After completing each action, OCS sends an event communicating the
action result of the action to the instance of the state machine that SCXML
engine is running.
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8. OCS continues processing the actions, as defined in the state machine.

9. When the processing of the chain of records is completed and chain is
finalized, OCS deletes the instance of that state machine.

Note: A state machine may not be able to complete the script for a chain of
records if:

* The campaign is unloaded.
* OCS shuts down.

After a particular instance of the state machine is restored, OCS sends the
ocs.daytime_change event to the instance so it can adjust its behavior
according to the current daytime interval.

Outbound Contact Custom Actions and Events

Tables 38 and 39 describe the custom actions and events supported in
Outbound Contact 8.0 for SCXML treatments.

Table 38: Custom Actions

Action

Action Details

timeout

Response event: ocs.timeout

Element attribute: de lLay—Timeout in seconds

Child elements: none

Description: Waits for the specified time.

Examples
* A five minute delay: <ocs:timeout delay="300"/>
* A delay to the nearest holiday: <ocs:timeout delay="HDAY"/>

next_record

Reponse event: ocs.next_record

Element attribute: repeat_chain— (Optional) Controls whether the chain
should be cycled again starting with the record at the beginning of the chain.

Child elements: contact_info_type

0 or more elements can be applied.

Description: Requests the next record in the chain. The next record is
selected according to the criteria defined by the contact_info_type child
elements (for example, type_id or type_name).

Note: An empty record_id indicates that there is no next record.
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Table 38: Custom Actions (Continued)

Architecture

Action

Action Details

contact_info_type

Element attributes:

* type_id—ID of the contact information type, as specified in the
contact_info_type field in the Calling List

* type_name—Mnemonic name of the contact information type.
The list identifies each possible IDs and its corresponding type name
¢ 0—NO_TYPE
¢ 1—HOME
+ 2—DIRECT_BUSINESS
¢ 3—BUSINESS_WITH_EXTENSION

+ 4—MOBILE

+ 5—VACATION
+ 6—PAGER

+ T7—MODEM

+ 8—VOICE_MAIL
+ 9—PIN_PAGER
+ 10—E-MAIL

* exclude—The value that determines whether records that match these

criteria are excluded from the result. A value of no (the default) includes

the records. A value of yes excludes the records.

Child elements: none

Description: Identifies the attribute for contact_type_info. At least one
attribute (type_id or type_name) must be specified.

If both are specified, type_id has priority.

Note: If both are specified, confirm that the type_id and type_name values

match each other. Otherwise, a warning appears in the log.

Deployment Guide
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Table 38: Custom Actions (Continued)

Action

Action Details

Examples
Example 1, Getting Next Record with the Home Phone
<ocs:next_record)

{ocs:contact_info_type type_id=1 />
{/ocs:next_record>

Example 2, Getting the Next Record with Phone Other than Home and
Mobile

<ocs:next_record)
<ocs:contact_info_type type_name="'HOME'" exclude="'yes'" />
{ocs:contact_info_type type_name="'MOBILE'" exclude="'yes'" />
{/ocs:next_record)

Example 3, Getting the Next Record According to the Database Order
{ocs:next_record/>

Example 4, Cycling Through the Chain and Getting the Next Record from
the Beginning of the Chain

<ocs:next_record repeat_chain="'yes'"/>

get_daytime

Request event: daytime_change

Element attributes: none

Child elements: none

Description: Requests information about the current daytime interval.

364
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Table 38: Custom Actions (Continued)

Action

Action Details

get_info

Request event: ocs. info

Element attributes:

* what—(Mandatory) A string with the type of information being
requested. The supported value is TIMERANGE .

+ param—(Optional) A string that is the parameter of the request. For the
TIMERANGE type of information, valid values include:

+ BBH: Before business hours on a weekday

+ BH: Business hours on a weekday

*

ABH: After business hours on a weekday
WEND: Weekend
HDAY: Holiday

*

*

Child events: none

Description: Requests the execution of content-related information from
OCS. TIMERANGE, param values = <BBH, BH, ABH, WEND, or HDAY)
requests the time period (in seconds) when the specified param attribute
timerange begins for the current record.

Example
{ocs:get_info what= "'TIMERANGE'" param = "'HDAY'"/>

make_call

Response event: ocs.callresult

Element attribute: record_id—ID of the record for which the call will be
made.

Child elements: none

Description: As a result of this action, OCS initiates a request to make a call
using the contact information specified in this record.

Example:
<ocs:make_call record_id="record_id"/>

set_flex_attr

Response event: None if successful

Error.Attribute if an invalid value is configured

Element attributes: record_id—(Mandatory) Defines the ID of the record
(record handle) for which the flexible attribute(s) (options) are configured.
This element can contain a special value of @, which is interpreted as for
all records in chain. For example, it specifies that the same flexible
attribute(s) (options) must be set for all the records in the chain that are
processed.

Deployment Guide
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Table 38: Custom Actions (Continued)

Action

Action Details

set_flex_attr
(continued)

Child elements: flex_attr

1 or more elements can be defined.

Child element attributes:

+ attr— (Mandatory) Specifies the type of flexible attribute being
configured.

Allowed value: OPTIONS

* type—(Mandatory) Specifies the type of value that is used for the
flexible attribute.

Allowed values: string or int

* key—(Mandatory) Specifies the mnemonic name of the flexible
attribute.

(option name)
* value—(Mandatory) Specifies the value that is assigned to the attribute.

(option value)

Element description: Defines a single option, including its name, type,
and value.

Description: This custom action can be used to set one or more options for
the specified record in the chain or for all records in the chain. The actual
options and values are defined by the flex_attr child element(s).

Examples:

1. Set options for the current record:
ocs:set_flex_attr record_id="_eventdata.record_id")

{ocs:flex_attr attr=""OPTIONS'" type="'string'"
key="'CPNDigits'" value=""'8884554040"'"/>

{ocs:flex_attr attr="'OPTIONS'" type="'string'"
key="'pre-dial-validation'" value="'false'"/>

{/ocs:set_flex_attr)

2. Set option for all records in the chain:
{ocs:set_flex_attr record_id="'0"")

{ocs:flex_attr attr=""OPTIONS'" type="'string""
key="'pre-dial-validation'" value=""'true'"/>

{/ocs:set_flex_attr)

Note: This custom action is available in OCS release 8.0.001 and
beyond.

set_exec_flag

Response event: None if successful

Error.Attribute if an invalid value is configured

366

Outbound Contact 8.0 @



Chapter 13: SCXML-Based Treatments Architecture

Table 38: Custom Actions (Continued)

Action Action Details
set_exec_flag Element attributes:
(continued) + flag—(Mandatory) Defines the type of execution flag.

Allowed Value: PostProcessing
* value—(Mandatory) Defines the value of the execution flag.

For PostProcessing flag type, valid values are: Finalize and Switch.

Child elements: None

Description: This custom action allows the flag, that controls SCXML
treatment execution, to be set.

* PostProcessing flag—Determines how the chain of records is
processed when the SCXML treatment execution is completed.

* Finalize—(default) Processing of the chain is done, chain is finalized
(marked comp Leted) in the database.

* Switch—Processing of the chain continues after the SCXML treatment
execution ceases, and traditional treatments (if configured) take over
execution.

Examples:
1. Switch to traditional treatments:

{ocs:set_exec_flag flag=""'PostProcessing'" value="'Switch'"/>
2. Finalize chain processing:

{ocs:set_exec_flag flag=""'PostProcessing"'"
value=""'Finalize'"/>

Note: This custom action is available in OCS release 8.0.001 and
beyond.
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Table 39: Events from OCS

Event Event Details

ocs.callresult Response for make_call

Event properties: cal lresult—The result of the call. Values include:
+ GeneralError
+ SystemError
+ RemoteRelease
+ Busy
+ NoAnswer
¢ SIT_Detected
+ AnswMachine
¢ ALL_Trunks_Busy
¢ SIT_Invalid_Num
+ SIT_Vacant
¢+ SIT_Oper_Intercept
+ SIT_Unknown
+ SIT_No_Circuit
¢+ SIT_Reorder
+ Fax
+ Silence
+ Answer
+ NuTone
+ NoDialTone
+ NoProgress
+ NoRingBack
+ NoEstablished
+ PagerDetected

Description: OCS notifies the state machine instance of the call result.

ocs.daytime_change Response for get_daytime or an unsolicited request

Event properties: daytime_code—Code that defines the current daytime
interval. Values include:

+ BBH: Before business hours on a weekday

+ BH: Business hours on a weekday

*

ABH: After business hours on a weekday
WEND: Weekend
HDAY: Holiday

*

*
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Table 39: Events from OCS (Continued)

Event

Event Details

ocs.daytime_change

Description: Notifies instances of the SCXML scripts/state machine when

(continued) the daytime interval changes. If the script is designed to recognize the
change, it can result in a different number being dialed (for example, if the
daytime interval changes from BH to ABH, a script could be configured to
dial the home phone instead of a business phone).

ocs.info Response for get_info.

Event properties: result—A string that contains the information requested
from OCS.

Description: Returns information, based on what was requested from OCS
in the context of the current record.

ocs.next_record

Response for next_record

Event properties:

* record_id—The OCS-assigned ID of the record in the Calling List. If it
is equal to NULL, no next record is available and no other event
properties are assigned

e contact_info—The value of contact_info field for the record in the
Calling List.

» <pseudo-fields>—Helper fields defined by OCS including:
+ gsw_chain_attempts: (integer) Stores the number of attempts for each

chain, which equals the sum of the attempts field values for all records
that compose this chain.

+ gsw_preferred_f lag: (string) Indicates whether the chain was
prioritized by a custom field value, as defined by the
treatment-preferred-contact-field option (page 225). Valid values
for this event are yes and no.

» All other fields defined in the Calling List.

Description: Returns the next record according to the criteria set in the
next_record custom action.

ocs.timeout

Response for timeout

Event properties: none

Description: Indicates that the de lay specified in the timeout custom action
has expired.

Error.Attribute

Response for any custom action.

Event properties: error_code—An error code (integer) that specifies the
error that occurred.

Deployment Guide

369




Chapter 13: SCXML-Based Treatments Design and Configuration Task Summary

Table 39: Events from OCS (Continued)

Event Event Details

Error.Attribute
(continued)

Description: Indicates that an incorrect attribute value is included in the
custom action which triggered this event—for example, if the timeout
custom action includes a negative de Lay value or the make call custom
action includes a record_id value that does not exist.

Error.Configuration Response for any custom action

Event properties: error_code—An error code (integer) that specifies the
error that occurred.

Description: Indicates a configuration error—for example, if the timeout
custom action includes a delay value of WEND but the Statistical Table for
weekdays is not configured.

Design and Configuration Task Summary

Task Summary: Designing and Configuring SCXML
Treatments

Task Related Procedures and Actions

370

1. Configure the Statistical Days and
Statistical Tables.

See Procedure: Configuring Statistical
Days and Statistical Tables for Time
Ranges, on page 380.

2. Design the treatment scripts(s).

Create the .xml or .scxml files
according to your treatment
requirements. Some requirements may
include the following:

*  “Customer Contact According to
Daytime Intervals” on page 371

* “Record-Processing Order” on
page 372

e “Other Usages of SCXML
Treatments” on page 380

3. Configure the treatment options.

See “Configuring SCXML Treatment
Options” on page 381.

4. Deploy the treatment script(s).

See Procedure: Deploying a Treatment
Script to an Application Server (IIS),
on page 382.
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Customer Contact According to Daytime

Intervals

Deployment Guide

You can design a treatment script that takes into account the time of day when
determining how to contact a customer. Using predefined daytime intervals
and configured Statistical Days and Statistical Tables with a SCXML
treatment, OCS can also adjust how a customer is contacted if a daytime
switch occurs. For example, the treatment may request that OCS dial a
customer’s business phone during business hours, but dial the customer’s
mobile phone after business hours.

The predefined daytime intervals include:

* BH: Business hours on a weekday, from its start time to its end time.

ABH: After business hours on a weekday, from the end time of a weekday
until midnight.

* BBH: Before business hours on a weekday, from midnight to the start time
of the weekday.

* WEND: Weekend. Days that are identified by those days not configured as
weekdays in the Weekday Statistical Days Table.

* HDAY: Holiday. Days configured as holidays.

When a dialing session/campaign group loads, OCS reads the time intervals,
Statistical Days, and Statistical Tables configuration to determine the current
time interval. OCS looks for the Statistical Tables in the configuration database
in the following order:

* Under the Campaign Group Tenant.

* Under the Environment Tenant, if it is not found under the Campaign Group
Tenant.

Note: Ifthese Statistical Tables are not found in either location or a
Statistical Day is not configured, OCS considers the time range as a
holiday (HDAY).

At startup, OCS determines the time and identifies the daytime interval
according to the configured Statistical Days and Statistical Tables (see
Procedure: Configuring Statistical Days and Statistical Tables for Time
Ranges, on page 380). OCS dynamically processes configuration time interval
changes (for example, from BH to ABH), while a Campaign Group is active.
When the daytime interval changes, according to the contact’s time zone, OCS
informs the various instances of the state machine by sending the
ocs.daytime_change event (see page 368). This triggers the state machine to
proceed to the new daytime interval.

In addition, when the SCXML engine downloads a script, the state machine
requests the current daytime interval through the get_daytime action (see
page 364).
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Script Design

When designing your SCXML treatment to handle daytime intervals and
switching, include the following:

* FEach daytime interval and transition associated with changing from one
interval to another.

* For each interval, design the logic for making a call, and for handling call
states, number of attempts, delays, and so on.

* Define variables (data model) to represent different parameters/values (for
example, contact type, delay, number of attempts, and so on) that will be
used through the script. The value for these variables can also be specified
in the treatment-uri option (see page 381, page 256, or page 262).

You can also configure the script to delay switching of time intervals if the
daytime switch occurs while a particular substate is still being processed (for
example, the state machine is waiting for the ocs.callresult event). To
accomplish this, configure the script to store the daytime interval in a variable
and have the script check that variable when it is in a state for processing a
daytime change.

To simplify the script design, you might create one high level script and
multiple individual scripts to handle each daytime interval. When the daytime
switching occurs, the current time interval script will be stopped and the new
daytime interval script started. Then in the high level script, include a reference
in the script to an external file located at another URL using the src attribute.
For example:

(state id="ABH" src="someURL#ABH" >

When OCS requests a download of the script, the SCXML engine downloads
the script and all referenced scripts into one combined state machine. As usual,
an instance of this is created for each record/chain processed.

Note: For an example of a script which handles daytime intervals, see the
sample treatment script, sample@3.scxml, that installs with OCS.

Record-Processing Order

You can design scripts handle chains of records according to the contact
information type. You can further refine this ordering by designing the script
to specify parameters such as the number of retries or delay associated with
each contact info type or call result.

Script Design

When designing your SCXML treatment to specify record processing order, it
is recommended that the script include the following:
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* Data model variables for each contact type; for example, Type1, Type2,
and so on. You may or may not specify the values for each of these types.

* A subsection that defines how to handle that contact type.

Script Example

A script might order record processing according to three contact types, Type 1
(direct business), Type 2 (home), and Type 3 (other). The script defines these
as variables so that the user can change the default values (which specified in
the script) without altering the script itself.

Note: Users can change the default values by specifying them in the
treatment-uri option (see pages 256 and 262).

Script Outline

This script is divided into the following sections:
e Data Model:
+ The script identifies data model variables and their associated values,
which are used later in the script.

All of this should be programmed in the script. An Application Server that
supports JSP and ASP can dynamically modify the content of the script if this
is how the script is coded.

* Type 1 Records:
+ The script searches for Type 1 records, which are defined in the Data
Model section as equal to DIRECT_BUSINESS.

+ Ifno Type 1 records are found, the script skips to the Type 2 Record
section.
+ Ifarecord is found, the script directs OCS as follows:

+ Make a call—If the script receives an Answer call result, the script
ends. If it receives a SIT tone call result, the script searches for the
next Type 1 record; if it does not receive either an Answer or a SIT
call result, the script instructs OCS to delay.

+ Delay—If the script delays, it waits the specified time (per the
RetryDelay variable) and then attempts to make the call again. If the
number of retries is greater than the maximum specified, the script
searches for the next Type 1 record. If a record is found, the script
requests OCS to make a call.

* Type 2 Records:

+  The script searches for Type 2 records, which are defined in the Data
Model section as equal to MOBILE.

+ If Type 2 records are found, the script skips to the Other Records
section.

+ Ifarecord is found, the script directs OCS as follows:
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*
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Make a call—If the script receives an Answer call result, the script
ends. If it receives a SIT tone call result, the script searches for the
next Type 2 record; if it does not receive either an Answer or a SIT
call result, the script instructs OCS to delay.

Delay—If the script delays, it waits the specified time (per the
RetryDelay variable) and then attempts to make the call again. If the
number of retries is greater than the maximum specified, the script
searches for the next Type 2 record. If a record is found, the script
requests OCS to make a call.

*  Other Records:
The script searches for records that are neither Type 1 nor Type 2.

*

*

If no such records are found, the script goes to the End of Cycle
section.

If a record is found, the script directs OCS as follows:

*

Make a call—If the script receives an Answer call result, the script
ends. If it receives a SIT tone call result, the script searches for the
next Other record; if it does not receive either an Answer or a SIT
call result, the script instructs OCS to delay.

Delay—If the script delays, it waits the specified time (per the
RetryDelay variable) and then attempts to make the call again. If the
number of retries is greater than the maximum specified, the script
searches for the next Other record. If a record is found, the script
requests OCS to make a call.

* End of Cycle:

If the script reaches an end of the cycle coding and the number of
cycles is less than the maximum number of cycles, the script returns to
the beginning of the script.

*

If the script reaches an end of cycle coding and the number of cycles is
equal to or greater than the maximum number of cycles, the script ends
and the SCXML engine unloads it.

Script Coding

The script coding is as follows:
<{?xml version="1.0" encoding="UTF-8"?>
{scxml xmlns=http://www.w3.0rg/2005/07/scxml

xmlns:ocs=http://www.genesyslab.com/schemas/ocs/treatments

version="1.0"
profile="ecmascript"
initialstate="begin")

{datamodel)
{data ID="Typel1" expr="'DIRECT_BUSINESS'"/>
{data ID="Type2" expr=""MOBILE'"/>
{data ID="record_id" expr="'0""/>
{data ID="N1_retr" expr="0"/>
{(data ID="N1_retr_max" expr="3"/>
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{data ID="N2_retr" expr="0"/>

{data ID="N2_retr_max" expr="2"/>
{data ID="N3_retr" expr="0"/>

{data ID="N3_retr_max" expr="1"/>
{data ID="RetryDelay" expr="300"/>
{data ID="N_of_cycles" expr="0"/>
{data ID="N_of_cycles_max" expr="2"/>

{/datamodel
{script>
function isSIT( call_result )
{

if(call_result eq "SIT_DETECTED' || call_result eq
'SIT_Invalid_Num' || call_result eq "SIT_Vacant' || call_result eq
'SIT_Oper_Intercept' || call_result eq "SIT_Unknown' || call_result

eq 'SIT_No_Circuit' || call_result eq "SIT_Reorder'
return true;
else
return false;
}
{/script>

{state id="begin")
{transition target="DialTypelRecords" />

{/state>
{state id="DialTypelRecords")
dinitialy
{transition target="NextRecordTypel" />
{/initial>

{state id="NextRecordTypel">
{onentry)
{ocs:next_record>
{ocs:contact_info_type type_name="_data.Typel"/>
{/ocs:next_record)
{/onentry>

{transition event="ocs.next_record"
cond="_eventdata.record_id eq '0'"target="DialType2Records"/>
{transition event="ocs.next_record"
cond="_eventdata.record_id ne '0'"target="MakeCall")
{assign location="record_id" expr =
"_eventdata.record_id" />
{/transition)

{/state)
{state id="MakeCall")
<onentry»
<ocs:make_call record_id="_data.record_id"/)
{/onentry>
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{transition event="ocs.callresult"
cond="_eventdata.callresult eq 'Answer'"target="end" />

{transition event="ocs.callresult"
cond=isSIT(_eventdata.callresult) “target="NextRecordTypel" />

{transition event="ocs.callresult"
cond="(_eventdata.callresult ne 'Answer') and
(lisSIT(_eventdata.callresult) )" target="Delay" />

{onexit)
Cassign location="N1_retr" expr="_data.N1_retr+1" />
{/onexit>
{/state>

(state id="Delay")
{onentry»
{ocs:timeout delay="_data.RetryDelay" />

{/onentry>

{transition event="ocs.timeout" cond="_data.N1_retr Lt
_data.N1_retr_max"target="MakeCall"/)

{transition event="ocs.timeout" cond="_data.N1_retr ge
_data.N1_retr_max" target="NextRecordTypel" />

{/state>
{/state)
{state id="DialType2Records">
Cinitialy
{transition target="NextRecordType2" />
{/initial>

{state id="NextRecordType2")
{onentry)
<ocs:next_record)
{ocs:contact_info_type type_name="_data.Type2"/>
{/ocs:next_record>
{/onentry>
{transition event="ocs.next_record"
cond="_eventdata.record_id eq '0'"target="DialOtherRecords"/>
{transition event="ocs.next_record"
cond="_eventdata.record_id ne '0'"target="MakeCall2")
{assign location="record_id" expr ="_eventdata.record_id"

/>
{/transition)
{/state)
{(state id="MakeCall2")
{onentry»
{ocs:make_call record_id="_data.record_id"/>
{/onentry>

376 Outbound Contact 8.0 @



Chapter 13: SCXML-Based Treatments Record-Processing Order

{transition event="ocs.callresult"
cond="_eventdata.callresult eq 'Answer'"target="end" />

{transition event="ocs.callresult"
cond="_isSIT(_eventdata.callresult) “target="NextRecordType2" />

{transition event="ocs.callresult"
cond="(_eventdata.callresult ne 'Answer') and
(lisSIT(_eventdata.callresult) )" target="Delay2" />

{onexit>

Cassign location="N2_retr" expr="_data.N2_retr+1" />
{/onexit)
{/state)

{state id="Delay2">
<onentry>
{ocs:timeout delay="_data.RetryDelay" />

{/onentry>

{transition event="ocs.timeout" cond="_data.N2_retr Lt
_data.N2_retr_max"target="MakeCall" />

{transition event="ocs.timeout" cond="_data.N2_retr ge
_data.N2_retr_max"target="NextRecordType2" />

{/state)
{/state)
{state id="DialOtherRecords")
initial>
{transition target="NextOtherRecord" /)
/initial>

{state id="NextOtherRecord")
{onentry»
{ocs:next_record)
{ocs:contact_info_type type_name="_data.Typel1" exclude

IIyesll/>
{ocs:contact_info_type type_name="_data.Type2" exclude

"yes"/>
{/ocs:next_record)
{/onentry>
{transition event="ocs.next_record"
cond="_eventdata.record_id eq '0'"target="End0fCycle"/>
{transition event="ocs.next_record" cond=
"_eventdata.record_id ne '0'"target="MakeCall3")
{assign location="record_id" expr ="_eventdata.record_id"

/>
{/transition)
{/state)
{(state id="MakeCall3")
{onentry»
<ocs:make_call record_id="_data.record_id"/>
{/onentry>
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{transition event="ocs.callresult"
cond="_eventdata.callresult eq 'Answer'"target="end" />

{transition event="ocs.callresult"
cond="isSIT(_eventdata.callresult) "target="NextOtherRecord" />

{transition event="ocs.callresult"
cond="(_eventdata.callresult ne 'Answer') and
( lisSIT(_eventdata.callresult) )" target="Delay3" />

{onexit>

Cassign location="N3_retr" expr="_data.N3_retr+1" />
{/onexit)
{/state)

{state id="Delay3")
<onentry>
{ocs:timeout delay="_data.RetryDelay" />

{/onentry>

{transition event="ocs.timeout" cond="_data.N3_retr Lt
_data.N3_retr_max" target="MakeCall3" /)
{transition event="ocs.timeout" cond="_data.N3_retr ge
_data.N3_retr_max"target="NextOtherRecord" />
{/state)
{/state)

{state id="EndOfCycle")
<onentry>
{assign location="N_of_cycles" expr="_data.N_of_cycles+1"

/>
{/onentry>

{transition cond="_data.N_of_cycles Lt _data.N_of_cycles_max"
target="begin" />
<assign location="N1_retr" expr="0" />
{assign location="N2_retr" expr="0" />
{assign location="N3_retr" expr="0" />
{/transition)
{transition cond="_data.N_of_cycles ge _data.N_of_cycles_max"
target="end" />
{/state>

{final id="end"/>

{/scxml)
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Setting Options for Individual Records or
Chain of Records

The following options can be set now at the individual record or a chain of
records basis:

* CPNDigits—Defines the Caller ID for the outbound call (see page 237)

* pre-dial-validation—Controls whether or not pre-dial validation is in
effect (see page 220)

The ability to set these options for individual records enables you to fine-tune
record processing. Unlike the call_answer_type_recognition option (see
page 230) which can be set at individual record level, based on the specific
fields values of the record defined using the Business Attributes
configuration objects, these two options settings are defined by using flexible
SCXML treatments. This allows much greater flexibility in the calculation of
the option value and allows the definition of complicated business logic based
on which these calculations are made. For example, any property of the record,
or the time of day, the day of the week, or any other parameter that might be
calculated inside the SCXML treatment executable content (JavaScript) can
now affect the value of the option. For ease of use purposes, the
call_answer_type_recognition option can now also be set by using an
SCXML treatment.

Custom Actions

Deployment Guide

Custom actions for SCXML treatments, which allow setting options for the
individual records or chain of records are included in OCS 8.0.001. See
Table 38 on page 362 for a description of the set_f lex_attr and
set_exec_flag custom actions.

Using Custom Actions

Both set_flex_attr and set_exec_flag custom actions can be used together,
which allows you to set options for the records or chain and then, continue
with the regular processing of the chain (without the chain being processing by
the SCXML Treatment after the initial option setting). This is not mandatory
however. Custom actions can also be used separately. For example, options can
be set for the records or chain and then the chain can be processed by SCXML
Treatment logic. Alternatively, at some point, the SCXML Treatment
execution can be completed by using script logic and the control over the chain
can be passed to traditional treatments.

For the complete SCXML treatment that demonstrates the usage of both of
these custom actions, see the sampled6.scxml sample script, which is found in
the OCS installation folder, in the scxml_samples sub folder.
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Other Usages of SCXML Treatments

One important feature of SCXML treatments is the ability to define variables
that are used later in the script to specify different actions. You define these
values in the script. You can also specify their values. Whether or not you
decide to specify the variable values, you can also specify the values in the
treatment-uri option (see page 256) to enable you to reuse the same treatment
for different Calling Lists/Campaigns and their individual needs.

You can design the treatment script with variables for data such as the
following:

»  First contact type—Enables you to specify the contact type that OCS first
attempts when contacting a customer. One example of a variable definition
might be start_contact_type.

*  Number of dial attempts—Enables you to specify the number of dial
attempts made for a customer or contact type

* Call result—Enables you to specify an action in response to different call
results.

Note: “Script Example” on page 373 provides an example of a script that
includes the number of attempts and the call results.

You can also see sample02.scxml, sample@4.scxml and
samp Le05. scxml, which are sample treatment scripts that install with
OCS.

Configuration Tasks

380

Procedure:
Configuring Statistical Days and Statistical Tables for
Time Ranges

Purpose: To configure Statistical Days and Statistical Tables in Genesys
Administrator.

Start of procedure

1. InGenesys Administrator »Provisioningtab > Routing, in the Statistical
Tables view, create an OCS folder (for example, 0CServer).

2. Create a Statistical table with the Special Day type for weekdays.
a. Create Statistical Days for each weekday.
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b. For each day, configure the start and end time for the workday.

Note: A workdays list might not be limited to Monday through Friday if
you configure Saturday and/or Sunday as workdays.

3. Create a Statistical table with the Special Day type for holidays.

a. Create a Statistical Day for each holiday.
b. For each holiday, configure its start and end time.

Notes: When a Dialing Session for a Campaign Group is loaded, OCS

searches for the current date in the holiday table.

+ If the timerange for this date is not found, OCS looks in the
weekdays table.

+ If the time range for this date is still not found, OCS considers it a
weekend if one or both of the holiday and weekday tables are
configured.

* If neither table is configured and a time range for this date is not
found, OCS considers the time range as a holiday (HDAY).

For more information about configuring Statistical tables and days,
see Framework 8.0 Genesys Administrator Help.

End of procedure

Configuring SCXML Treatment Options

Configure the following options at either the Campaign Group or Calling List
level.

treatment-weekdays-table (see page 256)—Defines the name of the
Statistical Table configuration object for the business weekdays, as created
in Procedure: Configuring Statistical Days and Statistical Tables for Time
Ranges.

treatment-holidays-table (see page 255)—Defines the name of the
Statistical Table configuration object for holidays, as created in Procedure:
Configuring Statistical Days and Statistical Tables for Time Ranges.

treatment-uri (see pages 256 and 262)—Specifies the URI that defines the
resource location of the SCXML script on the Application Server. It can
include call parameters/values that you want applied to the treatment
script, allowing you to use the same treatment for different Calling Lists
but specify unique parameters/values for each Calling List.
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* treatment-preferred-contact-field (see pages 225 and 262)—Specifies
the field name in the Calling List table which OCS uses for the given
record to determine if this record in a chain should be used for the first
chain dial attempt.

Note: This value of this option identifies the contact type of the next
record for which to search in a chain when the ocs.next_record
event includes the gsw__preferred_flag equal to yes (see
page 369).

Procedure:
Deploying a Treatment Script to an Application Server

(1IS)

Purpose: To deploy the treatments to an Application Server.

Start of procedure

1. Navigate to the C:\Inetpub\wwwroot folder.

2. Copy the treatment script files with the .xml or .scxml extensions to that
folder.

End of procedure

Version Checking

If the script is updated while is it currently being used by a campaign that is
running, OCS applies the new treatment to all chains processed after the

update.

Error Handling

Error handling is addressed using the Error.Attribute and
Error.Configuration events, as described in the “Events from OCS” on

page 368.
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1 4 Deploying Do Not Call
Functionality

This chapter discusses the deployment of Do Not Call functionality. It covers
these topics:

«  User-Defined Field for Do Not Call, page 383

« Do Not Call Table Structure, page 385

+ Updating the DNC List, page 386

«  OCS-Desktop Protocol Changes for DNC, page 386

User-Defined Field for Do Not Call

The restriction on dialing a particular customer is an alternative to the Do Not
Call restriction applied to a particular telephone number. The ability to apply a
a Do Not Call request to a specific customer is helpful when the same phone
number appears on more than one customer's records. For example, in a family
or roommate situation, one member of the household might want to be on the
Do Not Call list while another person at the same residence and with the same
telephone number might not make that request.

The value of the customer_id option in the OCS Application object is the
name of the field that the user designates for the customer identifier. At
start-up, OCS reads all the records from the table referenced in the
gsw_donotcall_Llist Table Access and populates two separate tables in
memory with unique values from the phone field and from the customer_id
field. Do Not Call requests from the agent desktop can also populate these
tables in memory during runtime.
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User-Defined Field for Do Not Call

Configuration Procedure

384

Perform this procedure in Genesys Administrator to create a user-defined field
to identify customers for a Do Not Call List. This new field will serve as the
customer_id for Do Not Call requests and will be included in the UserData
attached to T-Server events. As the value of the customer_id option in the OCS
Application object, this field will correspond to the customer_id field in the Do
Not Call (gsw_donotcall_List) table.

Procedure:
Creating a User-Defined Field to Identify Customers
for the Do Not Call List

Start of procedure

1.

Create a new user-defined field. On the Configuration tab, define the fields
as follows:

* Name = <user-specific name)

* Data Type = varchar

* Length = 64

* Field Type = User-Defined

Also select the options Nullable and State Enabled.

Assign the send_attribute to on the Options tab by adding a default
section.

Define the fields as follows:

* Option Name = send_attribute

*  Option Value = GSW_CUSTOMER_ID

Designate the new user-defined field as the customer_id option in the 0CS
Application object.

In Genesys Administrator > Environment » Applications > Outbound
Contact folder> 0CS object > Options tab > 0CServer section, create and
define the customer_id option. Use the name of the new user-defined field
as the value of customer_id.

* Option Name = customer_id
* Option Value = <{name of new user-defined field>
Add the new field (defined in #1) to a new Format object.

In Genesys Administrator, go to <Tenant) > Provisioning tab » Outbound
Contact > Formats view, and create a new format for a Calling List table
that includes the new user-defined field.
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5. Configure a Table Access object for the gsw_donotcall_List.

In Genesys Administrator, go to <Tenant> > Provisioning tab > Outbound
Contact > Table Access view, and create and configure a new Table Access
object as follows:

In the Configuration tab, specify the following:

e Name = gsw_donotcall_Llist (required field value.)

* Table Type = Log Table

* DB Access Point = {user-specific name of DB Access Point)
The DB Access Point here is for gsw_donotcall_List.

* Format = None

o Database Table = <user-specific name of database table>
6. CreateaCalling List object using the new format. In Genesys

Administrator, go to <Tenant> > Provisioning tab > Outbound Contact >

Calling Lists view, and configure a Calling List object as follows:

In the Configuration tab, specify the following:

* Table Access: <New Calling List>

This is a new Calling List formatted with the customer_id field.

These configurations allow the customer ID to be inserted into Do Not Call

requests, into the database table specified in the gsw_donotcall_List Table
Access, and into the memory tables.

End of procedure

Do Not Call Table Structure

The Do Not Call table has a fixed structure, as shown in Table 40. The
customer_id field, like the phone field, is part of that established structure. The
Do Not Call table does not require Format and Field configurations. Genesys
Administrator generates this table if the Table Access object is present, but the
physical table does not yet exist.

Note: If you manually add entries to the Do Not Call table, you must restart
Outbound Contact Server (OCS) so that OCS can read the new
records into its memory.

Table 40: Do Not Call Table Structure

Field Name Type Nullable
phone varchar (64) yes
customer_id varchar (64) yes
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Table 40: Do Not Call Table Structure (Continued)

Field Name Type Nullable
dnc_message varchar (255) yes
tenant_dbid decimal (18, 0) yes
campaign_dbid decimal (18, 0) yes
list_dbid decimal (18, 0) yes
is_internal int yes
time stamp int yes

Note: The phone field in 6.5 was changed to the contact_info field in the 7.0
Calling List table. The phone field is still in the Do Not Call List table.

Updating

the DNC List

Through Genesys Administrator, you can update a current DNC list with data
from an external source. Genesys Administrator first reads data from an ASCII
file, which is in comma-delimited format. The user then maps this data to the
appropriate columns in the DNC list (database table).

The process to update or import data from an external source is composed of
three steps:

1. Selecting the data file and type.
2. Assigning names to data columns.
3. Specifying data import options.

For detailed instructions, see Framework 8.0 Genesys Administrator Help
(Provisioning Your Environment > Outbound Contact Object Types > Do Not
Call List > Importing a Do Not Call List File).

OCS-Desktop Protocol Changes for DNC

386

A Do Not Call (DNC) request from an agent (6SW_AGENT_REQ_TYPE = DoNotCall)
includes an attribute to specify the customer_id: GSW_CUSTOMER_ID. At least
one attribute (6SW_PHONE or GSW_CUSTOMER_ID) must be present in the UserData
of the request if the 6SW_RECORD_HANDLE is not specified.
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Configuring Dialogic
Boards

This chapter contains information on how to configure dialogic boards with
Outbound Contact. It contains these sections:

+ Introduction to Dialogic Boards, page 387

- Dialogic Board Setup, page 388

«  Configuring Dialogic Boards, page 391

+ Dialogic Board Configuration Structure, page 394
«  HMP Software, page 406

« Dialogic Utilities, page 410

Introduction to Dialogic Boards

Deployment Guide

If you intend to install CPD Server, you must first set up the Dialogic boards.
You need to install a hardware card and a software driver to implement
Dialogic. Contact the Dialogic vendor for your company or visit the Dialogic
support website for more information about Dialogic boards and supported
software. Information about Genesys supported hardware and third-party
software is available on the Genesys Technical Support website in the
documents:

*  Genesys Supported Operating Environment Reference Manual
*  Genesys Supported Media Interfaces Reference Manual

The following lists specific information when CPD Server is use with Dialogic
DM3 hardware:

* Allrecordings are in a PCM/8000Hz/8bps (VOX) format. The .wav format
is no longer supported.

* DM3 boards do not work with a NEC switch containing a line-side
configuration and the tscall option value is set to true or on.
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DM3 boards are supported in line-side environments.

Note: Starting with release 7.5, you can also use Dialogic’s Host Media

Processing (HMP) software instead of a physical hardware card. See
“HMP Software” on page 406 for more information.

Dialogic Board Setup

388

Procedure:
Setting Up Dialogic boards

Start of procedure

1. Make sure a supported version of Microsoft Windows operating system is
installed.

2. Install Dialogic SR 6.

3. Select the required drivers, firmware, and configuration files from the
custom package.

4. Configure the Dialogic boards. See “Configuring Dialogic Boards” on
page 391 for more information.

5. Start Dialogic Configuration Manager (DCM). DCM should automatically
detect the board and find valid address/port/interrupt values for the
particular computer.

6. Start the Dialogic drivers.

7. Use the Dialogic application provided with the Dialogic board to test each
port for off-hook ability, to dial a test telephone number, and then to place
the port on-hook.

8. Make sure that each port can complete this test before installing and

configuring CPD Server.
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Notes: * When installing Dialogic boards, make sure that the board number
set by the switch on the board is unique inside each board type. If
you have two T1 boards, the first one must be 0, the next 1, and so
on. Make sure the SCBus/CTBus cable connects the boards, if
needed.

+ If there are error messages when starting the Dialogic drivers, the
error messages display in the Windows Event Viewer. If there are
errors, restart Dialogic Configuration Manager or reinstall the
Dialogic boards. If these steps do not solve the problem, contact
Dialogic support.

End of procedure

Active Switching Matrix Mode Call Flow

Deployment Guide

Active Switching Matrix (ASM) mode is a dialer mode that eliminates various
problems of switches that do not support call progress detection or that
produces unacceptable transfer delays or force-tone problems.

You can configure ASM mode either in Genesys Administrator or in the
Outbound Contact Wizard. The switch determines the correct dialing mode
based on the presence or absence of a Dialogic board. CPD Server checks the
ASM configuration (for ISDN or Melcas) set up in Genesys Administrator to
determine what the dialing mode is.

The key feature of the ASM-mode call flow is the Engage call, which OCS
requests from the Dialogic board. This call engages the agent in a real,
established call before the dialed party actually responds and is connected to
the call. The sequence of events in this call flow is as follows:

1. The agent sets the phone set to Ready.

2. The switch notifies T-Server that this agent is ready, and T-Server informs
OCS by distributing an EventAgentReady message.

3. Assoon as OCS learns that one or more agents are available at a given
queue, it sends an EngageAgent request to CPD Server.

4. CPD Server instructs the Dialogic board to send a special Engage call to the
available agent’s queue. This is a real call, but is created only on an
internal segment—from a Dialogic port to the ACD Queue.

Note: The switch considers this an inbound call because the call is
coming to an internal DN from a point outside the switch.

5. The Engage call is queued, which generates an EventCal lQueued message.
T-Server distributes this event to OCS, but OCS recognizes it as a special
type of call and knows to ignore the event.
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6. Since this queue has an available agent, the ACD diverts the Engage call to
the agent’s desktop. This generates an EventDiverted message, but OCS
also ignores it, knowing that it refers to an Engage call.

7. The agent answers the Engage call, generating an EventEstablished
message. At this point the agent is on a real call and hears a tone from the
switch indicating that he or she is in an engaged state. The agent
encounters a delay of some seconds while OCS and CPD Server generate
the second segment of the call to a dialed number from the calling list.

8. InProgressive dialing mode, OCS waits until it knows the agent is Engaged
before asking CPD Server to make an outbound call. In Predictive dialing
mode, OCS is making outbound calls according to its predictive algorithm
without regard to availability of agents.

9. CPD Server informs the Dialogic board to make a call to the customer
number supplied by OCS.

Note: This call is dialed outside the switch, so that neither the switch nor
T-Server sees it. Therefore, no T-Server events are associated with
this call.

10. If the call reaches a live customer, CPD Server attaches the account
information or other data to the Engage call.

Note: The first agents engaged are the first to be distributed.

11. T-Server delivers this data to the Engaged agent’s desktop as a screen pop.
Simultaneously, CPD Server connects the internal and external segments
of the call, and the call is established between the agent and the customer.
T-Server considers the call type for the call to be Inbound, whereas OCS
sees the call type as Outbound because it was generated by CPD Server.

12. CPD Server informs OCS of the call result.

From this point, the call is handled according to the campaign requirements
similar to transfer-mode.

Port Requirements for ASM Mode

CPD Server uses two ports in ASM-mode to connect the agent to the customer.
CPD Server releases both ports at the end of the call.

When CPD Server is not in ASM-mode, it uses only one port to make a call and
to transfer it to an agent. CPD Server releases the port when the call is
transferred.

OCS reports the number of ports available. If for some reason, OCS does not
track the number of ports available, CPD Server sends a No Free Port message
to OCS.
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Configuring Dialogic Boards

Configuring Dialogic Boards

Outbound Contact Configuration Wizard puts the information about installed
Dialogic boards and resources in CME. You can use Genesys Administrator to
change the configurations, as needed. See “Dialogic Board Configuration
Structure” on page 394.

Frequently Used Configurations

Table 41 lists frequently used configurations for Dialogic boards. The driver
names are provided for a single board configuration. For multiple boards, the
corresponding board numbers must be sequentially numbered.

Table 41: Dialogic Board Configurations

Board Type Configuration
D/160JCT-LS Virtual Board 4 LSI (dxxxBl1...dxxxB4)
Virtual Device 4 channels on each board (dxxxBxCl1...dxxxBxC4)
Voice Virtual Board 4 voice (dxxxB1...dxxxB4)
Voice Virtual Device | 4 channels on each board (dxxxBxCl...dxxxBxC4)
D/41JCT Virtual Board 4 LSI (dxxxB1...dxxxB4)

Virtual Device

4 channels on each board (dxxxBxCl1...dxxxBxC4)

Voice Virtual Board

4 voice (dxxxB1...dxxxB4)

Voice Virtual Device

4 channels on each board (dxxxBxCl1...dxxxBxC4)

D/480SC-2T1

Virtual Board

2 DTI boards (dtiB1, dtiB2)

Virtual Device

24 channels (23 if) on each board (dtiBxT1...dtiBxT24)

Voice Virtual Board

12 voice boards (dxxxB1...dxxxB12)

Voice Virtual Device

4 channels on each board (dxxxBxCl1...dxxxBxC4)

D/300JCT-2E1 | Virtual Board 2 DTI boards (dtiB1, dtiB2)

Virtual Device 30 channels on each (dtiBxT1...dtiBxT30)

Voice Virtual Board 8 voice boards (dxxxB1...dxxxB§)

Voice Virtual Device 4 channels on boards 1 to 7, 2 channels on board 8
DM/V300 DM3 board with CPD | 30 channels

functionality

Deployment Guide
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Table 41: Dialogic Board Configurations (Continued)

Configuring Dialogic Boards

Board Type Configuration
DM/V600-2E1 | DM3 board with CPD | 60 channels
functionality
DM/V600BTEP | DM3 board with CPD | 60 channels
EQ functionality
DM/V600BTEP | DM3 board with CPD | 60 channels
Y functionality
DM/V960-4T1 | DM3 board with CPD | 96 channels
functionality
DM/V1200-4E1 | DM3 board with CPD | 120 channels
functionality
DM/V1200BTE | DM3 board with CPD | 120 channels
PEQ functionality
DM/V1200TEP | DM3 board with CPD | 120 channels
Y functionality
Suggested DM/V Dialogic Board Configuration
When configuring a DM/V-type board, configure the Dialogic channels similar
to the way in which you configure any CPD Server that is operating in
Transfer mode and that interfaces with a lineside T1/E1. The following two
sections provide more information about configuring specific models of this
board type.
Note: The Line-type option must contain a value of Line-side-dm3. See
page 273 for more information about this option.
Procedure:
Configuring the DMV480A-2T1 Board
Start of procedure
If you are using a DMV480A-2T1 board, do the following:
1. Create a new file called pdk.cfg that contains the following statement:
Board 0 fcdfile ml2_dsa_cas.fcd pcdfile ml2_dsa_cas.pcd variant
pdk_sw_el_ntmd_io.cdp
2. Move this file to C:\Program Files\Dialogic\cfg.
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Open a command prompt and type in the following path:
C:\Program Files\Dialogic\bin

Execute the following command:

PDKManagerRegSetup add

You should receive the following message:

PDKManager key insertion succeeded.

Open Dialogic Configuration Manager and right-click your Dialogic board
type.

Select Configure device.

On the Misc tab, select:

* ml2_dsa_cas.fcd as the FCD file.

* ml2_dsa_cas.pcd as the PCD file.

Restart the Dialogic System Service.

Start CPD Server.

Note: If you are using a DMV960A-4T1 board, replace ml2_dsa_cas with
ml2_gsa_cas.

End of procedure

Procedure:
Configuring DMV480-4T1 Board

Start of procedure

If you are using a DMV480-4T1 board, do the following:

1.

Create a new file called pdk. cfg that contains the following statement:

Board 0 fcdfile ml1_4x2_cas.fcd pcdfile ml1_4x2_cas.pcd variant
pdk_sw_el_ntmd_io.cdp

Move this file to C:\Program Files\Dialogic\cfg

Open a command prompt and type in the following path:
C:\Program Files\Dialogic\bin

Execute the following command:

PDKManagerRegSetup add

You should receive the following message:

PDKManager key insertion succeeded.

Open Dialogic Configuration Manager and right-click your Dialogic board
type.
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6. Select Configure device.

7. On the Misc tab, select:
* ml1_4x2_cas.fcd as the FCD file.
* ml1_4x2_cas.pcd as the PCD file.

8. Restart the Dialogic System Service.
9. Start CPD Server.

End of procedure

Dialogic Board Configuration Structure

394

In Outbound Contact, the configuration process for Dialogic boards has been
simplified.

The structure of Dialogic board configuration is represented by a folder tree
under the Switch/DN view in Genesys Administrator. The folder tree consists
of the following folders:

<location>—This folder is taken from the location option (default section)
and serves as the board root folder. When a board is deleted, Wizard deletes
this folder and everything under it. The current Wizard implementation does
not allow deletion of only part of a board; the whole board is deleted.

regular—This folder contains channel-DN configuration for dialing outbound
calls.

recording — optional — folder contains channel-DN configuration for CPD
recording on the regular DNs. Recording is used to tune up Voice/AM
detection and should not be used in regular work since it takes half of the voice
resources. This folder is created but not configured by the Wizard.

engaging—This folder (optional) contains channel-DN configuration assigned
to engage agents when working in ASM mode.

dxxxB<n>—This root folder for an analog virtual (logical) board. It contains
voice resources (channels). It may have one or more voice resources.

dxxxB<n>C<m>—Voice resource (channel). In the configuration it links a
dialogic voice resource and a DN on the switch.

dtiB<n>—The root channel for a network (T1) virtual board. It contains one
or more digital resources.

dtiB<n>T<m>—Digital (network) resource. In the configuration it links a
Dialogic digital (network) resource and a DN on the switch.

Note: Non-analog line type folders representing dxxx channels do not have
to include real DNs. CPD Server works without DNs in dxxx folders
and performs call progress detection on non-analog lines. Thus,
multiple licenses are not required to allow for two DNs per channel
and a subsequent increase in dialing ports.
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Configuration Logical Structure

A logical structure describes a single configuration of many boards. Every
logical board in a configuration is given a unique logical board number based
on the order in which the boards are configured. See Figure 17.

Dialogic ;
CPU Board Logical Board
1 1.* 1 1.7
1 1.7
1
1 1
CPD Server Location Folder
1.*%

Figure 17: Logical Structure

Genesys recommends a 1-to-1 relationship between the CPU, CPD Server, and
the Location folder.

Note: The number 1 in the preceding diagram shows a 1-to-1 representation,

and 1...* shows a 1-to-more-than-1 representation.

The following describes what each item in Figure 17 represents:

Deployment Guide

Box—Represents a CPU (central processing unit of a computer running on
a Windows operating system), where the Dialogic boards and CPD Servers
are installed.

Dialogic Board—Represents a hardware board installed into the CPU. The
CPU may have more than one board installed.

Logical Board—A logical part of the hardware board representing four
analog or digital resources (for example, dxxxB1 and all the hierarchy
belonging to it). One hardware board consists of several logical boards.
One logical board belongs to only one hardware board.

CPD Server—Represents a piece of software installed on the box. It can be
one or more different CPD Server installations.

Location Folder—Represents a set of logical boards, and one CPD Server.
A Location Folder is allowed to have logical boards connected to different
hardware boards (see example below). Genesys recommends that you set
up a 1-to-1 association between CPD Server applications and the Locations
folder.
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Considerations

* The Location folder may have logical boards belonging to hardware boards
installed in one, and only one, computer running on the Windows
operating system.

* Ifyou have two or more different Location folders, they must not have the
same logical board configured.

* If you have more than one hardware board installed in the same computer,
then the first board (minimal hardware ID) has 1...n logical boards
numbering (dxxxB1...dxxxBn), the second board (next ID) has n+1...m
(m > n+1) logical boards numbering (dxxxB<n+1>...dxxxBm), and so on.
If a logical board is removed from a configuration, then all other logical
boards in the configuration must be renumbered to preserve a logical
numbering system.

CPD Server Dialogic Hardware Setup in Genesys
Administrator
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Genesys Administrator simplifies the configuration of the Dialogic hardware
in the Configuration Database. When you configure the Dialogic hardware by
going to Provisioning > Outbound Contact > Dialogic Boards, Genesys
Administrator creates all of the folders and subfolders, based on the selected
Dialogic Board and line type. For more information, see Framework 8.0
Genesys Administrator Help.

You can also manually configure provides the Dialogic hardware, per the
guidelines the follow.

Procedure:
Manually Setting Up Your Dialogic Hardware

Start of procedure

1. In either Genesys Administrator or Configuration Manager, create the
Location folder in the Switch DN folder.

2. Create three subfolders that will contain board resource subfolders with the

names:
* engaging (should contain only DM3 (Melcas) resources of Dialogic
board)

* recording (should contain only voice resources)
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* regular (can contain any type of Dialogic resources)

Note: These board resource subfolder names should be the same as the
virtual board names used for the Dialogic hardware that is
installed.

3. In each of these three subfolders, create another group of board resource
subfolders named exactly as the individual channels of the corresponding
virtual board.

4. In each channel subfolder, include the real DN (Extension) or virtual DN
(Call Processing Port) that corresponds to the DN assigned to the board
channel.

* For voice-processing ports and ISDN or Melcas virtual channels, you
must assign unique numbers to the Call-Processing port DN type.

* For LSI and T1/E1 ports, you should assign the Extension DN type and
real channel numbers that are recognizable by the switch.

Note: The ACD Position DN type is not a valid value for CPD Server
DNes.

5. The Register check box should be cleared (unchecked) for CPP and
selected (checked) for ACD Extension DNs.

End of procedure

Dialogic Board Configuration

The following includes configuration information you can use to configure
ASM (ISDN and Melcas), Analog, or T1/E1 line-side protocols.

Note: Figure 18 through Figure 23 reflect the configuration as it would
appear in Configuration Manager.

ASM Mode

An ASM configuration must have at least one digital board and one voice
board in the regular folder. Figure 18 shows the directory structure for an
ISDN or Melcas board.
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In the ISDN and Melcas configurations, network resources are associated with

DNs of Call Processing Port type. Figure 19 shows a call processing port DN
in an ASM configuration.

398 Outbound Contact 8.0 @



Chapter 15: Configuring Dialogic Boards

Configuration Manager - default default; Server Eahiti v. 7.0.000.10 on porE 6516

File Edit

Wiew Tools Help

Dialogic Board Configuration Structure

=10j x|

“‘{'_1 dHiE1T1

o %@ X E(E-

e

Wil Folders

Contents of "ConfigurationDemoESwitches DMEDNCED_DMS)T

1 ohjeck(=)

=28 DMs
] Agent Logins
E|~:J D=
=1 CPO_DMS
=] recording
LB diooBEs

{20 dwxxB25CH
) dioxBEEC2
0] dxxxB25C3
5 2 dionBESC4
= [ reqular

= dtie

o 4Ty dEBLTI

] dHiBLT2

) dbiB T
P LT diBiT4
-] driE2
E|<_} dixxB2E

----- [ dwxxB2acd

{20 dxxxB2RC2

L) dxxxB2eC3
LT dioonBREC4
<;] dwxxBET
<;] duxxB25
<_~] dixxB29
H- dwexB30
-] dexxBId
<;] duxxB3Z
<_~] dixxB33
H-) dicxBS4

Murmber

=

Tvpe

Switch

&

Enter bext here |5

Enter texk hers

i

Enter tex, ..

i E

(Canza4sase?

Zall Processing Port

DM3

=

=

Figure 19: ASM Call Processing Port DN

Analog

An Analog board configuration must have the following folders and subfolders
in this type of directory structure:

* A regular folder
+ At least one dxxxB<n> folder within the regular folder
+ At least one dxxxB<n>C<n> subfolder within the dxxxB<n> folder.

Figure 20 shows the directory structure for an Analog configuration.
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Figure 21 shows an Extension DN in an Analog configuration.
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Figure 21: Extension DN in Analog Configuration

For more information, see “CPD Server Dialogic Hardware Setup in Genesys
Administrator” on page 396).

T1/E1 Line-Side

A T1/E1 line-side configuration must have at least one digital and one voice
logical board configured in the regular folder. See Figure 22.
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Figure 22: T1/E1 Line-Side Directory Structure
In the line-side configuration, each network resource must have one, and only

one, DN associated with it. Network resources are associated with DN of type
Extension. See Figure 23.
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Figure 23: Extension DN in T1/E1 (Line Side) Configuration

Dialogic Board Configuration Examples

The following figures show sample configurations for ISDN or Melcas (in
ASM), Analog, or T1/E1 protocols.

ASM Mode (ISDN or Melcas)

An ASM configuration must have at least one digital board and one voice
board in the regular folder.

In the an ASM configuration, network resources are associated with DNs of
Call Processing Port type.
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Figure 24 shows a configuration example for an ISDN or Melcas protocol.

*

<switch> : Switch — <regular> : folder dxxxB<n> : folder . dxxxB<n>C<m> : folder
dtiB<n> : folder * | dtiB<n>T<m> : folder 1 DN : Call Processing Port
DNs : folder
<location> : folder recording : folder dxxxB<j> : folder « | dxxxB<j>C<m> : folder
t engaging : folder dtiB<k> : folder dtiB<k>T<m> : folder 1 |BN_: Call Processing Port

Figure 24: Board Configuration Example for ISDN or Melcas Protocol

Analog Board Configuration

Figure 25 shows a configuration example for an Analog board.

<switch> : Switch — <regular> : folder * 1 dxxxB<n> : folder . | dxxxB<n>C<m> : folder DN Extension | n
1
DNs : folder
<location> : folder recording : folder dxxxBsj> : folder » | dxxxB<j>C<m> : folder 1 DN Extension | n

Figure 25: Configuration Example for an Analog Board

Note: In the 7.x release, the only DN type for an Analog board or a
T1/E1 board is Extension, not Position.

T1/E1 Line-Side Configuration

A line-side configuration must have at least one digital and one voice logical
board configured in the regular folder.

In the line-side configuration, network resources are associated with DNs of
Extension type.

Figure 26 shows the configuration example for a T1/E1 Board.
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<switch> : Switch <regular> : folder * | dxxxB<n> : folder . | dxxxB<n>C<m> : folder
dtiB<n> : folder | dtiB<n>T<m> : folder 1 DN Extension | n
DNs : folder
<location> : folder recording : folder dxxxB<j> : folder » | dxxxB<j>C<m> : folder

Figure 26: Configuration Example for a T1/E1 Board

Note: Each network resource may have one, and only one, DN associated
with it.

DNs Inside Dialogic Channels Folders

For more information about the Dialogic boards and their channels, see the
following documents available on the Genesys Technical Support website:

*  Genesys Supported Operating Environment Reference Manual

*  Genesys Supported Media Interfaces Reference Manual

New Dialogic Board Configuration

Deployment Guide

Genesys Administrator simplifies the configuration of the Dialogic hardware
in the Configuration Database. When you configure the Dialogic hardware by
going to Provisioning > Outbound Contact > Dialogic Boards, Genesys
Administrator creates all of the folders and subfolders, based on the selected
Dialogic Board and line type. For more information, see Framework 8.0
Genesys Administrator Help.

You can also configure a new Dialogic board manually, by following the
procedure provided here.

Procedure:
Manually Configuring a New Dialogic Board

Start of procedure

1. In Genesys Administrator, create a <lLocation> folder under the Switch
object.

2. Under the <location) folder, create a folder named recording.
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Again in the <location) folder, create a folder named engaging.

Create a folder named regular. For a description of this folder, see “CPD
Server Dialogic Hardware Setup in Genesys Administrator” on page 396.

Configure the regular folder.

Note: A DN can belong to only one channel across the switch.

End of procedure

HMP Software

CPD Server 7.6 and higher supports Dialogic HMP software in both
transfer-mode and ASM-mode scenarios. HMP is enabled by the Line-type
option (page 273). The following are the differences between standard and
HMP deployment:

406

HMP is simply another connection protocol used in CPD Server.

An HMP board is represented in Genesys Administrator as an iptB1 folder
under the regular folder. There are no required changes for the names or
locations of the voice resources.

An HMP channel is represented as iptB1TX where X is a channel number.
The DN type is Call Processing Port. The maximum number of channels
is 256.

HMP transfer-mode requires the following amounts of resources:

+ The same amount of RTP/IPCC resources as standard transfer-mode
if OCS requests one-step transfer (that is, the OCS cal l_transfer_type
option is set to one_step (see page 232)).

+ The same amount of voice resources as the standard transfer-mode.

HMP ASM-mode requires the same amount of resources as regular
ASM-mode.

Unlike standard Transfer mode, the UserData in HMP Transfer mode is
attached when the call enters the agent ACD Queue or Routing Point. This
enables CPD Server to run in “hybrid” mode when a standard T-Server
target is used with a media gateway.

SIP Server is supported without needing to use a media gateway. However,
only the SIP protocol without registration is supported.

Each CPD port will still use one Genesys license. However, three types of
Dialogic HMP licenses are required for each successful outbound call:

+  One license for Voice (dxxx)

+ Two licenses for RTP_G 711

+ Two licenses for [P_Call_Control (ipt)
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Contact your Dialogic representative for more information about HMP
licensing.

Note: -« It is recommended that you complete the media processing channel
configuration in the Outbound Contact 7.5 Configuration Wizard or
Genesys Administrator.

* Only one instance of CPD Server using HMP software can be
executed on a host computer.

To enable CPD Server to work with HMP software, you must complete the
following configuration.

Procedure:
Configuring CPD Server for HMP Software

Start of procedure
In the CPD Server application in Genesys Administrator, configure the
following two options:

1. Setthe Line-type option to sip-hmp for Transfer mode, or sip-hmp-asm for
ASM mode. See page 273 for more information about this option.

2. Set the sip-proxy option in the hmp section. This option contains the IP
address of the SIP Server that HMP will use for dialing. See page 279 for
more information about this option.

End of procedure

Procedure:
Configuring the SIP Switch for HMP Software

The configuration of a Dialogic folder in Genesys Administrator is still
required when running HMP software. The subdirectories are still named
regular, engaging, and recording.

Note: The engaging folder is for ASM mode only.

Genesys Administrator simplifies the configuration of the Dialogic hardware
in the Configuration Database. When you configure the Dialogic hardware by
going to Provisioning > Outbound Contact > Dialogic Boards, Genesys
Administrator creates all of the folders and subfolders, based on the selected
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Dialogic Board and line type. For more information, see Framework 8.0
Genesys Administrator Help.

You can also manually configure the Dialogic hardware, per the procedure
below.

Start of procedure

Configure the subfolders under the main regular, engaging and recording
folders either manually or using the Configuration Wizard.

1. Configure the HMP board as an iptB1 folder under either the regular or
the engaging folder. No changes for the names or locations of the voice
resources (dxxx) are required.

2. Configure the HMP channels as iptB1TX where X is a channel number. The
DN type must be set to Call Processing Port. The maximum number of
channels is 256. Genesys does not recommend using more than 128
channels per server. See Figure 27 as an example of the configuration in
Configuration Manager.

Configuration Manager - default default {default), Server east.ca.int.genesyslabic

File Edit Wiew Tools Help
JI_}iptBlTl | j| AR SEREIP. =R EE

5] -

7|

Wl Folders Contents of YConfigurationf/OutBoundiSwitchesSIRP- A5 MDMN SRy
= B8 sIP-ASM o || Mumber =~ Type Switch
=) Agent Logins Erter text here 5P| Enter text here  [SF] Enter text here |57
El I DNs (3001 Call Processing Port  SIP-ASM
= 3 SIP
[ engaging
T recarding
= I regular

o dxxxBl

Ty dwxxB2

o dxxxB3

I dixxBd

= 05 iptEl
! iptB1T1
) iptE1TZ
) IptB1TS
) iptE1T4
) iptB1TS
) IptB1TE
) iptE1TY
) iptE1TE -

|1 ohjeck(s)

Figure 27: Configuring HMP Channels
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3.

Configure the ipt DNs as type Call Processing Ports. The Options tab of
these ports must contain a TServer section with the following entries:

+ contact, with a value of <DNeIP Address). This specifies the host
running the HMP software.

+ refer-enabled, with a value of false.

Refer to the Framework 8.0 SIP Server Deployment Guide for more
information about these options.

Notes: * HMP transfer mode requires two times as many RTP/IPCC

resources as hardware transfer mode, but the same number of voice
resources as hardware transfer mode. HMP ASM mode requires the
same number of resources as hardware ASM mode.

* Unlike hardware transfer mode, the UserData in HMP transfer
mode is attached when the call enters the agent queue or route
point. This allows CPD Server to run in environments where a
conventional T-Server (not SIP Server) with a media gateway is
used.

End of procedure

Procedure:
Configuring Host Media Processing (HMP) Software

Start of procedure

Perform the following configuration instructions to use HMP software:

1.

The fcd and pcd file names are the license file name with an fcd or pcd
extension. They are stored in the .. .\HMP\data directory on the host where
HMP is installed. There are 4 license files with the following extensions:

* Llic, which is the actual license file provided by Dialogic.

e pcd, which is the pcd file that will be used by HMP, as generated from
the . Lic file.

* fcd, which is the fcd file that will be used by HMP, as generated from
the . lic file.

* config, which is the configuration file that will be used by HMP.
Generate these files by performing the following steps:

a. RuntheDialogic NetStructure Host Media Processing (HMP)
License Manager from the Windows Start menu.

b. Browse to the desired license file.

Click the Activate License file to generate the fcd, pcd and config
files.

409



Chapter 15: Configuring Dialogic Boards Dialogic Utilities

3. Configure the HMP software to use the newly generated files by
performing the following steps:

a. StartDialogic Configuration Manager (DCM).

b. Stop the HMP software (if not already stopped).

¢. Right-click the HMP entry in DCM and select Restore Device Defaults.
d

Select the pcd file in the Assign Firmware File window that is
associated with the license file created by Dialogic’s License Manager.

4. Start the system.

Note: Only the SIP protocol without registration (registrar) is currently
supported.

End of procedure

Dialogic Utilities

The following utilities can help you to resolve problems that might occur when
you are using Dialogic boards.

ISDIAG Dialogic Utility

The ISDIAG Dialogic Utility is part of the Dialogic software package. Use this
utility to test lines, for example, when working with different protocols. You
can also set call parameters using this utility.

The utility is a console application. To run the utility, follow the Help menu
using the command prompts. If the system is not working, use this utility to
make a call, if you can; then, if the system is still not working, check your
hardware settings. If you cannot make a call using the utility, contact Genesys
Technical Support.

Also, try comparing the Trace log against the Dialogic board Component log
to check for possible problems.

PRI-Trace Utility
The PRI-Trace utility is part of the Dialogic software package. Use it to see all

the parameters sent through the D-channel. The parameters display in binary
log files; the PRI-Trace utility turns the logs into readable text.

Dialogic Configuration Manager

Dialogic Configuration Manager (DCM) is part of the Dialogic software
package.
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Make sure that you use this utility when you are configuring Dialogic boards
for your system. To access this utility from the Start menu, select

Programs » Dialogic System Software > Dialogic Configuration Manager-
DCM.
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Starting and Stopping
Procedures

This chapter explains how to start and stop Outbound Contact 8.0 with the
Solution Control Interface (SCI), and how to start and stop Outbound Contact
Server and CPD Server manually. It contains these sections:

«  Prestart Information, page 413

+  Using Solution Control Interface, page 414
« Starting Manually, page 416

«  Stopping Manually, page 421

«  Connection and Reconnection, page 424

Prestart Information

Deployment Guide

Before starting Outbound Contact, the following Framework components must
be running:

* Configuration Server
* DB Server (for Configuration Server)

The next two components are optional; however, if you want to start Outbound
Contact Server with the Solution Control Interface, these must be running:

e Solution Control Server

e Solution Control Interface

Notes: * If you will be using the CPD Server, install all Dialogic
components on the same computer as CPD Server before starting
CPD Server.
* You can also start and stop Outbound Contact using Genesys
Administrator. For more information, see Framework 8.0 Genesys
Administrator Help.
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Reporting components can be started anytime after the Framework
components are started.

Using Solution Control Interface

Outbound Contact components can be started and stopped through or Solution
Control Interface (SCI)) or Genesys Administrator according to the specified
starting and stopping sequence in the Outbound Solution object.

Note: Instructions in the section are based on starting using SCI.

Starting Outbound Contact

By starting the Outbound Contact solution, you start the components that make
up that solution.

Procedure:
Starting Outbound Contact Solution/Components with
SCI

Start of procedure

1. Start SCI either by clicking Sci.exe or selecting Solution Control
Interface from the Start menu.

2. Go to the Solutions view.
3. Select the solution in the List pane.
4. Click Start or select Start from the shortcut menu.

The solution’s status changes from Stopped to Started after all solution
components have reported that their status is Running.

Note: Because many components are shared by several solutions, some
Outbound Contact components may have the status Started before the
solution is started.

End of procedure

Stopping Outbound Contact Solution/Components with SCI

There are three ways to stop all servers in Outbound Contact using SCI:

* Inthe Solutions folder, select the Outbound Contact to stop.
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* Select Stop from the Action menu.
*  From the toolbar, click the Stop Solution/Application button.

You can also stop components individually. See the next sections.

Note: Stopping the solution does not stop OCM; You must stop OCM
manually (see page 420).

If you are using Genesys Administrator, because it is a web
application, you log out and close the browser window.

Procedure:
Stopping CPD Server

Start of procedure

To stop CPD Server using SCI:
1. Select the CPD Server component in the Applications folder.

2. Select Stop from the Action menu.

End of procedure

Procedure:
Stopping CPD Proxy Server

Start of procedure

To stop CPD Proxy Server using SCI:
1. Select the CPD Proxy Server component in the Applications folder.

2. Select Stop from the Action menu.

End of procedure

Procedure:
Stopping OCS

Start of procedure

To stop OCS in SCI:
1. Select the OCS component in the Applications folder.

2. Select Stop from the Action menu.
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For more information, see Framework 8.0 Solution Control Interface Help. To
view the Help file, open SCI, and then launch the Help file.

End of procedure

Starting Manually

416

To start Outbound Contact manually, components must be started in a specific
order. For information about starting the Framework components DB Server,
Configuration Server, T-Server, and Stat Server, see the Framework 8.0
Deployment Guide.

For information about starting the Reporting components ICON and
CC Pulse+, see the Interaction Concentrator 7.5 Deployment Guide (or later)
and Reporting 7.5 Deployment Guide respectively.

Start components in the following order:

DB Server for Configuration Server

Configuration Server

T-Server

All other DB Servers (for Calling Lists)

Stat Server

ICON components for historical reporting

CPD Server (if needed)/CPD Proxy Server (if used)
Outbound Contact Server (OCS)

CC Pulse+ (for real-time and historical reporting)
10. Outbound Contact Manager (OCM) or Genesys Administrator

I L I S

Procedure:
Starting Outbound Contact Server

Start of procedure

You can start Outbound Contact Server (OCS) manually in three ways:
*  From the Start menu.

*  Open an MS-DOS command prompt and type the directory where
Outbound Contact Server is installed, for example, \Gcti\outbound
contact)\, and use a command line. When starting OCS from a command
line, use the following common command-line parameters:

-host The name of the host on which Configuration Server is running

-port The Configuration Server port
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-app The exact name of the Application as configured in the
Configuration Database

-1 The full path to the license file or host and port of the License
Manager in the <License Manager port>@<License
Manager host> format.

For example: cm_server.exe -host ConfigServer1 -port 2020 -app
0CServer1 -1 C:\flexlm\Llicense.dat.

Note: If you are implementing the client-side port security feature,
specify the additional arguments described in “Client-Side Port
Security Configuration” on page 132.

Run batch files, startServer.bat.

The startServer.bat files are created automatically during installation and
located at the same directories as executable files. Basically, these files
include some comments and the same options as are used when starting the
application from the command line.

The following is an example of a batch file for OCS:

eecho off

rem Copyright (C) 2009 Genesys Telecommunications Laboratories, Inc.
rem

rem startServer.bat file for Outbound Contact Server, version
8.0.000.05

@TITLE Outbound Contact Server v. 8.0.000.05: Application 0CServer
cm_server.exe -host lab1 -port 7070 -app 0CServer -1 7260elab1

End of procedure

Procedure:
Starting CPD Server

Start of procedure

You can start CPD Server manually in three ways:

From the Start menu.

Open an MS-DOS command prompt and type the directory where CPD
Server is installed—for example, \Gcti\cpd server\—and use a
command line.
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When starting CPD Server from a command line, use the following
common command-line parameters:

-host The name of the host on which Configuration Server is running
-port The Configuration Server port

-app The exact name of the application as configured in the
Configuration Database

-1 The full path to the license file or host and port of the License
Manager in the <License Manager port>@<License
Manager host> format.

For example: cpdserver.exe -host ConfigServer1 -port 2020 -app
CPDServer1 -1 C:\flexlm\Llicense.dat.

Note: If you are implementing the client-side port security feature,
specify the additional arguments described in “Client-Side Port
Security Configuration” on page 132.

e Run batch files, startServer.bat.

The startServer.bat files are created automatically during installation and
located at the same directories as executable files. Basically, these files
include some comments and the same options as are used when starting the
application from the command line.

The following is an example of a batch file for CPD Server:

eecho off

rem Copyright (C) 2009 Genesys Telecommunications Laboratories, Inc.
rem

rem startServer.bat file for Call Progress Detection Server, version
8.0.000.04

@TITLE Call Progress Detection Server v. 8.0.000.04: Application
cpdserver

cpdserver.exe -host lab2 -port 7070 -app cpdserver -1 7260elab2

End of procedure
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Procedure:
Starting CPD Proxy Server

Start of procedure

You can start CPD Proxy Server manually in three ways:
*  From the Start menu.

¢ Open an MS-DOS command prompt and type the directory where CPD
Proxy Server is installed—for example, \6cti\cpd_proxy\—and use a
command line. When starting CPD Proxy Server from a command line, use
the following common command-line parameters:

-host The name of the host on which Configuration Server is running
-port The Configuration Server port

-app The exact name of the application as configured in the
Configuration Database

For example: cpdproxy.exe -host ConfigServer1 -port 2020 -app
CpdProxy

Note: If you are implementing the client-side port security feature,
specify the additional arguments described in “Client-Side Port
Security Configuration” on page 132.

e Run batch files, startServer.bat.

The startServer.bat files are created automatically during installation and
located at the same directories as executable files. Basically, these files
include some comments and the same options as are used when starting the
application from the command line.

The following is an example of a batch file for CPD Proxy Server:

eecho off

rem Copyright (C) 2009 Genesys Telecommunications Laboratories, Inc.
rem

rem startServer.bat file for Call Progress Detection Proxy, version
8.0.000.04

@TITLE Call Progress Detection Proxy v. 8.0.000.04: Application
cpdproxy

cpdproxy.exe -host lab3 -port 7070 -app cpdproxy

End of procedure
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Procedure:
Starting and Logging In to Outbound Contact Manager

Note: For instructions on how to start and log into Genesys Administrator,

see the Framework 8.0 Genesys Administrator Deployment Guide.

Start of procedure

1.

To start Outbound Contact Manager, from the Start menu, select ALL
Programs » Genesys Solutions > Outbound Contact > Outbound Contact
Manager (OCM).

Note: When using Windows Explorer, you can also locate the OCM
executable in the destination folder of the OCM installation and
double-click it.

In the Login dialog box, enter a user name that has permission to use this
OCM. Change the user name to match Configuration Manager’s user
name.

Note: Persons (non-agents) are added automatically to the Admin Access
Group.

Click Details.

Enter the application name. The default application name is blank; this
name must be changed to the instance of Outbound Contact Manager as it
is registered in the Configuration Database.

Enter the host name of the computer running Configuration Server.

Enter the port number for the network port used by Configuration Server
on the host computer.

Click oK.

Note: Login will fail if Configuration Server is not running or if you do
not have permission to log in.

In the Select Tenant window, select a tenant from the list and click Next.
(Outbound Contact Manager can work with only one tenant at a time).

Note: You only see all tenants if you are a Super Administrator.
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9.

In the next window, select the Outbound Contact Server to which you
would like to connect and click Finish.

Campaigns, Calling Lists, Agent Groups, and Place Groups that have already
been defined in the Configuration Database appear the first time OCM is run.

If Outbound Contact Server is not running, Outbound Contact Manager still
logs in to Configuration Server and the user can work with calling lists.

End of procedure

Stopping

Manually

Stop components in the following order:

1.

S LA AN A WD

Outbound Contact Manager (OCM), if used instead of Genesys
Administrator

CCPulse+

Outbound Contact Server (OCS)

CPD Server/CPD Proxy Server (if used)
ICON components for historical reporting
Stat Server

All other DB Servers (for Calling Lists)
T-Server

Configuration Server

10. DB Server for Configuration Server

Outbound Contact Manager (OCM)

Deployment Guide

Note: Because Genesys Administrator is a web application, you log out of

the application instead of stopping it. For more information about
Genesys Administrator, see the Framework 8.0 Genesys
Administrator Deployment Guide.
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Procedure:
Stopping OCM

Start of procedure

1. Select the File menu.

2. SelectExit.

End of procedure

Outbound Contact Server (OCS)

Procedure:
Stopping Manually

Start of procedure

1. Find the 0CS console window on the computer’s desktop.

2. Click the Close button in the window’s upper-right corner.
End of procedure

Procedure:
Stopping as a Windows Service

Start of procedure

1. Select Services in the computer’s Control Panel.
2. In the Windows services window, select the OCS to stop.

3. Select Stop.

End of procedure
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CPD Server

Procedure:
Stopping Manually

Start of procedure

1. Find the CPD Server console window on the computer’s desktop.

2. Click the Close button in the window’s upper-right corner.
End of procedure

Procedure:
Stopping as a Windows Service

Start of procedure

1. Select Services in the computer’s Control Panel.
2. In the Windows Services window, select the CPD Server to stop.

3. Select Stop.

End of procedure

CPD Proxy Server

Deployment Guide

Procedure:
Stopping Manually

Start of procedure
1. Find the CPD Proxy Server console window on the computer’s desktop.

2. Click the Close button in the window’s upper-right corner.

End of procedure
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Procedure:
Stopping as a Windows Service

Start of procedure

1. Select Services in the computer’s Control Panel.
2. In the Windows Services window, select the CPD Proxy Server to stop.

3. Select Stop.

End of procedure

Restarting Outbound Contact Components

To restart Outbound Contact components, follow the previously documented
steps.
OCM does not keep long-term data, so it is safe to stop and restart/log in. OCS

will provide OCM with the campaign status. The same applies to Genesys
Administrator.

Connection and Reconnection

424

Outbound Contact components connect to servers to deliver and receive
information about the contact center. OCS and CPD Server can be set up with
the following standby mode:

¢ Warm Standby

Note: Currently, Outbound Contact components cannot be set up in cold
standby or hot standby modes.

OCS has a warm standby mode to handle situations in which OCS stops
working for any reason.

In Outbound Contact, the primary and backup OCS communicate through a
direct TCP/IP connection. In the warm standby mode, a secondary OCS
receives all of the same data about a dialing session/campaign group status (for
example, start, stop, Lload, unload) as the primary OCS. If the primary OCS
stops working for any reason, the secondary OCS takes over the operations of
the primary OCS without interruption. All client applications are connected to
the primary OCS.

For more information about the standby modes, refer to the Framework 8.0
Deployment Guide.
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OCS Connections
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OCS has connections to these components:

* DB Server

* T-Server or SIP Server, see page 426

o Stat Server, see page 427

» Configuration Server, see page 427

e CPD Server, see page 428

* CPD Proxy Server (if used), see page 428
* Backup or primary OCS

* Interaction Server (if used), see page 429
* OBN Manager (optional), see page 429

Using the outbound_contact_server option, you can set up special options for
the Communication DN that OCS uses. The Communication DN
communicates information about the status of dialing sessions/campaign
groups (for example, start, stop, load, unload, and so on) between the
backup and primary OCS as well as third-party applications, which can be
used in place of OCM or Genesys Administrator.

OCS and DB Server

If the connection between OCS and DB Server is lost, OCS sends an error
message. Depending on how long the loss of connection lasts, a message may
display in real-time reporting and historical reporting to indicate that OCS is
waiting for records.

Warm Standby

OCS supports DB Server in warm standby mode without manual intervention
and without double dialing of records.

If the OCS connection to the primary DB Server is lost, the currently running
dialing session for a campaign continues to dial calls until all records in the
OCS buffer are depleted. OCS sends a Waiting-for-Records message to Stat
Server, which causes the message to display also in CCPulse+. OCS then
connects to the backup DB Server. The dialing session for a campaign
continues to run after the switchover is complete. After switching to the
backup DB Server, OCS retries the failed transactions from the transaction
buffer. Double dials due to failed transactions are not induced by the
switchover.

If the connection to the backup DB Server is lost, OCS will reconnect to the
primary DB Server. OCS retries any failed transactions. During the switchover
to the primary DB Server, OCS runs without manual intervention.

Because OCS periodically queries calling lists for the number of ready records
and notifies Stat Server of the estimated time to complete the campaign
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calculation, this function may be interrupted during the loss of connection.
However, OCS continues to send this information after the connection is
reestablished.

No Standby

OCS tries to reconnect to DB Server without manual intervention and without
double dialing of records. Failed transactions are retried.

OCS and T-Server or SIP Server

The OCS connection to T-Server or SIP Server is set up on the Configuration
tab/Connections section of the 0CS Application object in Genesys
Administrator.

Note: Starting with release 7.5, the backup OCS application maintains a
direct connection to the primary OCS application.

Hot Standby

T-Server can operate in hot standby mode; however, this mode is transparent
to OCS. That is, although OCS is connected to T-Server, the switchover
between primary and secondary T-Servers does not affect OCS call processing.

Warm Standby

OCS reconnects to T-Server without manual intervention and without double
dialing of records.

OCS cannot send statistics during the switch to a backup server. OCS does not
re-send the statistics after the reconnection; therefore, some campaign statistics
might be lost.

Some calls are lost while OCS tries to reconnect to T-Server. According to an
internal timer expiration, OCS is able to track the lost calls, and mark the call
records with stale call result, which prevents double dialing of records.

If the OCS connection to the primary T-Server is lost, the currently running
dialing session for a campaign pauses. OCS connects to the backup T-Server
and then queries the backup T-Server for Queue, Agent, and Call Status. The
dialing session for a campaign continues to run after the switchover is
complete.

If the connection to the backup T-Server is lost, OCS reconnects to the primary
T-Server.

ADDP

OCS supports Advanced Disconnect Detection Protocol (ADDP), which
enables speedy disconnect detection. Configure the connection protocols in the
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OCS application object (Connections section of the Configuration tab in
Genesys Administrator).

The connection between OCS and T-Server is a passive connection; OCS
receives information from T-Server and relies on TCP/IP timeouts to identify
whether the disconnection might be too long. ADDP speeds up the detection of
the disconnect.

If no warm standby mode is specified, OCS will keep trying to connect to the
currently configured T-Server. The currently running dialing session for a
campaign will be paused until connection is resumed.

OCS, Stat Server, and Reporting

OCS can now connect directly with Stat Server, and submit data required for
statistical calculations for Stat Server extensions. OCS also communicates with
Stat Server through a Communication DN. OCS can send statistics to multiple
Stat Servers through one or more Communication DNs.

There is no warm standby or hot standby mode for Stat Server. Redundancy
for Outbound Contact real-time reporting can be achieved by:

* OCS sending statistics to multiple Stat Servers running simultaneously.
*  CCPulse+ reconnecting to a backup Stat Server when the primary is down.

If the OCS connection to Stat Server is lost, real-time reporting and data
collection for historical reporting resume without manual intervention after
Stat Server is running again. Note that real-time reporting and data collection
for historical reporting is interrupted when Stat Server is down.

In a multi-site environment, OCS is able to identify the statistics for each
T-Server and thus send statistics using the Communication DN registered with
each T-Server. Redundancy for Outbound reporting is possible by setting up
multiple Stat Servers running simultaneously.

OCS and Configuration Server

If the connection between OCS and Configuration Server is lost, OCS sends an
error message to Management Layer and does the following:

* After waiting the length of time specified in the Reconnect Timeout
parameter set in the application object, OCS tries to connect to a backup
Configuration Server.

* Ifno backup Configuration Server exists, after the timeout it tries to
reconnect to the primary Configuration Server.

OCS also supports Advanced Disconnect Detection Protocol (ADDP) to
Configuration Server. To enable ADDP between this server and Configuration
Server, add the Configuration Server Application (named confserv) to the
Configuration tab/Connections tab of Genesys Administrator and specify the
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values in seconds for the connection protocol. For more information, refer to
Framework 8.0 Genesys Administrator Help.

OCS and CPD Server

OCS can connect to multiple CPD Servers. In the Outbound Contact Wizard,
the association with CPD Server is set at the application level. To set it on the
group level, use Genesys Administrator or Configuration Manager.

Warm Standby

OCS supports CPD Server in warm standby mode without manual intervention
and without double dialing of records.

If OCS loses connection to CPD Server, OCS will send a message to
Management Layer and a system error message to Stat Server for real-time and
historical reporting.

If the OCS connection to the primary CPD Server is lost, the currently running
dialing session for a campaign is paused. OCS then connects to the backup
CPD Server and the dialing session for a campaign will continue to run after
the switchover to the backup CPD Server is complete.

After switching over to the backup server, OCS does not retry the previous
transactions handled by the disconnected CPD Server. Instead, call records in
those transactions are marked with the stale call result when the OCS internal
timer for those records expires. Double dialing of the same call record does not
occur.

If the connection to a backup CPD Server is lost, OCS reconnects to the
primary CPD Server without attempting to redial failed transactions.

No Backup

If there is no warm standby, OCS supports reconnection without manual
intervention and without double dialing of records. OCS tries to connect to the
currently configured CPD Server. The currently running dialing session for a
campaign pauses until the connection is restored.

Some calls are lost while OCS tries to reconnect to CPD Server. OCS tracks
lost calls according to the expiration of the internal timer for those records and
marks the call records with the stale call result, which prevents double dialing
of records.

OCS and CPD Proxy Server

OCS can connect to multiple CPD Proxy Servers. In the Outbound Contact
Wizard, the association with CPD Proxy Server is set at the application level.
To set it on the group level, use Genesys Administrator or Configuration
Manager.
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Warm Standby

OCS supports CPD Proxy Server in warm standby mode without manual
intervention and without double dialing of records.

If OCS loses connection to CPD Proxy Server, OCS will send a message to
Management Layer and a system error message to Stat Server for real-time and
historical reporting.

If the OCS connection to the primary CPD Server is lost, the currently running
dialing session for a campaign is paused. OCS then connects to the backup
CPD Proxy Server and the dialing session for a campaign will continue to run
after the switchover to the backup CPD Server is complete.

After switching over to the backup server, OCS does not retry the previous
transactions handled by the disconnected CPD Proxy Server. Instead, call
records in those transactions are marked with the stale call result when the
OCS internal timer for those records expires. Double dialing of the same call
record does not occur.

If the connection to a backup CPD Proxy Server is lost, OCS reconnects to the
primary CPD Proxy Server without attempting to redial failed transactions.

No Backup

If there is no warm standby, OCS supports reconnection without manual
intervention and without double dialing of records. OCS tries to connect to the
currently configured CPD Proxy Server. The currently running dialing session
for a campaign pauses until the connection is restored.

Some calls are lost while OCS tries to reconnect to CPD Proxy Server. OCS
tracks lost calls according to the expiration of the internal timer for those
records and marks the call records with the stale call result, which prevents
double dialing of records.

OCS and Interaction Server

For OCS to process requests and responses from Interaction Server, OCS must
be a server for Interaction Server and must receive these responses on a special
ESP-type port rather than its default listening port. This ESP PortID must be
used instead of the default PortID, when configuring a connection to the OCS
Application object on the Configuration tab of the Interaction Server
Application object in Genesys Administrator. This makes OCS a server for
Interaction Server and Interaction Server a client for OCS.

OCS and OBN Manager (Optional)

OCS uses the Outbound Notification Manager (OBN) application as a
connector to GVP to request that GVP dial records. The OBN Manager GVP
application should be created in Genesys Administrator or Configuration
Manager to provide its host and port information to OCS. This application
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must be specified on the Configuration tab/Connections section of the
Campaign Group configuration object in Genesys Administrator to enable
GVP integration. This configuration will enable basic connection capabilities.

If full connection abilities are required, including Advanced Disconnect
Detection Protocol (ADDP), then this application should also be present on the
Configuration tab/Connections section of the OCS application object in
Genesys Administrator, where the ADDP connection protocol can be
specified.

For more information about Outbound Contact and GVP integration, see
“Genesys Voice Platform” on page 82. See also the Genesys 8.0 Proactive
Contact Solution Guide.

OCS, Failover, Campaigns

If OCS is running dialing sessions for campaigns and then stops functioning
due to software, hardware, or network issues, the campaigns and records
associated with outbound calls are affected.

Note: You can configure OCS to restart automatically if you have
configured LCA, Solution Control Server, and Solution Control
Interface accordingly.

Impact on Campaigns

When OCS stops functioning, dialing sessions/campaign groups will not be
loaded and will not restart automatically even if OCS restarts.

If OCS is operating in the Warm Standby mode and running dialing sessions
for campaigns, the failure of the primary OCS causes the backup OCS to
continue running the dialing sessions for campaigns with a new set of available
records, which must be retrieved from the database. The retrieval occurs
immediately after the switchover to the backup OCS.

For Do Not Call records, when OCS switches from the backup server to the
primary server, OCS rereads those records that were added after the Do Not
Call list was initially read by OCS for all Tenants that have active/ running
dialing sessions for campaigns and whose Do Not Call list(s) were imported.
This synchronizes the Do Not Call list between the backup and primary OCS if
the primary OCS updates the list after the backup reads it, due to the addition
of new records to the Do Not Call list. No call requests will be created by OCS
until the Do Not Call list table is completely read.

Note: The primary and backup Outbound Contact Servers synchronize not
only the state of the campaigns and sequences, but also the predictive
algorithm information. The backup OCS is capable of taking over and
continuing dialing as efficiently as the primary if a Predictive dialing
mode is used.
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Impact on Records and Calls

When a failure and switchover occurs, be aware that:

* Records in use by the primary OCS remain in the retrieved state in the
database. These must be manually updated if you want those records to be
in a final state or if you want the associated numbers to be dialed again
when you run the dialing session for the campaign another time.

* The internal state of the records and associated outbound calls stored in the
memory of the primary OCS are lost when it stopped functioning.

* Any calls or interactions (if using the Push Preview dialing mode) being
processed by the OCS at the time of the failure continue to be queued,
routed, established with an agent DN, transferred, and so on.

* As these calls are processed, however, the agents handling them cannot
update the associated records because the records were lost when the
primary OCS stopped functioning.

Impact on Connections for Genesys Administrator

Genesys Administrator connects to OCS only when some action for a
Campaign Group is required. It attempts to connect to a backup server if no
primary server can be connected.

If no connection with OCS can be established, Genesys Administrator makes
associated its controls unavailable.

Impact on Connections for Outbound Contact Manager

When Outbound Contact Manager loses its connection to the primary OCS,
OCM displays a dialog box that allows the user to retry the connection to the
primary server or connect to the backup server.

Note: Starting with release 7.5, OCM supports a silent reconnection.

This reconnection issue does not apply to other servers or dialers to which
OCS connects (for example, CPD Server, T-Server, DB Server, and so on),
because connections to them should already be specified in the backup OCS
Application object. Agent Desktops are also not affected as they do not have a
direct connection to OCS. They only need the new OCS DBID, which will be
delivered to the Desktop with a record’s attached data.

OCM/Genesys Administrator Connections

OCM/Genesys Administrator have connections to the following components:
« OCS
* DB Server

* Configuration Server

Deployment Guide 431



Chapter 16: Starting and Stopping Procedures Connection and Reconnection

OCM/Genesys Administrator and OCS

OCM

OCM connects to one OCS at a time by prompting the user during login. OCM
supports dynamic reconfiguration of all OCS Application objects listed on
OCM’s Connections tab. Multiple instances of OCM can be connected to one
OCS concurrently. If multiple OCS Application objects are defined on the
OCM Application object’s Connections tab, the list of OCS Application
objects is displayed for the user to select.

If the connection between OCM and OCS is lost, OCM prompts the user to
reconnect or to select a backup OCS (if available).

Genesys Administrator

Genesys Administrator allows the user to select OCS any time an operation for
a Campaign Group is required.

OCM/Genesys Administrator and DB Server

OCM and Genesys Administrator establish an active connection to the
DB Server that is associated with the calling list on which the user is working.

If the original connection fails, OCM prompts the user to reconnect to the
DB Server or to select a backup DB Server (if available).

CPD Server Connections

432

A CPD Server connects to one T-Server (and one switch) only.

In a multi-site/multi-switch environment, Outbound Contact needs at least one
CPD Server per switch.

CPD Server and T-Server

The CPD Server connection to T-Server is set up on the Configuration
tab/Connections section of the CPD Server Application object.

Warm Standby

CPD Server with a T-Server in Warm Standby mode supports reconnection
without manual intervention and without double dialing of records.

If CPD Server’s connection to the primary T-Server is lost, the currently
running dialing session for the campaign pauses. CPD Server connects to the
backup T-Server. The currently running dialing session for the campaign
continues to run after the switchover to the new server. Some calls might be
lost in warm standby mode. According to an internal timer expiration, OCS
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tracks the lost call and marks the calls record as stale to prevent double
dialing.

If the connection to the backup T-Server is lost, CPD Server reconnects to the
primary T-Server. After switching over to the primary T-Server, CPD Server
runs without manual intervention.

No Backup

If CPD Server loses its connection to a T-Server that is not in a standby mode,
CPD Server tries to reconnect to the same T-Server. It reconnects without
manual intervention and without double dialing of records. The currently
running dialing session for the campaign pauses until the connection is
restored.

Some calls might be lost while CPD Server is trying to reconnect to T-Server.
OCS tracks the lost calls and marks the call record as stale to prevent double
dialing.

CPD Proxy Server Connections

Deployment Guide

A CPD Proxy Server connects to several CPD Servers, which must be
connected to the same switch only.

CPD Proxy Server and CPD Server(s)

The CPD Proxy Server connections to CPD Servers are set up on the
Configuration tab/Connections section of the CPD Proxy Server Application
object.

Warm Standby

CPD Proxy Server with a CPD Server in Warm Standby mode supports
reconnection without manual intervention and without double dialing of
records. If CPD Proxy Server's connection to the primary CPD Server is lost,
the currently running dialing session for the campaign slows down due to a
decreasing of the number of available dialing resources. CPD Proxy Server
connects to the backup CPD Server. After the switchover to the backup CPD
Server is completed the currently running dialing session for the campaign
speeds up due to an increasing of the available dialing resources. Some calls
might be lost during reconnection in warm standby mode on CPD Server side.
CPD Proxy Server reports to OCS about such calls as an Error to OCS. OCS
tracks the lost call and marks the calls record accordingly to prevent double
dialing.

If the connection to the backup CPD Server is lost, CPD Proxy Server
reconnects to the primary CPD Server. After switching over to the primary
CPD Server, CPD Proxy Server runs without manual intervention.
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No Backup

If CPD Proxy Server loses its connection to CPD Server that is not in a standby
mode, CPD Proxy Server tries to reconnect to the same CPD Server. It
reconnects without manual intervention and without double dialing of records.
The currently running dialing session for the campaign slows down until the
connection is restored.

Some calls might be lost while CPD Proxy Server is trying to reconnect to
CPD Server.

CPD Proxy Server reports to OCS about such calls as an Error to OCS. OCS
tracks the lost calls and marks the calls record accordingly to prevent double
dialing.

Transport Layer Security Connections

434

Outbound Contact Server, CPD Server, and CPD Proxy Server support
Transport Layer Security (TLS) with any Genesys TLS-supporting
client/server.

Outbound Contact Manager and the Outbound Contact Configuration Wizard
do not support TLS.

Notes: * If you are configuring TLS between OCS and DB Server, add a
Database Access Point (DAP) to DB Server on the Configuration
tab/Connections section of the OCS Application object in Genesys
Administrator.

* Genesys Administrator also supports TLS.

See the TLS section of the Genesys 8.0 Security Deployment Guide for more
information.
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Supplements

Related Documentation
Resources

The following resources provide additional information that is relevant to this
software. Consult these additional resources as necessary.

Outbound Contact

*  The Outbound Contact 8.0 Reference Manual, which describes application
features for Outbound Contact 7.6 and provides information about
configuration options, constants, and communication protocols.

*  QOutbound Contact Manager 8.0 Help, which describes how to use
Outbound Contact Manager.

Genesys Administrator

*  Genesys Administrator 8.0 Help, which describes how to use Genesys
Administrator, including topics covering Outbound Contact specific tasks.

Proactive Contact/Routing

*  The Genesys 8.0 Proactive Contact Solution Guide, which consolidates
information about the Genesys Proactive Contact solution. The Genesys
Proactive Contact solution integrates Outbound Contact with Genesys
Voice Platform (GVP), and provides the ability to proactively initiate and
handle outbound campaign calls using GVP.

* The Genesys 8.0 Proactive Routing Solution Guide, which provides
instructions on how to integrate Outbound Contact with the Customer
Interaction Management (CIM) Platform.

Framework

* The Framework 8.0 Deployment Guide, which will help you configure,
install, start, and stop Framework components.
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*  The Framework 8.0 Configuration Options Reference Manual, which will
provide you with descriptions of configuration options for other
Framework components.

*  Framework 8.0 Configuration Manager Help, which will help you use
Configuration Manager.

Genesys

* The Genesys 8 Events and Models Reference Manual, which contains the
T-Library API, information on TEvents, and an extensive collection of call
models.

*  Genesys Technical Publications Glossary, which ships on the Genesys
Documentation Library DVD and which provides a comprehensive list of
the Genesys and computer-telephony integration (CTI) terminology and
acronyms used in this document.

*  Genesys Migration Guide, which ships on the Genesys Documentation
Library DVD, and which provides documented migration strategies for
Genesys product releases. Contact Genesys Technical Support for more
information.

* Release Notes and Product Advisories for this product, which are available
on the Genesys Technical Support website at
http://genesyslab.com/support.

Information about supported hardware and third-party software is available on
the Genesys Technical Support website in the following documents:

*  Genesys Supported Operating Environment Reference Manual
*  Genesys Supported Media Interfaces Reference Manual
Consult these additional resources as necessary:

*  Genesys Hardware Sizing Guide, which provides information about
Genesys hardware sizing guidelines for the Genesys 8.x releases.

*  Genesys Interoperability Guide, which provides information on the
compatibility of Genesys products with various Configuration Layer
Environments; Interoperability of Reporting Templates and Solutions; and
Gplus Adapters Interoperability.

* Genesys Licensing Guide, which introduces you to the concepts,
terminology, and procedures relevant to the Genesys licensing system.

For additional system-wide planning tools and information, see the
release-specific listings of System Level Documents on the Genesys Technical
Support website, accessible from the system level documents by release tab
in the Knowledge Base Browse Documents Section.

Genesys product documentation is available on the:

* Genesys Technical Support website at http://genesyslab.com/support.
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Related Documentation Resources

* Genesys Documentation Library DVD, which you can order by e-mail
from Genesys Order Management at ordermanegenesyslab.com.
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Document Conventions

Document Conventions

This document uses certain stylistic and typographical conventions—
introduced here—that serve as shorthands for particular kinds of information.

Document Version Number

A version number appears at the bottom of the inside front cover of this
document. Version numbers change as new information is added to this
document. Here is a sample version number:

80fr_ref_06-2008_v8.0.001.00

You will need this number when you are talking with Genesys Technical
Support about this product.

Screen Captures Used in This Document

Screen captures from the product graphical user interface (GUI), as used in this
document, may sometimes contain minor spelling, capitalization, or
grammatical errors. The text accompanying and explaining the screen captures
corrects such errors except when such a correction would prevent you from
installing, configuring, or successfully using the product. For example, if the
name of an option contains a usage error, the name would be presented exactly
as it appears in the product GUI; the error would not be corrected in any
accompanying text.

Type Styles

Table 42 describes and illustrates the type conventions that are used in this
document.

Table 42: Type Styles

Type Style | Used For Examples
Italic * Document titles Please consult the Genesys Migration
«  Emphasis Guide for more information.
« Definitions of (or first references to) Do not use this value for this option.
unfamiliar terms A customary and usual practice is one
o Mathematical variables that is widely accepted and used within a
Also used to indicate placeholder text within particular industry or profession.
code samples or commands, in the special case | The formula, x +1 =7
where angle brackets are a required part of the | where x stands for . . .
syntax (see the note about angle brackets on
page 439).
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Table 42: Type Styles (Continued)

Note: In some cases, angle brackets are
required characters in code syntax (for
example, in XML schemas). In these cases,
italic text is used for placeholder values.

Type Style | Used For Examples
Monospace | All programming identifiers and GUI Select the Show variables on screen
font elements. This convention includes: check box.
(Looks like | * The names of directories, files, folders, In the Operand text box, enter your
teletype or configuration objects, paths, scripts, dialog | formula.
typewriter boxes, options, fields, text and list boxes, Click 0K to exit the Properties dialog
text) operational modes, all buttons (including box.
radio buttons), check boxes, commands,
tabs, CTI events, and error messages. T-Server distributes the error messages in
. EventError events.
* The values of options.
. Logical ts and d svnt If you select true for the
gical arguments and command syntax. ) )
inbound-bsns-calls option, all

* Code samples. established inbound calls on a local agent

Also used for any text that users must are considered business calls.

manually enter during a configuration or . Enter exit on the command line.

installation procedure, or on a command line.
Square A particular parameter or value that is optional | smcp_server -host [/flags]
brackets ([ ])| within a logical argument, a command, or

some programming syntax. That is, the

presence of the parameter or value is not

required to resolve the argument, command, or

block of code. The user decides whether to

include this optional information.
Angle A placeholder for a value that the user must smcp_server -host <confighost)
brackets specify. This might be a DN or a port number
(<>) specific to your enterprise.
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Index

Symbols
[l (square brackets). . . . . . ... ... .. 439
<> (angle brackets) . . . .. ... ... .. 439
A
addpoption. . . . . ... 204
addp-remote-timeoutoption . . . . . . . .. 204
addp-timeout option . . . . . ... ... .. 204
addp-traceoption. . . . ... ... ... .. 204
Advanced Disconnect Detection Protocol . .426
agent assignment, multiple campaigns . . . 44
AgentBusy Factor . . . . . . ... ... .. 54
Agent Group and Place Group Objects . . . 161
Agent or Place Group Object—Advanced Tab
Fields . . . ... ... ... .... 161
agent_logout_preview_call_result option . .227
agent_preview_mode_startoption. . . . . . 228
agent-assignmentoption. . . . . . . .. .. 226
agent-assignment-max-num option . . . . . 227
agent-assignment-min-num option. . . . . . 227
agent-assignment-priority option. . . . . . . 226
am-beep-detection option . . . . . . .. .. 228
am-detection-map option. . . . . . . . . .. 259
anglebrackets . . . . . ... ... ... .. 439
answer,rules. . . . . ... 337
Answering Machine Call Handling . . . . . . 354
Perrecord. . . . . . . ... ... ... 354
Application Server . . . . . . ... L. 358
apply to call
definiton. . . . . . . . ... ..o L. 336
rules. . . ... 353
apply to record
definiton. . . . . ... ... 336
Apply to Record actions . . . . . . ... .. 345
ASClifile. . . . ... ... ... .. ... 169
ASMmode . . . ... ... ... ... 53
callflowmodel. . . . . . ... ... ... 389
enablinginOCM. . . . ... ... .... 205
portrequirements . . . . . .. ... ... 390
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reporting statistic . . . . . .. ... ... 205
asmoption. . . . ... ... ... 205
asm_drop_am_announcement_data option . 211,

229

asm_drop_announcement_data option . . . 211
attach configuration userdata. . . . . . . . 217
audience, fordocument . . . . . ... ... 16
audio-codecsoption . . . . ... ... ... 279
AutoReconnectoption. . . . ... ... .. 203
Average Waiting Time . . . . . . . . . .. 54,55
B

beep-on-mergeoption. . . . . . ... ... 230
brackets

angle . . ... ... 439

square. . . ... 439
bridgingmethod . . . . . . . ... ... ... 94
busy-tone-1option. . . . . ... ... ... 285
busy-tone-2 option. . . . . . .. ... ... 285
C
calculating records

powergvp. . . . . . ... 83

powergvp (VoiP) . . . . . ... ... ... 84

progressive gvp. . . . . . ... ... 84

pushpreview . . . . ... ... ...... 83
call result

definiton . . . . . ... ... ... ... 336

outcomes . . . . . . ... 353

retry . . ..o 346

retryin. . . ... 346

rules. . . ... 337
call_answer_type_recognition option . 230, 263
call_timeguard_timeout option. . . . . . .. 233
call_transfer_type option. . . . . . . .. .. 232
call_wait_agent_connected_timeout option . 233
call_wait_connected_timeout option. . . . . 234
call_wait_in_queue_timeout option . . . . . 234
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call_wait_original_establish_timeout option . 234

callback-observe-group option. . . . . . .. 223
called-party-number-plan option . . . . . . . 279
called-party-number-type option . . . . . . . 279
Calling List

changing structure. . . . . . ... .. .. 177

definiton. . . . . . .. ... ... ... .. 36

finetuning . . . . . ... ... ... 177

weights in, definition. . . . . . . ... .. 112
Calling Listobject . . . . . ... ... ... 195

Generaltab . . . . ... ... ...... 176

Treatmentstab . . . . ... ... .... 176
Calling List properties

definiton. . . . . ... ... 112
Calling Session

configuring. . . . . . . ... ... .. .. 196
Calling Session object

creation . . . . ... ... ... ... 196
Calling Time From object. . . . . . . . . .. 173
Calling Time Toobject . . . . . . . .. ... 173
calling-party-number option . . . . . . . .. 280
calling-party-number-plan option. . . . . . . 280
calling-party-number-type option. . . . . . . 280
campaigncallback . . . . . ... ... .. 47,59
Campaign Group

definiton. . . . . . ... ... ... 42
Campaign Groups

Connections. . . . . . . ... ... ... 200
Campaign object

creation . . . . ... ... Lo 195

definition. . . . . .. ... ... ... .. 194
Campaign prioritization. . . . . . . . .. .. 46
Campaign sequencing . . . . . . . . .. .. 48
campaign_name_field option. . . . . . . .. 260
campaign-callback-distr option. . . . . . . . 235
Campaigns

definiton. . . . . .. ... ... ... 43,112

prioritization . . . . . ... ... L. 46

sequencing . . . .. ... 48

staffinglevels . . . . . . .. ... ... .. 46
cancel-on-desktop option . . . . . .. . .. 235
CCPulse. . . ... ... ... .. ..... 416
centralized configuration. . . . . . ... .. 73
chained records

definiton. . . . . ... ... ... 341

nextinchain. . . . .. .. ... ... 342,345

next in chain limitations . . . . . . . . .. 350

redial. . . . .. ... L 346

rules. . . ... ... 341
channel_numoption . . . . . .. ... ... 264
chardatatype . . . . ... ... ... ... 166
check _dnc_callback option. . . . . .. . .. 212
check dnc listoption . . . . ... ... .. 223
command-line . . ... ... ... 416,418,419
commenting on this document . . . . . . . . 16
CommunicatonDN . . . .. ... ... .. 159
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configuration
centralized . . . ... ... ... ..... 73
Configuration of Framework Objects . . . . 159
Configuration Server. . . . . . . . 413,416, 421
configuring
CPD Proxy Server . . . . .. ... ... 139
CPDServer. . ... ........... 138
OCM . . ... .. ... .. 136
OCS. . . ... . . . 134
Outbound Solution object. . . . . . . .. 144
connect outcome
definiton . . . . . .. ... ... ... 353
connection/reconnection. . . . . . . . . .. 424
continuous-no-signal option . . . . . . . .. 271
conventions
indocument. . . . . .. ... 438
typestyles. . . . ... ... 438
conversation-file-name-prefix option. . . . . 271
conversionoption . . . .. ... ... ... 259
CPD Proxy Server
configuring . . . . . . . .. ... ... 139
connections. . . . . ... ... ... .. 433
starting . . . . . ... Lo 419
CPD Proxy Server, General options
max-dialing-channels . . . . . . .. ... 278
max-engaging-channels . . . . . . . .. 278
CPDrecording. . . . ... ... ... ... 394
CPDServer . .. ... ....... 58,416, 421
configurationsteps . . . . . . ... ... 125
configuring . . . . . ... ... ... .. 138
connections. . . . ... ... ... ... 432
definiton . . . . ... ... 100, 137
Host Media Processing . . . . . . . . .. 406
recommended configuration process . . . 125
starting . . . .. ... 417
CPD Server Options
General Section. . . . . . ... ... .. 271
ISDN Section . . . . . ... ... .... 279
License Section. . . . . ... ... ... 292
Line-side Section . . . . . . . . ... .. 282
Tones Section. . . . . . ... ... ... 283

CPD Server options
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modes. . . . . . ... ... 292
CPD Server Section
Line-Side . . . .. ... ......... 282
ToneOptions . . . ... ... ...... 284
CPD Server, General options
continuous-no-signal . . . . . .. .. .. 271
conversation-file-name-prefix. . . . . . . 271
cpd-file-name-prefix. . . . . . ... . .. 271
cpd-if-established . . . . . . ... .. .. 272
cpd-recording . . . . .. ... ... ... 271
destination-busy-timeout . . . . . . . .. 272
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